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Preface

1. General information

1.1. Purpose

This User Guide explains how to manage Talend Open Sudio for Data Integration functions in a
normal operational context.

Information presented in this document applies to Talend Open Sudio for Data Integration releases
beginning with 5.1.x.

1.2. Audience

This guide isfor users and administrators of Talend Open Sudio for Data Integration.

Thelayout of GUI screens provided in this document may vary slightly from your actual GUI.

1.3. Typographical conventions

This guide uses the following typographical conventions:

* text in bold: window and dialog box buttons and fields, keyboard keys, menus, and menu and
options,

* text in[bold]: window, wizard, and dialog box titles,
e textincouri er: system parameters typed in by the user,

» textinitalics: file, schema, column, row, and variable names,

The '# iconindicates an item that provides additional information about an important point. It is
also used to add comments related to atable or afigure,

The £4 icon indicates a message that gives information about the execution requirements or
recommendation type. It is also used to refer to situations or information the end-user need to be
aware of or pay specia attention to.

2. History of changes

The following table lists changes made in the Talend Open Studio for Data Integration User Guide.
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Feedback and Support

Version

Date

History of Changes

v5.0 a

12/12/2011

Updates in Talend Open Studio for Data Integration User Guide
include:

 Post-migration restructuring

 Updated documentation to reflect new product names. For further
information on these changes, see Talend's website.

» Updated chapter: Getting Started with Talend Open Sudio for
Data Integration

« Updated chapter: Designing a data integration Job
» Updated chapter: Mapping data flows
» Updated chapter: Managing M etadata

 Updated appendix: Theory into practice: Job examples

v5.0 b

13/02/2012

Updates in Talend Open Studio for Data Integration User Guide
include:

» Added legal noticesto the User Guide.

 Updated the formatting of part of the User Guide.

v5.1 a

03/05/2012

Updates in Talend Open Studio for Data Integration User Guide
include;

» Added descriptions about multiple loop elements and setting the
root element asloop element in using tXMLMap.

e Updated screenshots and descriptions about setting up a
Copybook connection.

3. Feedback and Support

Y our feedback isvaluable. Do not hesitate to give your input, make suggestions or requests regarding
this documentation or product and find support from the Talend team, on Talend’ s Forum website at:

http://talendforge.org/forum

viii
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Chapter 1. Data integration and Talend
Studio

There is nothing new about the fact that organizations' information systems tend to grow in complexity. The
reasons for this include the “layer stackup trend” (a new solution is deployed athough old systems are still
maintained) and the fact that i nformati on systems need to be more and more connected to those of vendors, partners
and customers.

A third reason is the multiplication of data storage formats (XML files, positiona flat files, delimited flat files,
multi-valued files and so on), protocols (FTP, HTTP, SOAP, SCP and so on) and database technologies.

A question arises from these statements: How to manage a proper integration of this data scattered throughout the
company’ sinformation systems? Various functions lay behind the dataintegration principle: businessintelligence
or analytics integration (data warehousing) and operational integration (data capture and migration, database
synchronization, inter-application data exchange and so on).

Both ETL for analyticsand ETL for operational integration needs are addressed by Talend Open Sudio for Data
Integration.

Talend Open Studio for Data Integration User Guide



Data analytics

1.1. Data analytics

While mostly invisible to users of the Bl platform, ETL processes retrieve the data from all operational systems
and pre-process it for the analysis and reporting tools.

Talend Open Sudio for Data Integration offers nearly comprehensive connectivity to:

 Packaged applications (ERP, CRM, etc.), databases, mainframes, files, Web Services, and so on to address the
growing disparity of sources.

» Datawarehouses, data marts, OLAP applications - for analysis, reporting, dashboarding, scorecarding, and so
on.

* Built-in advanced components for ETL, including string manipulations, Slowly Changing Dimensions,
automatic lookup handling, bulk loads support, and so on.

M ost connectors addressing each of the above needs are detailed in the Talend Open Studio Components Reference
Guide. For information about their orchestration in Talend Open Sudio for Data Integration, see Chapter 4,
Designing a data integration Job. For high-level business-oriented modeling, see Chapter 3, Designing a Business
Model.

1.2. Operational integration

Operational data integration is often addressed by implementing custom programs or routines, completed on-
demand for a specific need.

Datamigration/loading and data synchronization/replication are the most common applications of operational data
integration, and often require:

Complex mappings and transformations with aggregations, calculations, and so on due to variation in data
structure,

Conflicts of datato be managed and resolved taking into account record update precedence or “record owner”,

Data synchronization in nearly real time as systemsinvolve low latency.

2 Talend Open Studio for Data Integration User Guide



Operational integration

M ost connectors addressing each of the above needs are detailed in the Talend Open Studio Components Reference
Guide. For information about their orchestration in Talend Open Sudio for Data Integration, see Chapter 4,
Designing a data integration Job. For high-level business-oriented modeling, see Chapter 3, Designing a Business
Model. For information about designing a detailed data integration Job using the output stream feature, see
Section B.2, “ Using the output stream feature”.

Talend Open Studio for Data Integration User Guide 3
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Chapter 2. Getting started with Talend Studio

This chapter introduces Talend Open Sudio for Data Integration. It provides basic configuration information
required to get started with Talend Open Sudio for Data Integration.

The chapter guides you through the basic stepsin creating local projects. It aso describes how to set preferences
and customize the workspace in Talend Open Studio for Data Integration.

Before starting any data integration processes, you need to be familiar with Talend Open Sudio for Data
Integration Graphical User Interface (GUI). For more information, see Appendix A, GUI.

Talend Open Studio for Data Integration User Guide



Important concepts in Talend Open Sudio for Data Integration

2.1. Important concepts in Talend Open
Studio for Data Integration

When working with Talend Open Sudio for Data I ntegration, you will often come acrosswords such asrepository,
project, workspace, Job, component and item.

Understanding the concept behind each of these words is crucial to grasping the functionality of Talend Open
Sudio for Data Integration.

What isarepository? A repository isthe storage location Talend Open Sudio for Data I ntegration usesto gather
datarelated to al of the technical itemsthat you use either to describe business models or to design Jobs.

What isa project? Projects are structured collections of technical items and their associated metadata. All of the
Jobs and business models you design are organized in Projects.

Y ou can create as many projects asyou need in arepository. For moreinformation about projects, see Section 2.4,
“Working with projects’.

What is a workspace? A workspace is the directory where you store all your project folders. You need to have
oneworkspace directory per connection (repository connection). Talend Open Sudio for Data | ntegration enables
you to connect to different workspace directories, if you do not want to use the default one.

For more information about workspaces, see Section 2.3, “Working with different workspace directories’.

What isa Job? A Job isagraphical design, of one or more components connected together, that allows you to set
up and run dataflow management processes. It translates business needs into code, routines and programs. Jobs
address all of the different sources and targets that you need for data integration processes and all other related
processes.

For detailed information about how to design data integration processes in Talend Open Sudio for Data
Integration, see Chapter 4, Designing a data integration Job.

What is a component? A component is a preconfigured connector used to perform a specific data integration
operation, no matter what data sources you are integrating: databases, applications, flat files, Web services, etc.
A component can minimize the amount of hand-coding required to work on data from multiple, heterogeneous
sources.

Components are grouped in families according to their usage and displayed in the Palette of the Talend Open
Sudio for Data Integration main window.

For detailed information about components types and what they can be used for, see the Talend Open Studio for
Data Integration Reference Guide.

What isan item? Anitemisthefundamental technical unitinaproject. Itemsare grouped, according to their types,
as. Job Design, Business model, Context, Code, Metadata, etc. One item can include other items. For example,
the business models and the Jobs you design are items, metadata and routines you use inside your Jobs are items
aswell.

2.2. Launching Talend Open Studio for Data
Integration

2.2.1. How to launch the Studio for the first time

To open Talend Open Sudio for Data Integration for the first time, complete the following:
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4,

Unzip the Talend Open Sudio for Data Integration zip file and, in the folder, double-click the executable
file corresponding to your operating system.

The Studio zip archive contains binaries for several platformsincluding Mac OS X and Linux/Unix.
b

Inthe[License] window that appears, read and accept the terms of the end user license agreement to continue.

The startup window appears.

Welcome ko Talend Open Studio

Before wou can begin working with Talend, wou need ko create a project,
You can skart with a demo project that contains useful examples, or
create an empky project of wour own,

Select A Demo Project | TALENDDEMOS 1844 v| [wmport |
Create & Mew Project | projectiame Create

v

This screen appears only when you launch the Talend Open Sudio for Data Integration for the first
¥ timeor if all existing projects have been deleted.

Click the Import button to import the selected demo project, or type in aproject name in the Create A New
Project field and click the Create button to create a new project, or click the Advanced... button to go to
the Studio login window.

In this procedure, click Advanced... to go to the Studio login widow. For more information about the other
two options, see Section 2.4.2, “How to import the demo project” and Section 2.4.1, “How to create aproject”
respectively.

YWelcome to Talend Cpen Studio.Please select an existing
project to start work,or create a new one,

Project:

[Create... ] [Impu:-rt...] [ Demo Project... ]

Workspace! | E:\Studios\Talend_S\TOS-Allr70871-V5.0.0M8\workspac| [ Change |
x A project is needed...

From the Studio login window:

Click... To..
Create... create a new project that will hold all Jobs and Business models designed
in the Studio.

Talend Open Studio for Data Integration User Guide 7
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Click... To...
For more information, see Section 2.4.1, “How to create a project”.

Import... import one or more existing projects.

For more information, see Section 2.4.3, “How to import projects’.

Demo Project... import the Demo project including numerous samples of ready-to-use
Jobs. This Demo project can help you understand the functionalities of
different Talend components.

For more information, see Section 2.4.2, “How to import the demo
project”.

Open open the selected existing project.

For more information, see Section 2.4.4, “How to open a project”.

Delete... open adialog box in which you can delete any created or imported project
that you do not need anymore.

For more information, see Section 2.4.5, “How to delete a project”.

Asthe purpose of this procedureisto create a new project, click Create... to open the [New project] dialog
box.

5. Inthe diaog box, enter a name for your project and click Finish to close the dialog box. The name of the
new project is displayed in the Project list.

Welcome to Talend Open Studio, Please seleck an existing
project to skart work,or create a new one,

Project:  |Rfei=an

[Create... ] [Impnrt...] [ Dermno Project. .. ]

workspace: | E:\Studios| Talend_5\TOS-all-r70207-Y5.0,0NB workspac
S

6. Select the project, and click Open.

The Connect to TalendFor ge page appears, inviting you to connect to the Talend Community so that you can
check, download, install external components and upload your own components to the Talend Community
to share with other Talend users directly in the Exchange view of your Job designer in the Studio.

To learn more about the Talend Community, click the read more link. For more information on using
and sharing community components, see Section 4.5.3, “How to download/upload Talend Community
components’.

7. If you want to connect to the Talend Community later, click Skip to continue.

8. If you are working behind a proxy, click Proxy setting and fill in the Proxy Host and Proxy Port fields of
the Network setting dialog box.

9. By default, the Studio will automatically collect product usage data and send the data periodically to servers
hosted by Talend for product usage analysis and sharing purposes only. If you do not want the Studio to do
so, clear the | want to help to improve Talend by sharing anonymous usage statistics check box.
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How to launch the Studio for the first time

10.

11.

Y ou can a'so turn on or off usage data collection in the Usage Data Collector preferences settings. For more
information, see Section 2.5.15, “Usage Data Collector preferences’.

Fill in the required information, select the | Agreeto the TalendForge Terms of Use check box, and click
Create Account to create your account and connect to the Talend Community automatically. If you aready
have created an account at http://www.talendforge.org, click the or connect on existing account link to sign
in.

Be assured that any personal information you may provide to Talend will never be transmitted to
2 third parties nor used for any purpose other than joining and logging in to the Talend Community
and being informed of Talend latest updates.

% Connect to TalendForge Pgl

Cannect your studio o TalendForge, the Talend online cammunity,

® Download new components and connectors from Talend Exchange

®  Access the mosk recent documentation and tech articles From
the Talend social knowledgebase,

telen
forge

* See the latest messages in the Talend discussion Forums

Create an accounk

Username: | testuser *

Emnail: |testuser@compan\;.com *

*

Password{again): |******** *

Passwiard: |******** |

Country: | nited States v

[#]1 agree ta the TalendForge Terms of Use
[#]1 want to help ko improve Talend by sharing anonymous usage skatiskics

{read more...)

[ Create Account

Prowy settings. .. Skip

This page will not appear again at Studio startup once you successfully connect to the Talend
2 Community or if you click Skip too many times. You can show this page again from the
[Preferences] dialog box. For more information, see Section 2.5.3, “Exchange preferences’.

A progress information bar and a welcome window display consecutively. From this page you have direct
links to user documentation, tutorials, Talend forum, Talend Exchange and Talend latest news.

Click Start now! to open Talend Open Studio for Data Integration main window.
The main window opens on a welcome page which has useful tips for beginners on how to get started with
the Studio. Clicking an underlined link brings you to the corresponding tab view or opens the corresponding

dialog box.

For more information on how to open a project, see Section 2.4.4, “How to open a project”.
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How to set up a project

[ Talend Gpen studio 23 =8

Welcome to Talend Open Studio

This powerful and flexible tool helps you take control of your data.
Before you get started, here are the basics:

First, create a Job using Drop source, target, and Wiew and configure the

the Job Designer. transformation properties of your Job
Right click and select components from the components in the
Create Job. Palette to wour Job .. Component tab.

And finally, use the Run Job tab to execute your Job and wiew the results.

2.2.2. How to set up a project

To open the Talend Open Studio for Data Integration main window, you must first set up a project.
Y ou can set up aproject by:
* creating anew project. For more information, see Section 2.4.1, “How to create a project”.

 importing oneor more projectsyou aready created in other sessionsof Talend Open Sudio for Data I ntegration.
For more information, see Section 2.4.3, “How to import projects’.

 importing the Demo project. For more information, see Section 2.4.2, “How to import the demo project”.

2.3. Working with different workspace
directories

Talend Open Studio for Data Integration makes it possible to create many workspace directories and connect to
aworkspace different from the one you are currently working on, if necessary.

This flexibility enables you to store these directories wherever you want and give the same project name to two
or more different projects as long as you store the projects in different directories.
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How to create a new workspace directory

2.3.1. How to create a new workspace directory

Talend Open Sudio for Data Integration is delivered with adefault workspace directory. However, you can create
as many new directories as you want and store your project folders in them according to your preferences.

To create a new workspace directory:

1. Inthe project login window, click Change to open the dialog box for selecting the directory of the new

workspace.
welcome to Talend Qpen Studio, Please select an existing
project ko skart wark,ar creake a new one.
[ Creake, ., ] [Impnrt. " ] [ Dermo Project... ]
Workspace: | E1\studios| Talend_SiTOS-All-+70207-45.0.0NB workspac
S

2. Inthediaog box, set the path to the new workspace directory you want to create and then click OK to close
the view.

On the login window, a message displays prompting you to restart the Studio.

3. Click Restart to restart the Studio.

4. Onthere-initiated login window, set up a project for this new workspace directory.
For more information, see Section 2.2.2, “How to set up aproject”.

5. Select the project from the Project list and click Open to open Talend Open Sudio for Data Integration
main window.

All business models or Jobs you design in the current instance of the Studio will be stored in the new workspace
directory you created. .

When you need to connect to any of the workspaces you have created, simply repeat the process described in
this section.

2.4. Working with projects

In Talend Open Sudio for Data Integration, the highest physical structure for storing all different types of data
integration Jobs and business models, metadata, routines, etc. isthe “ project”.

From the login window of Talend Open Sudio for Data Integration, you can:
* import the Demo project to discover the features of Talend Open Sudio for Data I ntegration based on samples

of different ready-to-use Jobs. When you import the Demo project, it isautomatically installed in the workspace
directory of the current session of the Studio.
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How to create a project

For more information, see Section 2.4.2, “How to import the demo project”.

« createalocal project. When connecting to Talend Open Sudio for Data Integration for the first time, there are
no default projectslisted. Y ou need to create aproject and open it in the Studio to store all the Jobs and business
models you create in it. When creating a new project, a tree folder is automatically created in the workspace
directory on your repository server. This will correspond to the Repository tree view displaying on Talend
Open Sudio for Data Integration main window.

For more information, see Section 2.4.1, “How to create a project”.

 import projects you have already created with previous releases of Talend Open Sudio for Data Integration
into your current Talend Open Sudio for Data Integration workspace directory by clicking Import... .

For more information, see Section 2.4.3, “How to import projects’.
 open aproject you created or imported in the Studio.
For more information, see Section 2.4.4, “How to open a project”.
 deletelocal projectsthat you aready created or imported and that you do not need any longer.
For more information, see Section 2.4.5, “How to delete a project”.
Once you launch Talend Open Sudio for Data Integration, you can export the resources of one or more of the

created projects in the current instance of the Studio. For more information, see Section 2.4.6, “How to export
aproject”.

2.4.1. How to create a project

When you launch the Studio for the first time, there are no default projectslisted. Y ou need to create a project that
will hold al dataintegration Jobs and business models you design in the current instance of the Studio.

To create a project:
1. Launch Talend Open Sudio for Data Integration.
2. Usedither of the following two options:

» Enter aproject nameinthe Create A New Project field and click Createto openthe[New project] dialog
box with the Project namefield filled with the specified name.

 Click Advanced, and then from the login window click Create... to open the [New project] dialog box
with an empty Project namefield.
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How to create a project

%* New project |Z|E

Project 1.!
ol il
3
Project name |F‘ru:-jeu:t 1| |
Technical Mame | |
Project description
Finish l [ Cancel

In the Project namefield, enter aname for the new project, or change the previously specified project name
if needed. Thisfield is mandatory.

A message shows at the top of the wizard, according to the location of your pointer, to inform you about the
nature of datato be filled in, such as forbidden characters

The read-only “technical name” is used by the application as file name of the actual project file.
2 This name usually corresponds to the project name, upper-cased and concatenated with underscores
if needed.

Click Finish. The name of the newly created project is displayed in the Project list in Talend Open Sudio
for Data Integration login window.

Wilcome to Talend Open Studio, Please seleck an existing
project to skart work, or create a new one,

Project: | TTeR]= i

Delete. ..

[Create... ] [Impn:nrt...] [ Derno Project. .. ]

workspace: |E:'I,Studiu:us'l,TaIend_S'l,TOS-.ﬁ.II-r?IZIS1I-HS.D.DRCI'I,WDrkspE
Al

[ Change ]

From version 5.0 onwards, Java s the only language generated.
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How to import the demo project

To open the newly created project in Talend Open Sudio for Data Integration, select it from the Project list and
then click Open. A generation engine initialization window displays. Wait till the initialization is complete.

Later, if you want to switch between projects, on the Studio menu bar, use the combination File > Switch Pr oj ect.

If you already used Talend Open Studio for Data Integration and want to import projects from a previous release,
see Section 2.4.3, “How to import projects’.

2.4.2. How to import the demo project

In Talend Open Sudio for Data Integration, you can import the demo project that includes numerous sampl es of
ready to use Jobs. This demo project can help you understand the functionalities of different Talend components.

At thefirst launch of Talend Open Studio for Data Integration, you can:

* create anew project in your repository using the demo project as atemplate,
* import the demo project TALENDDEMOSIAVA into your repository.

To create anew project based on the demo project:

1. Click the Import button next to the Select A Demo Project list box. The [Import Demo Project] dialog

box opens.
% Import Demo Project El@@

Project

Project name Demo-based project

Technical Mame

Project description

Finish ] [ Cancel

2. Typeinaname for the new project, and click Finish to create the project.

A confirmation message is displayed, informing you that the demo project has been successfully imported
in the current instance of the Studio.

3. Click OK to close the confirmation message.
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How to import projects

All the samples of the demo project are imported into the newly created project, and the name of the new
project is displayed in the Project list on the login screen.

To import the demo project TALENDDEMOSIAVA into your repository:

1. Click Advanced..., and then from the login window click Demo Project.... The [Import demo pr oject]
dialog box opens.

Import demo project

Select the demo project to import.,

Available demo projects.

; LB T A ENDDEMOSJAVA

The Java Demo project
can help you grasp all
functionalities and
components at a

glance. Discover how to
setup and configure the
powerful components via
meaningful job samples

Finish l [ Cancel

2. Select the demo project and then click Finish to close the dialog box.

A confirmation message is displayed, informing your that the demo project has been successfully imported
in the current instance of the Studio.

3. Click OK to close the confirmation message.
The imported demo project displaysin the Project list on the login window.

To open the imported demo project in Talend Open Studio for Data Integration, select it from the Project list and
then click Open. A generation engine initialization window displays. Wait till the initialization is complete.

The Job samples in the open demo project are automatically imported into your workspace directory and made
available in the Repository tree view under the Job Designs folder.

Y ou can use these samples to get started with your own Job design.

2.4.3. How to import projects

In Talend Open Sudio for Data Integration, you can import projects you already created with previous releases
of the Studio.
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How to import projects

1. If you are launching Talend Open Sudio for Data Integration for the first time, click Advanced... to open
to the login window.

2. From the login window, click Import... to open the [Import] wizard.

Import Projects =
Select a directory to search For existing Eclipse projects, .-" .'

-

() Select root directary:  |E:\alTOS-All-r57577-v4, 2.0RC 1 workspe

() Select archive file:

Projects:

PROJECT 2010 (E:\a\TOS-Al-r57577-44.2 0RC1workspacy | salect &l
PROJECT 2011 (E:\a\TOS-Al-r57577-v4. 2, 0RC 1 warkspac
Deselect Al
’ ,

Copy projects into workspace

Import project as Finish ] [ Zancel

3. Click Import several projectsif you intend to import more than one project simultaneously.

4. Click Select root directory or Select ar chive file depending on the source you want to import from.

5. Click Browse... to select the workspace directory/archive file of the specific project folder. By default, the
workspace in selection is the current release’s one. Browse up to reach the previous release workspace

directory or the archive file containing the projects to import.

6. Select the Copy projects into workspace check box to make a copy of the imported project instead of
moving it.

If you want to remove the original project folders from the Talend Open Sudio for Data Integration
¥ workspace directory you import from, clear this check box. But we strongly recommend you to keep
it selected for backup purposes.
7. Fromthe Projectslist, select the projectsto import and click Finish to validate the operation.

In the login window, the names of the imported projects now appear on the Project list.

16 Talend Open Studio for Data Integration User Guide



How to open a project

Welcome to Talend Open Studio, Please seleck an existing
project to skart work,or create a new one,

ey e S PR CJECT 2010
2n
PROJECT 2011 B op

[Create... ] [Impnrt...] [ Dermno Project. .. ]

Workspace: £y studios| Talend_S1TOS-All70511-¥5.0.0RCLworksps
A

Y ou can now select the imported project you want to open in Talend Open Studio for Data Integration and click
Open to launch the Studio.

A generation initialization window might come up when launching the application. Wait until the
¥ initialization is complete.

2.4.4. How to open a project

When you launch Talend Open Studio for Data Integration for the first time, no project names are
displayed on the Project list. First you need to create a project or import a Demo project in order to
populate the Pr oj ect list with the corresponding project names that you can then open in the Studio.

VLN

To open aproject in Talend Open Sudio for Data Integration:

On the Studio login screen, select the project from the Project list, and click Open.

Welcome ko Talend Open Studio.Please seleck an existing
project to skart wark,or creake a new one,

Project:  |[I:TeR=m il

[Create... ] [Impl:urt...] [ Derno Project,.. ]

workspace:  E:\Studios| Talend_S\TOS-Allr70511-v5.0,0RCLworkspe
A

A progress bar appears, and the Talend Open Sudio for Data I ntegration main window opens. A generation engine
initialization dialog bow displays. Wait till initialization is complete.

When you open a project imported from a previous version of the Studio, an information window pops
¥ up to list a short description of the successful migration tasks. For more information, see Section 2.4.7,
“Migration tasks’.
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How to delete a project

2.4.5. How to delete a project

1. Onthelogin screen, click Delete...to open the [Select Project] dialog box.

# Select Project

Delete Project

[tk MyPROJECT Select Al
ml=3rarallELIzE
Deselect Al

[ ] Do not delete projects physically

K ] [ Cancel

2. Select the check box(es) of the project(s) you want to delete.
3. Click OK to validate the deletion.
The project list on the login window is refreshed accordingly.

Be careful, thisaction isirreversible. When you click OK, there is no way to recuperate the deleted
£\ project(s).

If you select the Do not delete proj ects physically check box, you can del ete the selected project(s)

4 only from the project list and till have it/them in the workspace directory of Talend Open Studio for
Data Integration. Thus, you can recuperate the del eted project(s) any time using the Import existing
project(s) aslocal option on the Project list from the login window.

2.4.6. How to export a project

Talend Open Studio for Data I ntegration, allows you to export projects created or imported in the current instance
of Talend Open Sudio for Data I ntegration.

1
On the toolbar of the Studio main window, click el to open the [Export Talend projectsin archivefile]

dialog box.
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Migration tasks

Archive file

Export resources to an archive file on the local file syskem,

[B]= FIRSTPROJECT %] .project
[¥] = MYPROJECT = talend. project
[ ]i=F TALEMDDEMOSIAYA

[Filter Types.., ] [ Select Al ] [ Deselect all ]
Ta archive File: | L\ CienkxML. zip V| [ Browse, ..
Options

(%) Save in zip Format (%) Create directory struckure For Files

() Save in tar format (") Create only selected directories

Compress the cantents of the file

(7 [ Finish l [ Cancel

2. Select the check boxes of the projects you want to export. You can select only parts of the project through
the Filter Types... link, if need be (for advanced users).

3. IntheTo archivefilefield, type in the name of or browse to the archive file where you want to export the
selected projects.

4. Inthe Option area, select the compression format and the structure type you prefer.
5. Click Finish to validate the changes.

The archived file that holds the exported projectsis created in the defined place.

2.4.7. Migration tasks

Migration tasks are performed to ensure the compatibility of the projects you created with a previous version of
Talend Open Sudio for Data Integration with the current release.

As some changes might become visible to the user, we thought we' d share these update tasks with you through
an information window.

This information window pops up when you launch the project you imported (created) in a previous version
of Talend Open Sudio for Data Integration. It lists and provides a short description of the tasks which were
successfully performed so that you can smoothly roll your projects.
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Setting Talend Open Studio for Data Integration preferences

x]

# Migration tasks done

Hete are the migration tasks applied on this session on this project,

B Rename tDBAxTotOraclexx

Migrate database generic components connecked to a Oracle dakabase to the corresponding specific Cracle
compaonents,

B Hename tDBxxTotMySOLxx

Migrate database generic components connected to a MySOL database to the corresponding specific MyS0L
cormponents,

B Rename tDBRXTotPostgresqlx

Migrate database generic companents connecked ko a PostareaL dakabase ba the corresponding specific
PostgrescL components,

B Rename tDBHHTotMssqlux

Migrate database generic components connecked to a Microsoft S0L Server database ko the corresponding "

Some changes that affect the usage of Talend Open Sudio for Data Integration include, for example:

» tDBInput used with a MySQL database becomes a specific tDBMysgll nput component the aspect of which
isautomatically changed in the Job where it is used.

» tUnigRow used to be based on the Input schemakeys, whereas the current tUnigRow allows the user to select
the column to base the unicity on.

2.5. Setting Talend Open Studio for Data
Integration preferences

Y ou can define various properties of Talend Open Sudio for Data Integration main design workspace according
to your needs and preferences.

Numerous settings you define can be stored in the Preference and thus become your default values for all new
Jobs you create.

The following sections describe specific settings that you can set as preference.

First, click the Window menu of your Talend Open Studio for Data Integration, then select Prefer ences.

2.5.1. Java Interpreter path

The Java Interpreter path is set default in the Java file of your computer (by default Program Files\Java\jre6\bin
\java.exe).
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External or User components

Talend =1 - -
Temporary files  ChUsers\fbensaidDesktoph TMDMCE-5Studio-All-ri9933-V5.0.0MB termp Browse...
Java interpreter  C:M\Program Files'Javajref\bin\java.exe Browse...
Preview limit 50

Multi Thread execution (Default value for job creation)

iReport path Browse...

| Always show welcome view when startup

| Restare Defaults| | Apply |

[ Ok ] | Cancel |

To customize your Java Interpreter path:

1

2.

If needed, click the Talend node in the tree view of the [Pr efer ences] dialog box.

Enter apath in the Java interpreter field if the default directory does not display the right path.

On the same view, you can also change the preview limit and the path to the temporary files or the OS language.

2.5.2. External or User components

Y ou can create and develop your own components for use in Talend Open Sudio for Data Integration.

For further information about the creation and devel opment of user components, refer to the component creation
tutorial on our wiki at http://www.talendforge.org/wiki/doku.php?id=component_creation.

1

In the tree view of the [Preferences] dialog box, expand the Talend node and select Components.

Components T v
User component Folder: | CriDocuments and SetkingsihmassyiBureadit
Mapper
Default mapping links display as @ | Auko w
ERunJob

[ JDon't show correspanding job after double click on a tRunlob Component,

[ Restare Defaulks ] [ Apply ]

[ ok ][ Cancel ]

Enter the User componentsfolder path or browse to the folder that holds the components to be added to the
Talend Open Sudio for Data Integration Palette.

From the Default mapping links display as list, select the mapping link type you want to use in the tM ap.

Talend Open Studio for Data Integration User Guide 21


http://www.talendforge.org/wiki/doku.php?id=component_creation

Exchange preferences

4. Under tRunJob, select the check box if you do not want the corresponding Job to open upon double clicking
atRunJob component.

You will still be able to open the corresponding Job by right clicking the tRunJob component and
¥ selecting Open tRunJob Component.
5. Click Apply and then OK to validate the set preferences and close the dialog box.

The external components are added to the Palette.

2.5.3. Exchange preferences

Y ou can set preferencesrel ated to your connection with Talend Exchange, whichispart of the Talend Community,
in Talend Open Studio for Data Integration. To do so:

1.  Fromthe menu bar, click Window > Preferences to open the [ Pr efer ences] dialog box.
2. Expand the Talend node and click Exchange to display the Exchange view.

Exchange = v

User Logged : < Mone =

Motify me when updated extensions are available.

3. Set the Exchange preferences according to your needs:

« |If you arenot yet connected to the Talend Community, click Sign I n to go to the Connect to TalendForge
page to sign in using your Talend Community credentials or create a Talend Community account and
then signin.

If you are already connected to the Talend Community, your account is displayed and the Sign In button
becomes Sign Out. To get disconnected from the Talend Community, click Sign Out.

« By default, while you are connected to the Talend Community, whenever an update to an installed
community extension is available, a dialog box appears to notify you about it. If you often check for
community extension updates and you do not want that dialog box to appear again, clear the Notify me
when updated extensions ar e available check box.

For more information on connecting to the Talend Community, see Section 2.2, “Launching Talend Open Studio

for Data Integration”. For more information on using community extensions in the Studio, see Section 4.5.3,
“How to download/upload Talend Community components’.

2.5.4. Language preferences

Y ou can set language preferences in Talend Open Studio for Data Integration. To do so:
1.  Fromthe menu bar, click Window > Prefer ences to open the [ Pr efer ences] dialog box.

2. Expand the Talend node and click I nternationalization to display the relevant view.
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Debug and Job execution preferences

Internationalization

Local Languagelneed restart)

English

W

Test translation with Balibi (warks only For current language, other language selection needs restark)

[Impu:urt all translations ]

[Impu:-rt only validated translations ]

[ Restore Defaults ] [ Apply ]

[ o, H Cancel ]

From the Local Language list, select the language you want to use for Talend Open Sudio for Data

Integration graphical interface.

Click Apply and then OK to validate your change and close the [Pr efer ences] dialog box.

Restart Talend Open Sudio for Data Integration to display the graphical interface in the selected language.

2.5.5. Debug and Job execution preferences

Y ou can set your preferences for debug and job executions in Talend Open Sudio for Data Integration. To do so:

1

2.

From the menu bar, click Window > Preferences to display the [Prefer ences] dialog box.

Expand the Talend node and click Run/Debug to display the relevant view.

Run,/Debug

Fun process configuration
Talend client configur ation

Skats port range @ | 3334

Trace patt range : | 4334

[ ]5ave before run
[] Statistics

Job Run WM arguments

Argqument

-RMs256M
-amx1024M

T -
bo | 4333
to | 5333
Clear before run [ ]Exec time
[ Traces Pause Time(ms) | 1000
Mew

Restore Defaults ] [ Apply

» IntheTalend client configuration area, you can define the execution options to be used by default:
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Designer preferences

Statsport range

Specify arange for the ports used for generating statistics, in particular, if the ports
defined by default are used by other applications.

Trace port range

Specify a range for the ports used for generating traces, in particular, if the ports
defined by default are used by other applications.

Save beforerun

Select this check box to save your Job automatically before its execution.

Clear beforerun

Select this check box to del ete the results of aprevious execution before re-executing
the Job.

Exec time Select this check box to show Job execution duration.

Statistics Select this check box to show the statistics measurement of data flow during Job
execution.

Traces Select this check box to show data processing during job execution.

Pause time Enter the time you want to set before each data line in the traces table.

* IntheJob Run VM argumentslist, you can define the parameter of your current VM according to your needs.
The by-default parameters -Xms256M and -Xmx1024M correspond respectively to the minimal and maximal
memory capacities reserved for your Job executions.

If you want to use some VM parameters for only a specific Job execution, for example if you want to display
the execution result for this specific Job in Japanese, you need open this Job's Run view and then in the Run
view, configure the advanced execution settings to define the corresponding parameters.

For further information about the advanced execution settings of a specific Job, see Section 4.2.7.4, “How to set
advanced execution settings’.

For more information about possible parameters, check the site http://www.oracle.com/technetwork/javaljavase/
tech/vmoptions-jsp-140102.html.

2.5.6. Designer preferences

Y ou can set component and Job design preferencesto let your settings be permanent in the Studio.

1. Fromthe menu bar, click Window > Preferences to open the [ Pr efer ences] dialog box.

2. Expandthe Talend > Appearance node.

3. Click Designer to display the corresponding view.

On this view, you can define the way component names and hints will be displayed.
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Adding code by default

4.

Designer oo -
Components default label __UMNIQUE_MAME
Components defaulk hink <b=_ UMIQUE_MAME__ =/b=<hbr=_ COMMENT

Component default conneckion | Fow
[ ] 5how components' hink
Ilse the Repository name as label for the components dragged and dropped From the Repository Metadata,

[ Juse antialiasing and interpolation in the Job Designer

Compaonent defaulk Filepath S _Buildsi TOS-all-k23793-43, 1 0RC3hworkspace

Icon size:
(%) 24 pixels ()32 pixels
Component setkings tab layout:

(%) compact view () table view

[ ]Compute byte length of source codes generated by components

Restare Defaulks ] [ Apply

Select the relevant check boxes to customize your use of Talend Open Sudio for Data Integration design
workspace.

2.5.7. Adding code by default

Y ou can add pieces of code by default at the beginning and at the end of the code of your Job.

1

2.

From the menu bar, click Window > Pr efer ences to open the [Pr efer ences] dialog box.

Expand the Talend and Import/Export nodes in succession and then click Shell Setting to display the
relevant view.

Shell Setting T -

Command

o GEMERATED_TOS_CALL%

Restore Qefaults] [ Apply

In the Command field, enter your piece/pieces of code before or after UGENERATED TOS CALL%to
display it/them before or after the code of your Job.
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Performance preferences

2.5.8. Performance preferences

You can set the Repository tree view preferences according to your use of Talend Open Studio for Data
Integration. To refresh the Repository view:

1

2.

From the menu bar, click Window > Pr efer ences to open the [Pr efer ences] dialog box.
Expand the Talend node and click Performance to display the repository refresh preference.
Performance (=T -

[] Deactivate auto detectupdate after a modification in the repository

[ ]check the property Fields when generating code {disable will make the components properties Faster)
[ ]Generate code when opening the job

Check only the last version when updating jobs or joblets

[ ]Propagate add/delete variable changes in repository conkesxts

Activate the timeout For database connection.

Connection timeout {(seconds) | 15

&dd all user routines ko job dependencies, when create new job

add all syskem routines to job dependencies, when create new job

[Resture DeFauIts] [ Apply ]

[ Ok H Cancel ]

Y ou can improve your performance when you deactivate automatic refresh.
¥

Set the performance preferences according to your use of Talend Open Sudio for Data Integration:

Select the Deactivate auto detect/update after a modification in the repository check box to deactivate the
automatic detection and update of the repository.

Select the Check the property fields when generating code check box to activate the audit of the property
fields of the component. When one property filed is not correctly filled in, the component is surrounded by red
on the design workspace.

Y ou can optimize performance if you disable property fields verification of components, i.e. if you
¥ clear the Check the property fields when generating code check box.

Select the Gener ate code when opening the job check box to generate code when you open a Job.

Select the Check only the last version when updating jobs or joblets check box to only check the latest
version when you update a Job.

Select the Propagate add/delete variable changes in repository contexts to propagate variable changes in
the Repository Contexts.

Select the Activate the timeout for database connection check box to establish database connection time out.
Then set thistime out in the Connection timeout (seconds) field.

Select the Add all user routinesto job dependencies, when create new job check box to add all user routines
to Job dependencies upon the creation of new Jobs.

Select the Add all system routinesto job dependencies, when createjob check box to add all system routines
to Job dependencies upon the creation of new Jobs.
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2.5.9. Documentation preferences

Y ou can include the source code on the generated documentation.

1.  Fromthe menu bar, click Window > Prefer ences to open the [ Pr efer ences] dialog box.

2. Expand the Talend node and click Documentation to display the documentation preferences.
Documentation A

|:| Source code to HTML generation
IJse CS5 file as a template when export to HTML

3. Customize the documentation preferences according to your needs:

» Select the Source code to HTML generation check box to include the source code in the HTML
documentation that you will generate.

» Select the Use CSSfile as atemplate when export to HTML check box to activate the CSSFilefield if
you need to use a CSSfile to customize the exported HTML files.

For more information on documentation, see Section 5.6.1, “How to generate HTML documentation” and
Section 4.2.6.5, “Documentation tab” .

2.5.10. Displaying special characters for schema
columns

You may need to retrieve a table schema that contains columns written with special characters like Chinese,
Japanese, Korean. In this case, you need to enable Talend Open Sudio for Data Integration to read the specia
characters. To do so:

1. Fromthe menu bar, click Window > Preferences to open the [ Pr efer ences] dialog box.

2. Onthetreeview of the opened dialog box, expand the Talend node.

w

Click the Specific settings node to display the corresponding view on the right of the dialog box.

»

Select the Allow specific characters (UTFS,...) for columns of schemas check box.

Specific Settings -

[ ] allow specific characters (UTFS,...) for columns of schemas

2.5.11. SQL Builder preferences

Y ou can set your preferences for the SQL Builder. To do so:
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1. Fromthe menu bar, click Window > Prefer ences to open the [ Pr efer ences] dialog box.

2. Expand the Talend and Specific Settings nodes in succession and then click Sgl Builder to display the
relevant view.

SqlBuilder =T -

[ ]add quotes, when vou generate sql statement
85400 S0L generation

() Standard 5L Statement

() Syvstem SOL Statement

Enable check queries in the database components (disable to avoid warnings for specific queries)

3. Customize the SQL Builder preferences according to your needs:

» Select the add quotes, when you generated sgl statement check box to precede and follow column and
table names with inverted commas in your SQL queries.

* In the AS400 SQL generation area, select the Standard SQL Statement or System SQL Statement
check boxes to use standard or system SQL statements respectively when you use an AS400 database.

 Clear the Enable check queriesin the database components (disable to avoid warnings for specific
queries) check box to deactivate the verification of queriesin all database components.

2.5.12. Schema preferences

Y ou can define the default data length and type of the schemafields of your components.
1. Fromthe menu bar, click Window > Preferences to open the [ Pr efer ences] dialog box.

2. Expand the Talend node and click Default Type and L ength to display the data length and type of your
schema

28 Talend Open Studio for Data Integration User Guide



Libraries preferences

% Preferences |Z|@@

|type filker best | Default Type and Length =T v
General
Connectivity Default Settings For Fields with rull Yalues
InstallfUpdate Default Length | |
Java

Perl EPTC Default Setkings For All Fields
Talend Defaul Length | |
Appearance

Cornponents Default Length For Data Tyvpe
Import/Expart Boolean Ii’ BigDecimal I:I
Internationalization Byte |:| Integer |:|

Performance

runloos el [ Jumw [
%esqlBuilder

Default Type and Length

Metadata of TalendTvpe

Talend Component Designer Float |:| Lisk I:I

(0] ] ] ] ] ] - ]

Team
=ML

[Restnre Qefaults] [ Apply ]
f\':?:. [ Ok l [ Cancel ]

3. Set the parameters according to your needs:

* Inthe Default Settingsfor Fieldswith Null Valuesares, fill in the datatype and the field length to apply
to the null fields.

» Inthe Default Settingsfor All Fields area, fill in the data type and the field length to apply to al fields
of the schema.

* Inthe Default Length for Data Type area, fill in the field length for each type of data.

2.5.13. Libraries preferences

Y ou can define the folder where to store the different libraries used in Talend Open Sudio for Data Integration.
To do so:

1.  Fromthe menu bar, click Window > Preferences to display the [Prefer ences] dialog box.

2.  ExpandtheTalend and Specific Settingsnodesin succession and then click Librariesto display the relevant
view.
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Libraries =T -

External libraries path  /C:/Users/fbensaid/Desktop/TMDMCE-Studio-All-r89939-Y5.0.0ME/lib Browse...

| Restore Defaults| | Apply |

[ 0K ] | Cancel |

3. Setthe access path in the External libraries path field through the Browse... button. The default path leads
to thelibrary of your current build.

2.5.14. Type conversion

You can set the parameters for type conversion in Talend Open Sudio for Data Integration, from Java towards
databases and vice versa

1. Fromthe menu bar, click Window > Preferences to display the [Prefer ences] dialog box.

2. Expand the Talend and Specific Settings nodes in succession and then click M etadata of Talend Typeto
display the relevant view.

Metadata of TalendType -

Talend Tvpe Mapping Files

Metadaka Mapping File

mapping_Access, xml
mapping_a5400, xml
mapping_Firebird.xml
mapping_Gresnplum, <l
mapping_HSOLDE, xml
mapping_IEMDBZ., xml
mapping_InFormix.xml

The Metadata M apping File arealiststhe XML filesthat hold the conversion parameters for each database
type used in Talend Open Sudio for Data Integration.

« You can import, export, or delete any of the conversion files by clicking Import, Export or Remove
respectively.

» You can modify any of the conversion files according to your needs by clicking the Edit button to open
the [Edit mapping file] dialog box and then modify the XML code directly in the open dialog box.

2.5.15. Usage Data Collector preferences

By alowing Talend Open Studio for Data Integration to collect your Studio usage statistics, you help users better
understand Talend products and help Talend better learn how users are using the products, thus enabling Talend
to improve product quality and performance to serve users better.
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By default, Talend Open Sudio for Data Integration automatically collects your Studio usage data and sendsthis
dataon aregular basisto servershosted by Talend. Y ou can view the usage data collection and upload information
and customize the Usage Data Collector preferences according to your needs.

Be assured that only the Studio usage statistics datawill be collected and none of your privateinformation
¥ will be collected and transmitted to Talend.

1.  Fromthe menu bar, click Window > Preferences to display the [Pr efer ences] dialog box.

2. Expand the Talend node and click Usage Data Collector to display the Usage Data Collector view.
Usage Data Collector =T -

Appearance .

The Usage Data Collector collects information about how
Components

_ individuals are using the Talend products. The intent is to use
Documentation this data to help users and organizations better understand
Exchange how developers are using Talend products.

Import/Export Enable capture
Internationalization
Metadata
Performance
RunDebug
Specific Settings
Usage Data Collector
Talend Component Design

3. Read the message about the Usage Data Collector, and, if you do not want the Usage Data Collector to collect
and upload your Studio usage information, clear the Enable capture check box.

4. Tohaveapreview of the usage data captured by the Usage Data Collector, expand the Usage Data Collector
node and click Preview.

Preview Sl =

The following Keys/Values have been captured by the Usage Data Collectar.

Key Value
= tokenStudio

typestudio tos

uniqueld RURLfjefSckhad/4R53E0p Iz +KTL2GScr Y BEUAT, ..

VErsion 5.0.0,RC1_r/511

=) properties

tos. count. businessModels 0
tos, count, componentsPer Job 0.0
tos.count.contextvariablesPerJob 0.0
tos,count,debugRuns 0
tos,count,generatedJobDocs 0
tos,count, jobExparts ]
tos.count. jobs 0
tos,count, jobsPerProject 0,0
tos,count. localProjects 1
tos.count. metadatas g
tos, count.runs g
tos.count, usercomponents ]
tos.job, frequentComponents <Empty =
tos,user.components <Empty =

5. To customize the usage data upload interval and view the date of the last upload, click Uploading under the
Usage Data Collector node.
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Uploading =T -
Information gathered by the Usage Data Collector is periodically uploaded to servers hosted by Talend.
pload Period | 10 Days

Last Upload

» By default, if enabled, the Usage Data Collector collects the product usage data and sends it to Talend
serversevery 10 days. To changethe dataupload interval, enter anew integer value (in days) in the Upload
Period field.

» Theread-only Last Upload field displays the date and time the usage datawas last sent to Talend servers.

2.6. Customizing project settings

Talend Open Studio for Data Integration enables you to customize the information and settings of the project in
progress, including the Palette, Job settings and Job version management, for example.

To customize project settings:

1
Click = onthe Studio tool bar, or select File > Edit Project Properties from the menu bar.

The [Project Settings] dialog box opens.

# Project Settings

=R Ceneral General
Version Management

[=)- Desigrer
Palette Setkings Mame DOC

[=)- Job Settings Descripbion | This project gathers the Jobs created ko
Skats & Logs docurment the compaonents in the Talend

Irplicit context lnad Component Reference Guide,

se Project Settings

Stakus
Security

[Restnre Qefaults][ Apply ]
'::?:' Impork H Export H Ik, H Cancel ]

2. Inthetree diagram to the left of the dialog box, select the setting you wish to customize and then customize
it, using the options that appear to the right of the box.

From the dialog box you can also export or import the full assemblage of settings that define a particular project:

» To export the settings, click on the Export button. The export will generate an XML file containing all of your
project settings.

» Toimport settings, click on the Import button and select the XML file containing the parameters of the project
which you want to apply to the current project.
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2.6.1. Palette Settings

Y ou can customize the settings of the Palette display so that only the components used in the project are |oaded.
Thiswill allow you to launch the Studio more quickly.

To customize the Palette display settings:

1

On the toolbar of the Studio’s main window, click = or click File > Edit Project Properties on the menu
bar to open the [Project Settings] dialog box.

% Project Settings IZIEIF'S__(I
General Palette Settings

= Designer
Paletke Settings
Job Settings

Skatus

Security

[ Business

(= Business Inteligence
[= Cuskom Code
[ Daka Quality
[ Databases
= ELT

[= File

[ FileScale

[= Internet

(= Logs & Errors
= Misc

[= Orchestration
(= Processing
(= System

(= Talend MDM
[= Technical
=

[ Restare Defaults ] [ Apply ]

@:‘ [ Impork ][ Export H [0]4 H Cancel ]

In the General view of the [Project Settings] dialog box, you can add a project description, if you
s did not do so when creating the project.

In the tree view of the [Project Settings] dialog box, expand Designer and select Palette Settings. The
settings of the current Palette are displayed in the panel to the right of the dialog box.

Select one or several components, or even set(s) of componentsyou want to remove from the current project’s
Palette.

Use the left arrow button to move the selection onto the panel on the left. This will remove the selected
components from the Palette.

To re-display hidden components, select them in the panel on the left and use the right arrow button to restore
them to the Palette.

Click Apply to validate your changes and OK to close the dialog box.
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"

To get back to the Palette default settings, click Restor e Defaults.

For more information on the Palette, see Section 4.2.8.1, “How to change the Palette layout and settings’.

2.6.2. Version management

You can aso manage the version of each item in the Repository tree view through General > Version
Management of the [Project Settings] dialog box.

To do so:

1.

On the toolbar of the Studio main window, click =~ or click File > Edit Project Propertiesfrom the menu
bar to open the [Project Settings] dialog box.

2. In the tree view of the dialog box, expand General and select Version Management to open the
corresponding view.
% Project Settings |-_|@E]
= General Yersion Management
Version M.
. .Status Ma []iL* Busin Ciptions
esu;ner. =-[m EE Job D (%) Change all items to a Fixed version,
Job Settings DD Tl
ztatu.st H Oy [Revert] [select all dependencies]
ey
4 ol o ¥_ (") Update the version of each item, select all subjobs
[ EE bic [Fix tRundob versions if Latest
[ cu
% B Items Version Mew version
B
O 'EE o ’Ebexpu:urt_ju:ul:u 2.0 4.0 mm x
] S e ’Eb extract 0.1 mmm ]
[ ex EF sardemo 0.1 0.1 mm i
G ex 1 globalContext 0.1 .1 mm x
[ ex
(it sp
[ wu
i Joblel
=-[#] [ Conte
E-_'I g'l:
[] & cCode
L sque
[E]EE Metar
& pocur
< | > [Restu:ure DeFauIts] [ Apply ]
':':’:' Import ] [ Export ] [ a4 ] [ Zancel ]
3. Inthe Repository tree view, expand the node holding the items you want to manage their versions and then
select the check boxes of these items.
34 Talend Open Studio for Data Integration User Guide



Status management

5.

Thesdlected itemsdisplay inthe ltemslist to theright along with their current versionin the Version column
and the new version set in the New Version column.

Make changes as required:

 Inthe Options area, select the Change all itemsto a fixed version check box to change the version of
the selected items to the same fixed version.

 Click Revert if you want to undo the changes.

» Click Select all dependencies if you want to update all of the items dependent on the selected items at
the sametime.

» Click Select all subjobs if you want to update all of the subjobs dependent on the selected items at the
same time.

« Toincrement each version of the items, select the Update the ver sion of each item check box and change
them manually.

» Select the Fix tRunjob versionsif Latest check box, if you want the father job of current version to keep
using the child Job(s) of current version in the tRunjab to be versioned, , regardless of how their versions
will update. For example, atRunjob will update from the current version 1.0to 1.1 at both father and child
levels. Once this check box is selected, the father Job 1.0 will continue to use the child Job 1.0 rather than
the latest one as usual, say, version 1.1 when the update is done.

To use this check box, the father Job must be using child Job(s) of the latest version as current
version in the tRunjob to be versioned, by having selected the Latest option from the drop-down
version list in the Component view of the child Job(s). For more infomation on tRunJaob, see
Talend Open Studio Components Reference Guide.

Click Apply to apply your changes and then OK to close the dialog box.

For more information on version management, see Section 5.5, “Managing Job versions’.

2.6.3. Status management

Y ou can a so manage the status of each item in the Repository tree view through Gener al > Status M anagement
of the [Project Settings] dialog box.

To do so:

1

On the toolbar of the Studio main window, click = or click File > Edit Project Propertiesfrom the menu
bar to open the [Project Settings] dialog box.

Inthetree view of the dialog box, expand Gener al and select Status M anagement to open the corresponding
view.

Talend Open Studio for Data Integration User Guide 35



Job Settings

®= Project Settings

=) General Status Management
: ersion M:
. Status Ma ~[]itk Business Models Options
[+ Designer - i
: 5 . UEE Job Designs (1 Change all techinal items to a fixed status,
- Iob Settings 71 Contesxts
Skatys EID 2 Code () Change all documentation items ko a fixed status,
- Security @[]t Routines derveloprnent Revert
E:H'"D?‘J. 5QL Templates (¥ Update the Status of each item.
EIEE Metadata
%i Dll:' E:r:nectil;ns Ttems Status Mew Stakus
----- File delimite ’
. ;. 77 globalcantest development | besting | 3
----- 11 File positional - =
..... IR File regex I drysaL besting development || 3¢
----- B File xml |j'_:b Multilars production | development v | 3
----- 1= File Excel
----- & File 1dif 5
----- O Lpar
----- 1% salesforce
----- [l Generic schema
----- 0@ F1p
----- 1 valend MDM
----- I wsbL
[ Documentation
Restore Defaults &ppl
aEm = [ AT
@ [ Imnpark ] [ Export ] [ Ok J [ Cancel ]

In the Repository tree view, expand the node holding the items you want to manage their status and then
select the check boxes of these items.

The selected items display in the Items list to the right along with their current status in the Status column
and the new status set in the New Status column.

In the Options area, select the Change all technical itemsto a fixed status check box to change the status
of the selected items to the same fixed status.

Click Revert if you want to undo the changes.

To increment each status of the items, select the Update the version of each item check box and change
them manually.

Click Apply to apply your changes and then OK to close the dialog box.

For further information about Job status, see Section 2.6.8, “ Status settings’.

2.6.4. Job Settings

You can automatically use Implicit Context Load and Stats and L ogs settings you defined in the [Project
Settings] dialog box of the actual project when you create a new Job.

36
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To do so:

1.

On the toolbar of the Studio main window, click =

bar to open the [Project Settings] dialog box.

or click File> Edit Project Propertiesfrom the menu

2. Inthetreeview of the dialog box, click the Job Settings node to open the corresponding view.

3. SdecttheUseproject settingswhen create a new job check boxes of the Implicit Context L oad and Stats

and L ogs aress.

#* Project Settings |:|@@

4,

= General Job Settings
Version Manac
E'n Irnplicit Conbexk Load
Job Settings
T Iz project settings when create a new job
Status
Security Skats and logs
Il=e project settings when create a new job
¢ 5 [Restn:-re DeFauIts] [ Apply ]
@ Impart ] [ Expart ] [ ()4 l [ Cancel ]

Click Apply to validate your changes and then OK to close the dialog box.

2.6.5. Stats & Logs

When you execute a Job, you can monitor the execution through the tStatCatcher Statistics option or through
using alog component. Thiswill enable you to store the collected log datain .csv files or in a database.

Y ou can then set up the path to the log file and/or database once for good in the [Proj ect Settings] dialog box so
that the log data get always stored in this location.

To do so:

1

On the toolbar of the Studio main window, click =
bar to open the [Project Settings] dialog box.

or click File> Edit Project Propertiesfrom the menu

In the tree view of the dialog box, expand the Job Settings node and then click Stats & Logs to display
the corresponding view.
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Stats Logs

Use statistics (tStatCabcher) Use logs (tLogCatcher) Use wolumetrics (tFlowMeterCatcher)

[Jon Consale

©On Files

File: Path "D /5 _BuildsTIS_EE-all-r23530-v3, 1, 0RC2(TIS_EE-All-r23530-%3. 1.ORC2 'workspace/ metadata” [:]
Stats File Name "stats_File,bxt" *
Log File Mame "logs_File. bxt" *
Meter file name "meter_file, bxt" *
On Databases

Property Type Repository s | | DB (MySQL):localhost [3

Db Type MySCL v ;

Hust "localhost” o Port | "3308" N
Db Mame "talend" o Additional parameters | "noDatetimeStringSync=trus" N
User "root" ; Password | ek g
Stats Table "statistics" E]
Logs Table "logs" E]
Meker Table "wolurnetrics” E]

Cakch runtime errors akch user errors akch user warnings
[ atch components skatistics (tSkatCatcher Statistics)

[ Restare Defaults ] [ apply ]

If you know that the preferences for Stats & Logs will not change depending upon the context of
¥ execution, then simply set permanent preferences. If you want to apply the Stats & Logs settings

individually, then it is better to set these parameters directly onto the Stats & Logs view. For more

information about this view, see Section 4.6.7.1, “How to automate the use of statistics & logs’.

3. Select the Use Statistics, Use Logs and Use Volumetrics check boxes where relevant, to select the type of
log information you want to set the path for.

4. Select aformat for the storage of thelog data: select either the On Filesor On Database check box. Or select
the On Console check box to display the datain the console.

The relevant fields are enabled or disabled according to these settings. Fill out the File Name between quotes or
the DB name where relevant according to the type of log information you selected.

Y ou can now store the database connection information in the Repository. Set the Property Typeto Repository
and browse to retrieve the relevant connection metadata. The fields get automatically completed.

Alternatively, if you save your connection information in a Context, you can also access them through
’ Ctrl+Space.

2.6.6. Context settings

Y ou can define default context parameters you want to use in your Jobs.

To do so:

1.
On the toolbar of the Studio main window, click =~ or click File > Edit Project Propertiesfrom the menu
bar to open the [Project Settings] dialog box.

2. Inthetreeview of the dialog box, expand the Job Settings node and then select the Implicit Context L oad
check box to display the configuration parameters of the Implicit tContextL oad feature.
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Implicit context load

Implicit tZonkextLoad
Implicit EContextLoad

(%) From File

") From Database

From File context, IMPLICIT _TCOMTEXTLOAD_FILE E]
Field Separator "t

If a wariable lnaded, buk not in the conkext | Warning s

If a wariable in the conbext, buk not loaded | Warning s

|:| Print operations
[ ] pisable errars [¢] Disable warnings [] Disable infos

[Restu:ure Qefaults] [ Apply

Select the From File or From Database check boxes according to the type of file you want to store your
contextsin.

For files, fill in thefile path in the From File field and the field separator in the Field Separ ator field.
For databases, select the Built-in or Repository mode in the Property Typelist and fill in the next fields.
Fill in the Table Name and Query Condition fields.

Select the type of system message you want to have (warning, error, or info) in case avariableisloaded but
is not in the context or vice versa.

Click Apply to validate your changes and then OK to close the dialog box.

2.6.7. Project Settings use

From the [Project Settings] dialog box, you can choose to which Job in the Repository tree view you want to
apply the Implicit Context L oad and Stats and L ogs settings.

To do so:

1

On the toolbar of the Studio main window, click =~ or click File > Edit Project Propertiesfrom the menu
bar to open the [Project Settings] dialog box.

In the tree view of the dialog box, expand the Job Settings node and then click Use Project Settings to
display the use of Implicit Context Load and Stats and L ogs option in the Jobs.
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Use Project Settings

Select the itern you wank to use project setkings

Implicit Context Load Settings Skaks Logs Settings
= [E]sp Job Designs = [E]ip Job Designs
-] misc -] misc
=-[w] (= roadshow =[] = roadshow
+py roadshow_exoZ 0,1 py roadshow_exoZ 0,1
“py roadshow_exo3 0.1 py roadshow_exo3 0,1
S test 0.1 S best 0.1
=[] sco -] sco

+
+

[0 t01_cCompo

[]0 t02_cencatening
[0 to3_DemoRoutines
[ to4_Conkext

[0 t01_cCompo

[0 t02_cConcatening
[0 to3_DemoRoutines
[ tos_Conkext

+
+

+
+

+
+

[ Jrip beforeRundobs 0.1 [Jrin beforerunlobs 0.1

[Jih job 0.1 [Jih job 0.1

[riy positionalfile 0.1 [rin positionalfile 0.1

ety priorTest 0.1 [Jeta priorTest 0.1

ety readme 0.1 et readme 0.1

[ ity regex 0.1 [etp regex 0.1

ipy retrievecustomerscherna 0,1 ipy retrievecustomerscherna 0.1
[eigy =ml 0,1 [ty =oml 001

IRestDre DeFauItsI [ Apply

In the Implicit Context Load Settings area, select the check boxes corresponding to the Jobs in which you
want to use the implicit context load option.

In the Stats L ogs Settings area, select the check boxes corresponding to the Jobs in which you want to use
the stats and logs option.

Click Apply to validate your changes and then OK to close the dialog box.

2.6.8. Status settings

In the [Project Settings] dialog box, you can aso define the Status.

To do so:

1

On the toolbar of the Studio main window, click = or click File > Edit Project Propertiesfrom the menu
bar to open the [Project Settings] dialog box.

2. Inthetree view of the dialog box, click the Status node to define the main properties of your Repository
tree view elements.
The main properties of a repository item gathers information data such as Name, Purpose, Description,
Author, Version and Status of the selected item. Most properties are free text fields, but the Status field
isadrop-down list.
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% Project Settings |-_|['E|f'5__<|
General Status
Desigrer
Job Settings Technical status
Skak
3 U,S Code Label
Security
DEY development
TEST kesting Remove
PROD production

Mew. ..

Davan

Documentation skatus

Code Label
1st 15k wersion
2nd 2nd wersion
WAL Yalidate
[Restnre Qefaults] [ apply ]
@ Import ] [ Export ] [ ok, ] [ Cancel ]

3. Click the New... button to display a dialog box and populate the Status list with the most relevant values,
according to your needs. Note that the Code cannot be more than 3-character long and the L abel is required.

Code:

Label: | Cualiby Assurance| |

[ Ok, H Cancel ]

Talend makes a difference between two status types: Technical status and Documentation status.

The Technical statuslist displays classification codes for elements which are to be running on stations, such
as Jobs, metadata or routines.

The Documentation status list helps classifying the elements of the repository which can be used to
document processes (Business Models or documentation).

4. Onceyou completed the status setting, click OK to save

The Status list will offer the status levels you defined here when defining the main properties of your Job
designs and business models.

5. Inthe[Project Settings] dialog box, click Apply to validate your changes and then OK to close the dialog
box.
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2.6.9. Security settings

Y ou can hide or show your passwords on your documentations, metadata, contexts, and so on when they are stored
in the Repository tree view.

To hide your password:

1
On the toolbar of the Studio main window, click = or click File > Edit Project Propertiesfrom the menu
bar to open the [Project Settings] dialog box.

2. Inthetreeview of the dialog box, click the Security node to open the corresponding view.

3. Sdlect the Hide passwor ds check box to hide your password.

If you select the Hide passwords check box, your password will be hidden for all your

2 documentations, contexts, and so on, as well as for your component properties when you select
Repository inthe Property Typefield of the component Basic settingsview, i.e. the screen capture
below. However, if you select Built-in, the password will not be hidden.

Property Tvpe Repository s || | DB (MySQL):demalysql [3
|:| Use an existing connection

Host "localhost" % Port | "3308" E
Database "rest" g
Idsername "root" ? Password | ek E

4. Inthe[Project Settings] dialog box, click Apply to validate your changes and then OK to close the dialog
box.

2.7. Filtering entries listed in the Repository
tree view

Talend Open Sudio for Data Integration provides the possibility to choose what nodes, Jobs or items you want
to list in the Repository tree view.

You can filter the Repository tree view by job name, Job status, the user who created the Job/items or simply

by selecting/clearing the check box next to the node/ item you want to display/hide in the view. Y ou can al so set
several filters simultaneously.

2.7.1. How to filter by Job name

To filter Jobslisted in the Repository tree view by Job name, complete the following:

1
In the Studio, click the C l}s icon in the upper right corner of the Repository tree view and select Filter
settings from the contextual menu.

The [Repository Filter] dialog box displays.
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#® Repository Filter Setting |Z||E|[z|

Select the available extensions to show (unchecked
extensions will not display content):

{1 Business Models | |

[ IFilter By Mame :

% Job Designs
1 Contexts

v Cod
:E:': : Li Filter By User @ [+] &l Users
ourines
LI sqL Templates oan e ——

=-[#]i& Metadata
il Db Connections

[ File delimited
¥ File positional
[# File Regex
File XML
[#][x] File Excel

File LDIF

RIEIEIEIEEE]

LDAP . *
¢ Salesforce Filker By Status
Generic schemas Code Label
[ ¥ Talend MDM DEY development
[7I Web Service TEST testing
[#]= FTP PROD production
& Documentation nak set status
[+]/E Recycle bin
Ok l [ Cancel

Select the Filter By Name check box.

The corresponding field becomes available.

Filter By Mame :

| kMap*, kest®

The patterns are separated by cormma, where
* = any string, ¥ = any character, ,, =,

Follow the rules set below the field when writing the patterns you want to use to filter the Jobs.
In this example, we want to list in the tree view al Jobs that start with tMap or test.
In the [Repository Filter] dialog box, click OK to validate your changes and close the dialog box.

Only the Jobs that correspond to the filter you set are displayed in the tree view, those that start with tMap
and test in this example
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(i x o] | o |8 T O
LCAL: companent
=1ty Job Designs
=I-[= components
=-[=- tMap
i tMap_03_persiskence_01_n_lookup
i tMap_08_persistence_01_n_laokup
#- [ Databases
=I-[= Impactanalysis
ipy TestImpactanalysisl 0,1
i1y TestImpackanalysisz 0,1
=-[== tMap
1y tMap_dieonerror 0.1
1y EMap_in_joblet 0.1

Y ou can switch back to the by-default tree view, which lists all nodes, Jobs and items, by simply clicking
theicon E2. Thiswill cause the green plus sign appended on the icon to turn to a minus red sign (5<).

2.7.2. How to filter by user

To filter entries in the Repository tree view by the user who created the Jobs/items, compl ete the following:

1.
In the Studio, click the == Lv@ icon in the upper right corner of the Repository tree view and select Filter
settings from the contextual menu.

The [Repository Filter] dialog box displays.
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2.

#® Repository Filter Setting |Z||E|[z|

Select the available extensions to show (unchecked
extensions will not display content):

{1 Business Models | |

% Job Designs
1 Contexts

[ IFilter By Mame :

v Cod
:E:': : Li Filter By User @ [+] &l Users
ourines
LI sqL Templates oan e ——

=-[#]i& Metadata
il Db Connections
[ File delimited
¥ File positional
[# File Regex
File XML
[#][x] File Excel
File LDIF

RIEIEIEIEEE]

LDAP . *
¢ Salesforce Filker By Status
Generic schemas Code Label
[ ¥ Talend MDM DEY development
[7I Web Service TEST testing
[#]= FTP PROD production
& Documentation nak set status
[+]/E Recycle bin
Ok l [ Cancel

Clear the All Users check box.

The corresponding fields in the table that follows become available.

Filter By User : [_] all Users

Login FirstMarne LastMame
admin@compary.com  Adminiskr akor Administrator
nha@ktalend. com kalend rha
Copy_of _Copw_of,.. talend nha

This table lists the authentication information of all the users who have logged in to Talend Open Studio for
Data Integration and created a Job or an item.

Clear the check box next to auser if you want to hide all the Jobs/items created by him/her in the Repository
tree view.

Click OK to validate your changes and close the dialog box.
All Jobs/items created by the specified user will disappear from the tree view.

Y ou can switch back to the by-default tree view, which lists all nodes, Jobs and items, by simply clicking
theicon 9. Thiswill cause the green plus sign appended on the icon to turn to aminus red sign (I@).
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2.7.3. How to filter by job status

To filter Jobsin the Repository tree view by the job status, complete the following:

1 ==
In the Studio, click the |§| %S icon in the upper right corner of the Repository tree view and select Filter
settings from the contextual menu.

The [Repository Filter] dialog box displays.

* Repository Filter Setting

Select the available extensions to show {unchecked
extensions will nok display content):

{1 Business Models | |
£ Job Designs
2 Contexts
= Code
[+]=3 Routines
.:_J‘ SOL Templates
=[] Metadata
&8 Db Connections
B File delimited
¥ File positional
[# File Regex
File XML
[#][=] File Excel
File LDIF

[ ]Fileer By Mame

Filter By User : [+]al Users

—

ogin FirstMarme LaskMarm

RIEIEIEEEE

LDAP S5 k4
¢ Salesforce Filter By Status :
Generic schemas Code Label
[/]&" Talend MDM DEY developrent
[¥]IB Web Service TEST testing
V] = FTP PROD praduction
E Documentation not set skatus

(3 Recycle bin

(0] 4 l [ Cancel

2. Inthe Filter By Status area, clear the check boxes next to the status type if you want to hide all the Jobs
that have the selected status.

3. Click OK to validate your changes and close the dialog box.
All Jobs that have the specified status will disappear from the tree view.

Y ou can switch back to the by-default tree view, which lists all nodes, Jobs and items, by simply clicking
theicon 9. Thiswill cause the green plus sign appended on the icon to turn to aminus red sign (=).

2.7.4. How to choose what repository nodes to display

To filter repository nodes, complete the following:
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In the Studio, click the |@| ng icon in the upper right corner of the Repository tree view and select Filter
settings from the contextual menu.

The [Repository Filter] dialog box displays.

* Repository Filter Setting

Select the available extensions to show {unchecked
extensions will nok display content):

{1 Business Models | |

£ Job Designs
2 Contexts

[ ]Fileer By Mame

E-[w Code
[#]%3 Routi Filter By User : [v] Al Users
outines
':J- oOL Templates Login FirstMame Lastham

=[] Metadata
&8 Db Connections
B File delimited
¥ File positional
[# File Regex
File XML
[#][=] File Excel
File LDIF

RIEIEIEEEE

LDAP < e
¢ Salesforce Filker By Skatus :
Generic schemas Code Label
[/]&" Talend MDM DEY development
[VII Web Service TEST testing
[v]= FTP PROD production
E Documentation not set skatus

3l Recycle hin

[ (4 l [ Cancel

2. Select the check boxes next to the nodes you want to display in the Repository tree view.

[]!1 Business Models
% Job Designs
i Joblet Designs
] Contests
[] & Code
=] |E|.=J‘ SOL Templates
150 Generic
3 Hive
0 mysiL
[0 Metezza
150 oracle
[15 Paraccel
[]50 Teradata
=[5 Metadata
il Db Connections
[J& SaAP Connections
1) File delimited

Talend Open Studio for Data Integration User Guide 47



How to choose what repository nodes to display

<p Job Designs
L Contexts
=[] & Code
[J#¥ Routines
_r SOL Templates
[1/El Recycle bin

Consider, for example, that you want to show inthetree view all the Jobs listed under the Job Designs node,
three of the folders listed under the SQL Templates node and one of the metadata items listed under the
M etadata node.

3. Click OK to validate your changes and close the dialog box.

Only the nodes/folders for which you selected the corresponding check boxes are displayed in the tree view.
X - | R |E8|Y T O
LOCAL: component

i Job Designs
= _r SQL Templates
T Hive
L MysoL
[ Metezza
= L{ﬂ Metadata
il Db Connections
(2} Recycle bin

If you do not want to show all the Jobs listed under the Job Designs node, you can filter the Jobs using
’ the Filter By Name check box. For more information on filtering Jobs, see Section 2.7.1, “How to filter
by Job name”.
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Chapter 3. Designing a Business Model

Talend Open Sudio for Data Integration offersthe best tool to formalize business descriptionsinto building blocks
and their relationships. Talend Open Sudio for Data Integration allows to design systems, connections, processes
and requirements using standardized workflow notation through an intuitive graphical library of shapesand links.

This chapter aims at business managers, decision makers or devel operswho want to model their flow management
needs at amacro level.

Before starting any business processes, you need to be familiar with Talend Open Sudio for Data Integration
Graphical User Interface (GUI). For more information, see Appendix A, GUI.
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3.1. What is a Business Model

Talend’s Business Models allow data integration project stakeholders to graphically represent their needs
regardless of the technical implementation requirements. Business Models help the I T operation staff understand
these expressed needs and translate them into technical processes (Jobs). They typically include both the systems
and processes already operating in the enterprise, aswell as the ones that will be needed in the future.

Designing Business Modelsis part of the enterprises’ best practices that organizations should adopt at avery early
stage of a data integration project in order to ensure its success. Because Business Models usually help detect
and resolve quickly project bottlenecks and weak points, they help limit the budget overspendings and/or reduce
the upfront investment. Then during and after the project implementation, Business Models can be reviewed and
corrected to reflect any required change.

A Business Model is anon technical view of a business workflow need.

Generally, atypical Business Model will include the strategic systems or processes already up and running in your
company aswell as new needs. Y ou can symbolize these systems, processes and needs using multiple shapes and
create the connections among them. Likely, all of them can be easily described using repository attributes and
formatting tools.

In the design workspace of Talend Open Studio for Data Integration, you can use multiple tools in order to:
* draw your business needs,
* create and assign numerous repository items to your model objects,

» define the business model properties of your model objects.

3.2. Opening or creating a Business Model

Open Talend Open Sudio for Data Integration following the procedure as detailed in Section 2.2, “Launching
Talend Open Sudio for Data Integration”.

In the Repository tree view, right-click the Business M odel's node.
fﬁj Repositary &9 To Mavigator t{?‘ =08
ERFousiness o
¥ DWFeer E Create Business Maodel k
i3y Job Desigl [ Create Folder
Contexts Expand/Collapse

+
+

* Code [z Import items
#-L[ sgL patte
=

=

+

[l Expart iters
L-ﬂ Metadata i

=

= Documentation
(2} Recycle bin

Select Expand/Collapseto display all existing Business Models (if any).

50 Talend Open Studio for Data Integration User Guide



How to open a Business Model

3.2.1. How to open a Business Model

Double-click the name of the Business Model to be opened.

The selected Business Model opens up on the design workspace.

3.2.2. How to create a Business Model

Right-click the Business M odels node and select Create Business M odel.
The creation wizard guides through the steps to create a new Business Model.
Select the L ocation folder where you want the new model to be stored.

And fill in a Name for it. The name you alocate to the file shows as a label on a tab at the top of the design
workspace and the same name displays under the Business M odels node in the Repository tree view.

The Modeler opens up on the empty design workspace.

Y ou can create as many models as you want and open them all, they will display in atab system on your design
workspace.

53 ™ = O @) Model DwFeeding 53 =0

& e -
= business 40
<> Decision
D Action
f:] Terminal
D Data
(-] Document
ﬂ Inpuk
B st

Ej Datasource

—— Action

e

% Actar i Busin 59 Cont | %e Comp | OB Runi | (20 Probl | =, Modul | @& Talen | EP Sche | Te 200 | T O

() Ellipse th DWfeeding 0.1

é:} Gear

/ Relationship

Directional
Relationship
' P
" Eidirectional Versian urpose Status

Main Mame
Appearance
Rulers & Grid

Author Wersion

Relationship —
escriptian

Creation Modification

The Modeler is made of the following panels:
» Talend Open Sudio for Data Integration’s design workspace

» aPalette of shapes and lines specific to the business modeling
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 the Business Model panel showing specific information about all or part of the model.

3.3. Modeling a Business Model

If you have multiple tabs opened on your design workspace, click the relevant tab in order to show the appropriate
model information.

In the Business M odel view, you can see information relative to the active model.

Usethe Palette to drop the relevant shapes on the design workspace and connect them together with branches and
arrange or improve the model visual aspect by zooming in or out.

2 Palette 57 = 0O

[}S FE )
(= business 40
<> Deecision
D Ackion
D Terminal
Q Drata
[ Document
] tnput
B List
E] Datasource
% Ackor
O Ellipse
{::} Gear

" Relationship
/' Directional Relationship
/ Bidirectional Relationship

This Palette offers graphical representations for objects interacting within a Business Model.

The objects can be of different types, from strategic system to output document or decision step. Each one having
a specific rolein your Business Model according to the description, definition and assignment you giveto it.

All objects are represented in the Palette as shapes, and can be included in the model.

Note that you must click the business folder to display the library of shapes on the Palette.

3.3.1. Shapes

Select the shape corresponding to the relevant object you want to include in your Business Maodel. Double-click
it or click the shape in the Palette and drop it in the modeling area.

Alternatively, for a quick access to the shape library, keep your cursor still on the modeling area for a couple of
seconds to display the quick access toolbar:
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DO0ORBEBIAS {0

For instance, if your business process includes a decision step, select the diamond shape in the Palette to add this
decision step to your model.

When you move the pointer over the quick access toolbar, atooltip helps you to identify the shapes.
2

Then asimple click will do to make it show on the modeling area.

The shapeis placed in adotted black frame. Pull the corner dotsto resize it as necessary.

]

.\_ /\
L

Also, ablue-edged input box allows you to add alabel to the shape. Give an expressive name in order to be able
to identify at a glance the role of this shape in the model.

Two arrows below the added shape allow you to create connections with other shapes. Y ou can hence quickly
define sequence order or dependencies between shapes.

Related topic: Section 3.3.2, “Connecting shapes’.

The available shapesinclude:

Callout Details

Decision The diamond shape generally represents an if condition in the model. Allows to take
context-sensitive actions.

Action The sguare shape can be used to symbolize actions of any nature, such astransformation,
tranglation or formatting.

Terminal The rounded corner square can illustrate any type of output terminal.

Data A parallelogram shape symbolize data of any type.

Document Inserts a Document object which can be any type of document and can be used as input
or output for the data processed.

Input Inserts an input object allowing the user to type in or manually provide data to be
processed.

List formsalist with the extracted data. Thelist can be defined to hold acertain nature of data.

Database Inserts a database object which can hold the input or output data to be processed.

Actor This schematic character symbolizes players in the decision-support as well technical
processes.

Ellipse Inserts an ellipse shape.

Gear This gearing piece can be used to illustrate pieces of code programmed manually that

should be replaced by a Talend Job for example.

3.3.2. Connecting shapes

When designing your Business Model, you want to implement rel ations between a source shape and atarget shape.
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There are two possible ways to connect shapes in your design workspace:

/ Relationship
/' Cirectional Relationship
I/' Bidirectional Relationship

Either select the relevant Relationship tool in the Palette. Then, in the design workspace, pull alink from one
shape to the other to draw a connection between them.

Or, you can implement both the relationship and the element to be related to or from, in afew clicks.

1.

Simply move the mouse pointer over a shape that you already dropped on your design workspace, in order
to display the double connection arrows.

Select the relevant arrow to implement the correct directional connection if need be.

Drag alink towards an empty area of the design workspace and release to display the connections popup
menu.

Select the appropriate connection from the list. You can choose among Create Relationship To, Create
Directional Relationship To or Create Bidirectional Relationship To.

Then, select the appropriate element to connect to, among the items listed.

y Lnnnrfir‘n \9— _z| &rtion
'_," i) Create Moke Attachment To r
’,"/ / Create Relationship To k ’;
<—E1' Create Directional Relationship To L4 D hew Element: Action
‘ / Create Bidirectional Relationship To L4 O Mew Element: Terminal
Q Mew Element: Docurment
Ej MNew Element: Database
- narpie _._-—-:i-:@ a Mew Element; Lisk
Q MNew Element: Data
ﬂ Mew Element; Inpuk
<> Mew Element: Decision
'% Mews Element: actar

O Mew Element: Elipse
ﬁ:} Mew Element: Gear

Existing Element

Y ou can create a connection to an existing element of the model. Select Existing Element in the popup menu and
choose the existing element you want to connect to in the displaying list box.
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% Select domain model element |Z|@E|

Available domain model elements:

D.ﬁ.ctiun Business Ikem Action

% Actor Business Ikem name

“% Ackar Business Tker narmes
EjDataI:uase Business Item CRA
EjDataI:uase Business Ikem DB
E]Datal:uase Business Tkem D
<>Deu:isiu:un Business Ikem Decision
QDDcument Business Ikem Reparting
QDDcument Business Item Reportingz

(7] Ok ] [ Cancel

The connection is automatically created with the selected shape.

The nature of this connection can be defined using Repository elements, and can be formatted and labelled in the
Properties panel, see Section 3.3.4, “Business Models’.

When creating a connection, an input box allows you to add a label to the connection you have created. Choose
ameaningful name to help you identify the type of relationship you created.

You can aso add notes and comments to your model to help you identify elements or connections at a
¥ later date.

Related topic: Section 3.3.3, “How to comment and arrange a model”.

3.3.3. How to comment and arrange a model

Thetools of the Palette allow you to customize your model:

Callout Details

Select Select and movethe shapesand linesaround in the design workspace’ smodeling area.

Zoom Zoominto apart of themodel. To watch more accurately part of the model. To zoom
out, press Shift and click the modeling area.

Note/Text/Note Allows comments and notes to be added in order to store any useful information

attachment regarding the model or part of it.

3.3.3.1. How to add a note or free text

To add anote, select the Note icon in the Palette, docked to the right of the design workspace.

Alternatively right-click the model or the shape you want to link the note to, and select Add Note. Or select the
Note tool in the quick access toolbar.

A sticky note displays on the modeling area. If the note is linked to a particular shape, aline is automatically
drawn to the shape.
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Typeinthetext in the input box or, if the latter does not show, typein directly on the sticky note.

/7|

If you want to link your notes and specific shapes of your model, click the down arrow next to the Note tool on
the Palette and select Note attachment. Pull the black arrow towards an empty area of the design workspace, and
release. The popup menu offers you to attach a new Note to the selected shape.

You can also select the Add Text feature to type in free text directly in the modeling area. Y ou can access this
feature in the Note drop-down menu of the Palette or via a shortcut located next to the Add Note feature on the
quick access toolbar.

3.3.3.2. How to arrange the model view

Y ou can a'so rearrange the look and feel of your model viathe right-click menu.

gy Show Business Models Yiew
Add »
Mavigake L4
File: 3
Edit k

oF Arrange Al % All Shapes
Filters ¥ 7 Al Connectors
Yiew k

'i.,,', Zoam k

Load Resource, ..

Place your cursor in the design area, right-click to display the menu and select Arrange all. The shapes
automatically move around to give the best possible reading of the model.

Alternatively, you can select manually the whole model or part of it.
To do so, right-click any part of the modeling area, and click Select.
Y ou can select:

* All shapes and connectors of the model,

 All shapes used in the design workspace,

« All connector s branching together the shapes.

From this menu you can also zoom in and out to part of the model and change the view of the model.
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3.3.4. Business Models

Theinformation in the Business M odels view corresponds to the current selection, if any. This can be the whole
model if you selected all shapes of it or more specifically one of the shapesit is made of. If nothing is selected,
the Business M odels tab gives general information about the model.

The Business M odels view contains different types of information grouped in the Main, Appearance, Rules &
Grid, and Assignment tabs.

TheMain tab displays basic information about the selected item in the design workspace, being aBusiness Model
or a Job. For more information about the Main tab, see Section 4.2.8.3, “How to display Job configuration tabs/
views”'.

3.3.4.1. Appearance tab

From the Appearance tab you can apply filling or border colors, change the appearance of shapes and linesin
order to customize your Business Model or make it easier to read.

The Business M odel view includes the following formats:
« fill the shape with selected color.

* color the shape border

* insert text above the shape

* insert gradient colors to the shape

* insert shadow to the shape

You can also move and manage shapes of your model using the edition tools. Right-click the relevant shape to
access these editing tools.

3.3.4.2. Rulers and Grid tab

To display the Rulers & Grid tab, click s on the Palette, then click any empty area of the design workspace
to deselect any current selection.

Click the Rulers & Grid tab to access the ruler and grid setting view.

Main Display Measurement
]
Appearance Shaw Ruler Ruler Units | Inches w
Rulers & Grid Show Grid ]
Grid Spacing | 0,125
Yersion Grid In Fronk pacing

arid Line Snap To Grid

Colar [snap To Shapes
Style |Spaced Dot a Restore Defaulks

In the Display area, select the Show Ruler check box to show the Ruler, the Show Grid check box to show the
Grid, or both heck boxes. Grid in front sends the grid to the front of the model.

In the M easur ement area, select the ruling unit among Centimeters, Inches or Pixels.
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IntheGrid Lineares, click the Color button to set the color of thegrid linesand select their stylefromthe Stylelist.

Select the Snap To Grid check box to bring the shapes into line with the grid or the Snap To Shapes check box
to bring the shapes into line with the shapes already dropped in the Business Model.

Y ou can a'so click the Restor e Defaults button to restore the default settings.

id| *Model Demol &3 = 8

At

Ernail
erminal

T DoORB\Bga¢e 0w

Chieck metadata

i Wirite
- B Ction Yes E

3.3.4.3. Assignment tab

The Assignment tab displays in a tabular form details of the Repository attributes you allocated to a shape or
aconnection.

To display any assignment information in the table, select a shape or a connection in the active model, then click
the Assignment tab in the Business M odel view.

3y Business Models(Dwf 25 Contexts | %+ Component | DB Run job | é& Talend Exchange = 8

in DWfeeding 0.1

Appearance Type Marne Zommenk

if=“ EDDcumentatiu:un tRegex.txt

Assignment
D File Delimited Metadata  Cars

You can aso display the assignment list placing the mouse over the shape you assigned information to.

e

o assigned Metadata

l% tReqge:x. bt (Documentation)

|_|i] Zars (File Delimited Metadata)
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Y ou can modify some information or attach a comment. Also, if you update data from the Repository tree view,
assignment information gets automatically updated.

For further information about how to assign elementsto a Business Model, see Section 3.4, “ Assigning repository
elementsto a Business Model”.

3.4. Assigning repository elements to a
Business Model

The Assignment tab in the Business M odels view lists the elements from the Repository tree view which have
been assigned to a shape in the Business Model.

fﬁ‘_‘[ Repository &4 T Mavigakar = 0O
'f.gh
=I-{Lf Business Models
& DWieeding 0.1
1 Job Designs
Contexts
+ Code
+ _r S0QL Templates
+- i Metadata
=&
Z| tRegex.tx 0.1
#-[5} Recycle bin

o

Y ou can define or describe a particular object in your Business Model by simply associating it with various types
of information, i.e. by adding metadata items.

Y ou can set the nature of the metadata to be assigned or processed, thus facilitating the Job design phase.

To assign a metadata item, simply drop it from the Repository tree view to the relevant shape in the design
workspace.

The Assignment table, located underneath the design workspace, gets automatically updated accordingly with the
assigned information of the selected object.

The types of items that you can assign are:

Element Details

Job designs If any Job Designs developed for other projects in the same repository are available,
you can reuse them as metadata in the active Business Model.

Metadata Y ou can assign any descriptive data stored in the repository to any of the objects used
in the model. It can be connection information to a database for example.

Business Models You can use in the active model all other Business Models stored in the repository of
the same project.

Documentation You can assign any type of documentation in any format. It can be a technical
documentation, some guidelines in text format or a simple description of your
databases.

Routines (Code) If you have developed some routines in a previous project, to automate tasks for

example, you can assign them to your BusinessModel. Routines are stored in the Code
folder of the Repository tree view.
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For more information about the Repository elements, see Chapter 4, Designing a data integration Job.

3.5. Editing a Business Model

Follow the relevant procedure according to your needs:

3.5.1. How to rename a Business Model

Right-click the relevant Business Model l1abel on the Repository tree view then select Edit propertiesto display
the corresponding M ain propertiesinformation in the [Edit properties] dialog box.

Edit the model name in the Name field, then click Finish to close the dialog box. The model label changes
automatically in the Repository tree view and will be reflected on the model tab of the design workspace, the
next time you open the Business Model.

If the Business Model is open, the information in the [Edit properties] dialog box will be read-only so
¥ you will not be able to edit them.

3.5.2. How to copy and paste a Business Model

In Repository > Business model, right-click the Business Model nameto be copied and select Copy in the popup
menu, or press Ctrl+C.

Then right-click where you want to paste your Business Model, and select Paste.

3.5.3. How to move a Business Model

To move a Business Model from a location to another in your business models project folder, select a Business
Model in the Repository > Business M odels tree.

Then simply drop it to the new location.

3.5.4. How to delete a Business Model

Right-click the name of the model to be deleted and select Delete in the popup menu.

Alternatively, simply select the relevant Business Model, then drop it into the Recycle bin of the Repository
tree view.

3.6. Saving a Business Model

To saveaBusinessModel, click File> Save or press Ctrl+S. The model is saved under the name you gave during
the creation process.
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An asterisk displays in front of the Business Model name on the tab to indicate that changes have been made to
the model but not yet saved.

T e

To save aBusiness Model and increment its version at the same time:
1. click FileeSaveas....The [Save as] dialog box displays.

2. Nexttothe Version field, click the M button to increment the major version and the m button to increment
the minor version.

3. Click Finish to validate the modification

By default, when you open a Business Model, you open its last version. Any previous version of the
¥ Business Model is read-only and thus cannot be modified.

You can access alist of the different versions of a Business Model and perform certain operations. To do that:
1. IntheRepository tree view, select the Business Model you want to consult the versions of.

2. Click the Business M odels>Version in succession to display the version list of the selected Job.

3. Right-click the Business Moddl version you want to consult.

4. Do one of thefollowings:

Select To...
Edit properties edit Business Model properties.

Note: The Business Model should not be open on the design workspace,
otherwise it will be in read-only mode.

Read Business M odel consult the Business Model in read-only mode.

Y ou can open and modify the last version of a Business Model from the Version view if you select Edit
7 Business M odel from the drop-down list.
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Chapter 4. Designing a data integration Job

Talend Open Sudio for Data Integration is the tool with the capabilities that treat al of the different sources and
targets required in data integration processes and all other associated operations.

Talend Open Studio for Data Integration helps you to design data integration Jobs that allow you to put in place
up and run dataflow management processes.

This chapter addresses the needs of programmersor I T managerswho are ready to implement the technical aspects
of aBusinessModel (regardless of whether it was designed in Talend Open Studio for Data Integration’ s Business
Modeler).

Before starting any data integration processes, you need to be familiar with the Talend Open Sudio for Data
Integration Graphical User Interface (GUI). For more information, see Appendix A, GUI.
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4.1. What is a Job design

A Job Design is the runnable layer of a business model. It is a graphical design, of one or more components
connected together, that allows you to set up and run dataflow management processes. A Job Design translates
business needs into code, routines and programs, in other words it technically implements your data flow.

The Jobsyou design can address all of the different sources and targetsthat you need for dataintegration processes
and any other related process.

When you design a Job in Talend Open Sudio for Data Integration, you can:
* put in place data integration actions using a library of technical components.

 change the default setting of components or create new components or family of components to match your
exact needs.

* set connections and relati onshi ps between componentsin order to define the sequence and the nature of actions.
* access code at any time to edit or document the components in the designed Job.

« create and add items to the repository for reuse and sharing purposes (in other projects or Jobs or with other
users).

In order to be able to execute the Jobs you design in Talend Open Sudio for Data Integration, you need
to install an Oracle JVM 1.6 or later (IBM JVM is not supported). You can download it from http://
www.or acle.com/technetwor k/java/javase/downl oads/index.html.

4.2. Getting started with a basic Job design

Until a Job is created, the design workspace is unavailable and the Palette does not display.

£

A Job design is made of one or several subjobs, which are themselves defined by one or, most likely, severa
components linked together. The properties of each component require to be configured individually, in order to
function properly.

For moreinformation, see Section 4.2.4, “How to connect componentstogether” and Section 4.2.6, “ How to define
component properties’.

4.2.1. How to create a Job

Talend Open Studio for Data Integration enables you to create a Job Design by dropping different technical
components from the Palette onto the design workspace and then connecting these components together.

Y ou can aso create different foldersto better classify these Jobs.
To create a Job, complete the following:

1.  Open Talend Open Sudio for Data Integration following the procedure detailed in Section 2.2, “Launching
Talend Open Sudio for Data Integration”.

2. Inthe Repository tree view, right-click the Job Designs node and select Create job from the contextual
menu.
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3.

e =
Repository £3 . TT Navigatuq -
3

ﬁ' Business Models
a1
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Job Designs
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nE‘b Create job From templates

‘ 7 Create folder
Expand/Collapse

(4l Tmport items

#-135) Re () Export ikems

The [New job] wizard opens to help you define the main properties of the new Job.

New job
Add a job in the repository ﬁ

MName | DECuskam |

Purpose | |

Diescription | description goes here. .,

author | user@company. com |
Locker | |
Version | (.1 [m][m]
Status | v
Path | [ selet |

@ L Finish ][ Cancel

Enter the Job properties according to the following table:

Field Description

Name the name of the new Job. A message comes up if you enter prohibited characters.
Purpose Job purpose or any useful information regarding the Job use.

Description Job description.

Author aread-only field that shows by default the current user login.

L ocker aread-only field that shows by default the login of the user who owns the lock on the

are editing the properties of an existing Job.

current Job. Thisfield isempty when you are creating a Job and has data only when you
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Field Description

Version aread-only field. Y ou can manually increment the version using the M and m buttons.
For more information, see Section 5.5, “Managing Job versions”.

Status alist to select from the status of the Job you are creating.

Path alist to select from the folder in which the Job will be created.

An empty design workspace opens up showing the name of the Job as atab label.

4. Drop the components you want to use in your Job design from the Palette onto the design workspace and
connect them together. For moreinformation, see Section 4.2.2, “How to drop components to the workspace”
and Section 4.2.4, “How to connect components together”.

5. Define the properties of each of the components used in the Job. For more information, see Section 4.2.6,
“How to define component properties’.

6. Saveyour Job and then press F6 to execute it. For more information, see Section 4.2.7, “How to run a Job”.

The Job you created is now listed under the Job Designs node in the Repository tree view.

Y ou can open one or more of the created Jobs by simply double-clicking the Job label in the Repository

2 tree view.

To create different folders for your Jobs, compl ete the following:

1. Inthe Repository tree view, right-click Job Designs and select Create folder from the contextual menu.

The [New folder] dialog box displays.

% New folder |Z|EI E|

Folder —_

Create a new Folder in repository | :’ ¥

Label | testing3si|

@::l Finish ] [ Cancel

2. IntheLabel field, enter a name for the folder and then click Finish to confirm your changes and close the

dialog box.

The created folder islisted under the Job Designs node in the Repository tree view.

If you have already created Jobs that you want to move into this new folder, simply drop them into the

2 folder.

For a scenario showing how to create areal-life data integration Job, see Appendix B, Theory into practice: Job

examples.
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4.2.2. How to drop components to the workspace

4.2.2.1. How to drop components from the Palette

To actually start building a Job, click a component on the Palette. Then click again on the design workspace to
drop it there and add it to your Job Design.

If the Palette does not show in the Studio, see the section called “How to show, hide the Palette and
’ change its position”.

You can drop a note to your Job the same way you drop components. For more information, see
’ Section 4.6.4, “How to add notes to a Job design”.

Each newly added component displays generally in a blue square that symbolizesit as an individua Subjob.

41 *Job Custemdab 0.1 53 = O || 2% palette =2 =0
. . . . . . . . . . . search camponent, | CK
[== Business Inteligence
= [-— Business
(%] [=% Cuskorm Code
@' | = Data Ouality
trileInputDelimited_1 [ ' ' gl [[=EEeEEE
[—=ELT
[ File £
[~ Input
Designer | Code " Bl op L
A - O R| BLP| b E| 2 = g =5 tFileInput ARFF
s=p tFileInputDelimited

Connect componentstogether in alogical order using the connections offered, in order to build afull Job or subjob.
For more information about component connection types, see Section 4.3.1, “ Connection types’.

The Job or subjob gets highlighted in one single blue rectangle. For more information about Job and subjob
background color, see Section 4.6.6, “How to manage the subjob display”.

Multiple information or warnings may show next to the component. Browse over the component icon to display
the information tooltip. This will display until you fully completed your Job design and defined all basic (and
sometimes advanced) component properties of the Component view.

y You will be required to use Java code for your project.
&8

Related topics:
» Section 4.2.4, “How to connect components together”.
» Section 4.6.3.1, “Warnings and error icons on components’.

» Section 4.2.6, “How to define component properties’.
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4.2.2.2. How to drop components from the Metadata node

For recurrent use of files and DB connections in various Jobs, we recommend you to store the connection and
schema metadata in the Repository tree view under the M etadata node. Different folders under the M etadata

node will group the established connections including those to databases, files and systems.

Different wizards will help you centralize connection and schema metadatain the Repository tree view. For more
information about the M etadata M anager wizards, see Section 4.4.1, “How to centralize the Metadata items”.

Once the relevant metadata is stored under the Metadata node, you will be able to drop the corresponding

components directly onto the design workspace.

1. Inthe Repository tree view, expand M etadata and the folder holding the connection you want to use in
your Job.
2. Drop the relevant connection/schema onto the design workspace.
- O £ *Job JobMew 52
OZAL: component = rg:,‘h |@| v| : .
Code Al
= Lﬁ Metadata
= Fﬁ] Db Connections . . . % comprehensive
= Fﬁ-j mysgl-talendl 0.1
= Queries
(] Synonym schemas
=20 Table schemas
B dients Designer | Code
2= 0 comprehensive
=] P 2| PerlD ' RegE
T employees roper et|Do .'EL eqgE:x
E Flowmeterz10
@ log210 E Metadata schema
0 Yiew schemas
B File delimited Main
E File positional -
" _ | Mersion
@ File regex
A dialog box prompts you to select the component you want to use among those offered.
!!!!l III. l|I '!II!_E!E!E:;I
Choose one component ko create,
- Y
% FELTMysqiMap =
ELT
f EMysgBulkExec
tltMysqlCDC B
.El] EMysqlConneckion
. EMysqlInput
Ca My sqlOukput 3
® [ K l [ Cancel
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3. Select the component and then click OK. The selected component displays on the design workspace.

Alternatively, according to the type of component (Input or Output) that you want to use, perform one of the
following operations:

» Output: Press Ctrl on your keyboard while you are dropping the component onto the design workspace to
directly include it in the active Job.

* Input: Press Alt on your keyboard while you drop the component onto the design workspace to directly include
it in the active Job.

If you double-click the component, the Component view shows the selected connection details as well as the
selected schema information.

If you select the connection without selecting a schema, then the properties will be filled with the first
¥ encountered schema.

4.2.3. How to search components in the Palette

If you do not want to browse the components families in the Palette to find the components you want to use in
your Job, you can search the desired component directly in the search field at the top of the Palette.

.8 Palette &2 = 0O
Find companent... -y

== Big Data

[= Business Inteligence

[— Business

To search for acomponent, do the following:

N Click = to clear the search field of any text.

2. Enter the name of the component you want to look for and click OK.

The Palette displays only the family/families that hold(s) the component.

.2 Palette 1 = O

tRunJob| O

[== Qrchestration £
'} tRunJob

== Svstem Lre)
'} tRunJob

To go back to the default Palette settings, click

4.2.4. How to connect components together

A Job or asubjob is defined by agroup of componentsinterconnected in alogical way. The Job itself can be built
with several subjobs carrying out various processings.
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The component forming a subjob, as well as the subjobs are connected to each other using various types of
connections.

Also, a Job (made of one or more subjobs) can be preceded by a pre-job and followed by a post-job components,
in order to ensure that some specific tasks (often not related to the actual data processing) are performed first or
last in the process. For more information, see Section 4.5.6, “How to use the tPrejob and tPostjob components”.

To connect two components, right-click the source component on your design workspace, select your type of
connection from the contextual menu, and click the target component.

When dragging the link from your source component towards the target component, a graphical plug indicates if
the destination component is valid or not. The black crossed circle disappears only when you reach avalid target
component.

Only the connections authorized for the selected component are listed on the right-click contextual menu.

The types of connections proposed are different for each component according to its nature and role within the
Job, i.e. if the connection is meant to transfer data (from a defined schema) or if no datais handled.

The types of connections available also depend if data comes from one or multiple input files and gets transferred
towards one or multiple outputs.

For more information about the various types of connections and their specific settings, see Section 4.3, “Using
connections”.

4.2.5. How to drop components in the middle of a Row
link

When creating a Job, Talend Open Sudio for Data Integration enables you to insert a component in the middle
of aRow > Main, Row > Reject or Row > Combine connection.

To do so, complete the following:
1. Drop two combine and two file components from the Palette onto the design workspace.

2. Connect the component pairs using a Row > Main (or a Row > Reject) connection and a Row > Combine
one.

- . . . . . . . . . .
:# _ ~ rowd {C-:nml;uine]l _ .':‘?:I

tCombinedsQLInput_1 " tCombinedSQLFilker 1

Iﬁ o rows {Ma_in} =CE|

tFileInputDelimited 2 ’ ' " tFileCutputDelimited 1

3. Drop the component you want to insert in the middle of the row. The link gets bold and then a dialog box
displays, prompting you to type in a name for the output link.
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- - - .‘i" - . . . . .
=
% rowll {Cnmbine}l;% g
ECombined3QLInput_1 EMap_17 ECombined3QLFilter _1
% tMap_170utput E|
- new Cubput name?
5D o
EFileInputDelimite
Ik ] [ Cancel

4. Typeinanameand click OK to close the dialog box.

You may be asked to retrieve the schema of the target component. In that case, click OK to accept
¥ or click No to deny.

The component isinserted in the middle of the link, which is now divided in two links.

% Fod I{Cn:-ml;nine]l .;E)\QE _ n:-gt (Mail_'ljl .;@:l

tCombinedsQLInpUE_1 tMap_ 12 tCombinedsQLFilker 1

%I ru:ua.uS I{Ma:in]l =E>\I?€. . DuI::IZIl I{Me:uin:l . =.@.

tFileInputDelimited_2 EMap_l4 ' tFileCutputDelimited 1

4.2.6. How to define component properties

The properties information for each component forming a Job or a subjob allows to set the actua technical
implementation of the active Job.

Each component is defined by basic and advanced properties shown respectively on the Basic Settings tab and
the Advanced Settings tab of the Component view of the selected component in the design workspace. The
Component view gathers also other collateral information related to the component in use, including View and
Documentation tabs.

For detailed configuration for each component displaying in the Palette, check out the Talend Open Sudio
Components Reference Guide.

4.2.6.1. Basic Settings tab

The Basic Settingstab is part of the Component view, which islocated on the lower part of the designing editor
of Talend Open Studio for Data Integration.
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7y Jobi Cont | w& Com £2 - O Run | [20 Probl| % Modu| é Ecos | BV Sche | T2 Job | Elprop — O

1= customer (tFileInputDelimited_1) == G
Basic settings Property Twpe Built-In i H
Advanced settings File Marne "Dnf4_dobs)_Filesfcustomer csy" * [3
Dynamic settings Row Separator "I * Field Separator | "}" *
View |:| CSY options
e Header f Footer | O Lirnit

Schema Builk-Tr ~|| Editschema [

Skip emply rows |:| Die on errar
Each component has specific basic settings according to its function requirements within the Job. For a detailed
description of each component properties and use, see the Talend Open Sudio Components Reference Guide.

Some components require code to be input or functions to be set. Make sure you use Java code in
¥ properties.
For File and Database components, you can centralize properties in metadata files located in the M etadata
directory of the Repository tree view. This means that on the Basic Settings tab you can set properties on the
spot, using the Built-In Property Type or use the properties you stored in the M etadata Manager using the
Repository Property Type. The latter option helps you save time.

Select Repository as Property Type and choose the metadata file holding the relevant information. Rel ated topic:
Section 4.4.1, “How to centralize the Metadata items”.

Alternatively, you can drop the M etadata item from the Repository tree view directly to the component already
dropped on the design workspace, for its propertiesto befilled in automatically.

If you selected the Built-in mode and set manually the properties of a component, you can also save those
properties as metadata in the Repository. To do so:

1. Click thefloppy disk icon. The metadata creation wizard corresponding to the component opens.

2. Follow the steps in the wizard. For more information about the creation of metadata items, see Chapter 7,
Managing Metadata.

3. The metadata displays under the M etadata node of the Repository.
For all components that handle a data flow (most components), you can define a Talend schema in order to
describe and possibly select the data to be processed. Like the Properties data, this schema s either Built-in or

stored remotely in the Repository in ametadatafile that you created. A detailed description of the Schema setting
isprovided in the next sections.

How to set a built-in schema

A schema created as Built-in is meant for asingle use in a Job, hence cannot be reused in another Job.

Select Built-in in the Property Type list of the Basic settings view, and click the Edit Schema button to create
your built-in schema by adding columns and describing their content, according to the input file definition.
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#* Schema of tFilelnputDelimited_1

tFileInputDelimited_1

Colurmn kKey  Type Mull...| Date Patt... | Length Fr.. D,
He, ___--
FirstName String
LastiMame |:| String 1IZI
Address [] string 0
City [] string g
¢ >

E3E3 S E IS BN

[ OK ] [ Cancel

In al output properties, you aso have to define the schema of the output. To retrieve the schema defined in the
input schema, click the Sync columnstab in the Basic settings view.

Some extra information is required. For more information about Date pattern for example, check out:
¥ http://docs.oracle.com/javase/6/docs/api/index.html.

How to set a repository schema

If you often use certain database connections or specific files when building your data integration Jobs, you can
avoid defining the same properties over and over again by creating metadatafilesand storing theminthe M etadata
nodein the Repository tree view

To recall a metadata file into your current Job, select Repository in the Schema list and then select the relevant
metadatafile. Or, drop the metadataitem from the Repository treeview directly to the component already dropped
on the design workspace. Then click Edit Schema to check that the datais appropriate.

b DBInput (tMysqlInput_1) e

Basic settings Property Type Repositary | | DB (MYSGLYmysql |

Advanced settings DE Yersion -;'

Dynamic settings [use an existing connection

Wiew Host | "localhost" |E Port | "3308" M

Documentation Database | "emnployes" 3
Usernarme | “root" |§ Password | Hibkkkhaok 3
Schema Repositary e | DB {MYSOLY:mysqgl - emplovee | E] Edit schema E]
Table Mame | "employes" | E]
Query Type | Bwilt-In W | [Guess Query l [Guess schema ]
Query "zelect id, name from emploves" * B

Y ou can edit arepository schemaused in aJob from the Basic settings view. However, note that the schemahence
becomes Built-in in the current Job.

You cannot change the schema stored in the repository from this window. To edit the schema stored
¥ remotely, right-click it under the Metadata node and select the corresponding edit option (Edit
connection or Edit file) from the contextual menu.
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Related topics: Section 4.4.1, “How to centralize the Metadata items”.

How to set a field dynamically (Ctrl+Space bar)

On any field of your Job/component Properties view, you can use the Ctrl+Space bar to access the global and

context variable list and set the relevant field value dynamically.
1. Placethe cursor on any field of the Component view.

2. Press Ctrl+Space bar to access the proposal list.

3. Select onthelist therelevant parametersyou need. Appended to the variablelist, ainformation panel provides

details about the selected parameter.

Description: Error Message

Global variable, property of component tMap [EMap_1].
Type: Skring

Availability: After

Yariable Mame: ((String)globalMap.get("tMap_1_ERROR_MESSAGE"T)

tFileInputDelimited_2 ERR.OR_MESSAGE
tFileInputDelimited_2.ME_LINE
tMap_1.ERROR_MESSAGE
kFileCutputDelimited 1 ERROR,_MESSAGE
EFileCutputDelimited _1,ME_LIME
tFileCutputDelimited_2 ERROR,_MESSAGE
kFileCukpukDelirmited_2 ME_LIME
tFileInputDelimited_3, ERROR_MESSAGE
tFileInputDelimited_3.ME_LIME
FFlowMeter 1, ERROR_MESSAGE
tFlowMeter 2 ERROR_MESSAGE

This can be any parameter including: error messages, number of lines processed, or else... The list varies
according to the component in selection or the context you are working in.

Related topic: Section 4.4.2, “How to centralize contexts and variables’.

4.2.6.2. Advanced settings tab

Some components, especialy File and Databases components, provides numerous advanced use possibilities.

Iﬁ tFileInputDelimited_1

Basic settings [ ] advanced separator (For numbers)

Advanced settings

[ ]Extract lines at randam Encoding Type

IS0-5859-15

Dvnamic settings [ Ttim all calumn ] Check each row skructure againsk schema

Wit Check columin to trir Calumn 1 Trim

Documnentation ke ]
valle ]

] split row before Field
[ ]tstatCakcher Skatiskics

The content of the Advanced settings tab changes according to the selected component.

Generally you will find on this tab the parameters that are not required for a basic or usual use of the component

but may be required for a use out of the standard scope.
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How to measure data flows

You can aso find in the Advanced settings view the option tStatCatcher Statistics that allows you, if selected,
to display logs and statistics about the current Job without using dedicated components. For more information
regarding the stats & log features, see Section 4.6.7.1, “How to automate the use of statistics & logs’.

4.2.6.3. Dynamic settings tab

The Basic settings and Advanced settingstabs of al all components display various check boxes and drop-down
lists for component parameters. Usually, available values for these types of parameters are either true or false and
can only be edited when designing your Job.

The Dynamic settings tab, on the Component view, allows you to customize these parameters into code or
variable.

This feature alows you, for example, to define these parameters as variables and thus let them become context-
dependent, whereas they are not meant to be by default.

Another benefit of this feature is that you can now change the context setting at execution time. This makes full
sense when you intend to export your Job in order to deploy it onto a Job execution server for example.

' =0
ies) tContextlLoad_1 BEE G

Basic setktings

Advanced settings Marne Code

Dynamic settings Print operations context. verbose
kSkakCatcher Skatistics ¥.| False

Wigw If a wariable in the context, buk nok Iu:u&@ed ”

Disahle errors

Dizable warnings
|Disable infos
FakabiCatcher Statistics

Dacurment ation

To customize these types of parameters, as context variables for example, follow the following steps:

1. Select the relevant component basic settings or advanced settings view that contains the parameter you want
to define as avariable.

2. Click the Dynamic settings tab.
3. Click the plus button to display a new parameter line in the table.

4. Click the Name of the parameter displaying to show the list of available parameters. For example: Print
operations

5. Then click in the facing Code column cell and set the code to be used. For example: context.verbose if you
create the corresponding context variable, called verbose.

As code, you can input a context variable or a piece of Java code.
b

The corresponding lists or check boxes thus become unavailable and are highlighted in yellow in the Basic
settings or Advanced settings tab.
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‘ =
= tContextload_1 [Ea [:
Basic settings Schema Type B ¥ | Edit schems [3
fdvanced settings If a variable loaded, buk not in the conkext | Info L
Cypanicetines If a wariable in the conkext, but not loaded | Info w
Wig
Documentation

Disable errors Disable warnings Disable infos

If you want to set a parameter as context variable, make sure you create the corresponding variable in
the Context view.

For more information regarding the context variable definition, see Section 4.4.2.2, “How to use variables
in the Contexts view”.

You can also use aglobal variable or pieces of Java code to store the values to be used for each parameter.

<y Component 75 Job Settingsi Contexts(Ioh | B Run (Iob Cop | (210 Problems | =, Modules Y scheduler | — B

I, tWwarn_1

Easic setkings
Advanced settings Mame Code

- . Prictity {{IntegeriglobalMap. get("tFilelnputDelimited _1_ME_LINE")=673:4)
Dynamic settings

Wiew

Cocumentation

[ e nddl [ x Delete]

For example, use some global variable available through the Ctrl+Space bar keys, and adapt it to your context.

4.2.6.4. View tab

The View tab of the Component view alows you to change the default display format of components on the
design workspace.

Field Description

Label format Free text label showing on the design workspace. Variables can be set to

retrieve and display values from other fields. The field tooltip usually shows the
corresponding variable where the field value is stored.

Hint format Hidden tooltip, showing only when you mouse over the component.
Connection format Indicates the type of connection accepted by the component.

Y ou can graphically highlight both L abel and Hint text with HTML formatting tags:
» Bold: <b> YourLabelOrHint </b>

* [talic: <i> YourLabelOrHint </i>
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 Return carriage: Y ourLabel OrHint <br> ContdOnNextLine
» Color: <Font color=‘#RGBcolor’'> Y ourLabel OrHint </Font>

To change your preferences of this View panel, click Window>Pr efer ences>T alend>Designer.

4.2.6.5. Documentation tab

Feel free to add any useful comment or chunk of text or documentation to your component.

,., Job DEoutput X = O
136 A
137
135

133==headl tDBOutput tDEOutput 1

140 Here goe= the chunk of text doocumenting the component selected.
141 This comment displays as POD code in the Code panel.

142 =cut

143

144 $_ngbals{tDBOutput_1}{OK} = false:
14E

Designet | Code

=l Properties &7 PerlDoc | ReqExp | Tasks | Run (Job DBoukput) | Problems (Job DB... | Modules | Scheduler = 0O

o
A
sl 1:8 tDBOutput
Properties
Wigw Commenkt Here goes the chunk of text documenting the

Docurmenkation Thi=s comment displawvs as POD code in the Cod

hd

In the Documentation tab, you can add your text in the Comment field. Then, select the Show Information
check box and an information icon display next to the corresponding component in the design workspace.

Y ou can show the Documentation in your hint tooltip using the associated variable  COMMENT _, so that when
you place your mouse on thisicon, the text written in the Comment field displaysin atooltip box.

For advanced use of Documentations, you can use the Documentation view in order to store and reuse any type
of documentation.

4.2.7. How to run a Job

Y ou can execute a Job in several ways. This mainly depends on the purpose of your Job execution and on your
user level.

If you are an advanced Java user and want to execute your Job step by step to check and possibly modify it on the
run, see Section 4.2.7.2, “How to run a Job in Java Debug mode”.

If you do not have advanced Java knowledge and want to execute and monitor your Job in normal mode, see
Section 4.2.7.1, “How to run a Job in normal mode”.

Talend Open Studio for Data Integration User Guide 77



How to run a Job

4.2.7.1. How to run a Job in normal mode

Make sure you saved your Job before running it in order for all properties to be taken into account.
7

To run your Job in anorma mode, complete the following:
1. Click the Run view to accessit.
2. Click the Basic Run tab to access the normal execution mode.

3. Inthe Context areato the right of the view, select in the list the proper context for the Job to be executed
in. You can aso check the variable values.

If you have not defined any particular execution context, the context parameter table is empty and the context is
the default one. Related topic: Section 4.4.2, “How to centralize contexts and variables’.

1. Click Run to start the execution.

2. On the same view, the console displays the progress of the execution. The log includes any error message
as well as start and end messages. It also shows the Job output in case of atL ogRow component is used
in the Job design.

3. Todefine the lines of the execution progress to be displayed in the console, select the Line limit check box
and typein avauein thefied.

4. Select the Wrap check box to wrap the text to fit the console width. This check box is selected by default.
When it is cleared, a horizontal scrollbar appears, allowing you to view the end of the lines.

1y Jobikernp Contexts) | %2 Compone LB 0 [%1 Problems &2, Modules | @& Talend Ex E{D Scheduler E JobHiera | — O

Job tempdata Prod v

. Execution
Basic Run

Mame = Walue
Debig Run File: [ ftalend_FilesiProdicu. ..

Advanced Settings
Targek Exec StarLrng b rapndans S8 187 Sl Re STy

[=tatistic=s] connecting to socket on port
3620

[=tatistic=s] connected

[=tatistic=s] disconnected

Job fenoda e anded a& I8 07 Sl s sl g,
fowr s oode=i

[tine mit | 100 Wrap < 3

Before running again a Job, you might want to remove the execution statistics and traces from the designing
workspace. To do so, click the Clear button.

If for any reason, you want to stop the Job in progress, smply click the Kill button. Y ou will need to click the
Run button again, to start again the Job.

Talend Open Studio for Data Integration offers various informative features displayed during execution, such as
statistics and traces, facilitating the Job monitoring and debugging work. For more information, see the following
sections.

4.2.7.2. How to run a Job in Java Debug mode

To follow step by step the execution of a Job to identify possible bugs, you can run it in Debug mode.
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To access the Debug mode:
1. Click the Run view to accessit.
2. Click the Debug Run tab to access the debug execution modes.

\ In order to be able to run a Job in Debug mode, you need the EPIC module to be installed.
&h

Before running your Job in Debug mode, add breakpoints to the major steps of your Job flow.

@_

. —n
Contracks_Ref

This will alow you to get the Job to automatically stop at each breakpoint. This way, components and their
respective variables can be verified individually and debugged if required.

To add breakpoints to a component, right-click it on the design workspace, and select Add breakpoint on the
contextual menu.

A pause icon displays next to the component where the break is added.

To switch to debug mode, click the Java Debug button on the Debug Run tab of the Run panel. Talend Open
Sudio for Data Integration’s main window gets reorganized for debugging.

Y ou can then run the Job step by step and check each breakpoint component for the expected behavior and variable
values.

To switch back to Talend Open Sudio for Data Integration designer mode, click Window, then Per spective and
select Talend Open Sudio for Data Integration.

4.2.7.3. How to run a Job in Traces Debug mode

The traces feature alows you to monitor data processing when running a Job in Talend Open Studio for Data
Integration.

It provides arow by row view of the component behavior and displays the dynamic result next to the Row link
on the design workspace.

=

@ row (faind =§§E ouk (Main) r @
tFileInput Delimited 1 ' ' ' ' tMap_1 ' ' ' " tfileOutputDelmited_1
= rowl (Main) 4 Current row 4 F}' out (Main) & Current row : 4
Postal : : : : : : :
State
Capital
MostPopulousCiby

This feature alows you to monitor all the components of a Job, without switching to the debug mode, hence
without requiring advanced Java knowledge.

The Traces function displays the content of processed rowsin atable.

Exceptionismade for external components which cannot offer thisfeatureif their design does not include
’ it.
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Y ou can activate or deactivate Traces or decide what processed columnsto display in thetracestablethat displays
on the design workspace when launching the current Job.

To activate the Traces mode in a Job:

B. .rnwl I:{Main]l: .;.%?E . ok l{r:'-“lain]l . ' @

EFileInputDelimited 1 tMap_1 ' tFileQutputDelimited_1
L L

1. Click the Run view.
2. Click the Debug Run tab to access the debug and traces execution modes.

3. Click thedown arrow of the Java Debug button and select the Traces Debug option. Anicon displays under
every flow of your Job to indicate that process monitoring is activated.

4. Click the Traces Debug to execute the Job in Traces mode.

To deactivate the Traces on one of the flowsin your Job:

B. .rc'wl I:{Main]l: .':Eiﬁ . alLk l{r:ﬂain]l . .':.@.

kFileInputDelimited_1 EMap_1 ' tFileCutputDelimited 1
L _ ]

1. Right-click the Tracesicon under the relevant flow.

2. Select Disable Tracesfrom thelist. A red minus sign replaces the green plus sign on theicon to indicate that
the Traces mode has been deactivated for this flow.

To choose which columns of the processed data to display in the traces table, do the following:

1. Right-click the Tracesicon for the relevant flow, then select Setup Tracesfrom thelist. The [Setup Traces]

dialog box appears.

Zolumn

o
[] postal

Capital
[] MastPopulou.. .

Ok l [ Cancel

2. Inthe dialog box, clear the check boxes corresponding to the columns you do not want to display in the
Tracestable.

3. Click OK to close the dialog box.
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Monitoring data processing starts when you execute the Job and stops at the end of the execution.

To remove the displayed monitoring information, click the Clear button in the Debug Run tab.

4.2.7.4. How to set advanced execution settings

Several advanced execution settings are avail able to make the execution of the Jobs handier:

» Statistics, thisfeature displays processing performance rate. For more information, see the section called “How
to display Statistics’.

» Exec time, this feature displays the execution time in the console at the end of the execution. For more
information, see the section called “How to display the execution time and other options”.

» Save Job befor e execution, this feature allows to automatically save the Job before its execution.
» Clear beforerun, thisfeature clears all the results of a previous execution before re-executing the Job.

» JVM Setting, thisfeatureallowsyou to define the parameters of your JVM according to your needs, for example
the parameters used to display special characters.

How to display Statistics
The Statistics feature displays each component performance rate, under the flow links on the design workspace.
51 rows in 0,035 51 rows in 0,035

[ T OIS I8 ronES E';% T i 18 ronsE ’ ’
@ rowl (Main) o auk (Main o @

EFileInputDelimited_1 ' ' EMap_1 ' tFileCutputDelimited 1

It shows the number of rows processed and the processing time in row per second, allowing you to spot straight
away any bottleneck in the data processing flow.

For trigger links like OnComponentOK, OnComponentError, OnSubjobOK, OnSubjobError and If, the
Statistics option displays the state of this trigger during the execution time of your Job: Ok or Error and True
or False.

Exception ismade for external components which cannot offer thisfeatureif their design does not include
4 it.

In the Run view, click the Advanced settings tab and select the Statistics check box to activate the Stats feature
and clear the box to disableiit.

The calculation only starts when the Job execution is launched, and stops at the end of it.
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Click the Clear button from the Basic or Debug Run views to remove the calculated stats displayed. Select the
Clear before Run check box to reset the Stats feature before each execution.

The datistics thread slows down Job execution as the Job must send these stats data to the design
7 workspace in order to be displayed.

Y ou can also save your Job before the execution starts. Select the relevant option check box.

How to display the execution time and other options

To display the Job total execution time after Job execution, select in the Advanced settings tab of the Run view
the Exec time check box before running the Job.

Thisway you can test your Job before going to production.
Y ou can also clear the design workspace before each Job execution by sel ecting the check box Clear before Run.

Y ou can a'so save your Job before the execution starts. Select the relevant option check box.

How to display special characters in the console

Talend Open Sudio for Data Integration can display special characters in the console. To enable the display of
Chinese, Japanese or Korean characters, for example, proceed as follows before executing the Job:

530 [ B2 co |53 co [0BRu 2 o Bipr | B Mo | i Ta || fe || & O

Job MySAP

Basic Fun Statistics Save Job before execution
Debug Run [JExec time Clear before run
Advanced Settings M Setting

Target Exec Job Run YM arguments

Use specific 1M arguments

Argqument

d Mew, ., E
-Rms25EM
-mmx 10240

1. Select the Advanced settings tab.

2. Inthe JVM settings area of the tab view, select the Use specific JVM arguments checkbox to activate the
Argument table.

3. Nexttothe Argument table, click the New... button to pop up the [Set the VM ar gument] dialog box.
4. Inthediaogbox, typein-Dfi | e. encodi ng=UTF- 8.
5. Click OK to close the dialog box.

Thisargument can be applied for all of your Job executionsin Talend Open Sudio for Data Integration. For
further information about how to apply this VM argument for all of the Job executions, see Section 2.5.5,
“Debug and Job execution preferences’.
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4.2.8. How to customize your workspace

When using Talend Open Sudio for Data Integration to design a data integration Job, you can customize the

Palette layout and setting according to your needs. Y ou can as well change the position of any of the panels that
exist in the Studio to meet your requirements.

All the panels, tabs, and views described in this documentation are specific to Talend Open Studio for

¥ Data Integration. Some views listed in the [Show View] dialog box are Eclipse specific and are not

subjects of this documentation. For information on such views, check Eclipse online documentation at
http://www.eclipse.org/documentation/.

4.2.8.1. How to change the Palette layout and settings

The Palette contains all basic technical components necessary to create the most complex Jobs in the design
workspace. These components are grouped in families and sub-families.

For specific component configuration, check out the Talend Open Sudio Components Reference Guide.

Talend Open Studio for Data Integration enables you to change the layout and position of your Palette according
to your requirements. the below sections explain all management options you can carry out on the Palette.

How to show, hide the Palette and change its position

By default, the Palette might be hidden on the right hand side of your design workspace.

Show Palette

Palett

If you want the Paletteto show permanently, click theleft arrow, at the upper right corner of the design workspace,
to make it visible at all times.

You can aso move around the Palette outside the design workspace within Talend Open Sudio for Data
Integration’s main window. To enable the standalone Palette view, click the Window menu > Show View... >
General > Palette.

If you want to set the Palette apart in a panel, right-click the Palette head bar and select Detached from the
contextual menu. The Palette opensin a separate view that you can move around wherever you like within Talend
Open Sudio for Data Integration’s main window.

How to display/hide components families

Y ou can display/hide components families according to your needs in case of visibility problems, for example.
To do so, right-click the Palette and select Display folder to display components families and Hide folder to
display components without their families.
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= B | 2k Palette 2 - = 0
Find component... (04

[~ Business Inkteligence

Add To Favorite
Display Faolder ! |
Layauk L3

Use Large Icons

Settings...

Find Cormponent in Jobs

Thisdisplay/hide option can be very useful when you arein the Favoriteview of the Palette. Inthisview,

¥ you usually have alimited number of componentsthat if you display without their families, you will have
themin an aphabetical list and thusfacilitate their usage. for more information about the Palette favorite,
see the section called “How to set the Palette favorite”.

How to maintain a component family open

If you often use one or many component families, you can add a pin on their names to stop them from collapsing
when you select components from other families.

= Databases -

== MaxDE
L= My50L
[ Oracle

To add apin, click the pinicon on the top right-hand corner of the family name.

How to filter the Palette

You can select the components to be shown or hidden on your Palette. You can aso add to the Palette the
components that you devel oped yourself.

For more information about filtering the Palette, see Section 2.6.1, “ Palette Settings”.

For more information about adding components to the Palette, either from Talend Exchange or from your own
development, see Section 4.5.3, “How to downl oad/upload Talend Community components” and/or Section 2.5.2,
“External or User components”.

How to set the Palette favorite

The Palette offers you search and favorite possibilities that by turn facilitate its usage.

Y ou can add/remove components to/from the Palette favorite view of Talend Open Sudio for Data Integration
in order to have a quick access to all the components that you mostly use.

To do so:
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1. Fromthe Palette, right-click the component you want to add to Palette favorite and select Add To Favorite.
[=File 42
[== Input
¥ bApachelogInput
=3 tFileInputARFF
s=d tFileInputDelimited
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A

Do the samefor all the components you want to add to the Palette favorite then click the Favorite “= button
in the upper right corner of the Palette to display the Palette favorite.
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Only the components added to the favorite are displayed.

To delete a component from the Palette favorite, right-click the component you want to remove from the
favorite and select Remove From Favorite.

To restore the Palette standard view, click the Standard *# button in the upper right corner of the Palette.

How to change components layout in the Palette

You can change the layout of the component list in the Palette to display them in columns or in lists, as icons
only or asicons with short description.

Y ou can a'so enlarge the component icons for better readability of the component list.
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To do so, right-click any component family in the Palette and select the desired option in the contextual menu or
click Settings to open the [Palette Settings] window and fine-tune the layout.

How to add external components to the Palette

Talend Open Sudio for Data Integration enables you to add external components to the Palette of your Studio
and use them in your Job designs.

For more information about the creation and development of user components, refer to the component creation
tutorial on our wiki at http://www.talendforge.org/wiki/doku.php?d=component_creation.

For more information about how to download user components in your Studio, see Section 4.5.3, “How to
download/upload Talend Community components”.

4.2.8.2. How to change panels positions

All panelsin the open Studio can be moved around according to your needs.
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All you need to do isto click the head border of a panel or to click atab, hold down the mouse button and drag
the panel to the target destination. Release to change the panel position.

Click the minimize/maximize icons (E]/) to minimize the corresponding panel or maximize it. For more
information on how to display or hide a panel/view, see Section 4.2.8.3, “How to display Job configuration tabs/
views’.
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Click the closeicon (&) to close atab/view. To reopen aview, click Window > Show View > Talend, then click
the name of the panel you want to add to your current view or see Section A.8, “ Shortcuts and aliases ™.

If the Palette does not show or if you want to set it apart in a panel, go to Window > Show view...> General >

Palette. The Palette opens in a separate view that you can move around wherever you like within Talend Open
Sudio for Data Integration’s main window.

4.2.8.3. How to display Job configuration tabs/views

The configuration tabs are located in the lower half of the design workspace. Each tab opens aview that displays
detailed information about the selected element in the design workspace.

tFileInputPositional_1 ' ) ' " tFileCutputdML_1

Designer | Code
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Main Mame

Extra . L
Author Yersion

Stats & Logs

Version Purpose Status
Description
Creation Modification

The Component, Run Job, and Contexts views gather all information relative to the graphical elements selected
in the design workspace or the actual execution of the open Job.

By default, when you launch Talend Open Studio for Data Integration for the first time, the Problems
¥ tab will not be displayed until the first Job is created. After that, Problems tab will be displayed in the
tab system automatically.

The M odules and Scheduler[depr ecated] tabs are located in the same tab system as the Component, L ogs and
Run Job tabs. Both views are independent from the active or inactive Jobs open on the design workspace.

Some of the configuration tabs are hidden by default such as the Error Log, Navigator, Job Hierarchy,
Problems, Modules and Scheduler[deprecated] tabs. Y ou can show hidden tabsin this tab system and directly
open the corresponding view if you select Window > Show view and then, in the open dialog box, expand the
corresponding node and select the element you want to display.

For detailed description about these tabs, see Section 4.2.8.3, “How to display Job configuration tabs/views”.
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4.3. Using connections

In Talend Open Sudio for Data Integration, a Job or a subjob is composed of a group of components logically
linked to one another viaconnections. This section will describe the types of connections and their related settings.

4.3.1. Connection types

There are various types of connections which define either the data to be processed, the data output, or the Job
logical sequence.

Right-click a component on the design workspace to display a contextual menu that lists all available links for
the selected component.

The sections below describe all available connection types.

4.3.1.1. Row connection

A Row connection handlesthe actual data. The Row connections can bemain, lookup, r g ect or output according
to the nature of the flow processed.

Main
Thistype of row connection is the most commonly used connection. It passes on data flows from one component

to the other, iterating on each row and reading input data according to the component properties setting (schema).

Data transferred through main rows are characterized by a schema definition which describes the data structure
inthe input file.

Y ou cannot connect two Input components together using a main Row connection. Only one incoming
¥ Row connection is possible per component. Y ou will not be able to link twice the same target component
using amain Row connection. The second row linking a component will be called L ookup.

(X]

p

- —a—= .
tFileInputCelinited_1

L‘::b Iﬁ rovl (Main) " :|

EFileList 1 ' tFileInputDelimited_2 " tFileCupREAL_ 2

To connect two components using a Main connection, right-click the input component and select Row > Main
on the connection list.
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Alternatively, you can click the component to highlight it, then right-click it and drag the cursor towards the
destination component. Thiswill automatically create a Row > Main type of connection.

For information on using multiple Row connections, see the section called “Multiple Input/Output”.

Lookup

This row link connects a sub-flow component to a main flow component (which should be allowed to receive
more than one incoming flow). This connection is used only in the case of multiple input flows.

i
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¥ Delete

Select All

Deactivate row:z

'E-Eet“khis conneckion as Main

Settings

A Lookup row can be changed into amain row at any time (and reversely, amain row can be changed to alookup
row). To do so, right-click the row to be changed, and on the pop-up menu, click Set this connection as Main.

Related topic: the section called “Multiple Input/Output”.

Filter

This row link connects specifically atFilter Row component to an output component. This row link gathers the
data matching the filtering criteria. This particular component offers also a Reject link to fetch the non-matching
data flow.

Rejects

Thisrow link connects a processing component to an output component. This row link gathers the data that does
NOT match thefilter or are not valid for the expected output. Thislink allows you to track the data that could not
be processed for any reason (wrong type, undefined null value, etc.). On some components, this link is enabled
when the Die on error option is deactivated. For more information, refer to the relevant component properties
available in the Talend Open Studio for Data Integration Reference Guide.

ErrorReject

This row link connects atMap component to an output component. This link is enabled when you clear the Die
on error check box in the tMap editor and it gathers data that could not be processed (wrong type, undefined
null value, unparseable dates, etc.).

Talend Open Studio for Data Integration User Guide 89



Connection types

Related topic: Section 6.2.4.6, “Handling errors”.

Output

Thisrow link connectsatM ap component to one or several output components. Asthe Job output can be multiple,
you get prompted to give a name for each output row created.

The system aso remembers deleted output link names (and properties if they were defined). This way,
¥ you do not have to fill in again property datain case you want to reuse them.

Related topic: the section called “Multiple Input/Output”.

Uniques/Duplicates

These row links connect atUnigRow to output components.

The Uniques link gathers the rows that are found first in the incoming flow. This flow of unique datais directed
to the relevant output component or else to another processing subjob.

The Duplicates link gathers the possible duplicates of the first encountered rows. This reject flow is directed to
the relevant output component, for analysis for example.

Multiple Input/Output

Some components help handle data through multiple inputs and/or multiple outputs. These are often processing-
type components such as thetM ap.

If thisrequiresajoin or sometransformation in oneflow, you want to use the tM ap component, which is dedicated
to thisuse.

For further information regarding data mapping, see Chapter 4, Designing a data integration Job.

For properties regarding the tM ap component aswell as use case scenarios, see Talend Open Studio Components
Reference Guide.

4.3.1.2. Iterate connection

The Iterate connection can be used to loop on files contained in a directory, on rows contained in afile or on
DB entries.

A component can be the target of only one Iterate link. The Iterate link is mainly to be connected to the start
component of aflow (in a subjob).

Some components such asthetFilel ist component are meant to be connected through an iterate link with the next
component. For how to set an I ter ate connection, see Section 4.3.2.2, “Iterate connection settings’.

The name of the Iteratelink isread-only unlike other types of connections.
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4.3.1.3. Trigger connections

Trigger connections define the processing sequence, i.e. no datais handled through these connections.

The connection in use will create a dependency between Jobs or subjobs which therefore will be triggered one
after the other according to the trigger nature.

Row b
2n Subijob Errar

<2 Undo Delete items
Run if

On Component Ok,
=| Zopy 2n Zamponent Errar

Trigger connectionsfall into two categories:
* subjob triggers: On Subjob Ok, On Subjob Error and Run if,

» component triggers: On Component Ok, On Component Error and Run if.
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OnSubjobOK (previously Then Run): Thislink is used to trigger the next subjob on the condition that the main
subjob completed without error. This connection is to be used only from the start component of the Job.

These connections are used to orchestrate the subjobs forming the Job or to easily troubleshoot and handle
unexpected errors.

OnSubjobError: This link is used to trigger the next subjob in case the first (main) subjob do not complete
correctly. This“on error” subjob helps flagging the bottleneck or handle the error if possible.

Related topic: Section 4.6.2, “How to define the Start component”.

OnComponentOK and OnComponentError are component triggers. They can be used with any source
component on the subjob.

OnComponentOK will only trigger the target component once the execution of the source component iscomplete
without error. Its main use could beto trigger a notification subjob for example.

OnComponentError will trigger the sub-job or component as soon as an error is encountered in the primary Job.

Run if triggers a subjob or component in case the condition defined is met. For how to set atrigger condition, see
the section called “Run if connection settings”.
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4.3.1.4. Link connection

The Link connection can only be used with ELT components. These links transfer table schema information to
the ELT mapper component in order to be used in specific DB query statements.

Related topics: ELT components in the Talend Open Studio Components Reference Guide.

TheLink connection therefore does not handle actual data but only the metadata regarding the table to be operated
on.

When right-clicking the ELT component to be connected, select Link > New Output.

Be aware that the name you provide to the link MUST reflects the actual table name.

In fact, the link name will be used in the SQL statement generated through the ETL Mapper, therefore the same
name should never be used twice.

4.3.2. How to define connection settings

Y ou can display the properties of a connection by selecting it and clicking the Component view tab, or by right-
clicking the connection and selecting Settings from the contextual menu. This section summarizes connection
property settings.

4.3.2.1. Row connection settings

The Basic settings vertical tab of the Component view of the connection displays the schema of the data flow
handled by the connection. Y ou can change the schema by clicking the Edit schema button. Once you change the
schema of the data flow, the schematype of the two components across the connection will become Built-In. For
more information, see the section called “How to set a built-in schema’.

o rowl

Basic settings Edit schema E]

Advanced settings Schema from tRileInputDelimited 1 output

Colurmn Key T... #| M., Date..| L... P.. D. C.. #
Gl i In... z 0
Cuskome, ., =l 225 0
Cuskome, .. Sk 255 0
idSkate In... z 0
idz In... 2 ]
ReqgTime Sk 50 ]

Reqister. .. at... 500 b

The Advanced settings vertical tab lets you monitor the data flow over the connection in a Job without using a
separate tFlowM eter component. The measured information will be interpreted and displayed in a supervising
tool such as Talend Activity Monitoring Console. For information about Talend Activity Monitoring Console, see
Talend Activity Monitoring Console User Guide.
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o rowl

: . [ ]use input connection name as label
Basic settings

Advanced settings Labed My Label
Mode dbsolube e [*
Threshalds Label p— — —_
£ 3

Manikor this conneckion

To monitor the data over the connection, perform the following settings in the Advanced settings vertical tab:
1. Select the Monitor this connection check box.

2. Select Useinput connection name aslabel to use the name of the input flow to label your datato belogged,
or enter alabel inthe Label field.

3. FromtheModelist, select Absoluteto log the actual number of rows passes over the connection, or Relative
to log the ratio (%) of the number of rows passed over this connection against a reference connection. If you
select Relative, you need to select a reference connection from the Connections List list.

4. Click the plus button to add a line in the Thresholds table and define a range of the number of rows to be
logged.

For more information about flow metrics, see tFlowMeterCatcher component in the Talend Open Sudio
Components Refer ence Guide and see Talend Activity Monitoring Console User Guide.

4.3.2.2. lterate connection settings

You can set an Iteratelink to run parallel iterations:

1. Simply select the Iterate link of your subjob to display the related Basic settings view of the Components
tab.

2. SdecttheEnableparallel execution check box and set the number of executionsto be carried out in parallel.
= iteratel
Basic settings Enable parallel execution  Number of parallel execution | 4|

Advanced setkings

When executing your Job, the number of parallel iterations will be distributed onto the available processors.
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3. Sdect the Statistics check box of the Run view to show the real time parallel executions on the design
workspace.

4.3.2.3. Trigger connection settings

Run if connection settings

In the Basic settings view of a Run if connection, you can set the condition to the Subjob in Java. Pressing Ctr|
+Space alows you to access al global and context variables.

o If1
o -
Basic settings Condition i [Integer)globalMap.get ("cFileInput
advanced ssttings Delimited 1 NE LINE") )
w

4.4. Using the Metadata Manager

Talend Open Sudio for Data Integration is a metadata-driven solution, and can therefore help you ensure the
whole Job consistency and quality through a centralized Metadata Manager in the repository.

Talend Open Studio for Data Integration provides a Metadata Manager that consolidates all project information
in a centralized repository shared by all users in the integration processes. This shared repository facilitates
collaboration between team members by allowing them to store and share their business models, integration jobs
and metadata.

4.4.1. How to centralize the Metadata items

The M etadata node in the Repository tree view gathers various wizards to help you set up connections to the
files, databases, and/or systems you may connect to.

This way you can store centrally the connection details you need to connect to your usual utilities and you can
easily reuse them over and over again in all your Job designs without filling them manually every time when
configuring the Job components.
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From the metadata wizards, you can collect and centralize connection details to various utilities including:

» DB Connection: connection details and table data description (schema) of any type of database and JDBC
connections

« File Delimited/Positional/Regex/XML/Excel/Ldif: file access details and description of data from the types of
filelisted.

» LDAP: access details and data description of an LDAP directory.

» Salesforce: access details and data description of a Salesforce table.

» WSDL : access details and data description of awebservice.

* Generic schema: access details and data description of any sort of sources.

For more information about these M etadata creation procedures, see Chapter 4, Designing a data integration Job.

4.4.2. How to centralize contexts and variables

Depending on the circumstances the Job is being used in, you might want to manage it differently for various
execution types (Prod and Test in the example given below). For instance, there might be various testing stages
you want to perform and validate before a Job is ready to go live for production use.

Talend Open Studio for Data Integration offersyou the possibility to create multiple context data sets. Furthermore
you can either create context data sets on a one-shot basis, from the context tab of a Job or you can centralize the
context data sets in the Contexts node of the Repository tree view in order to reuse them in different Jobs.

A context is characterized by parameters. These parameters are mostly context-sensitive variables which will be
added to the list of variables for reuse in the component-specific properties on the Component view through the
Ctrl+Space bar keystrokes.

4.4.2.1. How to use variables in a Job

Variables represent values which change throughout the execution of a program. A global variable is a system
variable which can be accessed by any module or function. It retainsits value after the function or program using
it has completed execution. A context variable is a variable which is defined by the user for a particular context.

You can use an existing global variable or context variable in any component properties field. Press Ctrl+Space
bar to display the full list of global and context variables used in various predefined Java functions.

Description: Error Message tFileInputbelimited _2 ERRCR_MESSAGE
kFileInputDelimited_2, ME_LINE

Global wariable, property of component tMap [tMap_1]. tMap 1.ERROR MESSAGE
Ut sicH STt tFileCutputDelimited_1.ERROR_MESSAGE
Avvailabilicy: After tFrileCutputDelimited_1.ME_LINE

Variable Mame: ((String)globalMap.get("tMap_1_ERROR_MESSAGE") EE::ngEﬁg:::m:Ezg_g'EERSEEMESSAGE
tFileInputDelimited_3.ERROR._MESSAGE
tFileInputDelimited_3.ME_LIME
tFlowMeter_1.ERROR_MESSAGE
tFlowMeter_2 ERROR_MESSAGE

Thelist grows along with new user-defined variables (context variables).
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Related topics:
» Section 4.4.2.4, “How to define variables from the Component view”

» Section 4.4.2.2, “How to use variables in the Contexts view”

4.4.2.2. How to use variables in the Contexts view

Various ways are at your disposal to create and define variables. You can manage your variables through the
Contextsview or directly on the Component view.

For moreinformation regarding the variabl e definition directly on the Component view, see Section 4.4.2.4, “How
to define variables from the Component view”.

The Contexts view is positioned on the lower part of the design workspace and is made of three tabs: Variables,
Valuesastree and Values astable.

If you cannot find the Contexts view on the tab system of Talend Open Sudio for Data Integration, go
¥ to Window > Show view > Talend, and select Contexts.

Variables tab

The Variables tab is part of the Contexts tab and shows all of the variables that have been defined for each
component in the current Job.

Yariables | Yalues as tree | Values as table

Marme Source Tvpe Script code
TST_DEMAME built-in Skring context, TST_DENAME
TST_IJSER. built-in Skring context, TST_IJSER,
TST_P&ss built-in Skring contexk, TST_PAss

= conkexkdProd contexk4Prod - -

context4Prod conkexk, File
newl context4Prod  String context,newl
Mewnariable built-in Skring conkexk, Newvariable

L
D [ Joriginal order

From this panel, you can manage your built-in variables:

» Add aparameter line to the table by clicking on [+]

» Edit the Name of the new variable and type in the <Newvariable> name.

» Delete built-in variables. (Reminder: repository variables are read-only.)

 Import variables from arepository context source, using the Repository variables button.

 Display the context variablesin their original order. They are sorted automatically by the studio upon creation
in the tab view or when imported from the Repository. To do this, select the Original order check box.
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Reorganize the context variables by selecting the variable of interest and then using the and buttons.

To do so, you need select the Original order check box to activate the two arrow buttons.

To define the actual value of anewly created variable, click the Value astreetab.

Y ou can add as many entries as you need on the Variables tab. By default the variable created is of built-in type.

Fields Description

Name Name of the variable. Y ou can edit this field, on the condition that the variable
is of Built-in type. Repository variables are read-only.

Source Built-in: The variable is created in this Job and will be used in this Job only.
<Repository entry name>: The variable has been defined in a context stored
in the repository. The source is thus the actual context group you created in the
repository.

Type Select the type of data being handled. Thisisrequired in Java.

Script code Code corresponding to the variable vaue. Displayed code will be:
cont ext . Your Par anet er Nane. This Script code is automatically
generated when you define the variable in the Component view.

Comment Add any useful comment.

2

Y ou cannot create contexts from the Variables view, but only from the Values astable or astree views.

For further information regarding variable definition on the component view, see Section 4.4.2.4, “How to define
variables from the Component view”.

For more information about the repository variables, see Section 4.4.2.5, “How to store contextsin the repository”.

Values as tree tab

This tab shows the variables as well astheir valuesin atree view.

Wariables |vYalies as tree | Walues as table

Wariable Conkext Prampk

1 F FH OFHF

T5T_DBEMAME

TST_USER

TST_PASS

File

new 1

new'dar
Defaulk | newz?
Prod | newzy

From this view, you can:

Yalue

MyCompary-Dbms|
null

» Definethevaue of abuilt-in variable directly in the Valuefield. Note that repository variables values are read-

only and can only be edited in the relevant repository context.
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 Define aquestion to prompt the user for variable value confirmation at execution time.
 Create or Edit a context name through the top right dedicated button.

» Rearrange the variable/context groupby display.

Fields Description

Variable Name of the variables.

Context Name of the contexts.

Prompt Select this check box, if you want the variable to be editable in the confirmation

dialog box at execution time.

If you asked for a prompt to popup, fill in thisfield to define the message to show
on the dialog box.

Value Value for the corresponding variable. Define the value of your built-in variables.
Note that repository variables are read-only.

Y ou can manage your contexts from this tab, through the dedicated button - placed on the top right hand side
of the Contexts view. See Section 4.4.2.3, “How to configure contexts’ for further information regarding the
context management.

Onthe Values astree tab, you can display the values based on the contexts or on the variables for more clarity.

To change the way the values are displayed on the tree, click the small down arrow button, then click the group
by option you want.

For more information regarding variable definition, see Section 4.4.2.4, “How to define variables from the
Component view” and Section 4.4.2.5, “How to store contexts in the repository”.

Values as table tab

This Values astable tab shows the context and variable settings in the form of atable.

Fields Description
Name Name of the variable.
<Y our ContextName> Corresponding value for the variable.

Y ou can manage your contexts from this tab, through the Configur e contexts button placed on the top right hand
side of the Contexts panel. See Section 4.4.2.3, “How to configure contexts’ for further information regarding
the context management.

For more information regarding variable definition, see Section 4.4.2.4, “How to define variables from the
Component view” and Section 4.4.2.5, “How to store contexts in the repository”.

4.4.2.3. How to configure contexts

You can only manage your contexts from the Values as table or Values as tree tabs. A dedicated button &
shows up on the top right hand side of the Contexts view.

Click the Configure Contexts... icon to open the management dialog box.
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% Configure Contexts @

Default is default context, it can nok be removed,
Peloefaul|
T3 Prod
Select Al
Deselect All
Mew.. || Edt. |
7 [ (0] 4 l [ Cancel

The default context cannot be removed, therefore the Remove button is unavailable. To make it editable,
2 select another context on the list.

Creating a context

Based on the default context you set, you can create as many contexts as you need.
To create a new context:
1. Click New inthe [Configure Contexts] dialog box.

2. Typeinaname for the new context.

#* Mew Context

x]

Give a name far the new conkext

| Prad| |

Ok H Cancel ]

3. Click OK to validate the creation.

When you create a new context, the entire default context legacy is copied over to the new context. You hence
only need to edit the relevant fields on the Value as tr ee tab to customize the context according to your use.

The drop-down list Default Context shows all the contexts you created.

Y ou can switch default context by simply selecting the new default context on the Default Context list on the
Variablestab of the Contexts view.

Note that the Default (or last) context can never be removed. There should always be a context to run the Job, be
this context called Default or any other name.
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Renaming or editing a context

To change the name of an existing context:

1. Click Edit onthe[Configure contexts] dialog box and enter the new context namein the dialog box showing
up.

2. Click OK to validate the change.

To carry out changes on the actual values of the context variables, go to the Values as tree or Values as table
tabs. For more information about these tabs, see Section 4.4.2.2, “How to use variables in the Contexts view”.

4.4.2.4. How to define variables from the Component view

Various ways are at your disposal to create and define context variables. Y ou can mostly manage your variables
from the Contexts view, but you can also create them directly on the Component view.

For more information related to the variable definition through the Contexts view, see Section 4.4.2.2, “How to
use variablesin the Contexts view”.

For moreinformation regarding the variable definitionin therepository, see Section 4.4.2.5, “ How to store contexts
in the repository”.

Context variables creation

The quickest way to create context variables on the spot is to use the F5 key:
1. Ontherelevant Component view, place your cursor on the field that you want to parameterize.
2. PressF5to display the context parameter dialog box:

% MNew Context Parameter §|

Context parameter

Creakte a new conkext parameter, D

Marne kalendDB

cCarmnrmenk

Type STRING Z

Prarmpk 15 'talend-dbms' a walid database haost connection Far this session?
Promet for value

Default value | talend-dbms'

() Einish l [ Cancel
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3. GiveaNameto thisnew variable, fill in the Comment area and choose the Type.

4. Enter a Prompt to be displayed to confirm the use of this variable in the current Job execution (generally
used for test purpose only). And select the Prompt for value check box to display the field as editable value.

5. If you filled in a value already in the corresponding properties field, this value is displayed in the Default
valuefield. Else, typein the default value you want to use for one context.

6. Click Finish to validate.
7. Goto the Contexts view tab. Notice that the context variables tab lists the newly created variables.
The newly created variables are listed in the Contexts view.

The variable name should follow some typing rules and should not contain any forbidden characters, such
¥ as space character.

The variable created this way is automatically stored in all existing contexts, but you can subsequently change
the value independently in each context.

For more information on how to create or edit a context, see Section 4.4.2.3, “How to configure contexts’.

StoreSQLQuery

StoreSQL Query is a user-defined variable and is mainly dedicated to debugging.

StoreSQL Query isdifferent from other context variablesin thefact that itsmain purposeisto be used as parameter
of the specific global variable called Query. It alows you to dynamically feed the global query variable.

The global variable Query, isavailable on the proposals list (Ctrl+Space bar) for some DB input components.

For further details on StoreSQL Query settings, see the Talend Open Studio Components Reference Guide, and
in particular the scenarios of the tDBInput component.

4.4.2.5. How to store contexts in the repository

You can store centrally all contexts if you need to reuse them across various Jobs.

How to create a context group
To create a context group, proceed as follows:

Procedure4.1. Create the context group and add required information

1. Right-click the Contexts node in the Repository tree view and select Create new context group from the
contextual menu.
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A 2-step wizard appears to help you define the various contexts and context parameters, which you will be
ableto select in the Contexts view of the design workspace.

In Step 1 of 2, type in a name for the context group to be created, and add any general information such as
adescription if required.

Click Next to go to Step 2 of 2, which allows you to define the various contexts and variables that you need.

Yariables '-.-'alueJ%s kree | Values as table

Marme Tvpe Script code Comment
Servername Skring contexk, Servername

context. Dbrame I

3 b

Procedure 4.2. Define the default context’s variable set to be used as basis for other

contexts
1. OntheVariablestab, click the [+] button to add as many new variable lines as needed and define the name
of the variables.
In this example, we define the variables that can be used in the Name field of the Component view.
2. Select the type of the variable from the Typelist.
The Script code varies according to the type of variable you selected, and will be used in the generated code.
The screen shot above shows the Java code produced.
3. OntheTreeor Tableviews, define the various contexts and the values of the variables.
‘ariables | Yalues as tree |Walues as table
EE}‘
Mame Defaulk Prod
SEFYErMAanme Testserver Prod3erver
Dbname TestDE ProdDE
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First, define the values for the default (first) context variables, then create a new context that will be based
on the variables values that you just set.

For more information about how to create a new context, see Section 4.4.2.3, “How to configure contexts’.

4. OntheValuesastreetab, add aprompt if you want the variable to be editable in a confirmation dialog box
at execution time.

Wariables | values as tree | Walues as table

o
©
Conkext Yariable Prampk Yalue -
= Default
SErvErname w| Confirm Server name?  Teskserver
Dbname | newi? TestDE
= Prod v
< b

To add a prompt message, select the facing check box, then type in the message you want to display at
execution time.

Once you created and adapted as many context sets as you want, click Finish to validate. The group of contexts
thus displays under the Contexts node in the Repository tree view.

How to create a context from a Metadata

When creating a Metadata (through the File or DB metadata wizards), you have the possibility to Export the
metadata connection information as a Context.

For more information about this feature, see Section 7.17, “ Exporting M etadata as context”.

4.4.2.6. How to apply context variables to a Job from the
repository

Once a context group is created and stored in the Repository, there are two ways of applying it to a Job:
1. Drop acontext group. Thisway, the group is applied as awhole.

2.
Use the context icon button G Thisway, the variables of a context group can be applied separately.

How to drop a context group onto a Job

To drop a context group onto a Job, proceed as follows:
1. Double-click the Job to which a context group is to be added.

2. Once the Job is opened, drop the context group of your choice either onto the Job workspace or onto the
Contexts view beneath the workspace.
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How to use the context icon button

To use the context icon button to apply context variables to a Job, proceed as follows:
1. Double-click the Job to which a context variableis to be added.
2. Oncethe Job is opened in the workspace, click the Contexts view beneath the workspace to open it.

3. At the bottom of the Contexts view, click the button to open the wizard to select the context variables to
be applied.
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4. Inthewizard, select the context variables you need to apply or clear those you do not need to.

The context variables that have been applied are automatically selected and cannot be cleared.

x

5. Click OK to apply the selected context variables to the Job.

4.4.2.7. How to run a Job in a selected context

Y ou can select the context you want the Job design to be executed in.

Conktext - Target execution
Test W
Marne Yalue
hiost 'talend-dbrs-test'
pork ‘gos0’
db "Talend-test'

Click the Run Job tab, and in the Context area, select the relevant context among the various ones you created.

If you did not create any context, only the Default context shows on the list.

All the context variables you created for the selected context display, along with their respective value, in atable
underneath. If you clear the Prompt check box next to some variables, you will get a dialog box allowing you to

change the variable value for this Job execution only.

To make a change permanent in a variable value, you need to change it on the Context view if your variable is
of type built-in or in the Context group of the repository.

Related topics:

» Section 4.4.2.2, “How to use variables in the Contexts view”

» Section 4.4.2.5, “How to store contexts in the repository”
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4.4.3. How to use the SQL Templates

Talend Open Sudio for Data I ntegration allowsyou to benefit from using some system SQL templates since many
query structures are standardized with common approaches.

Talend Open Sudio for Data Integration lists system SQL templates under the SQL Templates node in the
Repository treeview. There, you can find severa standardized SQL templatesincluding Generic, Hive, MySQL,
Oracle, and Teradata.

Contexts

[+ Code

2L
#-L0 Generic
#-L Hive
= MysgL

= system
[ UserDefined

7 MNetezza

3 Oracle

7 Paraceel
H-0 Teradata

[+ Lﬁ Metadata

[+ l==“ Documentation
[5)} Recycle bin

el e |

In each of the above categories, you can create your own user-defined SQL templates using the SQL templates
wizard and thus centralize them in the repository for reuse.

For more information about the use of SQL templatesin Talend Open Studio for Data Integration, see Chapter 4,
Designing a data integration Job.

For more information about how to create auser-defined SQL template and useit in a Job context, seethe scenario
of tMysqlTablelList component in the Talend Open Studio Components Reference Guide.

4.5. Handling Jobs: advanced subjects

The sections below give detail information about various advanced configuration situations of a data integration
Job including handling multipleinput and output flows, using SQL queries, using external componentsin the Job,
scheduling atask to run your Job.

4.5.1. How to map data flows

The most common way to handle multiple input and output flows in your Job including transformations and data
re-routing is to use the tM ap component.

For more information about the principles of using this component, see Chapter 4, Designing a data integration
Job.

For examples of Jobs using this component, seetM ap in the Talend Open Studio Components Reference Guide.
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4.5.2. How to create queries using the SQLBuilder

SQLBuilder helps you build your SQL queries and monitor the changes between DB tables and metadata tables.
Thiseditor isavailable in all DBInput and DBSQL Row components (specific or generic).

Y ou can build a query using the SQL builder whether your database table schemais stored in the Repository tree
view or built-in directly in the Job.

Fill in the DB connection details and select the appropriate repository entry if you defined it.

Remove the default query statement in the Query field of the Basic settings view of the Component panel. Then
click the[...] button to open the [SQL Builder] editor.

# SOL Builder FEX)
Dakabase Structure o= rﬁﬁ talend{ClientDE). sql
Databases Repositary Diff X =8E 4
= ® talend ClientDE
= EH diert client

B ID_CLIENT  ID_CLIENT
B CLIENT_MAME CLIEMT_MAME
B CLIEMT_BIRTHICLIEMT BIRTHDAY

CLIEMT _ACCOLCLIEMT _ACCOUMT
1 client_conkract client-contract

¢ | S0L - Limit Rows | 100
Execute a guery ko see the results || Columns - Preview | Row Count | Primary Kevs | Exported Kevs | 7=
COLUMM_NAME  DATA_TYPE  TYPE_MAME  COLUMM_SIZE  DECIME
ID_CLIENT 4 ink 11 ]
CLIENT_MAME 1z varchar 150 0
CLIEMT_BIRTH... 91 date 10 ]
CLIENT_ACCD,,, 8 double 5 z
< | >
Columns For “talend™ . client”
04 ] [ Cancel

The[SQL Builder] editor is made of the following panels:
+ Database structure,

* Query editor made of editor and designer tabs,

* Query execution view,

» Schemaview.

The Database structure shows the tables for which a schema was defined either in the repository database entry
or in your built-in connection.

The schemaview, in the bottom right corner of the editor, shows the column description.
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4.5.2.1. How to compare database structures

On the Database Structure panel, you can see all tables stored in the DB connection metadata entry in the
Repository tree view, or in case of built-in schema, the tables of the database itself.

The connection to the database, in case of built-in schema or in case of a refreshing operation of a
’ repository schema might take quite sometime.

Click the refresh icon to display the differences between the DB metadata tables and the actual DB tables.

Database Structure CURRES
Databases Repasitary Diff L
= W talend ClientDE &

= E client client *‘3{}&

B CLIENT_ACCOUNT CLIENT_ACCOUNT
B CLIENT_BIRTHDAY CLIENT_BIRTHDAY
B ID_cCLIEMT ID_CLIENT

A

= EH client_contract client-conkrack ®
B COMTRACT_TYPE COMTRACT _TYPE
B COMTRACT _WALUE CONTRACT _WALUE
B ID_CLIENT ID_CLIENT
B ID_COMTRACT ID_COMNTRACT

= [ axelkablel axeltablel
B ID_MONTH ID_MOMTH
B ID_TYPE ID_TYFE
B MONTH MONTH

I IJSER
7 sales v

The Diff icons point out that the table contains differences or gaps. Expand the table node to show the exact column
containing the differences.

The red highlight shows that the content of the column contains differences or that the column is missing from
the actual database table.

The blue highlight shows that the column is missing from the table stored in Repository > M etadata.

4.5.2.2. How to build a query

The [SQL Builder] editor is a multiple-tab editor that allows you to write or graphically design as many queries
as you want.

To create anew query, complete the following:
1. Right-click the table or on the table column and select Gener ate Select Statement on the pop-up list.

2. Click the empty tab showing by default and type in your SQL query or press Ctrl+Space to access the
autocompletion list. Thetooltip bubble showsthe whol e path to thetable or table section you want to searchin.
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talend(Talend-DEMS), sql

X &6 &4 E
zelect cars.Reg Car,owners. Nane Customer . owners. ID Ins
from cars.owners.resellers

"talend","resellers"."ID_Reseller" H ID_Cwner i

B Mame_Customer
E resellers
Address_Reseller
ity

Name_%eseller

f ZipCode

ﬂ absolute

& add

7 v

01 O 008 Oom

£ »
SGL - Limit Rows | 100
Edit | Designer

Alternatively, the graphical query Designer allows you to handle tables easily and have real-time generation
of the corresponding query in the Edit tab.

Click the Designer tab to switch from the manual Edit mode to the graphical mode.

Y ou may get a message while switching from one view to the other as some SQL statements cannot
2 be interpreted graphically.

If you selected atable, all columns are selected by default. Clear the check box facing the relevant columns
to exclude them from the selection.

Add moretablesin asimple right-click. On the Designer view, right-click and select Add tablesin the pop-
up list then select the relevant table to be added.

If joins between these tables already exist, these joins are automatically set up graphically in the editor.

You can also create a join between tables very easily. Right-click the first table columns to be linked and
select Equal on the pop-up ligt, to join it with the relevant field of the second table.
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kalendiTalend-DEMS),sql [ talend(Talend-DEMS) . =gl &2
F (= E G 4 Ei |Talend-DBMS W

owners | cars [ resellers

* * x
w'i 10 _Owmer [w 10_0Owners v 10_Reseller
[W Mame_Customer [ Reg_car ¥ Hame_Reseller
|7 10_In=urance |7 Make P fddress_Reseller
[w Color W Ziptode
[w I0_Reseller W City

seleck owners, ID_Cwner, owners, Name_Cuskomer, owners, ID_Insurance,cars,ID_Owners.
From owners,cars, reselers
where owners, ID_Owner=cars,ID_COwners and cars, ID_Reseller=reselers. ID_Reseller

< >
Edit | Designer

The SQL statement corresponding to your graphical handlings is also displayed on the viewer part of the
editor or click the Edit tab to switch back to the manual Edit mode.

In the Designer view, you cannot include graphically filter criteria. You need to add these in the
¥ Edit view.

Once your query is complete, executeit by clicking the * jcon on the toolbar.

The toolbar of the query editor allows you to access quickly usual commands such as; execute, open, save
and clear.

The results of the active query are displayed on the Results view in the lower |eft corner.

4.5.2.3. How to store a query in the repository

To be ableto retrieve and reuse queries, we recommend you to store them in the repository.

In the [SQL Builder] editor, click the icon on the toolbar to bind the query with the DB connection and schema
in case these are also stored in the repository.

The query can then be accessed from the Database structur e view, on the left-hand side of the editor.

4.5.3. How to download/upload Talend Community
components
Talend Open Studio for Data Integration enables you to access a list of all community components in Talend

Exchange that are compatible with your current version of Talend Open Studio for Data Integration. Y ou can
then download and install these componentsto use them later in the Job designs you carry out in the Studio. From
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Talend Open Sudio for Data I ntegration, you can also upload components you have created to Talend Exchange
to share with other community users.

A click on the Exchange link on the toolbar of Talend Open Sudio for Data I ntegration opens the Exchange tab
view on the design workspace, where you can find lists of:

» components available in Talend Exchange for you to download and install,

» components you downloaded and installed in previous versions of Talend Open Studio for Data Integration but
not installed yet in your current Studio, and

» components you have created and uploaded to Talend Exchange to share with other Talend Community users.

» Before you can download community components or upload your own components to the community,

¥ you need to sign in to Talend Exchange from your Studio first. If you did not sign in to Talend

Exchange when launching the Studio, you still have a chance to sign in from the Talend Exchange
preferences settings page. For more information, see Section 2.5.3, “Exchange preferences’.

e The community components available for download are not validated by Talend. This explains why
you may encounter component loading errors sometimes when trying to install certain community
components, why an installed community component may have a different name in the Palette than
in the Exchange tab view, and why you may not be able to find a component in the Palette after it
is seemingly installed successfully.

4.5.3.1. How to install community components from Talend
Exchange

Toinstall community components from Talend Exchange to the Palette of your current Talend Open Sudio for
Data Integration:

1. Click the Exchange link on the toolbar of Talend Open Studio for Data Integration to open the Exchange
tab view on the design workspace.

Qéh
Downloaded Extensions
My Extensions Extension Name Version Rating Author View
Facebook Application Insights o
0.1 saburo view /download
Component
tFileOutputDelimitedEx 1.0 Alezis view/download
tScriptRules 1.0 walkerca | view/download
tWorldBank components Demao 0.2 saburo view/download
pUpdateMailOffer Vo2 PayZen view/download
pCreateMailOffer Vo2 PayZen wiew/download
tDBFOutput 1.1 S - BiSi view/download
tDBFInput 1.1 BiSi view/download
pCreatePayment V05 B PayZen view/download

2. Inthe Available Extensions view, if needed, enter afull component name or part of it in the text field and
click the fresh button to find quickly the component you are interested in.

3. Click the view/download link for the component of interest to display the component download page.
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tPDFToText

Version 1.1
2011-05-17

Convert a PDF to text file. It's possible to extract a

delimited area.

User Reviews

-L" -l." -L"' - - oy
bien it's good
e e e o .
It works on 4.2.2 You can use it, it works o
n4.2.21

tPOFToText This does not seem compatible
with TOS 4.2.2r63143. I have installed it on TOS and it does n

ot generate an output file.

4. View the information about the component, including component description and review comments from
community users, or write your own review comments and/or rate the component if you want. For more
information on reviewing and rating a community component, see Section 4.5.3.3, “How to review and rate

acommunity component”.

write a review

If needed, click the left arrow button to return to the component list page.

5. Clickthelnstall buttonintheright part of the component download pageto start the download and install ation

process.

A progress indicator appears to show the completion percentage of the download and installation process.
Upon successful installation of the component, the Downloaded Extensions view opens and displays the

status of the component, which is I nstalled.
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Available Extensions Extension Name Downloaded Version Download Date Install/Update

My Extensions tDBFInput 1.1 2011-11-17 Install
tOBFOutput 1.1 2011-10-31 Install
bcLogbackConfig 1.2 2011-10-31 Install
bcLogbackCatch 1.3 2011-10-31 Install
tLog4] 1.4 2011-11-17 Install
tFileQutputDelimitedEx 1.0 2011-11-17 Install
null null 2011-11-17 Install
tScriptRules 1.0 2011-11-17 Install
BRules 1.1 2011-11-17 Install
tPDFToTaxt 1.1 2011-11-18 Installed

4.5.3.2. How to reinstall or update community components

Fromthe Exchangetab view, you can reinstall componentsyou already downloaded and installed in your previous
version of Talend Open Sudio for Data Integration or install the updated version of Talend Open Sudio for Data
Integration or componentsin your current Studio.

By default, while you are connected to Talend Exchange, adialog box appearsto notify you whenever an

’ update to an installed community component is available. If you often check for community component

updates and you do not want that dialog box to appear again, you can turn it off in Talend Exchange
preferences settings. For more information, see Section 2.5.3, “Exchange preferences’.

To reinstall acommunity component you already downloaded or update an installed one, complete the following:

1. From the Exchange tab view, click Downloaded Extensions to display the list of components you have
already downloaded from Talend Exchange.

In the Downloaded Extensions view, the components you have installed in your previous version of Talend
Open Sudio for Data Integration but not in your current Studio have an Install link in the Install/Update
column, and those with updates available in Talend Exchange have an Update link.

2. Click theInstall or Update link for the component of interest to start the installation process.

A progress indicator appears to show the completion percentage of the installation process. Upon successful
installation, the Downloaded Extensions view displays the status of the component, which is Installed.

4.5.3.3. How to review and rate a community component

To review and rate a community component:

1. Fromthe Available Extensions view, click the view/download link for the component you want to review
or rate to open the community component download page.

2. Onthe component download page, click thewriteareview link to open the[Review the component] dialog
box.
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Review the component
@ Flease give a review for the component,
Title: ™
|Llseﬁ_|l.
%) (%% %] ]
Good: 4 stars out of 5
Review:®
Good thing to have,
o
@J Submit RE'-,'iE'A'] [ Cancel

Fill in the required information, including atitle and areview comment, click one of thefive starsto rate the
component, and click Submit Review to submit you review to the Talend Exchange server.

Upon validation by the Talend Exchange moderator, your review is published on Talend Exchange and
displayed in the User Review area of the component download page.

4.5.3.4. How to upload a component you created to Talend
Exchange

Y ou can create your own components for usein your Jobsin Talend Open Sudio for Data Integration and upload
them to Talend Exchange to share with other Talend Community users. For information on how to create your
own components and deploy them in Talend Open Sudio for Data Integration, see Section 2.5.2, “External or
User components’.

To upload a component you created to Talend Exchange, compl ete the following:

1. Fromthe Exchangetab view, click My Extensions to open the My Extensions view.
Available Extensions Add New Extension
Downloaded Extensions
Extension Name Version Upload Date Operation
2. Click the Add New Extension link in the upper right part of the view to open the component upload page.
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=
Extension Title:  tExEvaluate Initial 1.0
Version:
Compatibility: | All versions
" | version and older:
* | versions and newer:|5.0
" | all versions except:
" | only these versions:
Description: tExEvaluate evaluates the execution of a Jok.
File: \Work\ComponentstExEvaluate zip | & Upload Extension

3. Complete the required information, including the component title, initial version, Studio compatibility
information, and component description, fill in or browse to the path to the source package in the File field,
and click the Upload Extension button.

Upon successful upload, the component islisted in the My Extensions view, where you can update, modify
and delete any component you have uploaded to Talend Exchange.

Available Extensions Add New Extension
Downloaded Extensions

Extension Name Version Upload Date Operation

tExEvaluate 1.0 2011-11-18 ¥ 7 R

4.5.3.5. How to manage components you uploaded to Talend
Exchange

From the Exchange tab view, you can manage components you have uploaded to Talend Exchange,
including updating component version, modifying component information, and deleting componentsfrom Talend
Exchange.

To update the version of a component, compl ete the following:

L From the My Extensions view, click the T iconinthe Operation column for the component your want to

update to open the component update page.
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<5

Initial a0
Version:
Compatibility: All versions
Version and older:

>

~

" | Versions and newer:
" | All versions except:
~

Only these versions:

File: Upload Extension

2. Fill in the initial version and Studio compatibility information, fill in or browse to the path to the source
package in the File field, and click the Update Extension button.

Upon successful upload of the updated component, the component isreplaced with thenew versionon Talend
Exchange and the My Extension view displays the component's new version and update date.

To modify the information of a component uploaded to Talend Exchange, complete the following:

L From the My Extensionsview, click the # iconinthe Operation column for the component your want to

modify information for to open the component information editing page.
(4=
Extension Title:  {ExBvaluate

Compatibility: Al versions

Version and older:

~
~
| versions and newer:|5.1
" | All versions except:

~

Only these versions:

Description: tExEvaluate evaluates the excecution of a Job.
It requires tExCather to work with it.

Modify Extension

2. Complete the Studio compatibility information and component description, and click the M odify Extension
button to update the component information to Talend Exchange.
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To delete a component you have uploaded to Talend Exchange, click ¥ icon for the component from the My
Extensions view. The component is then removed from Talend Exchange and is no longer displayed on the

component list in the My Extensions view.

4.5.4. How to install external modules

The use of some componentsin Talend Open Studio for Data | ntegration requires specific modulesto beinstalled.

The Modules view lists al modules necessary to use the components embedded in the Studio. Few of these
modules do not exist by default and thus you must install them in order to be able to run smoothly the Jobs that
use such components.

If the Modules tab does not show on the tab area of your design workspace, go to Window > Show
¥ View... > Talend and then select M odules from the list.

To access the Modules view, click the M odules tab in the design workspace.

o Comp | OB Run Tg JobH | = Modul &3

Status
| Installed
| Installed
| Installed
| Installed
| Installed
| Installed
@ Mot installed
@ Mot installed
@ Mot installed
@ Mot installed
@ Mat installed
@ Mot installed
@ Mot installed
@ Mot installed
@ Mot installed
1% Mot installed
1% Mot installed

Conte | T Mavig | g Jobic @l Errar EQ-EJ' Sche | & Talen | [21 Probl =0
b J,
Context Module Description Required "
tWwebService geronimo-ws-metadata_2....  Required For using this component, |+
tWwebService geronimo-jaxws_z.1_spec,.. Required For using this component, [
twebService wskx-asl-3,2,8.jar Required For using this component,
tWebService saaj-api-1.3.jar Required For using this component, |+
tWebService saaj-impl-1.3.2.jar Required For using this component, [+
tWwebService jcifs-1.3.11.jar Required For using this component,
JEass ESE Export jbossesb-rosetta.jar Library needed to export to JBaos.., v
Db connection wizard £as,Core, jar Required ko define 545 connection
Db connection wizard =85, svC.conneckion. jar Required ko define SA5 connection |+
Db connection wizard sas,intrnet, javatools, jar Required to define 343 connection |+
tHL7Input hapi-structures-w51-0.6.jar  Required For using this component, |+
tlasperOutput poi-3.2-FINAL-Z0081019.jar  Required Far using this component, [
tJasperoutputExec jasperreports-3,1.4.jar Required For using this component,
tJasperOutputExec poi-3.2-FINAL-20051019.jar  Required For using this component, |+
LLDAPALLributesInput courtinessl, jar Required For using this component, [+
tMomInput log4-1.2.13.jar Required For using this companent.
tMormOutput log4i-1.2.13.jar Required For using this component, b

The table below describes the information presented in the M odules view.

Column

Description

Status

points out if amoduleisinstalled or not installed on your system.

The

corresponding component listed in the Context column. The @ icon indicates that
the module is absolutely required for the corresponding component.

icon indicates that the module is not necessarily required for the

Context

lists the name of Talend component using the module. If this column is empty,
the module is then required for the general use of Talend Open Sudio for Data
Integration.

Thiscolumn lists any external libraries added to the routines you create and
¥ save in the Studio library folder. For more information, see Section 8.4.3,
“How to edit user routine libraries’.

Module

lists the modul e exact name.
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Column Description
Description explains why the module/library is required.
Required the selected check box indicates that the module is required.

To install any missing module, complete the following:

Inthe Modules view, click the . iconin the upper right corner of the view.
The [Open] dialog box of your operating system appears.
2. Browseto the module you want to install, select it and then click Open on the dialog box.
The dialog box closes and the selected module isinstalled in the library folder of the current Studio.

Y ou can now use the component dependent on this module in any of your Job designs.

4.5.5. How to launch a Job periodically

The Scheduler view in Talend Open Sudio for Data Integration helps you to schedule a task that will launch
periodically a Job viaatask scheduling (crontab) program.

Through the Scheduler view, you can generate a crontab file that hol ds cron-compatible entries (the datarequired
to launch the Job). These entries will allow you to launch periodically a Job viathe crontab program.

This Job launching feature is based on the crontab command, found in Unix and Unix-like operating systems. It
can be also installed on any Windows system.

To access the Scheduler view, click the Scheduler tab in the design workspace.

If the Scheduler tab does not display on the tab system of your design workspace, go to Window > Show
¥ View... > Talend, and then select Scheduler from the list.

E'_L"-' Scheduler i3 +2 Component | B Run {Job curr Contexts{Job | w5l Mavigator | (g Joblcurrent =08

H %+ i X
Minute Hour Day Mankth Weekday Command
0 1z 7 1 0 Z: [Program Files Java)iresbingiawva. exe -xXms256M -Xm:xl024
30 10 * fi 1 C: [Program Files) Java)ired biniawva. exe -xXms256M -Xmxl 024
n g 22 12 5 i /Program Files/Javafjres/binfjiava. exe -¥ms256M -xmx1024

This view is empty if you have not scheduled any task to run a Job. Otherwise, it lists the parameters of all the
scheduled tasks.

The procedure below explains how to schedule atask in the Scheduler view to run a specific Job periodically and

then generate the crontab file that will hold al the data required to launch the selected Job. It aso points out how
to use the generated file with the crontab command in Unix or atask scheduling program in Windows.

Click the ' icon in the upper right corner of the Scheduler view.

The [Open Scheduler] dialog box displays.
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X

% Open Scheduler - Add a task

Talend Jabs | Command
Project w401 A Job fdata_lineage E Context Default w
Dray of monkh Monkh
[E E] ’ January ] ’ February ] ’ farch ] [ April ] [ May ]
[ June ] ’ July ] ’ August ] [ September ] [ Cctober ]
[ Movember ][ December ]
(o ]
Dray of week Hoursfminutes
’ Monday ] ’ Tuesday ] ’ Wednesday ]
[ Thursday ][ Friday ][ Saturday ] Hours . @ E] E] E]
W BEEEEDEEDEE
(e
we DHNEEEEEREDE
Minute Hour rMonth Day wWeekday Carmmand
(%) Generated crontab entry | 0 1z 1 1 5 C: fProgram Files/lavafiret
O Custom crontab entry
I."-\dd this entrv] ’ Cancel ]

From the Project list, select the project that holds the Job you want to launch periodically.

Click the three-dot button next to the Job field and select the Job you want to launch periodically.
From the Context list, if more than one exists, select the desired context in which to run the Job.
Set the time and date details necessary to schedule the task.

The command that will be used to launch the selected Job is generated automatically and attached to the
defined task.

Click Add thisentry to validate your task and close the dialog box.

The parameters of the scheduled task are listed in the Scheduler view.

Click the (5] icon in the upper right corner of the Scheduler view to generate a crontab file that will hold
all the data required to start the selected Job.

The [Save as] dialog box displays.

Browse to set the path to the crontab file you are generating, enter a name for the crontab file in the File
name field, and then click Save to close the dialog box.

The crontab file corresponding to the selected task is generated and stored locally in the defined path.

In Unix, paste the content of the crontab fileinto the crontab configuration of your Unix system; in Windows,
install atask scheduling program that will use the generated crontab file to launch the selected Job.

You can use the * icon to delete any of the listed tasks and the I icon to edit the parameters of any of the

listed tasks.
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4.5.6. How to use the tPrejob and tPostjob
components

The prejob and postjob parts display as components on the design workspace, and are thus availablein the Palette
of components. To use these tPrejob and tPostjob components, simply drop them to the design workspace as
you would do with any other components. An orange square shows the pre and post-job parts which are different
types of subjobs.

However note that their use slightly differsfrom typical components, in the way that these two components do not
actually process data nor flows but are meant to help you make your Job design clearer.

AstPrejob and tPostjob are not meant to take part in any data processing, they can not be part of multi
¥ thread execution. Thetasksincluded in the tPrejob and tPostjob are done once for al following subjobs,
whether the subjobs are executed in sequence or in parallel.

Connect to these tPr g ob and tPostjob components, all the components that perform organizing tasks that are not
directly related to the data processing or the main subjob to help orchestrating the processing that will follow.
S - R R

tPrejbb_i

OnCarmponent ok

r 1 rows in 0,025
25 mwsis

-y,
i % raw (i) =
tFileInputCelirnited 1 ’ " bCantextload 2

onSulfiobok
) ) [ Postjole

L 479 powes in 0,565

',_:' S IE&. Fgfﬂﬁfm) =:§ L D

My sqlConnection 1 | ' | califomiaCites " Mysql_Local DB | | tPastipb_1

OnCornponentCl

=X
tFileDelate 1
Tasks that require atPrejob component to be used include for example:
* loading context information required for the subjob execution,
 opening a database connection,

» making surethat afile exists.

Many more tasks that are collateral to your Job and might be damaging the overall readability of your Job may
aswell need a prejob component.

Tasks that require atPostjob component to be used include, for example:
* clearing afolder or deleting afile,

 any tasksto be carried out even though the preceding subjob(s) failed.
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4.5.7. How to use the Use Output Stream feature

The Use Output Stream feature allows you to process the datain byte-arrays using ajava.io.outputstream() class
which writes data using binary stream without data buffering. When processing data with a linear format, for
example, when all datais of Sring format, this feature will help you improve the overall output performance.

=E
% tFileOutputDelimited_1 E

Basic settings Property Type Bl I ¥ H

advanced setkings Ise Cukpuk Strearn

Crwnamic setkings Cukput Skream (java.io, QukputStream)globalMap, gek("ouk_file")
Rl Row Separakar " Field Separatar  |"}"
Documentation Include Header [ | Compress as zip file

Yalidation Fules

Schema Bult-ln & | Editschema []

The Use Output Stream feature can be found in the Basic settings view of a number of components such as
tFileOutputDelimited.

To usethisfeature, select Use Output Stream check box in the Basic settings view of acomponent that has this
feature. In the Output Stream field that is thus enabled, define your output stream using a command.

Prior to use the output stream feature, you have to open a stream. For a detailed example of the
¥ illustration of this prerequisite and the usage of the Use Output Stream feature, see Section B.2, “

Using the output stream feature”. For an example of Job using this feature, see the second scenario of
tFileOutputDelimited in the Talend Open Studio Components Reference Guide.

4.6. Handling Jobs: miscellaneous subjects

The sections below give detail information about various subjects related to the management of a dataintegration
Job including defining the start component, handling errors, using the tPrejob and tPostjob components and
searching for jobs that use specific components.

4.6.1. How to share a database connection

If you have various Jobs using the same database connection, you can now factorize the connection by using the
Use or Register a shared connection option.

This option box has been added to all Connection componentsin order to reduce the number of connection opening
and closing.

Assuming that you have two related Jobs (a parent Job and a child Job) that both need to connect to your remote
MySQL database, then perform the operations below:

1. Drag and drop atMySQL Connection (assuming that you work with aMySQL database)

2. Connect it to the first component of your parent Job
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"

"namesandstates”

" rowd (Lookup)

=]
ECU onsubjobick .':& data_to_process (Mainjl'-=E q oukputl (Main) .':E

HMyvsglConnection_1 "people” tMap_1 kTeradataFastLoad_i

3. On the Connection Component view, tick the box Use or Register a shared connection.

4. Give aname to the connection you want to share, in the Shared DB Connection Name field.

py Job(DEMO 0,17 Contexts{Job DEMO 0.1) | & Component £2 [JE= run (Job DEMOY | (21 Problems =0
=
E’:ﬂ Mysql_Local_DB(tMysgliConnection_1) ==
Basic settings Property Type Fepository  w || (DB (MYSOQL):Mysgl_Local_DE E]
Advanced setkings DB Yersion MysglS .
Dynaric settings Host "localhost” o Port |"3308" o
e Database "mytalenddb” ; Additional JDBC Parameters  |"noDatetimestrings o
Dacumentation " "
Username "rook" M Password | kbbb o
+

Use or reqgister a shared DB Connection  Shared DB Connection Mame  |Mame_of_my_Conneckion

You are now able to re-use the connection in your Child Job (and any other Job that requires a connection
to the same database).

5.  Simply follow the same steps again and make sure you use the same name in the Shared DB Connection
Namefield.

For more information about how to use the Connection components, see Talend Open Studio Components
Reference Guide.

4.6.2. How to define the Start component

The Start component is the trigger of a Job. There can be several Start components per Job design if there are
several flows running in parallel. But for one flow and its connected subflows, only one component can be the
Start component.

Drop a component to the design workspace, al possible start components take a distinctive bright green
background color. Notice that most of the components, can be Start components.

Only components which do not make sense to trigger a flow, will not be proposed as Start components, such as
the tMap component for example.
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~

" tFilelnputlDIF 1

rowz {Lookup)

. . . . . . . . ‘r . - - - .G
: sl .
‘_Eb @ ol (fain =E 4 output {Main) *
kFileList_1 tFileInputDelimited_2 EMap_1 EFileCutput L1

Todistinguish which component isto bethe Start component of your Job, identify the main flow and the secondary
flows of your Job.

» The main flow should be the one connecting a component to the next component using a Row type link. The
Start component isthen automatically set on the first component of the main flow (icon with green background).

» The secondary flows are also connected using a Row-type link which is then called Lookup row on the design
workspaceto distinguish it from the main flow. ThisLookup flow isused to enrich the main flow with more data.

Be aware that you can change the Start component hence the main flow by changing a main Row into a Lookup
Row, simply through aright-click the row to be changed.

Related topics:
» Section 4.2.4, “How to connect components together”

» Section 5.1, “Activating/Deactivating a Job or a sub-job”

4.6.3. How to handle error icons on components or
Jobs

When the properties of a component are not properly defined and contain one or several errors that can prevent
the Job code to compile properly, error icons will automatically show next to the component icon on the design
workspace and the Job name in the Repository tree view.

4.6.3.1. Warnings and error icons on components

When a component is not properly defined or if the link to the next component does not exist yet, ared checked
circle or awarning sign is docked at the component icon.

Mouse over the component, to display thetooltip messages or warningsalong with the label. Thiscontext-sensitive
help informs you about any missing data or component status.
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Lx]

b tsasInput_1

. - (rasndngs:
ESasInput
s - This component should have outputs linked,

. |Erroes:

- Mo schema has been defined wet,

- Module sas,core.jar required

- Module sas, 5w, conneckion, jar required

- Module sas.intrnet.javatnnlijar required

When thetooltip messages of acomponent indicate that amoduleisrequired, you must install thismodule
¥ for this component using the M odule view. Thisview is hiden by default. For further information about
how to install external modules using this view, see Section 4.5.4, “How to install external modules”.

4.6.3.2. Error icons on Jobs

When the component settings contain one or several errors that can prevent the Job code to compile properly, an
icon will automatically show next to the Job name in the Repository tree view.

a x -0

LOCAL: component = ,:DQ‘:. o ™
+- 0 v23a L
H- [ wzac
== v2da

gy durnrme LForimpackyiess 0,1
i1y ForZloop 0.1
i msgdisplay 0.1

The error icon displays as well on the tab next to the Job name when you open the Job on the design workspace.
The compilation or code generation does only take place when carrying out one of the following operations:

* opening a Job,

« clicking on the Code Viewer tab,

* executing a Job (clicking on Run Jab),

* saving the Job.

Hence, the red error icon will only show then.

When you execute the Job, awarning dialog box opensto list the source and description of any error in the current
Job.
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Find Errors in Jobs

Warning! Some errors exisk in jobs, Would yvou like ko continue?

Resource Description

= ’EE kContextload_and_file
= General

_ (&) Invalid escape sequence (valid ones are ...

Cancel H Conkinue

Click Cancel to stop your Job execution or click Continue to continue it.

For information on errors on components, see Section 4.6.3.1, “Warnings and error icons on components”.

4.6.4. How to add notes to a Job design

Inthe Palette, click the Misc family and then drop the Note element to the design workspaceto add atext comment
to a particular component or to the whole Job.

[~ Logs 2 Errars
[== Misc

noke

Y ou can change the note format. To do so, select the note you want to format and click the Basic setting tab of
the Component view.

Cpacity

Fonts and Colars

| Tirme Mew Roman | 10 | Adjust horizontal adjust vertical

ilefe Covight (&) centre itop (O batkarn (5) centre

Text text

Select the Opacity check box to display the background color. By default, this box is selected when you drop a
note on the design workspace. If you clear this box, the background becomes transparent.

Y ou can select options from the Fonts and Colors list to change the font style, size, color, and so on as well as
the background and border color of your note.

You can select the Adjust horizontal and Adjust vertical boxes to define the vertical and horizontal alignment
of the text of your note.

The content of the Text field is the text displayed on your note.
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4.6.5. How to display the code or the outline of your
Job

This panel is located below the Repository tree view. It displays detailed information about the open Job or
Business Model in the design workspace.

The Information panel is composed of two tabs, Outline and Code Viewer, which provide information regarding
the displayed diagram (either Job or Business Model).

4.6.5.1. Outline

The Outline tab offers a quick view of the business model or the open Job on the design workspace and also a
tree view of all used elements in the Job or Business Model. As the design workspace, like any other window
area can be resized upon your needs, the Outline view is convenient to check out where about on your design
workspace, you are located.

EE Oukline 3 & |8 = 8
e
lF:IcIrp-\J;LE-IF_'.
+ @
. X .
WFiledist_1 FileInputDedimibed 2 Pap_L FileOutpunL,_L
E Code Viewsr &3 = =0
A
if i
my =
print {
et
[
map 4
=R =
= » hgt g
= b b AMP [ S
ot
h
1.
‘<" Sdesc ! tiML_1
£ >

This graphical representation of the diagram highlights in a blue rectangle the diagram part showing in the design
workspace.

Click the blue-highlighted view and hold down the mouse button. Then, move the rectangle over the Job.
The view in the design workspace moves accordingly.

The Outline view can also be displaying afolder tree view of componentsin use in the current diagram. Expand
the node of a component, to show the list of variables available for this component.

To switch from the graphical outline view to the tree view, click either icon docked at the top right of the panel.
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4.6.5.2. Code viewer

The Code viewer tab provides lines of code generated for the selected component, behind the active Job design
view, aswell the run menu including Start, Body and End elements.

This view only concerns the Job design code, as no code is generated from Business Models.
J

Using a graphical colored code view, the tab shows the code of the component selected in the design workspace.

Thisis a partial view of the primary Code tab docked at the bottom of the design workspace, which shows the
code generated for the whole Job.

4.6.6. How to manage the subjob display

A subjob is graphically defined by a blue square gathering all connected components that belong to this subjob.
Each individual component can be considered as a subjob when they are not yet connected to one another.

"'—t:b HW' % out {Main] ='—s

tFileList_1 ' tFileInputDelimited_1 tMap_2 " EMysqloutput 1 [

This blue highlight helps you easily distinguish one subjob from another.

A Job can be made of one single subjob. An orange square shows the prejob and postjob parts which are
¥ different types of subjobs.

For more information about prejob and postjob, see Section 4.5.6, “How to use the tPrejob and tPostjob
components”.

4.6.6.1. How to format subjobs

Y ou can modify the subjob color and itstitle color. To do so, select your subjob and click the Component view.
Job(Job tDTOYalidator 0,170 ContextsiJob tDTOYalidator 0, | iy Component &5 |
2 Subjob
Show subiob Eitle
Title DTD Walidation

Title calar [E] Subjob colar @

Basic settings

Advanced settings

In the Basic setting view, select the Show subjob title check box if you want to add atitle to your subjob, then
fill in atitle.

To modify thetitle color and the subjob color:

1. IntheBasic settingsview, click the Title color/Subjob color button to display the [Color s] dialog box.
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2. Setyour colors as desired. By default, the title color is blue and the subjob color is transparent blue.

4.6.6.2. How to collapse the subjobs

If your Job is made of numerous subjobs, you can collapse them to improve the readability of the whole Job.
The minus (-) and plus (+) signs on the top right-hand corner of the subjob allow you to collapse and restore the
complete subjob.

=
—lp ~ :??5
ro2 (THain) "—a Xi !
tFileInputExcel 1 ' ' ' © tMysgloutput_1 1 | tFileInputExcel_1

Click theminussign (-) to collapse the subjob. When reduced, only the first component of the subjob is displayed.

Click the plus sign (+) to restore your subjob.

4.6.6.3. How to remove the subjob background color

If you do not want your subjobsto be highlighted, you can remove the background color on all or specific subjobs.

To remove the background color of all your subjobs, click the Toggle Subjobsicon on the toolbar of Talend Open
Sudio for Data Integration.

|| 100%

=y |
Toggle Subjobs |

To remove the background color of a specific subjob, right-click the subjob and select the Hide subjob option
on the pop-up menu.

N
£ Fio

. : : - | < Unda Move Mode i

tRowGenerator 1 ' ' put_1
=| Copy

¥ Delete
Select All

Settings
Bring Forward
Bring to Fronk
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4.6.7. How to define options on the Job view

Onthe Job view located on the bottom part of the design workspace, you can define Job’ s optional functions. This
view is made of two tabs: Stats & L ogstab and Extratab.

The Stats & L ogs tab allows you to automate the use of Stats & L ogs features and the Context |oading feature.
For more information, see Section 4.6.7.1, “How to automate the use of statistics & logs’.

The Extra tab lists various options you can set to automate some features such as the context parameters use,
in the Implicit Context Loading area. For more information, see Section 4.6.7.2, “How to use the features in
the Extratab”.

4.6.7.1. How to automate the use of statistics & logs

If you have a great need of log, statistics and other measurement of your data flows, you are facing the
issue of having too many log-related components loading your Job Designs. You can automate the use of
tFlowM eter Catcher, tStatCatcher, tL ogCatcher component functionalities without using the components in
your Job viathe Stats & L ogstab.

For more information regarding the L og component, see the Talend Open Sudio Components Reference Guide.

The Stats& L ogspanel islocated on the Job tab underneath the design workspace and prevents your Jobs Designs
to be overloaded by components.

This setting supersedes the log-related components with a general log configuration.
i

To set the Stats & L ogs properties:
1. Click the Job tab.

2. Select the Stats & L ogs pand to display the configuration view.

Main Reload from project settings | | Save to project settings Use Project Settings

— | Use statistics (t5tatCatcher) || Use logs (tLogCatcher) || Use volumetrics (tFlowheterCatcher)
Stats & Logs On Console

Version On Files

Header/Footer | On Databases

Property Type Repository - DB (JDBC);jdbc_amc
Db Type eneral JDK -t
JOBC URL context.jdbc_amc_Jdbclrl

Driver jar Jar Name

context.jdbc_amc_Drrver)ar

|| X

User context.jdbc_amc_Login > Password contexdt.jdbc_amc_Password :
Class name context.jdbc_amc_ClassMame _ Stats Table “stat” e
Logs Table "log" |t
Meter Table "flow”™ el

#| Catch runtime emors || Catch user errors || Catch user warnings
Catch components statistics (t5tatCatcher Statistics
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3. Set therelevant details depending on the output you prefer (console, file or database).

4. Select the relevant Catch check box according to your needs.

3 Y ou can save the settings into your Project Settings by clicking the 22+ 2 project settings ] button. This
way, you can access such settings via File > Edit project settings > Job settings > Stats & L ogsor via

the = button on the toolbar.

When you use Stats & L ogs functionsin your Job, you can apply them to all its subjobs.
iy Job b_father 0.1

Main [Beln:nad fram preferences ] [ﬁave ko preferences ] [.ﬁ.ppl':.-' ko sub jobs ]

Extra
Stats & Logs

[ ]uUse statistics (tStatCatchery [ ]Use logs (tlogCatcherd [ ]Use wolumetrics {tFlowMeterCatcher)

Version

To do so, click the Apply to subjobs button in the Stats & L ogs panel of the Job view and the selected stats &
logs functions of the main Job will be selected for all of its subjobs.

4.6.7.2. How to use the features in the Extra tab

The Extra tab offers some optional function parameters.
» Select the Multithread execution check box to allow two Job executions to start at the same time.

» Set the Implicit tContextL oad option parameters to avoid using the tContextL oad component on your Job
and automate the use of context parameters.

Choose between File and Database as source of your context parameters and set manually the file or database
access.

Set notifications (error/warning/info) for unexpected behaviors linked to context parameter setting.

» When you fill in Implicit tContextL oad manually, you can store these parameters in your project by clicking
the Save to project settings button, and thus reuse these parameters for other components in different Jobs.

» Select the Use Project Settings check box to recuperate the context parameters you have already defined in
the Project Settings view.

The Implicit tContextL oad option becomes available and all fields are filled in automatically.
For more information about context parameters, see Section 2.6.6, “ Context settings’.

» Click Reload from project settings to update the context parameters list with the latest context parameters
from the project settings.

4.6.8. How to find components in Jobs

Y ou should open one Job at |east in the Studio to display the Palette to the right of the design workspace
¥ and thus start the search.
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From the Palette, you can search for all the Jobs that use the selected component. To do so:

1.

2.

In the Palette, right-click the component you want to look for and select Find Component in Jobs.

= Databases £
W trysgiemnm
i tMysglConnection
& tMysgllnput
Add To Favarite EMysolLastInsertd
Hide Folder I
Display Folder dhigejellesllls
EMysgloukputBulk,
Layauk k
EMysgloukputBUlkE e

se Large Icons

Setkings...

Find Component in Jobs

A progress indicator displays to show the percentage of

tMysglRollback,
kM sglFow
trlysqlaCD

the search operation that has been completed then

the [Find a Job] dialog box displays listing al the Jobs that use the selected component.

¥ Find a Job

Type job name prefix or patkern(™®, ¥, or camel case);

B=1E

=00 o _1oE
£ DWH_Load_CRM 0.1
=2- k01 _Campa
== Databases
== InCut
== MySOL
’Eb thysglInput 0.1
== 50D
£ stepzMadifyData 0.1
£ tMysglsCD 0.1
’EE dragdrop_rompaonents 0,1

Cancel

From thelist of Jobs, click the desired Job and then click OK to open it on the design workspace.
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4.6.9. How to set default values in the schema of an
component

You can set default values in the schema of certain components to replace null values retrieved from the data
source.

At present, only tFilel nputDelimited, tFilel nputExcel, and tFixedFlowl nput support default valuesin
¥ the schema.

In the following example, the company and city fields of some records of the source CSV file are left blank, as
shown below. The input component reads data from the source file and compl etes the missing information using
the default values set in the schema, Talend and Paris respectively.

i d; firstNane; | ast Nane; conpany; city; phone
1; M chael ; Jackson; | BM Roma; 2323

2; Elisa; Bl ack; M crosoft; London; 4499

3; M chael ; Duj ardi n; ; ; 8872

4; Mari e; Dol vi na; ; ; 6655

5; Jean; Perfi de; ; ; 3344

6; Em | i e; Tal dor; Oracl e; Madri d; 2266

7; Anne- Laur e; Pal dufi er; Appl e; ; 4422

To set default values:

1. Double-click the input component tFilel nputDelimited to show its Basic settings view.

. -—a—n . . . . - . - ' :. . . . . . “-“
tFileInputDelimited_1 tLogRow_1
Designer | Code | Jobscript
ify Job(set_default 0.1) Contexts{Job set_default 0.1) | %# Component &3 B Run (Job set_default) | [2{ Problems = O

=0
@ thileInputDelimited_1 Bl D

Basic settings Property Type Repository s+ | | DELIM:contactInfo [3

Advanced settings "When the input source is a stream or a zip file, footer and random shouldn't be bigger than 0.”

Dynamic settings File namefStream | "D:/Talend/Inputfcontactinfo.csy” .

View Row Separator 0  Field Separator E

Documentation .

I Header 1 p Footer |0 i Limit o
Schema Repository |« || [DELIM:contactInfo - metadata * [3 Edit schema [:

7 DUl'u:ompress az 7ip file |:| Die an error

In this example, the metadata for the input component is stored in the Repository. For information about
metadata creation in the Repository, see Section 4.4.1, “How to centralize the Metadata items”.

2. Click the[...] button next to Edit schema, and select the Change to built-in property option from the pop-
up dialog box to open the schema editor.

3. Enter Talend between quotation marks in the Default field for the company column, enter Paris between
quotation marksin the Default field for the city column, and click OK to close the schema editor.
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# Schema oftFilelnputDelimited_1 X

tFileInputDelimited_1

Calumn Key | Type w| M.| Dat.. | Le... | Pr... | Default C...
id ] 1nt... 1 0
firzstame [ ] String 10 0
lasthame [ ]  String g 0
company [ ]| String g 0 Talend’
city [] string g 0 Parig’
phone ] 1nt... 4 0

HENEE)

[ OK ][ Cancel

4. Configure the output component tL ogRow to display the execution result the way you want, and then run
the Job.

Execution

SEArtIing Jof s86 Jefand e 3¢ JE 5T ST

[ztati=tic=s] connecting to socket on port 3371
[ztati=stics] connected

tLogRow_1
id|firstHame |lastFWame |company |citvy | phone
1 |Hicha=sl | JTackson | IEM |Boma | 2323
2 |Eli=a |Blaclk |[Microsoft |London | 4499
3 |Hichael |[Dujardin |Talend |Pari=s |8872
4 |HMarie |[Dolwina | Talend |Paris |B6GE
£ |Jean |Perfide |Talend |Paris |3344
6 |Emilie [Taldor |[Oracle |Madrid| 2266
7 |Anne-Laure|Paldufier |Apple |Paris |4422

[statistics] disconnected
Joah maf defaunlt amdasd s 180 5F SRS fasr b oodes=g7

In the output data flow, the missing information is completed according to the set default values.
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Chapter 5. Managing data integration Jobs

This chapter describes the management procedures you can carry out on the Jobs you design in Talend Open

Sudio for Data Integration or you can carry out on any of the items included in a project, for example routines
or metadata.

These management procedures include importing and exporting Jobs and items between different projects or
machines, scheduling Job execution, etc.

Before starting any data integration processes, you nheed to be familiar with Talend Open Sudio for Data
Integration Graphical User Interface (GUI). For more information, see Appendix A, GUI.
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5.1. Activating/Deactivating a Job or a sub-
job
You can enable or disable the whole Job, sub-job directly connected to the selected component. By default, a

component is activated.

In the Main properties of the selected component, select or clear the Activate check box.

* '# rowE (M - @_ ......... T > 0

‘tRowSenerator 1 bFileQuktputDelimited 1 tDie 1

*— <) Undn Desactivate component

=| Copy

¥ Delete
Select All

Add breakpnig

Alternatively, right-click the component and select the relevant Activate/Deactivate command according to the
current component status.

If you disable acomponent, no codewill be generated, you will not be able to add or modify links from the disabled
component to active or new components.

Related topic: Section 4.6.2, “How to define the Start component”.

5.1.1. How to disable a Start component

In the case the component you deactivated is a Start component, components of all types and links of all nature
connected directly and indirectly to it will get disabled too.

5.1.2. How to disable a non-Start component

When you clear the Activate check box of aregular (non Start) component, are deactivated only the selected
component itself along with al direct links.

If adirect link to the disabled component isaMain Row connection to a sub-job, all components of this subjob
will also get disabled.
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5.2. Importing/exporting items or Jobs

Talend Open Sudio for Data Integration enables you to import/export your Jobs or items in your Jobs from/to
various projectsor various versions of the Studio. It enablesyou aswell to export Jobs and thus depl oy and execute
those created in the Studio on any server.

5.2.1. How to import items

You can import items from previous versions of Talend Open Sudio for Data Integration or from a different
project of your current version.

Theitems you can possibly import are multiple:

* Business Models

» Jobs Designs

* Routines

» Documentation

* Metadata

Follow the steps below to import them to the repository:

1. IntheRepository treeview, right-click any entry such asJob Designsor BusinessM odels, and select Import
Items from the contextual menu to open the [Import items] dialog box.

ﬁjRepnsitary £ 5. Mavigakar r;é"“ = 0O

1114 Business Models

4 50b Desians |

Cor 13 Create job
* Lot 9 Create folder
* —r sQi Expand|Callapse

+|- & ™ —
Eg € Lyl Generate Doc As HTML

4= D

ft’ Import items

[s! Export items

Alternatively, you can directly click the & jcon on the tool bar.

2. Inthedialog box that appears, select the root directory or the archive file to import the items from.

« If theitemstoimport are still stored on alocal repository, usethe Select root directory option and browse
to the relevant project directory on your system, and then proceed to the next step.

« If you exported theitemsfrom your local repository into an archivefile (including source files and scripts),
use the Select ar chive file option, browse to the file and then click Open to go to Step 6.

3. Browse down to the relevant Project folder within the workspace directory. It should correspond to the
project name you picked up.
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Select rook directary of the projects to impark

= [ TOS-Win3z-r3034-w2.0.0 L
+ ) configuration
+ | ) features
+ | lb
+ | ) plugins
|0 kemp
=l | ) workspace
# ) JJava
# [} .JETEmitters
# |} .metadata
I Perl
= |3 1ava_PROJECTL
+ | ) businessProcess
+ | ) code "

Dossigr @ | J6WA_PROJECTI

4. If you only want to import very specific items such as some Job Designs, you can select the specific folder,
such as Process where al the Job Designs for the project are stored. If you only have Business M odels to
import, select the specific folder: BusinessPr ocess.

5. Butif your project gather various types of items (Business Models, Jobs Designs, Metadata, Routines...), we
recommend you to select the Project folder to import all itemsin one go, and click OK to continue.
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% Import items |Z|@@

™,

Impart ikems from an archive file or direckory, E - 5
(%) Select rook directory: | D:\2_Perl_TOS-All-r16077-¥2 .4, 14TEx

i) Select archive File:

Ikems List

kyvpe filker bext
= [E]l= TALEMDDEMOSPERL Select Al
[E]ih Job Designs
=[] LA Contexts Deselect Al
|:| ) commonContext 0,1
[ commonContest 0.1
=-[]#3 Routines
[]=4 demon.l

[]=3 demoo.1
[ #d Db Connections

Refresh i

Errors and Warnings

'Conkexts globalConkext 0.1' ¢ wou kry bo add a java item in a perl project

|:| overwribe existing items

)] Finish ] [ Cancel

6. Select the overwirte existing items check box if you want to overwrite existing items with those having the
same names to be imported. Thiswill refresh the Items List.

7. From the Items List whih displays all valid items that can be imported, select the items that you want to
import by selecting the corresponding check boxes.

8. Click Finish to validate the import.
The imported items are displayed in the repository in the relevant folder respective to their nature.

If there are several versions of the same items, they will all be imported into the Project you are running,
7 unless you aready haveidentical items.

5.2.2. How to export Jobs

The Export Job feature allows you to deploy and execute a Job on any server, independent of Talend Open Sudio
for Data Integration.

The export Job feature adds all of the files required to execute the Job to an archive, including the .bat and .sh
along with any context-parameter files or other related files.
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To export Jobs, compl ete the following:

1. IntheRepository treeview, right-click the Job you want to export, and select Export Job to openthe[Export
Jobs| dialog box.

Y ou can show/hide atree view of all created Jobsin Talend Open Sudio for Data I ntegration directly

fromthe [Export Jobs] dialog box by clicking the ™ and the ! buttons respectively. The Jobsyou
earlier selected in the Studio tree view display with selected check boxes. This accessibility helpsto
modify the selected items to be exported directly from the dialog box without having to closeit and
go back to the Repository tree view in Talend Open Sudio for Data Integration to do that.

Select the items to Export:

xk Ta archive file: 2
= [Eia T-'_Dh Designs Select &l
#1530
=-[H] = vila Deselect Al Job Wersian
& E‘_' Jobscripts Expand Al Select the job wersion |0.1 W
=[] = tMap
4 i Call all
‘fy data_generation 0.1 -
1 Die_on_error 0.1
“py Mapping_data_flow_ Select the export type | Autonomous Job + | []Extract the zip file
#-[] [ tRundob
+ D - Webapp Cptions
[eiay custamer 0,1
et MsgBox 0.1 Shell launcher all -
[eo tempdata 0.1 System routines LIser routines
Required talend modules
Java classes
Source files [JExport Dependencies
Context scripks Default ] apphy to children
[Override parametet's values ]
< ¥
a
2 [ Finish I [ Cancel

2. OntheTo archivefilefield, browse to the directory where you want to save your exported Job.

3. OntheJob Version area, select the version number of the Job you want to export if you have created more
than one version of the Job.

4. Select the Export Typein thelist between Autonomous Job, Axis Webservice (WAR), Axis Webservice
(Zip), JBOosSESB, PetalsESB .

5. Sedlect the Extract the zip file check box to automatically extract the archive file in the target directory.

6. IntheOptionsarea, select thefiletype(s) you want to add to the archivefile. The check boxes corresponding
to the file types necessary for the execution of the Job are selected by default. You can clear these check
boxes depending on what you want to export.

Option Description
Shell launcher Select this check box to export the .bat and/or .sh files necessary to launch the
exported Job.

» All: exportsthe .bat and .sh files.
» Unix exportsthe .shfile.

» Windows exports the .bat file.

System routines Select this check box to export system routines.
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Option

Description

User routines

Select this check box to export user routines.

Required Talend modules

Select this check box to export export Talend modules.

Java classes Select this check bo to export export the .java file holding Java classes
generated by the Job when designing it.
Sour cefiles Select this check bo to export the sources used by the Job during its execution

including the .item and .propertiesfiles, Java and Talend sources.

If you select the Sour ce files check box, you can reuse the exported

¥ Job in aTalend Open Sudio for Data Integration installed on another
machine. These source files are only used in Talend Open Sudio for
Data Integration.

Export Dependencies

Select this check box if you want to export the dependencies of your Job, i.e.
contexts, routines, connections, etc.

Context script

Select this check box to export ALL context parametersfiles and not just those
you select in the corresponding list.

To export only one context, select the context that fits your needs

¥ from the Context script list, including the .bat or .sh files holding the
appropriate context parameters. Then you can, if you wish, edit the .bat
and .sh files to manually modify the context type.

Apply to children

Select this check box if you want to apply the context selected from the list to
all child Jobs.

7. Click the Override parameters values button, if necessary.

In the window which opens you can update, add or remove context parameters and values of the Job context

you selected in thelist.

8. Click Finish to validate your changes, complete the export operation and close the dialog box.

A zipped file for the Jobsis created in the defined place.

If the Job to be exported calls a user routine that contains one or more extra Java classes in parallel with

7 the public class named the same as the user routine, the extra class or classes will not be included in the
exported file. To export such classes, you need to include them within the class with the routine name as
inner classes. For more information about user routines, see Section 8.4, “Managing user routines’. For
more information about classes and inner classes, see relevant Java manuals.

5.2.2.1. How to export Jobs as Autonomous Job

In the case of a Plain Old Java Object export, if you want to reuse the Job in Talend Open Sudio for Data
Integration installed on another machine, make sure you selected the Sour ce files check box. These source files
(.item and .properties) are only needed within Talend Open Studio for Data Integration.

Select a context in the list when offered. Then once you click the Override parameters values button below
the Context script checkbox, the opened window will list al of the parameters of the selected context. In this
window, you can configure the selected context as needs.

All contexts parameter files are exported along in addition to the one selected in the list.

After being exported, the context selection information is stored in the .bat/.sh file and the context settings

2 are stored in the context

.propertiesfile.
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5.2.2.2. How to export Jobs as Webservice

In the [Export Jobs] dialog box, you can change the type of export in order to export the Job selection as
Webservice archive.
Export bvpe

Select the export bype | Autonomous Job w | []Extract the: zip File

‘Aukonormous Job
Axis WebService (WAR)
Ais WebService (ZIP)
JEoss ESE

Opkions

Select the type of archive you want to use in your Web application.

Archivetype Description

WAR The options are read-only. Indeed, the WAR archive generated includes
all configuration files necessary for the execution or deployment from
the Web application.

ZIP All options are available. In the case the files of your Web application
config are all set, you have the possibility to only set the Context
parameters if relevant and export only the Classes into the archive.

Once the archive is produced, place the WAR or the relevant Class from the ZIP (or unzipped files) into the
relevant location, of your Web application server.

The URL to be used to deploy the Job, typically reads as follow:

http://1 ocal host: 8080/ Webappnane/ ser vi ces/ JobNane?mnmet hod=r unJob&ar gs=nul |

where the parameters stand as follow:

URL parameters Description

http://local host: 8080/ Type in the Webapp host and port.

/Webappname/ Typein the actual name of your web application.

/services/ Typein“services’ asthe standard call term for web services.
/JobName Typein the exact name of the Job you want to execute.
?method=runJob& args=null The method is RunJdob to execute the Job.

The call return from the Web application is 0 when there is no error and different from O in case of error. For a
real-life example of creating and exporting a Job as a Webservice and calling the exported Job from a browser,
see Section 5.2.2.3, “An example of exporting a Job as aWeb service’.

The tBuffer Output component was especialy designed for this type of deployment. For more information
regarding this component, see Talend Open Sudio Components Reference Guide.

5.2.2.3. An example of exporting a Job as a Web service

This scenario describes first a simple Job that creates a .txt file and writes in it the current date along with first
and last names. Second, it shows how to export this Job as a Webservice. And finally, it calls the Job exported
as a Webservice from a browser. The exported Job as a Webservice will simply return the “return code” given
by the operating system.
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Procedure5.1. Creating the Job:

1.

Drop the following components from the Palette onto the design workspace: tFixedFlowlnput and
tFileOutputDelimited.

Connect tFixedFlowl nput to tFileOutputDeimited using a Row > Main link.

TF '-." rawl (Main) =@

[tFixedFlowInput_1 tFileCutputDelimited 1

In the design workspace, select tFixedFlowl nput, and click the Component tab to define the basic settings
for tFixedFlowl nput.

Set the Schema to Built-In and click the[...] button next to Edit Schema to describe the data structure you
want to create from internal variables. In this scenario, the schemais made of three columns, now, firstname,
and lastname.

% Schema of tFixedFlowlnput_1 E|
tFixedFlowInput_1
Colurnn kKey | Twpe  Mullable  DatePa...  Le...  Pr...  D... Coo.
C%, o Dake "dd-rara-...
firstname [] string
lastname [] string

[ (8]4 ] [ Cancel

Click the [+] button to add the three parameter lines and define your variables, and then click OK to close
the dialog box and accept propagating the changes when prompted by the system.

The three defined columns display in the Values table of the Basic settings view of tFixedFlowlnput.

Yalues
Calurnn Yalue

o
firskname
lastname

In the Value cell of each of the three defined columns, press Ctrl+Space to access the
global variable list, and select TalendDate.getCurrentDate(), talendDatagenerator.getFirstName, and
talendDataGenerator.getLastName for the now, firstname, and lastname columns respectively.

Inthe Number of rowsfield, enter the number of lines to be generated.
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4 =0
" l:b tFixedFlowInput_1 = E
Basic settings Schema Built-In v | Editschema [-]
Advanced settings Mumber of rows 3
Crymamic setkings Mode
Wigi %) Use Single Table
Documentatian Walues Calumin Value
Yalidation Rules i now TalendDate . getCurrentDatel)
Firskrarne TalendDataGenerator, getFirstManmel)
lastname TalendDataGenerator, getlastiMame()

3 Use Inline Table
3 Use Inline Content{delimited File)

8. Inthedesignworkspace, select tFileOutputDelimited, click the Component tab for tFileOutputDelimited,

and browse to the output file to set its path in the File name field. Define other properties as needed.

.. =

=y tFileOutputDelimited_1 — [:
Basic settings Property Type Built-In L/

Advanced setkings File Marne " foukput fiouk, css” * [II
Dynamics settings Row Separatar " Field Separator | ;"

Wie Cappend [ Include Header

Lacumentation Schema Built-In v | Edischema [

If you press F6 to execute the Job, three rows holding the current date and first and last names will be written

to the set output file.

Procedure5.2. Exporting the Job asa Webservice:

1. Inthe Repository tree view, right-click the above created Job and select Export Job. The [Export Jobs]

dialog box appears.
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To archive file: | ©:\Program Files\Apache Software Foundation\ Tome |

Job Mersion

Select the job version |01 %

Export bype

Select the export bype | Axis WebService (WARY  w

Options

Defaulk  » [ ]apply to chidren

7 Finish ] [ Cancel

2. Click the Browse... button to select adirectory to archive your Job in.
3. IntheJob Version area, select the version of the Job you want to export as aweb service.

4. IntheExport typearea, select the export typeyou want to usein your Web application (WAR inthisexample)
and click Finish. The [Export Jobs] dialog box disappears.

5. Copy the War folder and paste it in the Tomcat webapp directory.

Procedure5.3. Calling the Job from a browser:

1. Type the following URL into your browser: http://localhost:8080//export_job/services/export job2?
method=runJob where “export_job” is the name of the webapp directory deployed in Tomcat and
“export_job2" isthe name of the Job.

e
I_E_T httpsfflocalbost: 80580/ export_jobfservicesfexpart_jobz?method=runlab

2. Click Enter to execute the Job from your browser.
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iCe fichier 3L ne semble pas avorr d'information de style lu

— <soapenv:Envelope>
— <soapenv: Body>
— <runJobReturn xsi:type="n: 1 runJobEeturn">
— <nsl:item xsi:type="nz 1 ArrayOf zsd string">
<nsl:item xsi:type="z:sd:string">0</nsl:item>
</nsl:item>
<frunJobReturn>
</soapenv:Body>
</soapenv:Envelope>

The return code from the Web application is 0 when thereis no error and 1 if an error occurs.

For areal-life example of creating and exporting aJob asaWebservices using thetBuffer Output component,
see the tBuffer Output component in Talend Open Studio Components Reference Guide.

5.2.2.4. How to export Jobs as JBoss ESB

Talend Open Sudio for Data Integration provides the possibility to expose Talend Jobs as services into JBoss
ESB (Enterprise Service Bus) in order to execute these Jobs on the messaging engine (the bus).

In order to be able to export a Job to be deployed on a JBoss ESB server, make sure that the jar specific
to JBoss ESB isinstalled in the Java library and that it displays in the Modules view of Talend Open
Studio for Data Integration . For more information about the Modules view, see Section 4.5.4, “ How to
install external modules’.

In the [Export Jobs] dialog box, you can change the type of export in order to export the selected Job as an ESB
archive. Y ou can then deploy this exported Job on a JBoss ESB server.

To export a Job on ESB:

1. IntheJob Version area, select the version of the Job you want to execute on a JBoss ESB server.

2. From the Select export type list in the Export type area, select JBoss ESB.

3. Inthe Option area, select the file type you want to add to the archive. When the Context script list displays
more than one context, select the one you need, and select the Apply to children check box if you want to
apply the context selected from the list to al child Jobs.

4. To export the sources used by the Job during its execution including the files .item, .properties and Java
sources of Jobs and routines, select the Sour ce files check box.

If you select the Sour ce files check box, you can reuse the exported Job in a Talend Open Sudio
4 for Data Integration installed on another machine. These source files are only used in Talend Open
Sudio for Data Integration.

5. Select the Export Dependencies check box if you want to export dependencies with your Job, i.e. contexts,
routines, connections, etc.

6. Inthe ESB Export typelist, select between JBoss MQ or JBoss Messaging.

7. Inthe Service Namefield, type in the name of the service on which you will deploy your Job.
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8. Inthe Category field, typein the category of the service on which the Job will be deployed.
9. Inthe Message Queue Name field, type in the name of the queue that is used to deploy the Job.

10. Click the Browse... button next to the To archive file field and browse to set the path to the archive filein
which you want to export the Job. Then click Finish.

Thedialog box closes. A progressindicator displaysto show the progress percentage of the export operation.
The Job is exported in the selected archive.

When you copy the ESB archive in the deployment directory and launch the server, the Job is automatically
deployed and will be ready to be executed on the ESB server.

5.2.2.5. How to export Jobs as Petals ESB

Talend Open Sudio for Data Integration provides the possibility to expose Talend Jobs as services into petals
ESB (Enterprise Service Bus) in order to execute these Jobs on the messaging engine (the bus).

Integrating Talend with petals ESB

Talend provides a smooth approach to expose services on petals ESB and thus facilitates:

 application integration on the bus: This will enable the integration of systems and applications across the
enterprise.

» service interactions: The ESB provides connectivity between services. i.e. allows services with varying
interfaces to communicate.

The Java Business Integration (JBI) is the approach used to implement a service-oriented architecture (SOA) and
export Talend Jobs on petals ESB.

Petals ESB is complemented with Binding Components (BC) and T alend Service Engine (SE) in order to provide:
first the access methods necessary for different types of servicesincluding FileTransfer, WebService, MOM, and
second the engine to deploy the service. For more information about interaction between Petals and Talend Jobs,
check http://doc.petal slink.com/display/petal sesb/A+Simple+Talend+Job.

Then, with the integration of Talend and petals ESB, you can execute the Jobs designed in Talend Open Sudio
for Data Integration on petals ESB. For more information, see Section 5.2.2.5, “How to export Jobs as Petals
ESB”. Several mechanisms are provided to pass information and data to a Job and to retrieve information and
data from a Job.

Using Talend Open Studio for Data Integration and petals ESB, you can execute a Job which has no specific
interaction with Petals. Y ou can:

* expose a context as a parameter into the service's WSDL,
* pass attachment files to a Job,
* pass hative parameters and options to a Job,

* get the Job's execution result.

How to export Jobs to petals ESB

From the [Export Jobs] dialog box, you can export a selected Job as a petals ESB archive. Y ou can then execute
the exported Job on the bus (the messaging engine).
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To export a Job as a petals ESB archive, complete the following:

1. Inthe Repository tree view, right-click the Job you want to export and then select Export Job from the
contextual menu.

The [Export Jobs] dialog box displays.

#* Export Jobs |Z|@®

L b =4

Ta archive file: | D:\Builds\ TDQ BuildsiLatest TDQIY4, 1.0RCHEdg_ 411 v|[ e ]

Job Wersion
Select the job version
Expork bype
] Select the export bype |F'etals EsE w
Options
Singleton job User Routines

[ ]5enerate the end-point [ Source Files
[ ]walidate Petals messages

Job Contexts: | N |

Edit the exposed conkexts (0}

@:l Firish ] [ Cancel

2. IntheToarchivefilefield, browse to set the path to the archive file in which you want to export the Job.
3. Fromthe Select thejob version list, select the Job version you want to export.
4. From the Select export typelist in the Export type area, select Petals ESB.

The three following options in the Options area are selected by default: Singleton job, User Routines and
Sourcefile. You can select any of the other options as needed.

The table below explains the export options:

Option Description

Singleton job Exports the Job as singleton: A singleton Job can have only one instance running
at atime on agiven Talend Service Enginein petals ESB.

Generate the end-point | Generates the end-point at deployment time. If this option is not selected, the end-
point name is the Job name with the suffix Endpoi nt .
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Option Description
Validate Petals| Validates all the messages/ requests against the WSDL.
messages
Selecting this option reduces system performance (disk access).

8
User routines Embeds the user routines in the service-unit.
Sourcefiles Embeds the source filesin the generated service-unit.
Jobs contexts A list from which to select the context that will be used by default by the Job.

In the [Export Jobs] dialog box, click the Edit the exposed contexts link to open the [Context Export]

dialog box.

:

Contexts Export

Define the way contexts will be exported in the generated WSDL,

Marne w30 Tyvpe Export Mode
outputLocation xs:string Mobexported |
Hiluls cpoar _E:lj
Parameter
In-Aktachment
Cut-Atkachment
Parameter and Quk-akkachment
3
@

B

This dialog box will display alist of all the context variables that are used in the exported Job. Here you can
specify how each context variable should be exported in the generated WSDL file.

Click inthe Export Modefield and select from the list the context export mode for each of the listed context

variables.

The table below explains the export mode options:

Export Mode

Description

Not exported The context is not exported (not visible as a parameter). But the context can still
be overridden using the native parameters (options) of the Job.

Parameter The context is exported as a parameter in the WSDL.

In-Attachment The context will pass the path of atemporary file which content is attached in the

input message.

Out-Attachment

The context will be read after the Job execution.

-This context must point to afile,

-Thefile content will be read by the service engine and attached to the response,
-The context name will be used as the attachment name,

-Thefilewill be deleted by the service engine right after its content was |oaded.

Parameter and Out-
Attachment

A mix between the Parameter and the Out-Attachment modes.
-The context is exposed as a parameter,

-1t will also be read after the Job execution,

-Thefilewill be deleted anyway,
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Export Mode Description

The advantage of this export mode is to define the output file destination
dynamically.

7. Click OK to validate your choice and close the [Context Export] dialog box.
8. Inthe[Export Jobs] dialog box, click Finish.

Thedialog box closes. A progressindicator displaysto show the progress percentage of the export operation.
The Job is exported in the selected archive.

The Talend Job is now exposed as a service into petals ESB and can be executed inside the bus.

5.2.2.6. How to export Jobs as OSGI Bundle For ESB

Inthe [Export Jobs] dialog box, you can change the type of export in order to export the Job selection asan OSGI
Bundle in order to deploy your Job in Talend ESB Container.

% Export Jobs |:|@@

=
&
To archive File: |D:'I,TESE_SE-AII-rEuSDSB-'M.2.2NB'|,j-:uI:u_EI.1.jar v| [ [E— ]
Job Version
-: Select the job wersion
Expork bvpe
Select the export bype I:Z:I'E-GI Bundle For ESE
Opkions
L) —
C_,J [ Finish l [ Cancel

1. IntheJob Version area, select the version number of the Job you want to export if you have created more
than one version of the Job.

2. Inthe Export Type area, select OSGI Bundle For ESB to export your Job as OSGI Bundle.
The extension of your export automatically changeto .jar asitiswhat Talend ESB Container is expecting.

3. Click the Browse... button to specify the folder in which exporting your Job.
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4.

Click Finish to export it.

5.2.3. How to export items

Y ou can export multipleitemsfrom therepository onto adirectory or an archivefile. Henceyou have the possibility
to export metadata information such as DB connection or Documentation along with your Job or your Business
Model, for example.

To do so:

1

2.

3.

In the Repository tree view, select the items you want to export.

To select several items at atime, pressthe Ctrl key and select the relevant items.
Reposikary &4 5 Mavigator = 8
LOCAL: component = wﬂu |E| =

Lf Business Models ~
= 'EE Job Designs
== i _Compo
= Custom_Code
[0 Database
o Dratauality
-0 ELT
L File
[ Internet
(] Log_Errar
== Misc
= tContextload 0.1

S 1.
& Lock
¥ Delete

=| Copy

*& Generate Doc As HTML
iy Export Job

P Export items

i1 beforeRunlob 0.1
gy Prior_test 0.1
in readme 0.1

{,_- -;\5 If you want to export a database table metadata entry, make sure you select the whole DB connection,
and not only the relevant table as this will prevent the export process to complete correctly.

Right-click while maintaining the Ctrl key down and select Export items on the pop-up menu:
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% Export items |Z|@@
Val

Export items ko an archive file or directory, E 5
(%) Select root directory: Cuivark, Files\Exports

() Select archive File:

Export Dependencies

Select the items to expork;

kvpe filker bexk

[m] [ Contexts A Select Al
=-[m] £ Code
2-[E]% Routines Deselect Al
] ] system
[«] &3 DemaoRaoutines 0.1
[#]&=8 GetRandamPhaneMum 0.1 Collapse All
m-TLT snl Temnlates

Excpand All

@:’ | Finish |

Cancel

Y ou can select additional items on the tree for exportation if required.

4. Click Browseto browse to where you want to store the exported items. Alternatively, define the archivefile
where to compress the files for al selected items.

If you have several versions of the same item, they will al be exported.
Select the Export Dependencies check box if you want to set and export routine dependencies along

s with Jobs you are exporting. By default, all of the user routines are selected. For further information
about routines, see Section 8.1, “What are routines’.

5. Click Finish to close the dialog box and export the items.

5.2.4. How to change context parameters in Jobs

Asexplained in Section 5.2.2, “How to export Jobs’, you can edit the context parameters.

If you want to change the context selection, simply edit the .bat/.sh file and change the following setting: - -
cont ext =Pr od to the relevant context.

If you want to change individual parameters in the context selection, edit the .bat/.sh file and add the following
setting according to your need:

Operation Setting

To change valuel for parameter keyl --cont ext _param keyl=val uel
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Operation Setting
To change valuel and value2 for|--context_param  keyl=val uel --context_param
respective parameters keyl and key2 key2=val ue2

To change a value containing space|- - cont ext param keyl="path to file”
characters such asin afile path

5.3. Managing repository items

Talend Open Sudio for Data Integration enables you to edit the items centralized in the repository and to update
the Jobs that use these items accordingly.

5.3.1. How to handle updates in repository items

Y ou can update the metadata, context parametersthat are centralized in the Repository tree view any timein order
to update the database connection or the context group details, for example.

When you modify any of the parameters of an entry inthe Repository treeview, al Jobs using thisrepository entry
will be impacted by the modification. This is why the system will prompt you to propagate these modifications
to al the Jobs that use the repository entry.

The following sections explain how to modify the parameters of a repository entry and how to propagate the
modificationsto all or some of the Jobs that use the entry in question.

5.3.1.1. How to modify a repository item

To update the parameters of a repository item, complete the following:

1. Expand the Metadata, or Contexts node in the Repository tree view and browse to the relevant entry that
you need to update.

2. Right-click this entry and select the corresponding edit option in the contextual menu.
A respective wizard displays where you can edit each of the definition steps for the entry parameters.

When updating the entry parameters, you need to propagate the changes throughout numerous Jobs or all
your Jobs that use this entry.

A prompt message pops up automatically at the end of your update/modification process when you click the
Finish button in the wizard.

# Modification X

Do wou wank to propagate the modifications ko all jobs? It can take some
M:fj kirne

Yes l [ Mo

3. Click Yesto close the message and implement the changes throughout all Jobs impacted by these changes.
For moreinformation about thefirst way of propagating all your changes, see Section 5.3.1.2, “How to update
impacted Jobs automatically”.
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Click No if you want to close the message without propagating the changes. Thiswill allow you to propagate
your changes on the impacted Jobs manually on one by one basis. For more information on another way of
propagating changes, see Section 5.3.1.3, “How to update impacted Jobs manually”.

5.3.1.2. How to update impacted Jobs automatically

After you update the parameters of any item already centralized in the Repository tree view and used in different
Jobs, amessage will prompt you to propagate the modifications you did to all Jobs that use these parameters.

To update impacted Jobs, complete the following:

1

The properties used in the following items have been modified,
Choose and update what wou have checked.

(*1 1 This job is not opened.

Items Cperations
= 1y Job tExkractxMLField_prelim 0.1 (%)
= [w]=3 tMysqlOutput_1 -
11 Property IUpdate fram repositary
= [ip Job tExtractMLField 0.1 (*)
= []B "customerdetails" (EMysqlinput_1)
] Fﬁi Properky Ipdake Fram repositary

In the [Modification] dialog box, click Yesto let the system scan your Repository tree view for the Jobs
that get impacted by the changes you just made. This aims to automatically propagate the update throughout
al your Jobs (open or not) in one click.

The [Update Detection] dialog box displaysto list all Jobs impacted by the parameters that are modified.

Update Detection

Remarks
DE (MYSQL Localhost

DE (MySQLLacalhost

Expand All ] [ Collapse all ] [Deselect all ]

Ok ] [ Cancel ]

You can open the [Update Detection] dialog box any time if you right-click the item centralized
inthe Repository tree view and select M anage Dependencies from the contextual menu. For more
information, see Section 5.3.1.3, “How to update impacted Jobs manually”.

Click OK to close the dialog box and update all selected Jobs.

5.3.1.3. How to update impacted Jobs manually

If needed, clear the check boxes that correspond to the Jobs you do not wish to update. Y ou can update them
any time later through the Detect Dependencies menu. For more information, see Section 5.3.1.3, “How to
update impacted Jobs manually”.

Before propagating changes in the parameters of an item centralized in the tree view throughout the Jobs using
this entry, you might want to view all Jobs that are impacted by the changes. To do that, complete the following:
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1. Inthe Repository tree view, expand the node holding the entry you want to check what Jobs use it.
2. Right-click the entry and select Detect Dependencies.

A progress bar indicates the process of checking for all Jobs that use the modified metadata or context
parameter. Then adialog box displaysto list al Jobs that use the modified item.

Update Detection

The properties used in the Following items have been modified.
Choose and update what wou have checked,

(*1 1 This job is not opened.

Items Ciperations Remarks
= 1 Job tExkractxMLField_prelim 0.1 (%) - -
= [w]<3 tMysqloukput_1 - -
N‘I Properky Ipdate From repository DB (MYSOL): Localhost
= py Job EExtractxMLField 0.1 (*) - -
= E "customerdetails" (tMysgllnput_1) - -

ﬁl Property Idpdate From repository DE (MYSQLLocalhost
Expand All l [ Collapse all ] [ Deselect Al ]
[ CK, ] [ Zancel ]

3. Select the check boxes corresponding to the Jobs you want to update with the modified metadata or context
parameter and clear those corresponding to the Jobs you do not want to update.

4. Click OK to validate and close the dialog box.

The Jobs that you choose not to update will be switched back to Built-in, as the link to the Repository
¥ cannot be maintained. It will thus keep their setting as it was before the change.

5.4. Searching a Job in the repository

If you want to open a specific Job in the Repository tree view of the current Talend Open Sudio for Data

Integration and you can not find it for one reason or another, you can simply click P » on the quick accesstoolbar.

Tofind aJob in the Repository tree view, complete the following:

On Talend Open Sudio for Data Integration toolbar, click . . to open the [Find a Job] dialog box that lists
automatically al the Jobs you created in the current Studio.
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# Find a Job

Type job name prefix or pattern (%, ¥

D JobswithProblem

00y 311

00 v 311 _MPx

00y 3zt

4 bigFile 0.1

]jaj Call_Mvebservice_In_Job_ 0.1
]jE‘E Copy_of _MPX_Aggreqgate 0.1
UE‘E current 0,1

UEE data_lineage 0.1

UE‘E expark_job 0.1

UE‘E expart_jobZ 0.1

leE expart_job3 0.1

ﬂaj expart_job4 0.1

]jaﬁ expart_jobS 0.1
]jaj Impactanalysis_Datalineage 0.1

i best_Jobont
58 tRunJob_child 0.1

[Link Repository ] [

Cancel

ok ||

2. Enter the Job name or part of the Job name in the upper field.

When you start typing your text in the field, the Job list is updated automatically to display only the Job(s)

which name(s) match(es) the letters you typed in.

# Find a Job

Type job name prefix or pattern {*, ¥

Ll

= v_311_Mp

ﬂ% mpx 0.1

UEE MP¥_fggregate 0.1

o MPR_Sort 0.1
H-0y 3

[Link Repository ] [

ok ||

Cancel

3. Select the desired Job from the list and click Link Repository to automatically browse to the selected Job

in the Repository tree view.

4. If needed, click Cancel to close the dialog box and then right-click the selected Job in the Repository tree

view to perform any of the available operations in the contextual menu.
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Otherwise, click OK to close the dialog box and open the selected Job on the design workspace.

5.5. Managing Job versions

When you create a Job in Talend Open Sudio for Data Integration, by default its version is 0.1 where O stands
for the mgjor version and 1 for the minor version.

Y ou can create many versions of the same Job. To do that:

1. Closeyour Jobif it is open on the design workspace, otherwise, its properties will be read-only and thus you
can not modify them.

2. Inthe Repository tree view, right-click your Job and select Edit propertiesin the drop-down list to open
the [Edit properties] dialog box.

3. Nexttothe Version field, click the M button to increment the major version and the m button to increment
the minor version.

4. Click Finish to validate the modification.

By default, when you open a Job, you open its last version.

Any previous version of the Job is read-only and thus can not be modified.
To change the version of your Job, you can also:

1. Closeyour Jobif it is open on the design workspace, otherwise, its properties will be read-only and thus you
can not modify them.

2. Inthe Repository tree view, right-click your Job and select Open another version in the drop-down list.

3. Inthediaog box, select the Create new version and open it check box and click the M button to increment
the major version and the m button to increment the minor version.

4. Click Finish to validate the modification and open this new version of your Job.
Y ou can a'so save a Job and increment its version in the same time, by clicking File > Save as....

This option does not overwrite your current Job, it saves your Job as another new Job and/or with another
¥ version.

Y ou can access alist of the different versions of a Job and perform certain operations. To do that:
1. IntheRepository tree view, select the Job you want to consult the versions of .

2. Click Job > Version in succession to display the version list of the selected Job.

3. Right-click the Job version you want to consult.

4. Do one of thefollowings:

Select To..
Edit Job open the last version of the Job.
This option is only available when you select the last version of
¥ the Job.
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Select To..

Read job consult the Job in read-only mode.
Open Jab Hierarchy consult the hierarchy of the Job.
Edit properties edit Job properties.

Note: The Job should not be open on the design workspace, otherwise it
will bein read-only mode.

This option is only available when you select the last version of
¥ the Job.

Run job/Route execute the Job.

You can also manage the version of severa Jobs and/or metadata at the same time, as well as Jobs and their
dependencies and/or child Jobs from the Project Settings. For more information, see Section 2.6.2, “Version
management”.

5.6. Documenting a Job

Talend Open Sudio for Data Integration enables you to generate documentation that gives general information
about your projects, Jobs or joblets. Y ou can automate the generation of such documentation and edit any of the
generated documents.

5.6.1. How to generate HTML documentation

Talend Open Sudio for Data Integration allows you to generate detailed documentation in HTML of the Job(s)
you select in the Repository tree view of your Studio. This auto-documentation offers the following:

» The properties of the project where the selected Jobs have been created,

» The properties and settings of the selected Jobs along with preview pictures of each of the Jobs,
» Thelist of all the components used in each of the selected Jobs and component parameters.

To generate an HTML document for a Job, complete the following:

1. In the Repository tree view, right-click a Job entry or select several Job Designs to produce multiple
documentations.

2. Select Generate Doc asHTML on the contextual menu.
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% Generate Documentation @

Archive file

Generate job information to an archive file on the local file syskem, |

1=

To archive file: | C:YJob_doc.zip W

(7 Finish ] [ Cancel

3. Browseto the location where the generated documentation archive should be stored.
4. Inthesamefield, typein aname for the archive gathering al generated documents.
5. Click Finish to validate the generation operation.

The archivefileis generated in the defined path. It contains all required files along with the Html output file. You
can open the HTML file in your favorite browser.

5.6.2. How to update the documentation on the spot

Y ou can choose to manually update your documentation on the spot.

To update a single document, right-click the relevant documentation entry and select Update documentation.

5.7. Handling Job execution

5.7.1. How to deploy a Job on SpagoBI server

From Talend Open Sudio for Data Integration interface, you can deploy your Jobs easily on a SpagoBI server in
order to execute them from your SpagoBI administrator.

5.7.1.1. How to create a SpagoBI server entry

Beforehand, you need to set up your single or multiple SpagoBI server details in Talend Open Sudio for Data
Integration.
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1. Onthemenu bar, click Window > Prefer ences to open the [ Pr efer ences] dialog box.

2.  ExpandtheTalend > Import/Export nodesin succession and select SpagoBl Server to display the relevant
view.

SpagoBi Server (=T

Enable/Disable Deploy on Spagoki
SpagoEl server
Engine name Shork description Host e

Rermove

1]

o =
4

Danin

[ Restare Defaulks ] [ Apply

[ Ok H Cancel ]

3. Select the Enable/Disable Deploy on SpagoBI check box to activate the deployment operation.

4. Click New to open the [Create new SpagoBi server] dialog box and add a new server to thelist.

# Create new SpagoBi server ﬁl

Engine name mySpago

short description | i Prod Server

Host 92,168, 10.3
Park g0s0

Login rook
Passiwword snes

Ok l [ Cancel
5. Enter your SpagoBI server details, as described below:
Field Description
Engine Name Internal engine name used in Talend Open Studio for Data Integration. This name
isnot used in the generated code.
Short description Free text to describe the server entry you are recording.
Host IP address or host name of the machine running the SpagoBI server.
Login User name required to log on to the SpagoBI server.
Password Password for SpagoBI server logon authentication.

6. Click OK to validate the details of the new server entry and close the dialog box.
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SpagoBi Server Sl v

Enable/Disable Deploy on Spagobi

SpagoEl server

Engine name Short descripkion Hosk
mySpago i Prod Server 02,168.10.3
mySpago:s i Dey server 92.165.10.4

The newly created entry is added to the table of available servers. You can add as many SpagoBI entries
asyou need.

7. Click Apply and then OK to close the [Prefer ences] dialog box.

5.7.1.2. How to edit or remove a SpagoBI server entry

Select the relevant entry in the table, click the Remove button next to the table to first delete the outdated entry.

Then if required, smply create a new entry including the updated details.

5.7.1.3. How to deploy your Jobs on a SpagoBlI server

Follow the steps below to deploy your Job(s) onto a SpagoBI server.

ﬁj Repositary &4 T Nawvigakar = 8

t‘éh

4 Business Models
=Ivip Job Designs

A ordy (o Editjab
Conktex E‘ﬂjﬁ Read ]':lb
+ Code | &7 Edit properties
t Ii-ﬁ Metadi 3¢ Delete Celete
[.'=, Docum =| iZopy CEFHC
&) Recycl
N lagl Generate Doc As HTML
[xg Export Job Scripts

[x) Deploy on SpagoEl

1. IntheRepository tree view, expand Job Designs and right-click the Job to deploy.

2. Inthedrop-down list, select Deploy on SpagoBl.

3. Asfor any Job export, select a Name for the Job archive that will be created and fill it in the To archive
filefield.

4. Select therelevant SpagoBI server on the drop-down list.
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5. TheLabel, Name and Description fields come from the Job main properties.
6. Select therelevant context in thelist.
7. Click OK once you have completed the setting operation.

The Jobs are now deployed onto the relevant SpagoBI server. Open your SpagoBI administrator to execute your
Jobs.
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Chapter 6. Mapping data flows

The most common way to handle multiple input and output flows including transformations and data re-routing
isto use the dedicated mapping components: tMap and tXM LM ap.

This chapter gives details separately about the usage principles of these two components, for further information
or scenario and use cases, see Talend Open Studio Components Refer ence Guide.

Before starting any data integration processes, you need to be familiar with Talend Open Sudio for Data
Integration Graphical User Interface (GUI). For more information, see Appendix A, GUI.
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6.1. tMap and tXMLMap interfaces

tMap and tXMLMap are advanced components which require more detailed explanation than other Talend
components. The Map Editor is an “all-in-one” tool alowing you to define all parameters needed to map,
transform and route your data flows via a convenient graphical interface.

Y ou can minimize and restore the Map Editor and all tablesin the Map Editor using the window icons.

=[] var ok g ¥ JL B Auko map!
A s

cars_data & G | Defined_data & & o
Column Expression Column

4 ID_Owner cars_data.lD_Ow,.. % D 0.,

Reqistration cars_data.Reqistr. .. Reaqist...
Make cars_data,Make Make
Calor cars_data, Color Calar

1D_Reseller cars_data.ID_Re... ID_Re...
owners_data, Name Mame

owners_data ID_... 0 In...

owners_data _0 s L8l

Property Value Rejected_data _0 e e
Lookup Model Load once

Makch Model Unique match Expression ol
Jain Model Inner Join cars_data.ID_Ow... D 0.
Store temp d...  False cars_daka.Registr. .. Redqisk. ..
achema Type Bulit-In cars_data.ID_Re.., ID_Re...
owners_data, Mame Mame
Expr. key Colurmn
“‘P‘ cars_daka.ID, .. C% 0.,
Mame . Rejected_InnerJoin _0 %
Schema editor . Expression editor
cars_data Defined_data
Column Key | T.. 7 L., P Dun| ™ Column Key | T.. o I P o L.. P, D 1
o.. [] I. 2 0 o, L. 20
Re.. L] =, 70 Fe.. L[] 5. 70
Make [ ] 5. & 0 R Make [ ] 5. & 0 .
£ > 4 >
[ Apply ] [ Ok ] [ Cancel ]

Thisfigure presentstheinterface of tMap. That of tXM L M ap differsslightly in appearance. For example,

s in addition to the Schema editor and the Expression editor tabs on the lower part of this interface,
tXMLMap has athird tab called Tree schema editor. For further information about tXMLMap, see
Section 6.3, “tXMLMap operation”.

The Map Editor is made of several panels:
» Thelnput panel isthetop left panel on the editor. It offers agraphical representation of all (main and lookup)
incoming data flows. The data are gathered in various columns of input tables. Note that the table name reflects

the main or lookup row from the Job design on the design workspace.

» TheVariable pand isthe central panel inthe M ap Editor. It allowsthe centralization of redundant information
through the mapping to variable and alows you to carry out transformations.

» The Output pand isthe top right panel on the editor. It allows mapping data and fields from Input tables and
Variables to the appropriate Output rows.
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 Both bottom panels are the Input and Output schemas description. The Schema editor tab offersaschemaview
of al columns of input and output tables in selection in their respective panel.

» Expression editor is the edition tool for all expression keys of Input/Output data, variable expressions or
filtering conditions.

The name of input/output tables in the Map Editor reflects the name of the incoming and outgoing flows (row
connections).

The following sections present separately tMap and tXMLMap.

6.2. tMap operation

tMap alows the following types of operations:
* data multiplexing and demultiplexing,

 datatransformation on any type of fields,

fields concatenation and interchange,

field filtering using constraints,

data rejecting.

Asall these operations of transformation and/or routing are carried out by tM ap, this component cannot be a start
or end component in the Job design.

OMAINEFS. ' ' ' ' ' ' '
% . n

Msdred
owners_data (Lookup)
’ ’ T " Defined iMain order:1)
=
% cars_daka (Main) =E q Rejecked_data (Main curu:ler:Zf@
Cars tMap_1 MotInsured
Fejected_Innerloifrtain order: 3]
N-:u_'Owner'_ID

tMap uses incoming connections to pre-fill input schemas with data in the Map Editor. Therefore, you cannot
create new input schemas directly in the Map Editor. Instead, you need to implement as many Row connections
incoming to tMap component as required, in order to create as many input schemas as needed.

The sameway, create as many output row connections asrequired. However, you canfill in the output with content
directly in the Map Editor through a convenient graphical editor.

Note that there can be only one M ain incoming rows. All other incoming rows are of L ookup type. Related topic:
Section 4.3.1.1, “Row connection”.
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L ookup rows are incoming connections from secondary (or reference) flows of data. These reference data might
depend directly or indirectly on the primary flow. This dependency relationship is translated with a graphical
mapping and the creation of an expression key.

The Map Editor requires the connections to be implemented in your Job in order to be able to define the input
and output flows in the Map Editor. You also need to create the actual mapping in your Job in order to display
the Map Editor in the Preview area of the Basic settings view of thetMap component.

Map Editar: D Mapping links display as:  |&uto w
Store on disk,
Temp data directory path: E]
Prewview = =] o B TR
Lurk_luta F | A Vel ats &g =
dam warers muem T e wemalorall i
. |
1" Ardem ER aha
Hhi PO PR ok
ke LR Y LN YT 1", Asdean
X _a o thiea Hb Hab
bt .
naners fata #d 3 e i
. Y L T. I-ars
I==an [ ']
e ————— bt p|a
“orm w = daks LY el aha
e T T (R ¥ I A AL
- " vt b 1, Ardem I'ag A-dran
= Ll LR ¥ IYIN S A,
[ TSP ¥ :-_ [ Lo Y ) [
L'l Aman.
ey Erjarbad fnreriin L LI e |
- - mgees T z

To openthe Map Editor in anew window, double-click thetMap iconin the design workspace or click the three-
dot button next to the Map Editor in the Basic settings view of thetMap component.

The following sections give the information necessary to use the tMap component in any of your Job designs.

6.2.1. Setting the input flow in the Map Editor

The order of the Input tablesis essential. The top table reflects the Main flow connection, and for thisreason, is
given priority for reading and processing through the tMap component.

For this priority reason, you are not allowed to move up or down the Main flow table. This ensures that no Join
can belost.
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&4 B8
Owners = | Q
Colurmn
A ID_Cwirier
Marne
ID_Insurance
Chlidren_Mr
Cwwners, Chiidren_Mr == 2 &g
Cwners, Chlidren_Mr <=6
Cars _9 T Q
Property =
Lookup Madel Load once
Match Model &l matches
Join Maodel Inmer Join
Store kemp data false
schema Tvpe Bulit-In
Expr. key Column
“"l" Owners, ID_Owner ID_Cwner
Reqistration
L W L] Make
Color
o~ I0_Reseller
Resellers _9 e o]
Property Yalue
Lookup Madel Load once
Match Model All matches
Jain Model Inner Jain
Store kemp data false
achema Tvpe Bulit-In
Expr. key Colurmn
“—P‘ Cars,ID_Reseller I0'_Reseller

Mame_Reseler
Address_Res...
Ciby

ZIP

Although you can use the up and down arrowsto interchange L ook up tables order, be awarethat the Joins between
two lookup tables may then belost.

Related topic: Section 6.2.1.2, “How to use Explicit Join”.
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6.2.1.1. How to fill in Input tables with a schema

To fill in the input tables, you need to define either the schemas of the input components connected to the tM ap
component on your design workspace, or the input schemas within the Map Editor.

For moreinformation about setting acomponent schema, see Section 4.2.6, “How to define component properties”.

For more information about setting an input schema in the Map Editor, see Section 6.2.5, “ Setting schemas in
the Map Editor”.

Main and Lookup table content

The order of the Input tablesis essential.

The Main Row connection determines the M ain flow table content. This input flow is reflected in the first table
of the Map Editor’s Input panel.

The L ookup connections content fills in all other (secondary or subordinate) tables which displays below the
Main flow table. If you have not define the schema of an input component yet, the input table displays as empty
in the Input area.

Thekey isa so retrieved from the schema defined in the Input component. ThisK ey correspondsto the key defined
in the input schemawhere relevant. It has to be distinguished from the hash key that isinternally used in the Map
Editor, which displaysin adifferent color.

Variables

Y ou can use global or context variables or reuse the variable defined in the Variables area. Press Ctrl+Space bar
to access the list of variables. Thislist gathers together global, context and mapping variables.

Thelist of variables changes according to the context and grows along new variable creation. Only valid mappable
variablesin the context show on thelist.

Expr. key Colurmn
@, cars_data.ID_Owners| .. id_owner

.

cars_data.ID_Cwners A || Metadata column 'ID_Owaners' properties
cars_data,Reqistration - Columr:ID_Owners
cars_data.Make - Key ifalse
cars_data, Colar - Type :id_Integer
owrers_data, Chlidren_Me cars_data, ID_Reseller - Length :5
owners_data, Chlidren_Mr - cars, ERROR_MESSAGE - F‘FEEISIDI‘Il :
cars.ME_LINE J Eﬁiﬁrﬁﬁn} |
DataCperation, CHAR. - Bt

a editor _Expression edi DataCperation. DT
Dataioperation. FLx
rs_data DataCperation. $TD b

Docked at the Variablelist, ametadata tip box display to provide information about the selected column.
Related topic: Section 6.2.2, “Mapping variables’

6.2.1.2. How to use Explicit Join

In fact, Joins let you select data from a table depending upon the data from another table. In the Map Editor
context, the data of aMain table and of a L ookup table can be bound together on expression keys. In this case,
the order of table does fully make sense.
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Simply drop column names from one table to a subordinate one, to create a Join relationship between the two
tables. Thisway, you can retrieve and process data from multiple inputs.

The join displays graphically as a purple link and creates automatically a key that will be used as a hash key to
speed up the match search.

Y ou can create direct joins between the main table and |ookup tables. But you can also create indirect joins from
the main table to alookup table, via another lookup table. This requires adirect join between one of the L ookup
table to the Main one.

Y ou cannot create a Join from a subordinate table towards a superior table in the | nput area.
7

The Expression key field which is filled in with the dragged and dropped data is editable in the input schema,
whereas the column name can only be changed from the Schema editor panel.

You can either insert the dragged data into a new entry or replace the existing entries or else concatenate all
selected datainto one cell.

Cars _E a Q
Property Walue
Lookup Model Load once
Match Maodel &l matches
Join Model Inmer Join
Stare kemp data fal=ze
Schema Tvpe Bulit-In
Expr. kew Zalurmn
‘, Owners, ID_Owner ID_Cwiner
Reqistration
Make
Color
— ID_Reseler
Cars, Make, equalsBMW" ||
Cars,Make, equals“Mercedes")
Resellers By 0
Property Walue
Lookup Model Load once
fakch Model all matches
Join Model Inmer Join
Store kemp data False
Schema Tvpe Bulit-In
Expr. kew Colurmn
“‘—I'* Cars,ID_Reseller I0_Reseler

Mame_Reseller
Address_Reseller
ity

ZIP

For further information about possible types of drag and drops, see Section 6.2.4, “Mapping the Output setting ”.
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If you have a big number of input tables, you can use the minimize/maximize icon to reduce or restore
¥ the table size in the Input area. The Join binding two tables remains visible even though the table is
minimized.

Creating a Join automatically assigns a hash key onto the joined field name. The key symbol displaysin violet on
the input table itself and is removed when the Join between the two tables is removed.

Related topics:
 Section 6.2.5, “ Setting schemas in the Map Editor”
» Section 6.2.1.3, “How to use Inner Join”

Along with the explicit Join you can select whether you want to filter down to a unique match or if you alow
several matches to be taken into account. In this last case, you can choose to consider only the first or the last
match or all of them.

To define the match model for an explicit Join:
1. Click thetMap settings button at the top of the table to which the Join links to display the table properties.

2. Click inthe Value field corresponding to Match Model and then click the three-dot button that appears to
open the [Options] dialog box.

3. Inthe[Options] dialog box, double-click the wanted match model, or select it and click OK to validate the
setting and close the dialog box.

Cars d - ..',
% Options

Property Yalue

Lookup Model Load once Unigue match
Makch Model IJnique makch _ First match
Jain Model Left Outer Join &ll ratches
Store kemp data false

Schema Twpe Bulit-In

Expr. ke Zalurmn

@, Owners I0_Owner .| ID_Ciwiner
Reqistration

Mlake

Calar

I0_Reseller
Cars.Make . equals("BIMW" || I Ok l [ Cancel
Cars. Make, equals"Mercedes™) D

Unique Match

This is the default selection when you implement an explicit Join. This means that only the last match from the
L ookup flow will be taken into account and passed on to the output.

The other matches will be then ignored.

First Match

This selection implies that several matches can be expected in the lookup. The First Match selection means that
in the lookup only the first encountered match will be taken into account and passed onto the main output flow.
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The other matches will then be ignored.

All Matches

This selection implies that several matches can be expected in the lookup flow. In this case, all matches are taken
into account and passed on to the main output flow.

6.2.1.3. How to use Inner Join

The Inner join isaparticular type of Join that distinguishesitself by the way the rejection is performed.

This option avoids that null values are passed on to the main output flow. It allows also to pass on the rejected
datato a specific table called Inner Join Reject table.

If the data searched cannot be retrieved through the explicit Join or the filter Join, in other words, the Inner Join
cannot be established for any reason, then the requested data will be rejected to the Output table defined as I nner
Join Reject tableif any.

Simply drop column names from one table to a subordinate one, to create a Join relationship between the two
tables. The Join is displayed graphically as a purple link and creates automatically a key that will be used as a
hash key to speed up the match search.

To define the type of an explicit Join:

1. Click thetMap settings button at the top of the table to which the Join links to display the table properties.

2. ClickintheValuefield corresponding to Join M odel and then click the three-dot button that appearsto open
the [Options] dialog box.

3. Inthe [Optiong] dialog box, double-click the wanted Join type, or select it and click OK to validate the
setting and close the dialog box.
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Owners & o | 8
Colurnn
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Marme:
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Anlnner Join table should always be coupled to an I nner Join Reject table. For how to define an output
’ table asan Inner Join Reject table, see Section 6.2.4.4, “Lookup Inner Join rejection”.

You can aso use the filter button to decrease the number of rows to be searched and improve the performance
(in Java).

Related topics:
» Section 6.2.4.4, “Lookup Inner Join rejection”

» Section 6.2.1.5, “How to filter an input flow”

6.2.1.4. How to use the All Rows option

By default, without a Join set up, in each input table of the input area of the Map Editor, the All rows match
model option is selected. This All rows option means that all the rows are loaded from the L ookup flow and
searched against the Main flow.

The output corresponds to the Cartesian product of both table (or more tables if need be).

If you create an explicit or aninner Join between two tables, the All rowsoptionisnolonger available. Y ou
¥ then haveto select Uniquematch, Fir st match or All matches. For moreinformation, see Section6.2.1.2,
“How to use Explicit Join” and Section 6.2.1.3, “How to use Inner Join”.

6.2.1.5. How to filter an input flow

Click the Filter button next to the tMap settings button to add a Filter field.
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4B 8

Owners & ..'. Q

Colurmn
A ID_Cwirier
Marne
ID_Insurance
Chlidren_Mr

Cwwners, Chiidren_Mr == 2 &g
Cwners, Chlidren_Mr <=6 D

In the Filter field, type in the condition to be applied. This allows to reduce the number of rows parsed against
the main flow, enhancing the performance on long and heterogeneous flows.

Y ou can use the Auto-completion tool via the Ctrl+Space bar keystrokes in order to reuse schema columnsin
the condition statement.

6.2.1.6. How to remove input entries from table

To remove input entries, click the red cross sign on the Schema Editor of the selected table. Press Ctrl or Shift
and click fields for multiple selection to be removed.

If you remove Input entries from the Map Editor schema, this removal also occursin your component
¥ schema definition.

6.2.2. Mapping variables

The Var table (variable table) regroups all mapping variables which are used numerous times in various places.

You can also use the Expression field of the Var table to carry out any transformation you want to, using Java
Code.

Variables help you save processing time and avoid you to retype many times the same data.

Yar g |

Expression Type Yariahle

StringHandling, UPCASE(cars_data,Make)

There are various possibilities to create variables:

» Type in freely your variables in Java. Enter the strings between quotes or concatenate functions using the
relevant operator.

» Add new lines using the plus sign and remove lines using the red cross sign. And press Ctrl+Spaceto retrieve
existing global and context variables.

» Drop one or more I nput entries to the Var table.
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L o

Dragging 2 entries,
= Insert all selected entries

L

_StringHandling. IPCASE(caks data.Make)

£

Type Wariable
string [ ] warl

B

Ly,

Gk

Select an entry on the Input area or press Shift key to select multiple entries of one Input table.

Press Ctrl to select either non-appended entries in the same input table or entries from various tables. When
selecting entriesin the second table, notice that the first selection displaysin grey. Hold the Ctr| key down to drag
all entries together. A tooltip shows you how many entries arein selection.

Then various types of drag-and-drops are possible depending on the action you want to carry out.

To.. You need to...
Insert all selected entries as separated| Simply drag & drop to the Var table. Arrows show you where the
variables. new Var entry can beinserted. Each Input isinserted in aseparate

cell.

Concatenate all selected input entriestogether
with an existing Var entry.

Drag & drop onto the Var entry which getshighlighted. All entries
gets concatenated into one cell. Add the required operators using
Java operations signs. The dot concatenates string variables.

Overwrite a Va entry with seected
concatenated |nput entries.

Drag & drop onto the relevant Var entry which gets highlighted
then press Ctrl and release. All selected entries are concatenated
and overwrite the highlighted Var.

Concatenate selected input entries with
highlighted Var entries and create new Var
linesif needed

Drag & drop onto an existing Var then press Shift when browsing
over the chosen Var entries. First entries get concatenated with the
highlighted Var entries. And if necessary new lines get created to
hold remaining entries.

6.2.2.1. How to access global or context variables

Press Ctrl+Space to access the global and context variable list.

Appended to the variable list, a metadata list provides information about the selected column.

6.2.2.2. How to remove variables

To remove aselected Var entry, click the red cross sign. This removes the whole line as well as the link.

Press Ctrl or Shift and click fields for multiple selection then click the red cross sign.

6.2.3. Using the expression editor

All expressions (Input, Var or Output) and constraint statements can be viewed and edited from the expression
editor. This editor provides visual comfort to write any function or transformation in a handy dedicated view.
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6.2.3.1. How to access the expression editor

Y ou can writethe expressions necessary for the data transformation directly in the Expression editor view located
in the lower half of the expression editor, or you can open the [Expression Builder] dialog box where you can
write the data transformation expressions.

To open the Expression editor view, complete the following:
1. Double-click thetMap component in your job design to open the Map Editor.
2. Inthelower half of the editor, click the Expression editor tab to open the corresponding view.

To edit an expression, select it in the Input panel and then click the Expression editor tab and
s modify the expression as required.

R'}r;' ¥Yar 'ﬁfj-f@@?r;'

cars_data (2] s S Expression Tvpe Yariable

' cars_data,Make koUpperCased) [.. | sString [ warl

Colurmn
ID_Cwners
Registration
Make
Colar
ID_Reseller

Schema editor | Expression editor

cars_data.Make.tollpperCase)

3. Enter the Java code according to your needs. The corresponding expression in the output panel is
synchronized.

Refer to the Java documentation for more information regarding functions and operations.
2

To open the [Expression Builder] dialog box, click the three-dot button next to the expression you want to open
inthe Var or Output panel of the Map Editor.

a3 L1 auto map! Die or
namesAndstates & O i
Expression Colurmn

|_-§ Marme
rowz  Skate Skates

The[Expression Builder] dialog box opens on the selected expression.
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¥ Expression Builder E|
Expression Test
[v]wrap [LInu:Iu:u(CtrI + Z]l] [Clear]
StringHandling.EREPLACE (rowl.nsme, " ", " ") War Yalue A |Chuck _Horris
- row L id riull =

rowl.name  Chuck Morris
rowl.add,,. null

HUEE  HEEEEE L v

Cateqgoties Functions Help

*all A || ALPHA ry

# ; — — ! )

Dgf:ég:f;?odn ELENMGE Substitutes an element of a
Mathermnatical COUNT ||| string with a replacement
Murneric — || DOWNCASE

element.

Relational DOUOTE
StringHandling v b

@:‘ I Ck H Cancel

For a use case showing the usage of the expression editor, see the following section.

6.2.3.2. How to write code using the Expression Builder

Some Jobsrequire pieces of codeto bewritten in order to provide componentswith parameters. In the Component
view of some components, an Expression Builder interface can help you build these pieces of code (in Java).

The following example shows the use of Expression Builder in atMap component.
tFileInputDelimited_1

rowd iL l:u:ul_cj.lp]l

¥

. rowl {Main) =Eq namesandstates (Main) =E@|

tMysglInput_ 1 ' tMap_1 tLogRow 1

Two input flows are connected to the tM ap component.
» From the DB input, comes alist of names made of afirst name and alast name separated by a space char.
» From the File input, comes alist of US states, in lower case.

InthetMap, use the expression builder to: First, replace the blank char separating the first and last names with an
underscore char, and second, change the states from lower case to upper case.

1. InthetMap, set the relevant inner join to set the reference mapping. For more information regarding tM ap,
see Section 6.2, “tMap operation” and Section 6.1, “tMap and tXMLMap interfaces’.
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From the main (rowl) input, drop the Names column to the output area, and the Sate column from the lookup
(row2) input towards the same output area.

Then click in the first Expression field (rowl.Name) to display the three-dot button.

& L1 Auto map! | [] Die ar
[ |
namesAndstates __;v-L" = LAl
Expression Colurnn
oWl name - [ arne
rowZ, Skate Stakes
The [Expression Builder] dialog box opens up.
# Expression Builder g|
Expression Test
[] wirap lUnda(CtrI + Z)] lCIear]
StringHandling. EREFLACE (rowl. namwe, ™ ', " ") Var Yalue ~ Chuck_Marris
o id nll
rowl.name  Chuck Morris
rowl. add.,.. null
rowl.date  null 3z

HHUHE (SR

cmeead e

Remave

Categories
4l

*Jzer Defined
Dakadperation
Mathematical
Murmeric
Relational

Functions
# ||| BLPHA
|| BTRIM
CHANGE
ZOUNT
— || DT MCASE

Help

Substitutes an element of a
string with a replacement
element.

DgUOTE
b b
-

StringHandling

@

H Cancel l

In the Category area, select the relevant action you want to perform. In this example, select
Stri ngHandl i ng and select the EREPLACE function.

In the Expression area, paste rowl.Name in place of the text expression, in order to get:
StringHandl i ng. EREPLACE(rowl. Nanme, " ", " _"). This expression will replace the separating

space char with an underscore char in the char string given.

Now check that the output is correct, by typing in the relevant Value field of the Test area, adummy value,
e.g: Chuck Norris and clicking Test!. The correct change should be carried out, for example, Chuck Norris.

Click OK to validate the changes, and then proceed with the same operation for the second column (Sate).

InthetM ap output, select the row2.Sate Expression and click the[...] button to open the Expression builder
again.
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% Expression Builder @

Expression Test
[LIndu:ul[CtrI + Z]I] [Clear]
StringHandling.UPCA3E (rowZ.3tcate) War Value ~ IMDTAMA
rowZ,State indiana
rowz, Capital rdll =—
rowz. MostPopul,..  null v
L (== g _

Zateqory Functions Help

Mathematical A || CHANGE A

E:It:t%?;rlamn DLWHCASE Converts all lowercase letters
TalendDate DQUOTE in an expression to

Murneric EREPLACE

Talendstrin — ||LEFT UPPETCase.

|StringHand _ * | |RIGHT b/

I Ok H Cancel ]

This time, the St ri ngHandl i ng function to be used is UPCASE. The complete expression says:
StringHandl i ng. UPCASE(row2. St at e) .

9. Once again, check that the expression syntax is correct using adummy Valuein the Test area, for example
indiana. The Test! result should display INDIANA for this example. Then, click OK to validate the changes.

Both expressions are now displayed in the tM ap Expression field.

g XK L Auko map!

namesAndStates le’ .|'. i

Expression Colurmn
StringHandling, EREPLACE raw 1 Mame, " ",

| Mame

StringHandling, UPCASE{row?, State)

These changes will be carried out along the flow processing. The output of this example is as shown below.
Stareingy fobh Yasssdndseates 36 88 T G SRS

tLogRow_1
Hame | RandomStates
William_Grant I0Wa
William_Hoower HEW YORE
Grover_Lincoln HORTH DAEOTA
Lyndon_Jeffer=on OHIO
Gerald_Haves WASHIHGTOH
Benjamin Grant HATHE
George Fierce COHHECTICUT
Jimny_Reagan ALASEA
Hartin_Haves WASHINGTON
Franklin_ Jefferson |IOWA
Andrew_Nizon HEW HAMFSHIRE
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6.2.4. Mapping the Output setting

On the design workspace, the creation of a Row connection from the tMap component to the output components
adds Output schematablesin the Map Editor.

Y ou can also add an Output schemain your Map Editor, using the plus sign from the tool bar of the Output area.

You have as well the possibility to create a join between your output tables. The join on the tables enables you
to process several flows separately and unite them in a single output. For more information about the output join
tables feature, see Talend Open Studio for Data Integration Reference Guide.

Thejoin table retrieves the schema of the source table.
7

When you click the [+] button to add an output schema or to make a join between your output tables, a dialog
box opens. Y ou have then two options.

% Add a output §|

O Mew oukpuk

(¥ Create join table Fram [Ook | Mamed | ookl

ok ] [ Cancel
Select... To...
New output Add an independent table.
Createjoin table from Create ajoin between output tables. In order to do so, select inthe
drop down list the table from which you want to create the join.
In the Named field, type in the name of the table to be created.

Unlike the Input area, the order of output schema tables does not make such a difference, as there is no
subordination relationship between outputs (of Join type).

Once all connections, hence output schema tables, are created, you can select and organize the output data via
drag & drops.

Y ou can drop one or several entries from the I nput area straight to the relevant output table.
Press Ctrl or Shift, and click entries to carry out multiple selection.

Or you can drag expressions from the Var area and drop them to fill in the output schemas with the appropriate
reusable data.

Note that if you make any change to the Input column in the Schema Editor, a dialog prompts you to decide to
propagate the changes throughout all Input/V ariable/Output table entries, where concerned.

Action Result

Drag & Drop onto existing expressions. Concatenates the selected expression with the existing
eXpressions.

Drag & Drop to insertion line. Insertsoneor several new entriesat start or end of table or between
two existing lines.

Drag & Drop + Ctrl. Replaces highlighted expression with selected expression.

Drag & Drop + Shift. Addsthe selected fieldsto all highlighted expressions. Inserts new
linesif needed.
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Action

Result

Drag & Drop + Ctrl + Shift.

Replaces al highlighted expressions with selected fields. Inserts

new linesif needed.

Y ou can add filters and rejections to customize your outputs.

6.2.4.1. Building complex expressions

If you have complex expressions to build, or advanced changes to be carried out on the output flow, then the

Expression Builder interface can help in this task.

Click the Expression field of your input or output table to display the[...] button. Then click this three-dot button

to open the Expression Builder.

For more information regarding the Expression Builder, see Section 6.2.3.2, “How to write code using the

Expression Builder”.

6.2.4.2. Filters

Filters allow you to make a selection among the input fields, and send only the selected fields to various outputs.

Click the[+] button at the top of the table to add afilter line.

~aliirnn

£

|.ﬁ.ctivate,|'unactivate ExprEssIon Filter|

T _ T =T

—

Y ou can enter freely your filter statements using Java operators and functions.

Drop expressions from the I nput area or from the Var areato the Filter row entry of the relevant Output table.

owners_data o 0
Expr. kev Colurmn
* cars_data.ID_Cwners id_ownier
narne
id_insurance
Chlidren_mMr

Insured & gr| LA
owners_data,id_insurance 1= null G

Expression Colurmn
cars_daka, ID_Owiners ID_Owners
cars_daka,Reqistration Reqistration

An orange link isthen created. Add the required Java operator to finalize your filter formula.

You can create various filters on different lines. The AND operator isthe logical conjunction of al stated filters.

6.2.4.3. Output rejection

Reject options define the nature of an output table.

It groups data which do not satisfy one or more filters defined in the standard output tables. Note that as standard

output tables, are meant al non-reject tables.

This way, data rejected from other output tables, are gathered in one or more dedicated tables, allowing you to

spot any error or unpredicted case.
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The Reject principle concatenates all non Reject tables filters and defines them as an EL SE statement.
To define an output table as the Else part of the regular tables:
1. Click thetMap settings button at the top of the output table to display the table properties.

2. Click inthe Valuefield corresponding to Catch output reect and then click the [...] button that appearsto
display the [Options] dialog box.

3. Inthe [Options] dialog box, double-click true, or select it and click OK to validate the setting and close
the dialog box.

Ldr>_Udid., Ll BESENET 1R EsEnsT
R Options g] owners_data. Mame Mame

owners_data. ID_Insurance ID_Insurance

frue

false -
Rejected_data & | G i
Property Walue b
Catch output reject False [...]
Catch lookup inner join reject false
Schema Tvoe Bulit-In b/
< >
Expression Zalurmn
cars_daka, ID_Owner ID_Owiners
cars_daka,Reqistration Reqistration
cars_daka.ID_Reseller ID_Reseller
owners_data.Mame Marne

] 4 l [ Cancel =

You can define several Reject tables, to offer multiple refined outputs. To differentiate various Reject outputs,
add filter lines, by clicking on the plus arrow button.

Once atable is defined as Reject, the verification process will be first enforced on regular tables before taking in
consideration possible constraints of the Reject tables.

Note that dataare not exclusively processed to one output. Although a data satisfied one constraint, henceisrouted

to the corresponding output, this data still gets checked against the other constraints and can be routed to other
outputs.

6.2.4.4. Lookup Inner Join rejection

The Inner Join is a Lookup Join. The Inner Join Reject table is a particular type of Rejection output. It gathers
rejected data from the main row table after an Inner Join could not be established.

To define an Output flow as container for rejected Inner Join data, create a new output component on your Job
that you connect to the Map Editor. Then in the Map Editor, follow the steps below:

1. Click thetMap settings button at the top of the output table to display the table properties.

2. ClickintheValuefield corresponding to Catch lookup inner join reject and then click the[...] button that
appears to display the [Options] dialog box.

3. Inthe [Options] dialog box, double-click true, or select it and click OK to validate the setting and close
the dialog box.

Talend Open Studio for Data Integration User Guide 181



Mapping the Output setting

[ % Expression Zolumn
% Options El cars_data,ID_Cwner ID_wners

cars_data.Registration Reqistration
brue cars_daka,ID_Reseler ID_Reseller
) False owners_daka,Mame MName
3 Rejected_InnerJoin | o ..' i
Property Yalue *'\
Catch output reject false
Catch lookup inner join rejeck False L.
schema Tvoe Eulit-In b
< »
Expression olurmn
cars_data,ID_Cwner ID_Cwners
oK ] [ Cancel cars_data.Registration Reqistration

6.2.4.5. Removing Output entries

To remove Output entries, click the cross sign on the Schema Editor of the selected table.

6.2.4.6. Handling errors

The Die on error option prevent error to be processed. To do so, it stops the Job execution as soon as an error is
encountered. The tMap component provides this option to prevent processing erroneous data. The Die on error
option is activated by default in tMap.

Deactivating the Die on error option will allow you to skip the rows on error and complete the process for error-
free rows on one hand, and to retrieve the rows on error and manage them if needed.

To desactivate the Die on error option:
1. Double-click the tMap component on the design workspace to open the Map Editor.
2. Click the Property Settings button at the top of the input areato display the [Property Settings] dialog box.

3. In[Property Settings] dialog box, clear the Die on error check box and click OK.
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Yar

=p= H

W % Property Settings

C Store on disk

id Temp data directory path: | | [Brawse... ]

Max buffer size(nb of rows): |2|:|D|:||:|E||:| | *

row?

Prop
Liook)
[akc
Join
Stores
ache

[ O, H Cancel ]

Expr

A new table called ErrorReject appears in the output area of the Map Editor. This output table automatically
comprises two columns: error M essage and error Stack Trace, retrieving the message and stack trace of the error

encountered during the Job execution. Errors can be unparseable dates, null pointer exceptions, conversion issues,
etc.

You can aso drag and drop columns from the input tables to this error reject output table. Those erroneous data
can be retrieved with the corresponding error messages and thus be corrected afterward.

rowl L}b ..' .D ErrorReject Q

Colurmn Expressian Colurmn

id erroriMess, .,
Cuskomerame erroratack. ..

Customeraddress
idskate

idz

RegTime
ReqisterTime

Once the error reject table is set, its corresponding flow can be sent to an output component.
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tFileInput Defimited_3

rDWE{@DDkup}
=
3 ; rowl (Main) =E ;{i MarmeandCity (Main order:2) =3
tFileInputDelimited_2 ' ' ' tMap_1 : ' ' " EMysgloutput 1

tLogRow 1

To do so, on the design workspace, right-click the tM ap component, select Row > Error Reject in the menu, and
click the corresponding output component, here tL ogRow.

When you execute the Job, errors are retrieved by the Error Reject flow.
Starfing ol fie an arrar g8 15030 S1o8ReS8LE

java.text ParseException: Unparseable date: "08 01
1980" | jawva. lang.FuntineEzception:
java . text ParseEzception: Unparseable date: "08 01 1980°
at routines. TalendDate. parselate({TalendDate. java:503)
at
doc . die_on_error_0_1.Die _on _error.tFilelnputDelimnited_2Pro
ces=(Die_on_error . jawa:1409)
at
doc . die_on_error_0_1.Die_on_error. runJobInTOS{Die _on_error.
java:2262)
at
doc . die_on_error_0_1.Die_on_error main({lDie_on_error.java:l
1600
Cau=ed by: java.text. ParseEzception: Unparseable date: "08
o1 19a0”
at jawva.text DateFormat . parse(nknown Source)
at routines. TalendDate. parselate({TalendDate. java:501)

... 3 more
[1]08 01 1980
Joabh e on s anded g 1505 GLoRReRRIE farr b oods=07

The result contains the error message, its stack trace, and the two columns, id and date, dragged and dropped to
the Error Reject table, separated by apipe “|".

6.2.5. Setting schemas in the Map Editor

Inthe M ap Editor, you can define the type of atable schemaas Built-In so that you can modify the data structure
in the Schema editor panel, or Repository and retrieve the data structure from the Repository. By default, the
schematypeis set to Built-In for all tables.

6.2.5.1. Retrieving the schema structure from the Repository

To retrieve the schema structure of the selected table from the Repository:
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1.

2.

Click thetM ap Settings button at the top of the table to display the table properties.

Click in the Value fidld of Schema Type, and then click the three-dot button that appears to open the
[Options] dialog box.

% Options E|
Owners_data | /ﬂ| ..'
Property Walue
Loakup Madel Load once
Match Model IInique match
Join Model Inmer Join
Store temp data False
Schema Type Bulit-In
Expr, key Colurmn
‘-}‘ Cars_data. ID_Owaner I0_Cnaner
Marne
ID_Insurance
Chlidren_Mr Gk l [ Cancel

In the [Optiong] dialog box, double-click Repository, or select it and click OK, to close the dialog box and
display the Schema | d property beneath Schema Type.

If you close the Map Editor now without specifying a Repository schema item, the schema type
s changes back to Built-In.

Click inthe Valuefield of Schema Id, and then click the[...] button that appears to display the [Repository
Content] dialog box.

In the [Repository Content] dialog box, select your schema as you define a centrally stored schemafor any
component, and then click OK.

The Value field of Schema Id is filled with the schema you just selected, and everything in the Schema
editor panel for this table becomes read-only.
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Owners_data P 0
Property: Yalue
Lookup Model Load once
Match Model IInigue makch
Join Model Inmer Join
Store temp data False
Schema Type Repositary
i Schema Id DELIM:owners - metadata
Expr, ke Colurmn
ID_Cwrmer
Marne
ID_Insurance
Chlidren_Mr
L
Schema editor . Expression editor
Cwners_data
Colurnn kev T.. ] M., Dat.. L. P B ..
I ow... [] 1 z 0
Mamne d s 19 0
I Ins... [ ] 1 3 0
Chlidre... [ ] 1 z 0
< >

Changing the schema type of the subordinate table across a Join from Built-1n to Repository causes
2 the Join to get lost.

Changes to the schema of a table made in the Map Editor are automatically synchronized to the
schema of the corresponding component connected with the tM ap component.

6.2.5.2. Using the Schema Editor

The Schema Editor details al fields of the selected table. With the schema type of the table set to Built-In, you
can modify the schema of the table.

Schema editor . Expression editor

owners_daka

Colurmn key  Type | Length Precision = Mullable | Comment
Gl ID_Owner int z 0
FEEE I O
Marne [] s=tring & 0
I0_Insurance [] string 7 0

Use the tool bar below the schematable, to add, move or remove columns from the schema.

Y ou can aso load a schema from the repository or export it into afile.
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M etadata Description

Column Column name as defined on the Map Editor schemas and on the Input or Output
component schemas.

Key The Key shows if the expression key data should be used to retrieve data through
the Join link. If unchecked, the Join relation is disabled.

Type Type of data: String, Integer, Date, etc.

This column should always be defined in a Java version.
¥

Length -1 shows that no length value has been defined in the schema.
Precision precise the length value if any is defined.

Nullable Clear this check box if the field value should not be null.
Default Shows any default value that may be defined for thisfield.
Comment Free text field. Enter any useful comment.

Input metadata and output metadata are independent from each other. Y ou can, for instance, change the
¥ label of a column on the output side without the column label of the input schema being changed.

However, any change made to the metadata are immediately reflected in the corresponding schema on the tMap
relevant (Input or Output) area, but also on the schema defined for the component itself on the design workspace.

A Red colored background showsthat an invalid character has been entered. Most special charactersare prohibited

in order for the Job to be ableto interpret and use the text entered in the code. Authorized charactersinclude lower-
case, upper-case, figures except as start character.

6.2.6. Solving memory limitation issues in tMap use

When handling large data sources, including for example, numerous columns, large number of lines or of column
types, your system might encounter memory shortage issues that prevent your Job, to complete properly, in
particular when using atMap component for your transformation.

A feature has been added (in Java only for the time being) to the tM ap component, in order to reduce the memory
in use for lookup loading. In fact, rather than storing the temporary data in the system memory and thus possibly
reaching the memory limitation, the Store temp data option allows you to choose to store the temporary data
onto adirectory of your disk instead.

This feature comes as an option to be selected in the Lookup table of the input datain the Map Editor.

To enable the Store temp data option:

1. Double-click thetMap component in your Job to launch the Map Editor.

2. Ininput area, click the Lookup table describing the temporary data you want to be |oaded onto the disk rather
than in the memory.

3. Click thetMap settings button to display the table properties.

4. Click in the Value field corresponding to Store temp data, and then click the [...] button to display the
[Optiong] dialog box.

5. Inthe[Options] dialog box, double-click true, or select it and click OK, to enable the option and close the
dialog box.
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Owners_data |Flge | &
Property YWalue

Loakup Madel Load once

Match Model IJnique match

Join Model Left Cuker Join

Store temp data False
Schema Tyvpe Bulit-In
Expr. kew Calumn

B, Cars_dataID_Owner C id

Zuskamerame
Customerad. ..
idSkate

idz2

ReqTime
ReqisterTime

% Options
krue

false

K ] [ Cancel

3

For thisoption to befully activated, you also need to specify the directory on the disk, wherethe datawill be stored,
and the buffer size, namely the number of rows of data each temporary filewill contain. Y ou can set the temporary

storage directory and the buffer size either in the Map Editor or in the tMap component property settings.

To set the temporary storage directory and the buffer sizein the Map Editor:

1. Clickthe Property Settings button at the top of theinput areato display the [Property Settings] dialog box.

2. In[Property Settings] dialog box, fill the Temp data directory path field with the full path to the directory
where the temporary data should be stored.

3. Inthe Max buffer size (nr of rows) field, specify the maximum number of rows each temporary file can
contain. The default value is 2,000,000.

4. Click OK to validate the settings and close the [Property Settings] dialog box.

G = ‘Q Yar
% Property Settings
Die on error
Owing
Expr Store on disk
% c Temp data directory path: |D:,|'Tem|:| | [Browse. ..
Max buffer sizelnb of rows): |2|:||:||:||:|D|:| | 5
Rese
Prop
Looky]
Match
Jain
Skore
Scher [ (6.4 ] [ Cancel
Carr

]

To set thetemporary storage directory inthe tM ap component property settings without opening the M ap Editor:

1. Click thetMap component to select it on the design workspace, and then select the Component tab to show

the Basic settings view.
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2. Inthe Storeon disk area, fill the Temp data directory path field with the full path to the directory where
the temporary data should be stored.

Alternatively, you can use a context variable through the Ctrl+Space bar if you have set the variable in a
Context group in the repository. For more information about contexts, see Section 4.4.2, “How to centralize
contexts and variables’.

= properties | Ly Component &2 Job Setting Contextsi] | [ Problems | =, Modules | & Scheduler | — O
o =0
BX§ tMap_1 S
' o ' e
Basic settings Map Editor: E] Mapping links display as: | Auta L
&dvanced setkings Stare on disk N
e = Temp data directory path: | context.tempFolder E]
Wigw Presicw | 5 o =]
Drocumentation el +
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Hae
Sinbes
Topbepl Lk wasich T join +
Exr. bharp Cakrmn b

At the end of the subjob, the temporary files are cleared.

Thisway, you will limit the use of allocated memory per reference data to be written onto temporary files stored
on the disk.

As writing the main flow onto the disk requires the data to be sorted, note that the order of the output
¥ rows cannot be guaranteed.

On the Advanced settings view, you can also set abuffer sizeif needed. Simply fill out the field M ax buffer size
(nb of rows) in order for the data stored on the disk to be split into as many files as needed.

6.2.7. Handling Lookups

In order to adapt to the multiple processing types as well as to address performance issues, the tMap component
supports different lookup loading modes.

» Load once: Default setting. Select this option to load the entire lookup flow before processing the main flow.
Thisisthe preferred option if you have a great number of datafrom your main flow that needs to be requested
in your lookup, or if your reference (or lookup) data comes from afile that can be easily loaded.

» Reload at each row: At each row, the lookup gets loaded again. This is mainly interesting in Jobs where the
lookup volume is large, while the main flow is pretty small. Note that this option allows you to use dynamic
variable settings such as where clause, to change/update the lookup flow on the fly as it gets loaded, before
the main flow join is processed. This option could be considered as the counter-part of the Store temp data
option that is available for file lookups.

» Reload at each row (cache): Expressions (in the Lookup table) are assessed and looked up in the cache first.
The results of joins that have already been solved, are stored in the cache, in order to avoid loading the same
resultstwice. Thisoption optimizes the processing time and hel psimprove processing performance of thetM ap
component.

Note that for the time being, you cannot use Reload at each row (cache) and Store temp data at the
¥ sametime.

To set the loading mode of alookup flow:

1. Click thetMap settings button at the top of the lookup table to display the table properties.
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2. Click in the Value field corresponding to Lookup Model, and then click the [...] button to display the
[Options] dialog box.

3. Inthe[Optiong] dialog box, double-click the wanted loading mode, or select it and then click OK, to validate
the setting and close the dialog box.
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Match Madel IJnique match Reload at each row {cache)
Jain Model Inner Jain
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Schema Type Bulit-In
Expr, ke Colurmn
“‘P‘ Cars_data. ID_Owiner C%, ID_Cwwmer
Marne

ID_Insurance
Chlidren_Mr

Ik l [ Cancel

Resellers_data _.“ s &

For use cases using these options, see the tM ap section of the Talend Open Sudio Components Reference Guide.

When your lookup is a database table, the best practise is to open the connection to the database in the
¥ beginning of your job design in order to optimize performance. For a use case using this option, seetMap
in Talend Open Studio Components Reference Guide.

6.3. tXMLMap operation

Before starting this section, we recommend reading the previous tM ap sections for the basic knowledge
’ of a Talend mapping component.

tXMLMap isfine-tuned to leverage the Document data type for processing XML data, a case of transformation
that often mixes hierarchical data (XML) and flat data together. This Document type carries a complete user-
specific XML flow. In using tXMLMap, you are able to add as many input or output flows as required into a
visual map editor to perform, on these flows, the operations as follows:

« data multiplexing and demultiplexing,
« datatransformation on any type of fields, particularly on the Document type,

 datamatching viadifferent models, for example, the Unique match mode (related topic: Section 6.2.1.2, “How
to use Explicit Join”),

» XML tree construction on both of the input and the output sides,
* inner join and left outer join (related topic: Section 6.2.1.3, “How to use Inner Join™)

* lookup between data sources whatever they are flat or XML data using models like L oad once (related topic:
Section 6.2.7, “Handling Lookups”),

« fields concatenation and interchange,

« field filtering using constraints,

190 Talend Open Studio for Data Integration User Guide



Using the document type to create the XML tree

 datargecting.

LiketMap, amap editor isrequired to configure these operations. To open this map editor, you can double-click
the tXMLMap icon in the design workspace, or aternatively, click the three-dot button next to the Map Editor
in the Basic settings view of the tXM L M ap component.

tXMLMap and tMap use the common approaches to accomplish most of these operations. Therefore, the
following sections explain only the particular operations to which tXMLMap is dedicated for processing the
hierarchical XML data.

The operations focusing on hierarchical data are:

» using the Document type to create the XML tree of interest;
* managing the output XML data;

* editing the XML tree schema.

The following sections present more relevant details.

Different from tMap, tXMLMap does not provide the Store temp data option for storing temporary
¥ data onto the directory of your disk. For further information about this option of tMap, see Section 6.2.6,
“Solving memory limitation issuesin tMap use”.

6.3.1. Using the document type to create the XML tree

The Document data type fits perfectly the conception of defining XML structure as easily as possible. When
you need the XML tree structure to map the input or output flow or both, use this type. Then you can import the
XML tree structure from various XML sources and edit the tree directly in the mapping editor, thus saving the
manual efforts.

6.3.1.1. How to set up the Document type

The Document data type is one of the data types provided by Talend. This Document type is set up when you
edit the schemafor the corresponding datain the Schema editor . For further information about the schema editor,
see Section 6.2.5.2, “Using the Schema Editor”.

The following figure presents an example in which the input flow, Customer, is set up as the Document type. To
replicateit, in the Map editor, you can simply click the [+] button to add one row on the input side of the Schema
editor, rename it and select Document from the drop-down list of the given data types.

achema editor . Tree schema editor | Expression editor

Zolumn kKey  Twpe w| M. DatePattern... Lenagth Precision  Def...  Comm...
Customer [ EEEINE
short | Short 'y
Skring

Lisk
Crvnarmic

In practice for most cases, tXMLMap retrieves the schema of its preceding or succeeding components, for
example, from atFilelnputXML component or in the ESB use case, from atESBProvider Request component.
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This avoids many manual efforts to set up the Document type for the XML flow to be processed. However, to
continueto modify the XML structure asthe content of aDocument row, you need still to use the given Map editor.

Be aware that a Document flow carries a user-defined XML tree and is no more than one single field of
¥ a schema, which, same as the other schemas, may contain different data types between each field. For
further information about how to set a schema, see Section 4.2.6.1, “Basic Settings tab”.

Once the Document typeis set up for arow of data, in the corresponding data flow table in the map editor, abasic
XML tree structure is created automatically to reflect the details of this structure. This basic structure represents
the minimum element required by avalid XML treein using tXMLM ap:

» Theroot element: it is the minimum element required by an XML tree to be processed and when needs be, the
foundation to develop a sophisticated XML tree.

» Theloop element: it determines the element over which the iteration takes place to read the hierarchical data of
an XML tree. By default, the root element is set asloop element.

main irow3 Q

Calurnn

Cuskomer

=I- roak {looph

Thisfigure gives an example with the input flow, Customer. Based on this generated XML root tagged as root by
default, you can develop the XML tree structure of interest.

To do this, you need to:
1.  Import the custom XML tree structure from one of the following types of sources:

o XML or XSD files (related topic: Section 6.3.1.2, “How to import the XML tree structure from XML and
XSD files”)

« file XML connections created and stored in the Repository of your Studio (related topic: Section 6.3.1.3,
“How to import the XML tree structure from the Repository™).

If needs be, you can develop the XML tree of interest manually using the options provided on the
s contextual menu.

2. Resettheloop element for the XML tree you are creating, if needs be. Y ou can set as many loops asyou need
to. At this step, you may have to consider the following situations:

« If you haveto create several XML trees, you need to define the loop element for each of them.

« If you import the XML tree from the Repository, the loop element will have been set depending on the
set of the source structure. But you can still reset the loop €lement.

For further details, see Section 6.3.1.4, “How to set or reset aloop element for animported XML structure”

If needed, you can continue to modify the imported XML tree using the options provided in the contextual menu.
The following table presents the operations you can perform through the available options.

Options Operations

Create Sub-element and Create Attribute  |Add elements or attributes to develop an XML tree. Related
topic: Section 6.3.1.5, “How to add a sub-element or an attribute
to an XML tree structure”

Set a namespace Add and manage given namespaces on the imported XML tree.
Related topic: Section 6.3.1.7, “How to manage a namespace”
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Options Operations

Delete Delete an element or an attribute. Related topic: Section 6.3.1.6,
“How to delete an element or an attribute from the XML tree
structure”

Rename Rename an element or an attribute.

Asloop element Set or reset an element as loop element. Multiple loop elements
and optional |oop element are supported.

Asoptional loop Thisoption is not available unless to the loop element you have
defined.

When the corresponding element exists in the source file, an
optional loop element works the same way as a normal loop
element; otherwise, it resets automatically its parent element as
loop element or in absence of parent element in the source file,
it takes the element of the higher level until the root element.
But in the real-world practice, with such differences between the
XML tree and the source file structure, we recommend adapting
the XML tree to the source file for better performance.

Asgroup element On the XML tree of the output side, set an element as group
element. Related topic: Section 6.3.1.8, “How to group the
output data”

As aggregate element Onthe XML tree of the output side, set an element as aggregate
element. Related topic: Section 6.3.1.9, “How to aggregate the
output data”

Add Choice Set the Choice element. Then al of its child elements

developed underneath will be contained in this declaration.
When tXMLMap processes a choice element, the elements
contained in its declaration will not be outputted unless their
mapping expressions are appropriately defined.

Set as Substitution Set the Substitution element to specify the element substitutable
for a given head element defined in the corresponding XSD.
WhentXM L M ap processesasubstitution element, theelements
contained in its declaration will not be outputted unless their
mapping expressions are appropriately defined.

The following sections present more details about the process of creating the XML tree.

6.3.1.2. How to import the XML tree structure from XML and XSD
files

To import the XML tree structure from an XML file, proceed as follows:

1. Intheinput flow table of interest, right-click the column name to open the contextual menu. In this example,
it is Customer.

main :row3 Q

Calumn

Cishornoe
Import From File

== Import From Fepository

2. From this menu, select Import From File.
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3. In the pop-up dialog box, browse to the XML file you need to use to provide the XML tree structure of
interest and double-click the file.

To import the XML tree structure from an XSD file, proceed as follows;

1. Intheinput flow table of interest, right-click the column name to open the contextual menu. In this example,
it is Customer.

main :row3 Q

Calurnn

Cishornme
| Irnport Fram File

=4 Import From Repository

2. From this menu, select Import From File.

3. Inthepop-up dialog box, browseto the X SD file you need to use to provide the XML tree structure of interest
and double-click thefile.

4. Inthedialogbox that appears, select an element fromthe Root list astheroot of your XML tree, and click OK.

Root |(alddil= g A

[ OK H Cancel ]

The root of the imported XML treeis adaptable:

» Whenimporting either an input or an output XML tree structure from an XSD file, you can choose
an element as the root of your XML tree.

» Once an XML structure isimported, the root tag is renamed automatically with the name of the
XML source. To change thisroot name manually, you need use the tree schema editor. For further
information about this editor, see Section 6.3.3, “Editing the XML tree schema’.

Then, you need to define the loop element in this XML tree structure. For further information about how to define
aloop element, see Section 6.3.1.4, “How to set or reset aloop element for an imported XML structure”.

6.3.1.3. How to import the XML tree structure from the Repository

To do this, proceed as follows:

1. Intheinput flow table of interest, right click the column name to open the contextual menu. In this example,

it is Customer.
main :row3 |
Caolurmn
Cuskopeee
Import From File
Impork From Repasitory T

2. From this menu, select Import From Repository.
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3. Inthepop-up repository content list, select the XML connection or the MDM connection of interest to import
the corresponding XML tree structure.

% Repository Content E”E”E'

CustomerxMLConnections 0.1

[E] Talend MDM

(0.4 ] [ Cancel

Thisfigure presents an example of this Repository-stored XML connection.

To import an XML tree structure from the Repository, the corresponding XML connection should
s have been created. For further information about how to create a file XML connection in the
Repository, see Section 7.8, “ Setting up an XML file schema’.

4, Click OK to validate this selection.

The XML tree structure is created and aloop is defined automatically as thisloop was aready defined during the
creation of the current Repository-stored XML connection.

6.3.1.4. How to set or reset a loop element for an imported XML
structure

You need to set at least one loop element for each XML treeif it does not have any. If it does, you may have to
reset the existing loop element when needs be.

Whatever you need to set or reset aloop element, proceed as follows:

1. Inthecreated XML tree structure, right-click the element you need to define asloop. For example, you need
to define the Customer element as loop in the following figure.
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2. From the pop-up contextual menu, select Asloop element to define the selected element as loop.

Once done, this selected element is marked with the text: loop:true.
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[=I- Custamer {loop sbrue)
|

If you close the Map Editor without having set the required loop element for agiven XML tree, itsroot
¥ element will be set automatically as loop element.

6.3.1.5. How to add a sub-element or an attribute to an XML tree
structure

In the XML tree structure view, you are able to manually add a sub-element or an attribute to the root or to any
of the existing elements when needs be.

To do either of these operations, proceed as follows:

1. Inthe XML tree you need to edit, right-click the element to which you need to add a sub-element or an
attribute underneath and select Create Sub-Element or Create Attribute according to your purpose.
main :rowl Q
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E  Create Attribute
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2. Inthe pop-up [Create New Element] wizard, type in the name you need to use for the added sub-element
or attribute.

% Create Mew Element

Input the new element's valid label

| Reqg |

Ik l [ Cancel
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3.

Click OK to validate this creation. The new sub-element or attribute displaysin the XML tree structure you
are editing.

6.3.1.6. How to delete an element or an attribute from the XML
tree structure

From an established XML tree, you may need to delete an element or an attribute. To do this, proceed asfollows:

1

Inthe XML tree you need to edit, right-click the element or the attribute you need to delete.

main :rowl i

Colurmn
Cuskarner

"""""" : -@RegisterTne

—-Nar= 1
__________ ____4_ Create Sub-Element L

= Create Akkribute
---------- M- 1 gl Delete

As loop element
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In the pop-up contextual menu, select Delete.

Then the selected element or attribute is deleted, including all of the sub-elements or the attributes attached
to it underneath.

6.3.1.7. How to manage a nhamespace

When necessary, you are able to set and edit namespace for each of the element in the a created XML tree of the

input or the output data flow.

Defining a namespace

1

To do this, proceed as follows:

In the XML tree of the input or the output data flow you need to edit, right click the element for which you
need to declare a namespace. For example, in a Customer XML tree of the output flow, you need to set a
namespace for the root.
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Cuskomer
|
T

N T _| B Creake Sub-Element
-7 Create Attribute
T Set & Mamespace

Az group element

- ZuskomerMarme

[=-idState

2. Inthe pop-up contextual menu, select Set a namespace. Then the [Namespace dialog] wizard displays.

3. Inthiswizard, typein the URI you need to use.

¥ Mamespace dialog

Input new namespace

Input the prefix and value of the namespace

Mamespace | hikkp:| |

] Prefix

@ [ Ok ] [ Cancel

4. If you need to set a prefix for this namespace you are editing, select the Prefix check box in thiswizard and
typein the prefix you need. In this example, we select it and typein xhtml.

* Mamespace dialog E|

Input new namespace

Input the prefix and value of the namespace

Mamespace | http: /e w3, orgf 1999 bkl |
Prefix | xhtml |

@ [ 0.4 ] [ Zancel

5. Click OK to validate this declaration.
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Modifying the default value of a namespace

To do this, proceed as follows:

1. Inthe XML tree that the namespace you need to edit belongs to, right-click this namespace to open the
contextual menu.

= -xminsixhtml  (Defaulk dWalie chbbne tana s orgy 1999 =0kl
Set A Fixed Prefix

— | Delete 4|L|

2. Inthismenu, select Set A Fixed Prefix to open the corresponding wizard.
3. Typeinthe new default value you need in this wizard.

4, Click OK to validate this modification.

Deleting a namespace

To do this, proceed as follows:

1. Inthe XML tree that the namespace you need to edit belongs to, right-click this namespace to open the
contextual menu.

= -xminsixhtml  (Defaulk el chebne tanas s orgy 1999 =0kl
Set & Fixed Prefix

— |  Delete 4|L|

2. Inthismenu, click Delete to validate this deletion

6.3.1.8. How to group the output data

ThetXM LM ap component uses agroup €l ement to group the output data according to agiven grouping condition.
This allows you to wrap elements matching the same condition with this group element.

To set agroup element, two restrictions must be respected:
1. the root node cannot be set as group element;
2. the group element must be the parent of the loop element.

The option of setting group element is not visible until you have set the loop element; this option isalso
¥ invisible if an element is not allowed to be set as group element.

Once the group element is set, al of its sub-elements except the loop one are used as conditions to group the
output data.

Y ou have to carefully design the XML tree view for the optimized usage of a given group element. For further
information about how to use agroup element, seetXM L Map in the Talend Open Studio Components Reference
Guide.

tXMLMap provides group element and aggregate element to classify datain the XML tree structure.
¥ When handling arow of XML data flow, the behavioral difference between themiis:
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» The group element processes the data always within one single flow.

* The aggregate element splits this flow into separate and complete XML flows.

Setting a group element

To set agroup element, proceed as follows:

1. Inthe XML tree view on the output side of the M ap editor, right-click the element you need to set as group
element.

2. From the opened contextual menu, select As group element.

Then this element of selection becomes the group element. The following figure presents an example of an
XML tree with the group element.
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Customer_States

== cusktamers
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=I- Mame (loop krued
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T - Customerbame

[rowl . Customer: fCustomers)Custo. ..

<] | ]

Revoking a defined group element

To revoke a defined group element, proceed as follows:

1. Inthe XML tree view on the output side of the Map editor, right-click the element you have defined as
group element.

2. From the opened contextual menu, select Remove group element.

Then the defined group element is revoked.

6.3.1.9. How to aggregate the output data

With tXMLMap, you can define as many aggregate elements as required in the output XML tree to class the
XML data accordingly. Then this component outputs these classes, each as one complete XML flow.

1. Todefine an element as aggregate el ement, ssimply right-click this element of interest in the XML tree view
on the output side of the Map editor and from the contextual menu, select As aggr egate element.
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Then this element becomes the aggregate element. Textsin red are added to it, reading aggregate : true. The
following figure presents an example.

Customer L Q
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= Cuskamers

¢ [rowed, U3states: .. %- States (aggregate :brue)
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dl | 2+

2.  Torevokethe definition of the aggregate element, simply right-click the defined aggregate element and from
the contextual menu, select Remove aggr egate element.

To define an element as aggregate element, ensure that this element has no child element and the All

¥ in one feature is being disabled. The As aggregate element option is not available in the contextual
menu until both of the conditions are respected. For further information about the All in one feature, see
Section 6.3.2.1, “How to output elementsinto one document”.

For an example about how to use the aggregate element with tXM LM ap, see Talend Open Sudio Components
Reference Guide

tXMLMap provides group element and aggr egate element to classify data in the XML tree structure.
’ When handling one row of data ( one complete XML flow), the behavioral difference between themis:

* Thegroup element processes the data always within one single flow.

» The aggregate element splits this flow into separate and complete XML flows.

6.3.2. Defining the output mode

To define the output mode of the document-type data, you are defining whether to put all of the XML elementsinto
one single XML flow and when empty element exist, whether to output them. By doing this, you do not change
the structure of the XML tree you have created.

6.3.2.1. How to output elements into one document

Unlessyou are using the aggregate el ement which always classifies the output el ements and splits an output XML
flow, you are able to determine whether an XML flow is output as one single flow or as separate flows, using the
All in onefeaturein thetXMLMap editor.

To do this, on the output side of the M ap editor, proceed as follows:

1. Click the pincer icon to open the map setting panel. The following figure presents an example.
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2. ClicktheAll in onefield and from the drop-down list, select tr ue or false to decide whether the output XML
flow should be one single flow.

 If you select true, the XML datais output al in one single flow. In this example, the single flow reads
asfollows:
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The structure of this flow reads:
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<CustomerName>BEill's Diwve Shop</CustonerNames-
ZCustonerdddress»-51ll Maple Ave., Apt. l1EB</Customerdddress:-
<iditater35/iditate-
<Labelftatex0hio</Labelitates
<Lfoustoners
<CUSTOmer el"=
<Custonerane>DEN Bank< /Custonerlamne>
<Custonerhddress>456 Grogsman Ln.</Custonerhddress-
Lid3tatex>3bsfid5tate
<Labelftate>0hio</Labelitates
L/ oustoners-
<£CUStoner Te3"E
ZCustonerName=Pivot Point College</CustonerNames
<Customerkdddress>1547 Enolwood Rd.</Customerdddresss-
<id¥tatex9</iditate>
<LahelitatexFlorida<s/LabelStates-
</customer’
</ocustonerss

« If you select false, the XML datais output in separate flows, each loop being one flow, neither grouped
nor aggregated. In this example, these flows read as follows:
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Starting jobh c LW ENsn g6 IO FE GRS IS e

[ztatisztic=s] connecting to socket on port 4036

[ztati=stics] connected

<?Emnl wersion="1.0" encoding="UTEF-8"7:

{customersr<cusztomer id="1":r<CustomerHame:Griffith Paving
and
Sealcoatin<-CustomerHamne:<Custoneriddress:talend@apres91<.-C
usztomeriddres=sr<idStater7<-1d5tate:<LabelState:Connecticut ¢
<LabelState: < customer < custonsrs:

<?Eml wersion="1.0" encoding="UTEF-8"7:

{customers:<customer id="56"r<{CustomerHame:Glenn Oaks
Dffice Supplies<-CustomnerHamner<Custoneriddres=:1859 Green
Bavy

Fd . <~ Customeriddres=s:<idStater7<-1dStater<LabelState:Conne
cticut<-LabelStater< customerr<-custonsers:

<7Em]l wersion="1.0" encoding="UTF-8"7:

{customers:<customser id="2":<¢CustomerHame:Bill's Dive
Shop<-CustomerName:<Custonerdddre=s=:>511 Haple Awve. Apt.
1B: - Custonerdddres=sr<idStater35<-1d5tater<LabelState:Chiogs
LabelStater<-custoner r<-custonsers:

<7Eml wersion="1.0" encoding="UTEF-8"7:

{customers:<cusztomer id="61"r»<{CustomerHame:DBEH

Banl < -CusztomerHane:<Customneriddre=s=:>456 Grossman

In. < Customeriddress:<idStater35<-1d5tater<LabelState:0hiog
sLabelStater<-custonerr<-custonsers:

<7Eml wersion="1.0" encoding="UTEF-8"7:

{customersr<cusztomer id="63"r<{CustomerName:Fivot Foint
College<-CustomerName:<Custonerdddres=:>1547 Knolwood

Fd . <-Customerdddres=sr<idStater9<-1id5Stater<LabelState:Flori
da<-Lab=lStater< customner < -customsrs: ¥

Each flow contains one complete XML structure. To take the first flow as example, its structure reads:
<rxml wersion="1.0" encoding="UTF-&" 2>
{CUSTOMerss
<CUSTOme Y 17
LCustomerName=Griffith Paving and Sealcoatin<g /CustomerName:
<Custonerdddressrtalendfapresd1< /Customeriddresss
<id3tate=7</iditates-
<LabelitaterConnecticuts Labelitates-
< /CUstomer=
£foustomersx

The All in one feature is disabled if you are using the aggregate element. For further information about
’ the aggregate element, see Section 6.3.1.9, “How to aggregate the output data”

6.3.2.2. How to manage empty element in Map editor

It may be necessary to create and output empty elements during the process of transforming datainto XML flow,
such as, when tXM L Map works along with tWriteXMLField that creates empty elements or when there is no
input column associated with certain XML node in the output XML data flow.

By contrast, in some scenarios, you do not need to output the empty element while you have to keep them in the
output XML tree for some reasons.

tXMLMap alows you to set the boolean for the creation of empty element. To do this, on the output side of the
Map editor, perform the following operations:

1. Click the pincer icon to open the map setting panel.
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Customer

Property
atch Qukput Reject
Zatch Lookup Inner Join Reject
all in one

s ampty SEmERE N - v

Expression

[Fowl  Customer: fCustomers/ic, .,
[rowwl, Customer ; fustomers/ic, ..
[Fowl  Customer: fCustomers/ic, .,

[rowwl, Customer ; fustomers/ic, ..

|

£

1.

Yalue
False

False

frue

false

TsEomer_oEares
é‘- customers
é‘- cuskamer {loop ke

é‘- i@id
I
'%‘- Customeriame
rT'- CustomerAddre
ETL idState
I=- | abelskate

|+

2. Inthepandl, click the Create empty element field and from the drop-down list, select true or falseto decide
whether to output the empty element.

« If you select true, the empty element is created in the output XML flow and output, for example,

<cust omer ><Label St at e/ ></ cust oner >.

« If you select false, the empty element is not output.

6.3.2.3. How to define the sequence of multiple input loops

If aloop element, or the flat data flow, receives mappings from more than one loop element of the input flow, you
need to define the sequence of the input loops. The first loop element of this sequence will be the primary loop,
so the transformation process related to this sequence will first loop over this element such that the data outputted
will be sorted with regard to its element values.

Sequence input Loop Modes
1 row 1, doc: fproducts/types
z row 1, doc: fproducks/manufacture

(] 4 ] [ Cancel

For example, in this figure, the types element is the primary loop and the outputted data will be sorted by the

values of this element.
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CLYpESE
<typerDELLLZ3< ftypes
Litypess
<typess
<typexDELL123< ftypes
< itypes-
CLYpESE
<typerDELLALA S types
Litypess
<typess
<typexDELLASG ftype
< itypes-
CLYpESE
<typerHP 123/ types
Litypess
<typess
Ltype>HP 123« / typex
Litypess
CLYpESE
<typerHP456<  types
Litypess
<typess
Ltyper>HPALEL / typex
Litypess
<i/mamifactures>

In this case of receiving several input loop elements, a|[...] button appears next to this receiving loop element or
for the flat data, appears on the head of the table representing the flat data flow. To define the loop sequence,
do the following:

1. Click this[...] button to open the sequence arrangement window as presented by the figure used earlier in
this section.

2. Usethe up or down flash button to arrange this sequence.

6.3.3. Editing the XML tree schema

In addition to the Schema editor and the Expression editor viewsthat tM ap isalso equipped with, aTreeschema
editor view isprovided in the map editor of tXMLMap for you to edit the XML tree schema of an input or output
data flow.

To access this schema editor, click the Tree schema editor tab on the lower part of the map editor.
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Schema editor | Tree schema editor ™._Expression editor

#Path Key Tvpe w| Mullable Pattern #%||| ®Path b
row . iCuskomer: Custk. .. [l string il Cuskomer . newZolumn: fcustomers

row . iCustomer: JCust. .. [ string Fi Cuskomer . newZolumn: foustomer s fcuskomer

row . iCustomer: JCust. .. [ string Fi Cuskomer . newZolumn: foustomer sfcustomer i @id
row . iCustomer: JCust. .. [ string Fi Cuskomer . newZolumn: foustomer sfcustomer fCusko
row . iCustomer: JCust. .. [ string Fi Cuskomer . newZolumn: foustomer sfcustomer fCusko
rratl Tosknrmer sk |l Shrinm i o nskarmer newi”nlomne fonskamers fonskamer CDskn
£ > £ >

Theleft half of thisview is used to edit the tree schema of the input flow and the right half to edit the tree schema
of the output flow.

The following table presents further information about this schema editor.

M etadata Description

XPath Useit to display the absolute paths pointing to each element or attribute in a XML
tree and edit the name of the corresponding element or attribute.

Key Select the corresponding check box if the expression key data should be used to
retrieve data through the Join link. If unchecked, the Join relation is disabled.

Type Type of data: String, Integer, Document, etc.

This column should always be defined in a Java version.
7

Nullable Select this check box if the field value could be null.
Pattern Define the pattern for the Date data type.

Input metadata and output metadata are independent from each other. Y ou can, for instance, change the
¥ label of a column on the output side without the column label of the input schema being changed.

However, any change made to the metadata are immediately reflected in the corresponding schema on the
tXMLMap relevant (Input or Output) area, but also on the schema defined for the component itself on the design
workspace.

For detailed use cases about the multiple operations that you can perform using tXMLMap, see Talend Open
Sudio Components Reference Guide.
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Chapter 7. Managing Metadata

Metadata in Talend Open Studio for Data Integration is definitional data that provides information about or
documentation of other data managed within Talend Open Studio for Data | ntegration.

This chapter provides procedures to create and manage various metadata items that can be used in all your job
designs.

Before starting any metadata management processes, you need to be familiar with Talend Open Sudio for Data
Integration Graphical User Interface (GUI). For more information, see Appendix A, GUI.
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7.1. Objectives

The M etadata folder in the Repository tree view stores reusable information on files, databases, and/or systems
that you need to build your Jobs.

Various corresponding wizards hel p you store these pieces of information and use them later to set the connection
parameters of the relevant input or output components, but you can also store the data description called “ schemas”
in Talend Open Sudio for Data Integration.

Wizards procedures slightly differ depending on the type of connection chosen.

Click Metadata in the Repository tree view to expand the folder tree. Each of the connection nodes will gather
the various connections and schemas you have set up.

{1 Repositary £2 = 0O
SalaE
+-{LF Business Models L
+1iy Job Designs
+ Contexts
+ Code
+ _r S0L Templates

L-ﬂ Metadata
=-#§ll Db Connections
+- ] demaMysgl 0.1
+-J§0 Talend_MysoL 0.1
+-J§l Talend_Cracle 0.1
=-§] File delimited
+ D agg_resulk 0.1
= El cars 0,1

=0 Columns{5)

Colar

ID_Owners

ID_Reseller

Make

Reqgiskration

+ El customer 0,1 w

I 0011 O08 OO0 O

From Talend Open Sudio for Data Integration, you can set up the following, amongst others:
+ aDB connection,

* aJDBC schema,

* aSAS connection,

+ afile schema,

* an LDAP schema,

+ asalesforce schema,

 ageneric schema,

* aMDM connection,

* aWSDL schema,
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» aFTP connection,

The following sections explain in detail how to set up different connections and schemas.

7.2. Setting up a DB connection

If you often need to connect to database tables of any kind, then you may want to centralize the connection
information details in the M etadata folder in the Repository tree view.

3 You can aso set up a DB connection the same way by clicking the Hicon in the Basic settings view
of al input and output DB components.

7.2.1. Step 1. General properties

The creation procedure is made of two separate but closely related operations.

1. First expand Metadata in the Repository tree view and right-click Db Connections and select Create
connection from the pop-up menu.

2. In the connection wizard that opens up, fill in the generic Schema properties such as Schema Name and
Description. The Statusfield is a customized field you can definein Window > Prefer ences.

# Database Connection |:|®

Mew Database Connection on repository - Step 1/2

Define the properties ﬁi

Mame | CuskomersDEschemas |

Purpose | |

Description

Author

Locker

|

| |
Version | "E]

|

|

Stakus o |

Path " Select ]

ﬁ
@

3. Click Next when completed. The second step requires you to fill in DB connection data.
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7.2.2. Step 2: Connection

1. Select the type of the database to which you want to connect and some fields will be available/unavailable
according to the DB connection detail requirements.

# Database Connection |:||E| E|

MNew Database Connection on repository - Step 2/2
@ You must press the Check Butkon to check the Database Setting ﬁi

Database Settings
DB Type | Mys0L v|

Db Yersion MyS0L S v

| jdbc:mysql:f fkalend-dbms: 3306/t alend P noDatetimeString3ync=true

Login | rook
Password | sene
Port | 3306
DataBase | talend

Additional parameters | noDatetimestringSync=true

|
|
|
Setver | talend-dbrns |
|
|
|
|

Database Properties

SOL Synkax
Skring Quotke m Mull Char

Export as Conkext

® Einish ] [ Cancel

When you are creating the database connection of some databases like AS400, HSQDB, Informix,
¥ MsSQL, MySQL, Oracle, Sybase, or Teradata, you can specify additional connection properties
through the Additional parametersfield in the Database Settings area.
2. Fill inthe connection details and click Check to check your connection.
In order to be able to retrieve al table schemasin the database:

-enter dbo in the Schema field if you are connecting to MSSQL 2000,

-remove dbo from the Schema field if you are connecting to MSSQL 2005/2008.
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setup, click Finish to validate.

Fill in, if need be, the database properties information. That is all for the first operation on DB connection

The newly created DB connection is now available in the Repository tree view and displays four folders
including Queries (for SQL queriesyou save) and Table schemas that will gather all schemas linked to this

DB connection.

# Repository X

Mavigakar

= B

LOZaL: component

= Lﬁ Metadata
=-J§ll Db Connections
81 ClientDs 0.1
1 oDEC 0.1

Queries
] SYnNonymnm |

3 Yiew schei
157 Orders0.1
ﬂ'] Sales 0.1
[ Talend-DBMS 0.5

Bl | & |87

= ﬂ'l M] Edit connection

7

7 Tahle sche 9" Open queties

E Retrieve Schema

~

Edit queries

Delete

Chrl+iZ

4.

Right-click the newly created connection, and select Retrieve schema on the drop-down list in order to load

the desired table schema from the established connection.

An error message will display if there are no tables to retrieve from the selected database or if you

-z

7.2.3. Step 3: Table upload

do not have the correct rights to access this database.

When you click Retrieve Schema, a new wizard opens up where you can filter and display different objects
(tables, views and synonyms) in your database connection.

For the time being, synonyms option works for Oracle, IBM DB2 and MSSQL only.

Talend Open Studio for Data Integration User Guide

213



Step 3: Table upload

% Schema |:|@E]
Filker For the Table, @

Select Filker Conditions
() Use the Mame Filter () Use the Sql Filker

Select Tvpes
TABLE YIEW SYMOMNYM

[C]aLL_symorm

Set the Mame Filker:

T e

Edit...

Remove...

Jid

':':’:' uext = | [ Einish ] [ Zancel

In the Select Filter Conditions area, you can filter the database objects using either of the two options: Set the
Name Filter or Usethe Sql Filter through filtering on objects names or using SQL queries respectively.

To filter database objects using their names, do the following:
1. Inthe Select Filter Conditions area, select the Use the Name Filter option.
2. Inthe Select Typesarea, select the check box(es) of the database object(s) you want to filter or display.

Available options can vary according to the selected database.
¥

3. Inthe Set the Name Filter area, click Edit... to open the [Edit Filter Name] dialog box.

4. Enter thefilter you want to use in the dialog box. For example, if you want to recuperate the database objects
which names start with “A”, enter the filter “A%”", or if you want to recuperate all database objects which
names end with “type”, enter “%type” asyour filter.

5. Click OK to close the dialog box.

6. Click Next to open anew view on the wizard that lists the filtered database objects.

To filter database objects using an SQL query, do the following:

1. Inthe Select Filter Conditions area, select the Use Sql Filter option.

2. Inthe Set the Sgl Filter field, enter the SQL query you want to use to filter database objects.
3. Click Next to open anew view that lists the filtered database objects.

Once you have thefiltered list of the database objects (tables, views and synonyms), do the following to load
the schemas of the desired objects onto your repository file system:
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Select Schema ko create
Mame Filker; |
Marne Type Column number | Creation staktus
|:| executionvirtualserver _executionserver TAELE
[] extract TAELE
Familiestype TAELE & SuCCess
Farnily TAELE 3 SuCCess
[] Featuresls TAELE
[] Filetriggermask, TAELE
Filcer TAELE 4 SuCCess
] Flowmeterz10 TAELE
[] Flowmneterlog TAELE
[] Formattype TAELE
[] headertvpe TAELE
[] helene TAELE
|:| implicikcontextsettings TABLE
[ ] importstype TAELE
[] importtype TAELE
[] infobright_result TAELE
] information TAELE
[ ] input TAELE
[] instaltvpe TAELE
[ item TAELE
£ |
Select Al | Select Mone | | Check Connection
':':’:' < Back ” Mextk =
e

1. Select one or more database objects on the list and click Next to open a new view on the wizard where you
can see the schemas of the selected object.

If no schema is visible on the list, click the Check connection button below the list to verify the
¥ database connection status.
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schema "
HEN Familiestype
fFamiliestype
Farnily Comment
filker
Type
Based on table Retrieve Schemal lGuess Schemal
Schema
Colurmn Db Column Key DBTwpe = Type w| M.. DateP...
Gl eid e_id EIGINT  lang [
dtype dtype [] “aRCHAR  Skring F
e_version B _version |:| INT ink |:|
econtainer...  econtainer_class |:| VARCHAR  Skring
e_container | &_conkainer [] “aRCHAR  String
e_conkain... e_container_F... |:| INT Integer
< >
£
Add Schema ~
[ saasons
@ Finish H Cancel

2. Modify the schemas if needed and then click Finish to close the wizard.

The schemas based on the selected tables are listed under the Table schemas folder corresponding to the

database connection you created.

In Java, make sure the data type in the Type column is correctly defined.

For more information regarding data types, including date pattern, check out http://docs.oracle.com/

javase/6/docs/api/index.html.

7.2.4. Step 4: Schema definition

By default, the schema displayed on the Schema panel is based on the first table selected in the list of schemas
loaded (left panel). Y ou can change the name of the schema and according to your needs, you can also customize

the schema structure in the schema panel.

Indeed, the tool bar allows you to add, remove or move columnsin your schema. In addition, you can load an xml

schema from afile or export the current schema as xml.

To retrieve a schema based on one of the loaded table schemas, select the DB table schema name in the drop-
down list and click Retrieve schema. Note that the retrieved schemathen overwrites any current schemaand does

not retain any custom edits.
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Setting up a JDBC schema

Click Finish to complete the DB schema creation. All the retrieved schemas are displayed in the Table schemas
sub-folder under the relevant DB connection node.

7.3. Setting up a JDBC schema

For DB table based schemas, the creation procedure is made of two separate but closely related operations. First
right-click Db Connections and select Create connection on the pop-up menu.

7.3.1. Step 1: General properties

Fill in the schema generic information, such as Schema Name and Description.

For further information, see Section 7.2.1, “Step 1. Genera properties’.

7.3.2. Step 2: Connection

1. Select thetype of Database you want to connect to and fill in the DB connection details.
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% Database Connection

Mew Database Connection on repository - Step 2/2
@ ¥ou must press the Check Button to check the Database Setking %i

Dakabase Settings

DB Type | General JDEC " |

IDEC URL | jdbcimeesql: ffkalend-dbms: 35306, alend |

Diriver jar | CaMySQLMySOL Toals For 5,00 javaliblmysgl-connectar-java-5.l | B

Class name | com.mysgl. jdbe. Driver |

User name | rook |

Password | k| |

Mapping file | | B

| Check.

Dakabase Properties

SGL Synkax
Skring Quoke |I| rull Char

(%) Standard S0L Statement () System SOL Skatement

':':’:' Finish l [ Cancel

2. Fill in the connection details below:

Fill in the JDBC URL used to access the DB server.

Inthe Driver jar field, select the jar driver validating your connection to the database.

In the Class name field, fill in the main class of the driver allowing to communicate with the database.
Fill in your User name and Passwor d.

Inthe Mapping Filefield, select the mapping allowing the DB Type to match the Javatype of dataon the
schema. For example: the DB Type VARCHAR corresponds to the String Type for Java.

The Mapping files are XML files that you can access via Window > Preferences > Talend >

¥ M etadata of TalendType.

3. Click Check to check out your connection.

4. Fill in, if need be, the database properties information. That is all for the first operation on DB connection
setup, click Finish to validate.
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The newly created DB connection is now available in the Repository tree view and it displays four folders
including Queries (for the SQL queries you save) and Table schemas that will gather al schemas linked
to this DB connection.

|§| Repository X Mavigakar =0

LOiCAL: component = ,:gh |£E| ~

= L'.'E Metadata A
=}l Db Connections
[ ClientDE 0.1
[ oDBC 0.1
=Rl M‘ Edit connection
Queries | )
(3 Synonym | &7 Edit queries
7 Tahle sche 9" Open queties

(IR W = Retrieve Schema
Wl Orders 0.1 | 3¢ Delete Delete
W’l Sales 0.1 = Copy Chrl4C
[ Talend-DEMS 0. —
3 >

5. Right-click the newly created connection, and select Retrieve schema on the drop-down list.

7.3.3. Step 3: Table upload

A new wizard opens up on the first step window. The List offers all tables present on the DB connection. It can
be any type of databases.

Select one or more tables on the list, to load them onto your repository file system. Y ou will base your repository
schemas on these tables.

If no schemaisvisible on thelist, click Check connection, to verify the DB connection status.
Click Next. On the next window, four setting panels help you define the schemas to create.

In Java, make sure the data type is correctly defined. For more information regarding data types, including date
pattern, check out http://docs.oracle.com/javase/6/docs/api/index.html.

7.3.4. Step 4: Schema definition

By default, the schema displayed on the Schema panel is based on the first table selected in the list of schemas
loaded (left panel). Y ou can change the name of the schema and according to your needs, you can also customize
the schema structure in the schema panel.

Indeed, the tool bar allows you to add, remove or move columnsin your schema. In addition, you can load an xml
schema from afile or export the current schema as xml.

To retrieve a schema based on one of the loaded table schemas, select the DB table schema name in the drop-
down list and click Retrieve schema. Note that the retrieved schemathen overwrites any current schemaand does
not retain any custom edits.
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Click Finish to complete the DB schema creation. All the retrieved schemas are displayed in the Table schemas
sub-folder under the relevant DB connection node.

7.4. Setting up a SAS connection

Talend Open Sudio for Data Integration enables you to configure a connection to aremote SAS system.

7.4.1. Prerequisites

Before carrying on the below procedure to configure your SAS connection, make sure that you retrieve your
metadata from the SAS server and export it in XML format.

7.4.2. Step 1: General properties

1. Inthe Repository tree view of Talend Open Sudio for Data Integration, expand M etadata and then right-
click DB Connections.

2. Select Create connection from the contextual menu to open the [ Database Connection] wizard.

3.  Fill in schema generic information, such as Name and Description and click Next to open a new view on
the wizard.

For further information, see Section 7.2.1, “ Step 1: General properties’.

7.4.3. Step 2: Connection

1. Inthe DB typefieldin the [Database Connection] wizard, select SAS and fill in the fields that follow with
SAS connection information.
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* Database Connection ,-_ @@

New Database Connection on repository - Step 2/2
@ ¥ou must press the Check Button to check the Database Setking

v

Database Settings

DE Type | 543

Skring of Conneckion | jdbeisasionn: fflocalhost: 7070/ test

Sdditional parameters | noDaketimestring3ync=true

|
Login | [fululs |
Password | T |
Server | localhiost |
Port | 7070 |
Database | kest |
Schema | |

|

| Check, |

Database Properties

S0 Svntax
Skring Quoke |I| rull Char

Export as Conktext Rewvert from Conkexk

@ Mext = L_Einish J [ Cancel

If needed, click the Check tab to verify if your connection is successful.

If needed, define the properties of the database in the corresponding fields in the Database Properties area.

Click Finish to validate your changes and close the wizard.

Thenewly set connection to the defined database displays under the DB Connectionsfolder inthe Repository
tree view. This connection has four sub-folders among which Table schemas can group al schemasrelative

to this connection.
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= Lﬁ Metadata
=-}§ll Db Connections
L coe
> Wi
O Lock
[ [ Edit conmection
=0 &7 Edit queries

&d” Read queries

£ Retrieve Schema From 545

EH Retrieve Schema

&F SAP Lo
- 5 Simulate impack analysis
B File de & P ¥

@ File po qﬁh Manage Dependencies
# File rer 3¢ Delete
File xn 2 Copy

e
|:=| Duplicate N\ =

35 Outline &3
ligl Expott items -

kSasInput_1 ("F
ESasOutput_1 (PRIMANT)

5.  Right-click the SAS connection you created and then select Retrieve Schema from SAS to display al
schemas in the defined database under the Table schemas sub-folder.

7.5. Setting up a File Delimited schema

File Delimited metadata can be used to define the properties of tFilelnputDelimited and tFilel nputExcel
components.

The file schema creation is very similar for al types of file connections: Delimited, Positional, Regex,
¥ Xml, or Ldif.

In the Repository tree view, right-click File Delimited, and select Create file delimited on the pop-up menu.

= Lﬁ Metadata
I§J Db Connections
EF SAP Connections
5
& Fil B create file delimited
EI Fil ﬁ_? Import connections From CSY

<4 Fil
!' [ Create Falder
@ Fil

Fil, 4@ Impart items
LD @ Export items
© Salesforce

Unlike the DB connection wizard, the [New Delimited File] wizard gathers both file connection and schema
definitions in afour-step procedure.

7.5.1. Step 1: General properties

In the first step, fill in the schema generic information, such as Schema Name and Description.
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Step 2: File upload

For further information, see Section 7.2.1, “ Step 1: General properties’.

7.5.2. Step 2: File upload

Definethe Server |P address where the fileis stored. And click Browse... to set the File path.

# New Delimited File X

File - Step 2 of 4
Add a Metadata File on repository D

Define the path of the file and the Format settings

File Settings

el ocalhost 127.0.0.1 v

File C: InputfCars,csy

Farmak | LU= w
File Yigwer
ID_Owwners;Reg_Car;Make; Color;ID_Reseller ”

1;1301 DD 05; Citroen; gold; 38

22300 ZP 14;Citroen;blue; 66

34122 JI 74;Renault;yvellow; 6a

43395 QP 05;Citroen; yelow;51

5;0029 OF 61;Toyoka;red; 37

64287 YU 44; Citroen; blue; 43

717119 CQ 97 ;Honda; yelow; 39

3;3764 PA 47;Renault;orange; 100

9:9939 CJ 88;Mercedes;red; 71 w

(@ < Back ” Mesxk =

Select the OS For mat the file was created in. Thisinformation is used to prefill subsequent step fields. If the list
doesn’t include the appropriate format, ignore it.

TheFileviewer givesan instant picture of thefileloaded. It allows you to check the file consistency, the presence
of header and more generally the file structure.

Click Next to proceed to Step3.

7.5.3. Step 3: Schema definition

On this view, you can refine your data description and file settings. Click the squares below, to zoom in and get
more information.
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# New Delimited File X

File - Step 3 of 4

Add a Metadata File on repositary ;Il
Define the setking of the parse job

File Settings Rows To Skip
Encoding |US-ASCTI v IF any rows must be ignored, specify the Following parameters
Header & o
Field length Sernicalon w | Corresponding Character | ; ]
Foot h’
Row Separator | Standard ECL w n soter []

[ 5kip emphy row

Escape Char Settings Lirnit OF Rans
csy (%) Delimited If the number of lines must be limited, specify this number
Limit [ v
Preview
Set heading row as column names | Refresh Preview
id  CustomerMame Customerfddress idReseller  Make  ReqgTime Column & Colunn #
1 qGriffith Paving and Sealcoatin 355 Golf Rd, 7 1 03/11/1991 09:20  1973-01-17 06:26:40.000 67852,
2  Bill's Dive Shop 511 Maple Awve, Apt, 1E 35 1 19/11/1954 15:43 2010-06-07 09:40:00,000 38792,
3 Childress Child Day Care 662 Lyons Circle 39 1 16/02/1981 08:27  1990-04-01 21:00:00.000 35340,
4 Facelift Kitchen and Bath 220 Vine Ave, 41 1 Z22/08/2010 09:55  1972-04-23 18:00:00.000 &097.6
5 Terrinni & Son Auto and Truck 770 Exmoor Rd, 5 1 28/06/1995 09:15  1952-04-19 10:26:40.000 S146.5
& Kermit the Pet Shop 1860 Parkside Ln. 28 1 17008/2009 10:07  1991-05-27 17:00:00.000 16037,
7 Tub's Furniture Stare 807 old Trail Rd. 15 1 27/08/1976 03:13  1970-03-27 23:08:16.000 53216,
8 Toggle & Myerson Lkd 613 Sheriden rd. ] 1 24§03{2008 23:07  1951-05-02 01:26:40.000 74168,
e i S e . - j g e
£

@ l < Back ” Mext = ]

Set the Encoding, as well as Field and Row separatorsin the Delimited File Settings.

File Settings

Encoding 115-A5CT1 .
Field lzngth Sermicalan % | Corresponding Character | ;

Row Separator | Standard ECL v I

Escape Char Settings
(%) Cay () pelimited
Escape Char  |Empky

Text Enclosure |Empky W

Depending on your file type (csv or delimited), you can also set the Escape and Enclosure characters to be used.

If thefile preview shows a header message, you can exclude the header from the parsing. Set the number of header
rows to be skipped. Also, if you know that the file contains footer information, set the number of footer lines to
be ignored.
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Step 4: Final schema

Rows Ta Skip

If amy rows must be ignored, specify the following parameters
He:ader 3 v
Fooker [ b

[ ]3kip empty raw

Limnit CiF Rowws

If the number of lines must be limited, specify this number

Limit [ -

The Limit of rows alows you to restrict the extend of the file being parsed.
In the File Preview panel, you can view the new settings impact.

Check the Set heading row as column names box to transform thefirst parsed row aslabelsfor schema columns.
Note that the number of header rows to be skipped is then incremented by 1.

Prewvigw

Set heading row as column names | Refresh Preview
ID  Registration  Make Color | Reseller I Mame Insurance
1 57762094 Yolkswagen  gold 7 monkmont KW 2544
3 FEE0TT 77 Renault aorange 1 bouhman  BMUS147
A 1992 WE 14 ke, FaH Ry in kivkl~ TCOLISSESM

Click Refresh on the preview panel for the settings to take effect and view the result on the viewer.

7.5.4. Step 4: Final schema

The last step shows the Delimited File schema generated. You can customize the schema using the toolbar
undernesath the table.
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Setting up a File Positional schema

# New Delimited File X]

File - Step 4 of 4

Add a Schema on repository D
Define the Schema

Mame | metadata

Commenk |

Schema

Click to update sch i
jick o update schema prewew| Cless |
Descripkion af the Schema
Zolurmn Key | Type mullable | Length Preci. . v ZOmm,,
I [D_Ovrers I:I__--_
Req_Car Skring
Make |:| Skring 1III
Color [] string &
ID_Reseller ] int 3
#)(x)2)(e) (=) & ()«

':?:' Finish ] [ Cancel

If the Delimited file which the schema is based on has been changed, use the Guess button to generate again the
schema. Note that if you customized the schema, the Guess feature does not retain these changes.

Click Finish. The new schemais displayed under the relevant File Delimited connection node in the Repository
tree view.

For further information about how to drop component metadata onto the workspace, see Section 4.2.2.2, “How
to drop components from the Metadata node”

7.6. Setting up a File Positional schema

In the Repository tree view, right-click the File Positional node and select Create file positional on the pop-
up menu.
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Step 1: General properties

EF SAP Connections

[ File delimited

W File positional

E] ST [ Create file positional
File xml 79 craate folder

2| Fi

D File Excel IF_-*.EI Impart ikems

File Idif _
LDAP REI, Expoart items

S Salesforce

Proceed the same way asfor the file delimited connection. Right-click M etadata in the Repository tree view and
select Createfile positional.

7.6.1. Step 1. General properties

Fill in the schema generic information, such as Schema Name and Description.

7.6.2. Step 2: Connection and file upload

Then define the positional file connection settings, by filling in the Server |P address and the File path fields.

Likefor Delimited File schema creation, the format is requested to pre-fill the next step fields. If thefile creation
OSformat is not offered in thelist, ignore thisfield.

¥ Mew Positional File @

File - Step 2 of 4
Add a Metadata File on repository:
Define the path of the file and the Format settings

File Location Settings

Setver | ot |

File | i Inputfrave. head | [Bru:uwse... l

Forrnat | LNEX w

Thefile viewer shows afile preview and allows you to place your position markers.
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Step 3: Schemarefining

File Wigwer
5 10 15 20 25 a0 35 40 45 S0 55
..... R I IV A At RN PO : P IV A . IR I
25 13 11 I I
000048200503 2030708847 015 -0000007&49306-000007900T( L

0001082005033597670011292-0000000%6000-0000065000
0000172005032030708846752-000005140270-00000435000
00004582005032030708847759-000003993560-0000035000
0000322005032030708845274-000001032030-0000020000
0001022005032030708845311-000001248220-0000018000
0001042005032030708847063-000000103710-0000015000

AANaNA2AONCA2N2A7No0ACH1 o7 nnnnnonCnncn aonnnnd 2non

Field length 25,13,11,*

Marker position | 25,345,493

Click thefile preview and set the markers against the ruler. The orange arrow helps you refine the position.

The Field length field lists a series of figures separated by commas, these are the number of characters between
the separators. The asterisk symbol means all remaining characters on the row, starting from the preceding marker
position.

TheMarker Position showsthe exact position of the marker on theruler. Y ou can changeit to specify the position
precisely.

Y ou can add as many markers as needed. To remove amarker, drag it towards the ruler.

Click Next to continue.

7.6.3. Step 3: Schema refining

The next step opens the schema setting window. As for the Delimited File schema, you can refine the schema
definition by setting precisely the field and row separators, the header message lines and more...

At this stage, the preview shows the file delimited upon the markers’ position. If the file contains column labels,
select the check box Set heading row as column names.

7.6.4. Step 4: Finalizing the end schema

Step 4 shows the end schema generated. Note that any character which could be misinterpreted by the programis
replaced by neutral characters. Underscores replace asterisks, for example.

Y ou can customize the metadata name (by default, metadata) and edit it using the tool bar.

You can also retrieve or update the Positional File schema by clicking on Guess. Note that, however, any editsto
the schema might be lost after “guessing” the file-based schema.

The new schemais displayed under the relevant File positional connection node in the Repository treeview. You
can drop the defined metadata from the Repository onto the design workspace. A dialog box then opensin which
you can choose which component to use in your Job.
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Setting up a File Regex schema

7.7. Setting up a File Regex schema

Regex file schemas are used for files which contain redundant information, such aslog files.

E File positional

x| File | 9 create folder

File | L5zl Import items
LDAl -

Lyl Export items

) Sale

Generic schemas

Proceed the same way as for the file delimited or positional connection. Right-click M etadata in the Repository

tree view and select Createfile regex.

7.7.1. Step 1. General properties

Fill in the schema generic information, such as Schema Name and Description.

7.7.2. Step 2: File upload

Then define the Regex file connection settings, by filling in the Server |P address and the File path fields.

File Settings

Server | Localhost 127.00.1

File Ci/Users/fhensaid/Desktop/regex.bd

Format | WINDOWS

File Viewer

firstname=Michael lastname=Jackson age=42
firstname=Elisa lastnarne=Do Brasil age=28
firstname=Michel lastnarme=Dujardin age=26
firstname=Robert lastname=Partou age=56
firstname=Diana lastname=Melbourne age=34
firstname=Marie lastnarme=Delvina age=46
firstname=Jean lastname=Perfide age=59
firstname=Emilie lastname=Taldor age=21
firstname=Anne-Laure lastname=Paldufier age=67

4

Browsze...

m

Like for Delimited File schema creation, the format is requested for pre-fill purpose of next step fields. If thefile

creation OS format is not offered in the list, ignore thisfield.

Thefile viewer gives an instant picture of the loaded file. Click Next to define the schema structure.
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Step 3: Schema definition

7.7.3. Step 3: Schema definition

This step opens the schema setting window. As for the other File schemas, you can refine the schema definition
by setting precisely the field and row separators, the header message number of lines and else...

Inthe Regular Expression settings panel, enter the regular expression to be used to delimit thefile.

Regular Expression settings

"*Mirstnarme=(.+?)lastname={.+age=\\d+)5" e

Make sure to include the Regex code in single or double quotes accordingly.
&8

Then click Refresh preview to take the changes into account. The button changes to Wait until the preview is
refreshed.

Preview | Output

Set heading row as colurmn names | Refresh Preview

Colurnn 0 Column 1 Colurnn 2
Michael lackson 42
Eliza Do Brasil 28
Michel Dujardin 26
Robert Partou 56
Diana Melbourne 34
Marie Dolvina 15

Click Next when setting is complete. The last step generates the Regex File schema.

7.7.4. Step 4: Finalizing the end schema

Y ou can add a customized name (by default, metadata) and edit it using the tool bar.

You can also retrieve or update the Regex File schema by clicking on Guess. Note however that any edits to the
schemamight be lost after guessing the file based schema.

Click Finish. The new schemais displayed under the relevant File regex connection node in the Repository tree
view.

For further information about how to drop component metadata onto the workspace, see Section 4.2.2.2, “How
to drop components from the Metadata node”.

7.8. Setting up an XML file schema

Centralize your XPath query statements from adefined XML file and gather the values retrieved from it.
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Setting up an XML schemafor aninput file

Thisis done in the same way as for the connection of delimited or positional files.

According to the option you select, the wizard helps you create either an input or an output schema
In a Job, the tFilelnputXML component uses the input schema created to read XML files, whereas
tAdvancedFileOutputXML uses the output schema created to either write an XML file, or to update an existing
XML file.

Step 1, in which you enter the general properties of the schemato be created, precedes the step at which
¥ you set the type of schema as either input or output. It is therefore advisable to enter names which will
help you to distinguish between your input and output schemas.

For further information about reading an XML file, see Section 7.8.1, “Setting up an XML schema for an input
file".

For further information about writing an XML file, see Section 7.8.2, “ Setting up an XML schema for an output
file".

7.8.1. Setting up an XML schema for an input file

This section describes how to define and upload an XML schemafor an input file. To define and upload an output
file, see Section 7.8.2, “ Setting up an XML schema for an output file”.

7.8.1.1. Step 1: General properties

In this step, the schema metadata such as the Name, Pur pose and Description are set.
1. Inthe Repository view, expand the M etadata node.

2. Rightclick File XML, and select Create file XML from the pop-up menu.
File LI ¥ Create folder
LDAP Expand/Collapse

‘ié') Salesi lsg) Import items
Genel

= (el Export items
| ITaIen_LE‘rj'

3. Enter the generic schemainformation, such asits Name and Description.
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Setting up an XML schemafor aninput file

# New Xml File (=13
File -Step 1 of 5

#dd a File metadata on repository, Define the @
properties,

Marme: | XMLCustDmers|

Purpose |

Description

Authior

Locker

|
|
Version | ||E]
|
|

Status

Path

@ [ <o

4. Click Next to select the type of schema.

7.8.1.2. Step 2: Setting the type of schema (input)

In this step, the type of schemais set as either input or output. For this procedure, the schema of interest isinput.

1. Inthediaog box, select Input XML.

¥ New Xml File

File - Step 2 of 5

Select input or ouktput model to create XML metadata @
conneckion

Select one model ko create XML metadata

(%) Input XML
) OutPUE ML

@ [ < Back H Mext = Finish

2. Click Next to upload the input file.
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Setting up an XML schemafor aninput file

7.8.1.3. Step 3: Uploading the input file

This step involves selecting the input file, its encoding type and defining the number of columns on which the
XPath query is to be run. You can aso preview the structure of the selected input file, which can be an XML
file or an XSD file.

If you load an XSD file,

 thedatawill be saved inthe Repository, and therefore the metadatawill not be affected by the deletion
or displacement of thefile.

 you can choose an element as the root of your XML tree.
To upload an XML file, do the following:

1. Click Browse... and browse your directory to the XML file to be uploaded. Alternatively, enter the access
path to thefile.

The Schema Viewer area displays a preview of the XML structure. You can expand and visualize every
level of thefile's XML tree structure.

File -Step 3 of 5

#dd a File metadata on repository,
Define the path of the file and the Format sektings,

File Settings
wL L Inputcuskamer, xml
Encoding | I50-85859-15 * | Limit | 0

Schema Yiewer

[=)- cuskamer
i@id
Zuskameriame
Customer dddress
idskake
idz

@

2. Enter the Encoding typein the corresponding field if the system does not detect it automatically.

3. IntheLimit field, enter the number of columns on which the XPath query isto be executed, or O if you want
torunit against all of the columns.

4. Click Next to define the schema parameters.

To upload an XSD file, do the following:
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Setting up an XML schemafor aninput file

1. Click Browse... and browse your directory to the XSD file to be uploaded. Alternatively, enter the access
path to thefile.

2. Inthediaog box the appears, select an element from the Root list astheroot of your XML tree, and click OK.

Root | customers

[ OK H Cancel ]

The Schema Viewer area displays a preview of the XML structure. You can expand and visualize every
level of thefile’'s XML tree structure.

% New Xml File H=1E3

File - Step 3 of 5

Add a Metadata File on repository @
Define the path of the file and the format settings

File Settings
XML |D:.."talenu:l_ﬁlesﬁnput,."u:ustu:umer.xsd | [Browse... |
Encoding | UTF-3 v | Lmit [0

Schema Viewer

= customers
= customer
Customeriame
CustomerAddress
idstate
id2
@id

|

@

3. Enter the Encoding typein the corresponding field if the system does not detect it automatically.

4. IntheLimit field, enter the number of columns on which the XPath query isto be executed, or O if you want
to runit against all of the columns.

5. Click Next to define the schema parameters.

7.8.1.4. Step 4: Defining the schema

In this step the schema parameters are set.
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Setting up an XML schemafor aninput file

# New Xml File =3

File - Step 4 of 5

#dd a File metadata on repository, Define the setting of the parsed job,
Source Schema Target schema
[= customers ¥path loop expression
[=]- cuskamer ) e
@id Absoluke ¥Path expression Loop lirmit
Customerame a0 E
Customeraddress
idskate
idz Figlds to extract
Relative or absolute ¥Path ex... | Colum..,
Presiew | Cukput File Viewer

<vxml wersion="1.0" encoding="130-3359-1
Refresh Preview <Cuskomers=

<cusktomer id="1"=

<Custamerianme =&riffich Paving and Sealco.
<_usktomeraddress =talendi@apres91 </iCust
«idSkate =7 «<[idSkate =

<id2 =41 < fid2 =

< Jfoustomer =

“cusktomer id="ab"»

<CustomerMame =Billfapos;s Dive Shop</Cy
<CustomerAddress =511 Maple Awve, Apt. 11
<idSkate =35 <idState =

<idZ2 =5=<id2 =

4

Export as Context

@ T T

The schema definition window is composed of four views:

View Description

Sour ce Schema Tree view of the XML file.

Target Schema Extraction and iteration information.

Preview Preview of thetarget schema, together with the input data of the

selected columns displayed in the defined order.

The preview functionality isnot availableif you loaded
s an XSD file.

File Viewer Preview of the brute data.

First define an Xpath loop and the maximum number of times the loop can run. To do so:
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1. Populate the XPath loop expression field with the absolute XPath expression for the node to be iterated
upon. There are two waysto do this, either:

« enter the absolute X Path expression for the node to be iterated upon (Enter the full expression or press
Ctrl+Space to use the autocompletion list),

or
« drop anode from the tree view under Sour ce schema onto the Absolute XPath expression field.

An orange arrow links the node to the corresponding expression.

Source Schema Target schema
=l cusktomers ¥path loop expression

=|- cuskomer . e
@id Absoluke ¥Path expression Loop limit
Customerame [ftuskomers customer fidSkate 50
Customeraddress
idskate
idz Figlds to extract

The Xpath loop expression field is mandatory.

2. IntheLoop limit field, specify the maximum number of times the selected node can be iterated.

Next, it is necessary to define the fields to be extracted. To do so:

1. Drop the node(s) of interest from the Sour ce Schema tree onto the Relative or absolute XPath expression.
You can select several nodes to drop on the table by pressing Ctrl or Shift and clicking the nodes

¥ of interest. The arrow linking an individual node selected on the Sour ce Schema to the Fields to
extract table are bluein colour. The other ones are gray.

Source Schema Target Schema
= cuskomers ¥path loop expression

=|- custamer . e
@id Absolute XPath expression Loop lirmit
Customerhlame fouskomers)cuskamet fidskake 50
Customeraddress
idskake
idz Fields to extract

Relakive or absoluke ¥Path expression | Caolumn Mame
. JCustomeriame CustomerMare

2. If needed, you can add as many columns to be extracted as necessary, delete columns or change the column
order using the toolbar:

Add or delete acolumn using the. ™ and . % puttons.

Change the order of the columns using the . i ~and i buttons.
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Setting up an XML schemafor aninput file

Source Schema

Target schema

=l cusktomers ¥path loop expression
=|- cuskamer . e
@id Absolute XPath expression Loop limit
Customeriame [frustomers customer fidstate 50
Customeraddress
idskate
idz2 Fields to extract

Relative or absolute ¥Path expression
- JCustomerianme

Column Mame
Customeriame

3. Inthe Column namefields, enter labels for the columns to be displayed in the schema Preview area.

4. Click Refresh Preview to display a preview of the target schema. The fields are consequently displayed in

the schema according to the defined order.

The preview functionality is not available if you loaded an XSD file.

Preview | Output

Refresh Preview

Preview successful...

CustomerMame CustomerAddress

Griffith Paving and Sealcoatin talend @apress i

Bill's Dive Shop 511 Maple Ave, Apt. 1B
Childress Child Day Care &62 Lyons Circle
Facelift Kitchen and Bath 220 Vine Ave,

5. Click Next to finalize the end schema.

File Viewer

<?uml version="1.0" encoding="UTF-8"7>
<customers >
<customer id="1"=
<CustomerMame =Griffith Paving and Sealcoatin</CL
<CustomerAddress »talend @apres? 1< /CustomerAd
<idState »7</idState =
<id2=2011<fid2>
< fcustomer =
<customer id="2"=
<CustomerMame =EBill's Dive Shop</CustomerMame =

7.8.1.5. Step 5: Finalizing the end schema

The schema generated displays the columns selected from the XML file. Y ou can customize the schema according
to your needs, or reload the original schema using the Guess button.
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¥ New Xml File

File - Step 5 of 5

&dd a Schema on repositary
Marmne | rmekadata

Corment |

achema

Click to update schema preview
e

Description of the Schema

Calurnn kKey Twpe M., DatePattern ... Length  Precision  Defaulk Comment
CuskomerMamme |:| Skring 0
Columni [] string 4 0

@:‘ Finish ] [ Cancel

1 o .
Click the. ™ and. % buttonsto add or delete selected columns.
5 . .
Click the i and. i . buttons to modify the order of the columns.
3. Click Finish.

The new schema, along with it columns, appears under the File XML node in the Repository tree view.

7.8.2. Setting up an XML schema for an output file

This section describes how to define and upload an XML schemafor an output file. To define and upload an XML
schemafor an input file, see Section 7.8.1, “ Setting up an XML schema for an input file”.

7.8.2.1. Step 1: General properties

In this step, the schema metadata such as the Name, Pur pose and Description are set.

1. IntheRepository view, expand the M etadata node.
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Setting up an XML schemafor an output file

2. Rightclick File XML, and select Create file XML from the pop-up menu.
2 i xap
= rie o
File LI C¥ Create folder

LDAP Expand/Collapse
© Salesd (g Import items

_EEI'-IE' L]B Export items
=| Talenl

3. Enter the generic schemainformation, such asits Name and Description.

# New Xml File |:|[E

File - Step 1 of 5
Add a File metadata on repository, Define the properties,
Marme | MNewsML_Cubput |
Purpose | |
Description |
Author | |
Locker | |
Version | "E]
Skatus | o |
Fath | " Select ]
@ [ <o

4. Click Next to set the type of schema.

7.8.2.2. Step 2: Setting the type of schema (output)

In this step, the type of schemais set as either input or output. For this procedure, the schema of interest is output.

1. Fromthedialog box, select Output XML.
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# New Xml File M=1E3

File - Step 2 of 5

Select inpuk of oukput model ko create XML metadata
cannection

Select one model ko create XML metadata

) Input: ¥ML
(%) OutPUE XML

@:l [ < Back ” Mext =

2. Click Next to define the output file.

7.8.2.3. Step 3: Defining the output file

Y ou can choose whether to create your file manually or from an existing file. If you choose the Cr eate manually
option you will have to configure your schema, source and target columns yourself. The file is created in a Job
usingaan XML output component such astAdvancedFileOutputXML. Inthisexample, wewill createthe output
file by loading an existing XML or XSD file.

If you load an XSD file,

 thedatawill be saved in the Repository, and therefore the metadatawill not be affected by the deletion
or displacement of thefile.

* you can choose an element as the root of your XML tree.
To create the output XML schemafrom an XML file, do the following:
1. Select the Createfrom afile option.

2. Click the Browse... button next to the XML or XSD File field, browse to the access path to the XML file
the structure of which isto be applied to the output file, and double-click the file.

TheFileViewer areadisplaysapreview of the XML structure, and the File Content areadisplaysamaximum
of the first 50 rows of thefile.
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# New Xml File M (=3

File - Step 3 of 5

Select create manually or from a file
Define the output file
Qutput Setting

() Create manually
{*¥) Create from a file

¥ML ar XSD File |D:_-"talend_ﬁles_-"lnput_-"u:ustu:umer.xml

| [ Browse,.. ]

Encoding | LITF-g

v | Lmit [0 |

Cutput File Path

Cutput file |

| [ Browse. .. ]

File Viewer

{2 customers
= customer
@id
CustomerMame
CustomerAddress
idstate
id2

@

File Cantent

<?uml version="1.0" encoding="UTF-8"? =
<customers=
<rustomer id="1"=
<Customeriame =Griffith Paving and Sealco
= Customer Address >talend @apress 1</Cus
<idState =7« id5tate =
<id2=2011</id2=

Export as context

Enter the Encoding type in the corresponding field if the system does not detect it automatically.

In the Limit field, enter the number of columns on which the XPath query is to be executed, or enter O if
you want it to be run against al of the columns.

5. Inthe Output Filefield, in the Output File Path zone, browse to or enter the path to the output file. If the
file does not exist asyet, it will be created during the execution of aJob using atAdvancedFileOutputXML
component. If thefile already exists, it will be overwritten.

6. Click Next to define the schema.

To create the output XML schemafrom an XSD file, do the following:

1. Select the Createfrom afile option.

2. Click the Browse... button next to the XML or XSD Filefield, browse to the access path to the XSD file the
structure of which isto be applied to the output file, and double-click thefile.
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3. Inthedialogbox the appears, select an element from the Root list astheroot of your XML tree, and click OK.

Root [T TR ~ |
[ CK H Cancel ]

TheFileViewer areadisplaysapreview of the XML structure, and the File Content areadisplaysamaximum
of the first 50 rows of thefile.

% New Xml File =13

File - Step 3 of 5
Select create manually or from a file @

Define the output file
Cutput Setting

() Create manually
{(*) Create from a file

XML or XSD File |D:,r'taIenu:l_ﬁIes,r‘lnput,r'custu:umer.xsd | |§Bru:uw5e...§|

Encoding | UTF-& L | Limit IIII_|

Cutput File Path

Output file | | [Eiru:u'fx'se... ]
File Viewer File Content
= customers <?xml version="1.0" encoding="UTF-8"7>
2 customer <xs:schema xmins: xs="http: /fwww.w3.0rgf200 1/XMI

=xzielement name="customers ">

Customerhiame “wsicomplexType =

CustomerAddress <xsisequence>

idState «<xs:element maxOcocurs="unbounded” ref="cus'
idz? < NsiseqUENCE >

@id < |

Export as context

®@

4. Enter the Encoding type in the corresponding field if the system does not detect it automatically.

5. Inthe Limit field, enter the number of columns on which the XPath query is to be executed, or enter O if
you want it to be run against al of the columns.
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6. Inthe Output Filefield, in the Output File Path zone, browse to or enter the path to the output file. If the
file does not exist asyet, it will be created during the execution of a Job using atAdvancedFileOutputXML
component. If thefile already exists, it will be overwritten.

7. Click Next to define the schema.

7.8.2.4. Step 4: Defining the schema

Upon completion of the previous operations, the columns in the Linker Source area are automatically mapped
to the corresponding ones in the Linker Target area, as indicated by blue arrow links. Y ou can customize the
mappings while defining the schema.

In this step, you need to define the output schema. The following table describes how:

To...

Perform the following...

Define aloop element

IntheLinker Target area, right-click the element of interest and select Set AsL oop
Element from the contextual menu.

It isamandatory operation to define an element to run aloop on.
7

Define a group element

In the Linker Target area, right-click the element of interest and select Set As
Group Element from the contextual menu.

Y ou can set a parent element of the loop element as agroup element on the
¥ condition that the parent element is not the root of the XML tree.

Createachild element for an
element

IntheLinker Target area,

* Right-click the element of interest and select Add Sub-element from the
contextual menu, enter aname for the sub-element in the dialog box that appears,
and click OK, or

Select the element of interest, click the. ™ . button at the bottom, select Create
as sub-element in the dialog box that appears, and click OK. Then, enter aname
for the sub-element in the next dialog box and click OK.

Create an attribute for an
element

IntheLinker Target area,

* Right-click the element of interest and select Add Attribute from the contextual
menu, enter aname for the attribute in the dialog box that appears, and click OK,
or

Select the element of interest, click the. ™ button at the bottom, select Create
asattributein the dialog box that appears, and click OK. Then, enter anamefor
the attribute in the next dialog box and click OK.

Create a name space for an
element

IntheLinker Target area,

* Right-click the element of interest and select Add Name Space from the
contextual menu, enter a name for the name space in the dialog box that appears,
and click OK, or

Select the element of interest, click the. ™ button at the bottom, select Create
as name space in the dialog box that appears, and click OK. Then, enter aname
for the name space in the next dialog box and click OK.
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To...

Perform the following...

Delete one or more
elementd/attributes/name
spaces

IntheLinker Target area,

* Right-click the element(s)/attribute(s)/name space(s) of interest and select Delete
from the contextual menu, or

) Select the element(s)/attribute(s)/name space(s) of interest and click the . X
button at the bottom, or

» Sdlect the element(s)/attribute(s)/name space(s) of interest and press the Delete
key.

Deleting an element will also delete its children, if any.
]

Adjust the order of one or
more elements

Inthe Linker Target area, select the element(s) of interest and click the. il .and

i buttons.

Set a satic value for
an element/attribute/name
space

Inthe Linker Target area, right-click the element/attribute/name space of interest
and select Set A Fix Value from the contextual menu.

e Thevaueyou set will replace any value retrieved for the corresponding
column from the incoming data flow in your Job.

* You can set a static value for a child element of the loop element only,
on the condition that the element does not haveits own children and does
not have a source-target mapping on it.

Create
mapping

a  source-target

Select the column of interest in the Linker Source area, drop it onto the node of
interest in the Linker Target area, and select Create as sub-element of target
node, Create asattribute of target node, or Add linker to tar get node according
to your need in the dialog box that appears, and click OK.

If you choose an option that is not permitted for the target node, you will see a
warning message and your operation will fail.

Remove a source-target
mapping

In the Linker Target area, right-click the node of interest and select Disconnect
Linker from the contextual menu.

Create an XML tree from
another XML or XSD file

Right-click any schemaitem in the Linker Target area and select Import XML
Tree from the contextual menu to load another XML or XSD file. Then, you need
to create source-target mappings manually and define the output schema all again.

You can select and
2

operations.

drop several fields at a time, using the Ctrl + Shift technique to make multiple

selections, therefore making mapping faster. You can aso make multiple selections for right-click

In this example, we base the output schema on the loaded customer.xml, define a loop to run on the customer
element, and define the id node as a child element, rather than an attribute as in the loaded file. To do so:

1.
contextual menu.

In the Linker Target area, right-click the customer element and select Set As Loop Element from the

244
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2.

3.

Linker Target
|v:ustomers
¥ML Tree Related Column
| = customers
| B customae
(Y @i Add Sub-glement
Ly cu  Add Attribute
Ly cu  AddMame Space
-+ id3
+ gy Dot
<_ ST A alue |

Import XML Tree

Right-click the id note and select Delete from the contextual menu.

Linker Target
customers
¥ML Tree Related Column Mot
= customers
[= customer loop
.* m A4 < b alaman .
* Custo _ S
id Custol T
> dstah Add Mame Space
b id2
Disconkgct Linker
£ Set A Fix Value |
+ E ‘a) a2 Ha LOOD Clemel

Import XML Tree

Select theid columnin the Linker Sour ce area, and drop it onto the customer element inthe Linker Tar get

area.

The [Selection] dialog box appears, asking you to define the source-target relationship.
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#* Selection E'
Select the operation:
(%) Create as sub-element of target node
() Create as attribute of targek node
() add linker to target node

[ 0] 4 l [ Cancel

4. Select Create as sub-element of target node and click OK to validate the choice.

A blue arrow line links the columns mapped.

# Mew Xml File

File - Step 4 of 5

Add a Schema on repository
Define the Schema
Linker Source Linker Target
Schema Management] |r:|.|stomers Z |
Schema List KML Tree Related Column Mode Status
id i
CustomerMame —-:“ = ELIStDITn:rs | | ;
CustomerAddress == _a [= customer oop elemen
idState ¥ Custome  CustomerMame
id2 !; Custome CustomerAddress
! idState idState
} id2 id2
¥ iid id
S5 i

@ < Back ” Mext = Finish

5. Click Next to finalize the end schema.

7.8.2.5. Step 5: Finalizing the end schema

Step 5 displays the end schema generated.
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% New Xml File =3

File - Step 5 of 5

&)

Mame | metadata

Comment |

schema

Description of the Schema

Column Key | Type M.. Date Pattern (Ctrl...
id ] string
Customeriame [] string
Customeraddress [] string
idState ] string
id2 ] string
BBEEEEEE
® [ Finish ][ Cancel

Y ou can change the metadatain the Namefield (metadata,by default), add a Comment in the corresponding field

and make further modifications using the toolbar, for example:

Add or delete a column using the. - and. X buttons.

Change the order of the columns using the. i .and i buttons.

 Click Finish to finalize creation of the XML output file.

The new schemais displayed under the corresponding File XML node in the Repository tree view.

7.9. Setting up a File Excel schema

In the Repository tree view, right-click File Excel tree node, and select Create file Excel on the pop-up menu.
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Step 1. General properties

=i Metadata
¥ Db Connections
B File delimited
@ File positional
# File regex
File xmil
FM“E Idif [T Create file Excel
& LDAP [ Create Folder
Salesfor lsg Import items
Generic| [yl Expart items
P, WSDL —

Then proceed the same way as for the file delimited connection.

7.9.1. Step 1. General properties

Fill in the schema general information, such as Schema Name and Description.

7.9.2. Step 2: File upload

Browse to the file to upload and fill out the File field.

Y ou can upload all types of Excel filesincluding ..xIsx of Excel 2007.
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Step 3: Schemarefining

¥ Mew Excel File

File - Step 2 of 4

#dd a Metadata File on repository ‘m

Define the path of the file and the Format sektings

File Settings

Server

File | O Inputivideo/Video_Collection, xlsx | [Bruwse... ]

File Viewer and Sheets setting

Sek sheets parameters Flease select sheet{Sheet structure as schema quide) | Sheetl s

&l sheets/DSelect she i E C D E F

Sheetl Videa co...

[]5hestz id Title Categary  Year Language Cast

[]5hests 1 Tooksie Comedy 1982 Enalish Cuskin ..
2 The St...  Scence... 1997 French Bruce ...
3 Leom, k...  Action ... 1994 French Jean R...
< [ ¥

':?:' < Back ” Mexk =

The File viewer and sheets setting area shows a preview of the file.

In the Set sheets parameterslist, select the dialog box next to the sheet you want to upload. By default the file
preview displays the Sheetl.

Select another sheet on the drop-down list, if need be and check that the file is properly read on the preview table.

Click Next to continue.

7.9.3. Step 3: Schema refining

The next step opens the schema setting window.
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% New Excel File |Z|@@

File - Step 3 of 4

Add a Metadats File on repository 'K

Define the setting of the parse job

File Settings Fows To Skip

Encoding UTF-&8 v IF amy rows must be ignored, specify the Following parameters
[] advanced separatori{for number) Header Z ¥
Thousands separator: Footer [ ]

Decimal separator: [ skip empky row

The sameway asfor the File Delimited schema procedure, you can set precisely the separator, the rowsthat should
be skipped as they are header or footer.

Metadata column setking Limnit: QF Rows
First column: | 1 If the number of lines must be limited, specify this number
Last colurnn: Liit []

You can fill out the First column and Last column fields, to set precisely the columnsto be read in thefile. You
can need to skip column A for example asit may not contain proper data to be processed.
Preview

Set heading row as column names | Refresh Preview

a B C o E F

Yideo collect, .,

id Title Category Year Language Cask

1 Tooksie Camedy 1982 English Duskin Hoffrman, Jessica Lange, Sydney Pall,
z The Sth Elerment arience Fickion 1997 French Bruce Wilis, Gary Qldman, Milla Jowowitch

3 Leon, the Professional  Ackion drama 1994 French Jean Reno, Gary Oldman, Mathalie Portman
< >

Also check the Set heading row as column names to take into account the heading names. Make sure you press
Refresh to be able to view the change in the preview table.

Then click Next to continue.

7.9.4. Step 4: Finalizing the end schema

Step 4 shows the end schema generated. Note that any character which could be misinterpreted by the programis
replaced by neutral characters, like underscores replace asterisks.

Y ou can add a customized name (by default, metadata) and make editsto it using the tool bar.

You can aso retrieve or update the Excel File schema by clicking on Guess. Note however that any custom edits
to the schema might thus be lost using this feature.
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Click Finish. The new schemais displayed under the relevant File Excel connection node in the Repository tree
view.

7.10. Setting up a File LDIF schema

LDIF files are directory files described by attributes. File LDIF metadata centralize these LDIF-type files and
their attribute description.

[x] File Excel
File Idif

T B Create file dif
© Salesfa 9 Create folder

Generlt (& tmport items
P WsDL
[E pocument
[&} Recycle bin

L) Export items

Proceed the same way as for other file connections. Right-click M etadata in the Repository tree view and select
Createfile Ldif.

Make sure that you installed the relevant module as described in the Installation guide. For more

£4 information, check out http://talendforge.org/wiki/doku.php.

7.10.1. Step 1: General properties

On thefirst step, fill in the schema generic information, such as Schema name and description.

7.10.2. Step 2: File upload

Then define the Ldif file connection settings by filling in the File path field.
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Step 3: Schema definition

# New Ldif File X]

File - Step 2 of 4

Add a Metadata File on repository:

Define the path of the file and the Format settings

File Settings

4

File | C:  Tnpuk) gony Idif | [Eircuwse... ]

File Wigwer

# extended LDIF

#

# LDAPwS

# base <dc=demo,dc=net > with scope subkree
# filker: (objectclass=*)

# requesting: ALL

#

*

# demo.net

dn: dc=demo,dc=net

>

5.4

)] = Back ” Mext =

The connection functionality to aremote server is not operational yet for the LDIF file collection.
2

The File viewer provides a preview of thefile' sfirst 50 rows.

7.10.3. Step 3: Schema definition

Thelist of attributes of the description file displays on the top of the panel. Select the attributes you want to extract
from the LDIF description file, by selecting the relevant check boxes.
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Step 4: Finalizing the end schema

# New Ldif File X

File - Step 3 of 4

Add a Metadata File on repository:

Define the setting of the parse job

List aktributes of Ldif File

Attributes
[ ] password
name

[] changetype
lastname

Presview

Refresh Prewview

dn name | lastname

jbzv  jbzv  taus
Fked  Flod  kznj
bevy beyy  yhow
kskb  kskb v
fpfc  Fpfc ey
dogp dogp  eumg
i pi ocnb

)] = Back ” Mext =

Click Refresh Preview to include the selected attributes into the file preview.

DN is omitted in the list of attributes as this key attribute is automatically included in the file preview,
¥ hence in the generated schema.

7.10.4. Step 4: Finalizing the end schema

The schema generated shows the columns of the description file. Y ou can customize it upon your needs and rel oad
the original schema using the Guess button.

Click Finish. The new schema is displayed under the relevant Ldif file connection node in the Repository tree
view.

7.11. Setting up an LDAP schema

In the Repository tree view, right-click the LDAP tree node, and select Create L DAP schema on the pop-up
menu.
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Step 1. General properties

¥ .+ Creake LDAP schema
=5 ¢ O Creats Folder
-4 ExpandiCollapse
E: U [ Impart ikems
* B Ll Export items

=

+I-4=1 M

Unlike the DB connection wizard, the LDAP wizard gathers both file connection and schemadefinition in afour-
step procedure.

7.11.1. Step 1: General properties

On thefirst step, fill in the schema generic information, such as Schema Name and Description.

For further information, see Section 7.2.1, “ Step 1: General properties’.

7.11.2. Step 2: Server connection

Fill the connection details.

File - 5tep 2 of 5
Add a Metadata File on repository D

Define the path of the file and the Format settings

Metwork Parameter

Hosknare: Your-LDAP-IP W
Poart: a9 p
Encryption method: | LDAP L

Cilck the button ko check connection skatus,

Check Metwork Parameter

Then check your connection using Check Network Parameter to verify the connection and activate the Next
button.

Field Description

Host LDAP Server IP address

Port Listening port to the LDAP directory
Encryption method LDAP : no encryptionis used

LDAPS: secured LDAP

TLS: certificateis used

Click Next to validate this step and continue.
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Step 3: Authentication and DN fetching

7.11.3. Step 3: Authentication and DN fetching

In this view, set the authentication and data access mode.

% Create new LDAP schema

File - Step 3 of 5

#dd a Metadata File on repository
Cefine the setting of the parse job

Ease DM
et base DMs from Rook DSE

Ease DM:

Aliases Dereferencing
Finding

" Searching

) Mever

(%) Always

Authentication Method

Simple Authentication b |

Authentication Pararneter

Bind DM ar user: | cn=Directory Manager w |

Bind passward: | T |
Save passwiord [ Check Authentication ]

Fetch Base Dkls

Referrals Handling Limits
@ Ignore Count Limit: | 100

< Back ” Mext =

Click Check authentication to verify your accessrights.

Field

Description

Authentication method

Simple authentication: requires Authentication Parametersfield to be
filledin

Anonymous authentication: does not require authentication parameters

Authentication Parameters

Bind DN or User: login as expected by the L DAP authentication method
Bind passwor d: expected password

Save password: remembers the login details.

Get Base DN from Root DSE / Base
DN

Path to user’ s authorized tree leaf

Fetch Base DNs button retrieves the DN automatically from Root.

Alias Der eferencing

Never allows to improve search performance if you are sure that no
aliasesisto beder eferenced. By default, Alwaysisto beused. Always:
Always dereference aliases
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Field Description

Never: Never dereferences aliases.
Sear ching:Dereferences aliases only after name resolution.

Finding: Dereferences aliases only during name resolution

Referral Handling Redirection of user request:
I gnor e: does not handle request redirections

Follow:does handle request redirections

Limit Limited number of records to be read

Click Fetch Base DNsto retrieve the DN and click the Next button to continue.

7.11.4. Step 4: Schema definition

Select the attributes to be included in the schema structure.

Add afilter if you want selected data only.

% Create new LDAP schema

File - Step 4 of 5

#dd a Metadata File on repository D
Cefine the setting of the parse job

Lisk atkributes of LDWP Schema Filker

Attributes ~ (& objectClass=*))

[ ] description
[] userpasswaord
uid

[]snm

oL

Presiew

Refresh Preview

wid rnail givenname | telephonenumber

PIERRE DUPOMT  Pierre.Dupont@talend.com  PIERRE 00149584750
PIERRE DUPCM. .. mhirt78@talend. com PIERRE
rrhirt

greg

@ < Back ” Mexk =
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Click Refresh Preview to display the selected column and a sample of the data.

Then click Next to continue.

7.11.5. Step 5: Finalizing the end schema

The last step shows the LDAP schema generated. Y ou can customize the schema using the toolbar underneath
the table.

% Create new LDAP schema

File - Step 5o0f 5

Add a Metadata File on repository D
Define the setting of the parse job

Mame | metadaka

Comment |

Schema

Click ko update schema preview

Fuess
Description of the Schema
Colurmn Kev  Twpe Mullable = Date ... Length Precision
uid []  string 15
mail []  string 24
givenname |:| String =]
telephonenumber [] string 11

BB S ENE 50

If the LDAP directory which the schema is based on has changed, use the Guess button to generate again the
schema. Note that if you customized the schema, your changes will not be retained after the Guess operation.

Click Finish. The new schemaisdisplayed under therelevant LDAP connection nodein the Repository treeview.

7.12. Setting up a Salesforce connection

In the Repository tree view, right-click the Salesfor ce tree node, and select Create Salesfor ce Connection on
the pop-up menu.
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Step 1. General properties

15

=1 I8l S Create Salesforce schema
|: [ Create Folder
[ g Import items

i+
G-I W (gl Export items
% Docu.

Then proceed the same way as for any other metadata connection.

7.12.1. Step 1: General properties

Fill in the schema general information, such as Name and Description.

7.12.2. Step 2: Connection to a Salesforce account

The Salesforce Web service URL displays by default in the Web service URL field.

# New Salesforce |:|[E

File - Step 2 of 4

Add a Metadata File on repaositary
Define the path of the file and the Format setkings

Salesfarce parameters

Weh service LIRL |:‘|tt|:|s:,l',l'www.salesﬁ:uru:e.cu:um,l'services,l'Su:uap,l'u,l'lQ.III |
Iser name |cantnine@talenu:|.u:u:um |
Password | |
Batch Size 250 |

|

TimeOut {milisecands) 60000

procey paramekers
[ ]Enable Socks proxy [ |Enable Hitp prozy

Hask | | Part | |

sername | | Password | |

Check login

® Einish l [ Cancel

To define a Saleforce connection, do the following:
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Step 3: Retrieving Salesforce modules

1. Enter your User name and Password in the corresponding fields to connect to your Salesforce account
through the salesforce webservice.

2. Click Check login to verify that you can connect without issue.

3. Click Finish to close the wizard.

7.12.3. Step 3: Retrieving Salesforce modules

The next step retrieves Salesforce modules based on the connection you set up in Step 2.
=% Salesforce

€ I S Lock
Generic J Loc
=] Talend | ) Edit Salesfarce Connection
"'j Rules M E Rty alesforce Modules
B copybo w7 Impact Analysis
r‘ Web Se ¥ Delete
Ed validati c
= FTP =| -ORY
HLT o | Duplicate
I% UN/EDTI Gﬂ. Export ikems

=

In the Repository tree view, expand the Connection node, right-click the connection you set up in Step 2, and
select Retrieve Salesforce M odulesin the pop-up menu.

In the Select Schema to create area, you can narrow down the selection by filtering schemas displayed. Type
in the schema you want to filter on in Name Filter field. To retrieve more modules, select the check boxes for
respective schema.
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Step 4: Retrieving Salesforce schemas

New Schema in connection "Test"
#dd a Schema on repository @
Select Schema to create

Mame Filter: |

Mame Tyvpe Colurmn number Creation status
iAccount Modules 43 SuUCCess |
[ AccountContackRole Modules

[ AccountFeed Modules

[ AccountHistory Modules

AccountPartner Modules 13 Success
[] AccountShare Modules

AckivieyHiskory Madules 28 Success
[] additionalrumber Modules

[ ] AggregateResult Modules

[ apexclass Modules

ApexiComponent Modules 14 SUCCEsS
[ ] apexLog Modules

[] apexPage Modules

ApexTrigoer Madules 23 Success
[ ] approval Modules

[] Asset Modules

[] AssetFeed Modules

[ assignmentRule Modules

[] asyncapexlob Modules

[ Atkachment Modules
£

Select All | Select Mone | | Check Connection
@:l Finish l [ Cancel

Click Check Connection to verify the creation status and click Finish to save the modules you retrieved.

7.12.4. Step 4: Retrieving Salesforce schemas

This step opens the schema setting window based on the module you retrieved in Step 3.
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Step 5: Finalizing the end schema

=%} Salesforce
=% Testn.l
) Account
e AccountPartrisr
o) AckivityHistory
o) ApexComponent
E—'l ApexTrigger

Generic s -

D Talend ML i Retrieve Salesforce Schemas
i-J Rules Man ¥ Delete

@ Copybook @Expnrt itemns

Right-click the module you retrieved in Step 3, and select Retrieve Salesfor ce Schemas in the pop-up menu.

# Schema |:||E|[z|
File - Step 3 of 5
Add a Metadata File on repository @

Define the setting of the parse job

Madule Browse data column and set query condition
ZallZent
Sl-EnLer Query Condition |name="Chatter Free'
Salesforce Module Field detail order the fields
Column Ky Type Mullable  Data Patkern Length =~ Prec
1d False Skring False 18 III
LicenseDefinitionkesy False Strlng False
—I!-
SyskemModstamp False Date False "y -MM-dd'TH.,, 0

In the Browse data column and set query condition area, you can narrow down the selection by filtering
displayed data. To do that, type in the column you want to filter on and the value you want to drill down to in
the Query Condition field.

The columns in the Column list are listed in a phabetical order. Clear the order the fields check box to list them
randomly.

Presvies | Oukput

Refresh Previgw

Id LicenseDefinitionkey | MName SystemModstamp
100700000009 2KARY  CSM_User Chatter Free  2010-12-04T18:18:49,0007
100700000009R.acAAE SFDC Salesforce 2011-03-09T035:54:47.0002

Click Refresh Preview, if you entered aquery condition, so that the preview gets updated accordingly. By defaullt,
the preview shows all columns of the selected module.

Then click Next to continue.

7.12.5. Step 5: Finalizing the end schema

Step 5 shows the final generated schema.
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Step 5: Finalizing the end schema

Y ou can add a customized name (by default, metadata) and edit the schema using the tool bar.

File - Step 4 of 5

Add a Schema on repository @

Define the Schema

Schema Marne
CallCenter |CaIICenter |
Cormmenkt
|| |
Schema

Click. "Euess" butkon to update the schema below according to wour settings

Guess

Description of the Schema

Colurnn kKey | Type w| M., DatePat.. Len... Pre..
Id [1 string ] 18 0
Marme []  string ] &0 0
MamespacePr... [ ] Skring 15 0
Diescripion []  string 255 0
TableErumorld  [] String ] 40 0
Fy S IsActive (] bodl.. ] 1]
CreatedById []  string ] 15 0
Createdl.}fate ] Dal.:e ] M, 0
LastModifieds... []  String ] 13 ]
LastModifiedD.,.. [  Date ] Uy, 0

@:‘ [ Finish l [ Cancel

You can aso retrieve or update the Salesforce schema by clicking Guess. Note however, that any changes or
customization of the schema might be lost using this feature.

Click Finish. The new schemais displayed in the Repository tree view under the relevant File Excel connection
node.

Y ou can drop the metadata defined from the Repository onto the design workspace. A dialog box opensin which
you can choose to use either atSalesfor cel nput or tSalesfor ceOutput component in your Job.
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% Components |Z|EI E|

Choose one component ko create,

@ tSalesforceInput

@:J [ 0K, l [ Cancel

For more information about dropping component metadata in the design workspace, see Section 4.2.2.2, “How
to drop components from the Metadata node” .

7.13. Setting up a Generic schema

Talend Open Studio for Data Integration allows you to create any schema from scratch if none of the specific
metadata wizards matches your need or if you do not have any source file to take the schema from. The creation
procedure is made of two steps.

First right-click Generic Schema in the Repository tree view and select Create generic schema.

7.13.1. Step 1: General properties

A connection wizard opens up. Fill in the generic Schema properties such as SchemaName and Description. The
Statusfield is a customized field you can define in Window > Preferences.

Click Next when completed.

7.13.2. Step 2: Schema definition

There is no default schema displaying as there is no source to take it from.
 You can give a name to the schema or use the default name (metadata) and add a comment if you fed like.
 Customize the schema structure in the schema panel, based on your needs.

e Thetool bar allows you to add, remove or move columns in your schema. Also, you can load an xml schema
or export the current schema as xml.

 Click Finish to complete the generic schema creation. The created schema is displayed under the relevant
Generic Schemas connection node.
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7.14. Setting up an MDM connection

Talend Open Sudio for Data Integration enables you to centralized the details of one or more MDM connections
under the M etadata folder in the Repository tree view. Y ou can then use any of these established connections
to connect to the MDM server.

3 You can also set up an MDM connection the same way by clicking the (8] icon in the Basic settings
view of thetM DM I nput and tM DM Output components. For more information, see the Talend MDM
component chapter in the Talend Open Studio Components Reference Guide.

According to the option you select, the wizard helps you create an input XML, an output XML or areceive XML
schema. Later, in a Talend Job, the tM DM Input component uses the defined input schema to read master data
stored in XML documents, tM DM Output uses the defined output schemato either write master datain an XML
document on the MDM server, or to update existing XML documents and finally the tM DM Receive component
uses the defined XML schemato receive an MDM record in XML from MDM triggers and processes.

7.14.1. Step 1: Setting up the connection

To establish an MDM connection, complete the following:
1. Inthe Repository tree view, expand M etadata and right-click Talend MDM.
2. Sdlect Create MDM on the contextual menu.

The connection wizard displays.

Talend MDM -g_,\

Create a MDMConneckion

Mame Produck
Purpose purpose of this "product” MOM conneckion

Diescription | description of the "product” MODM connection

Author

Locker

Wersion
Status kesting w

path

Ii?:' Mext = ] [ Finish l [ Cancel

3. Fill in the connection properties such as Name, Pur pose and Description. The Statusfield is a customized
field that can be defined. For more information, see Section 2.6.8, “ Status settings”.
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4. Click Next to proceed to the next step.

Talend MDM '&\

Link, Parameter

|Jsername | admin

SEFVEr | localhost

passwiord | TIITY |

Port | &0&0

| Check, |

® [ < Back ][ Mext = Finish

5. Fill in the connection details including the authentication information to the MDM server and then click
Check to check the connection you have created.

A dialog box displays to confirm if your connection is successful.

6. Click OK to close the confirm dialog box and then Next to proceed to the next step.

Talend MDM '&\

Select Version

Yersion | [HEAD] W |

Data-model | Products w |

Daka-Conkainer F'r'I:u:Iu-:t::

@ Mext = Finish H Cancel

7. FromtheVersion list, select the master data version on the MDM server to which you want to connect.

8. From the Data-Model list, select the data model against which the master datais validated.
9. From the Data-Container list, select the data container that holds the master data you want to access.
10. Click Finish to validate your changes and close the dialog box.

The newly created connection is listed under Talend MDM under the M etadata folder in the Repository
tree view.
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Y ou need now to retrieve the XML schema of the business entities linked to this MDM connection.

7.14.2. Step 2: Defining MDM schema

= L-_‘E Metadata

I Db Connections
EF SAP Connections

[ File delimited

@ File positional
El File regex
File xmil
E] File Excel
File Idif
LDAP
¢ Salesforce
Generic schemas
7! BRMS

@ Copybook
& FTP

HL7

-} Rules

=-[£] Talend MDM

| DStar 0.1
o

| test 0.1 ) Lock

|
|
|

B WSDL =) Edit Mo
% CDocumentati
-E] Recycle bin

7.14.2.1. Defining Input MDM schema

This section describes how to define and download an input MDM XML schema. To define and download an
output MDM XML schema, see Section 7.14.2.2, “Defining output MDM schema’.

To set the values to be fetched from one or more entities linked to a specific MDM connection, complete the

following:

1. Inthe Repository tree view, expand M etadata and right-click the MDM connection for which you want to

retrieve the entity values.

2. Select Retrieve Entity from the contextual menu.

A dialog box displays.
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~DM Model

Select one model ko create MOM metadata

(%) Input MDM
() output MDM
() Receive MOM

3. Select the Input MDM option in order to download an input XML schema and then click Next to proceed
to the following step.

MDM Entity

Entities | Product w |

Mame | Product_Schema |

4. From the Entitiesfield, select the business entity (XML schema) from which you want to retrieve values.
The name displays automatically in the Name field.

You are freeto enter any text in thisfield, although you would likely put the name of the entity from
¥ which you are retrieving the schema.

5. Click Next to proceed to the next step.
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MDM Entity

Source Schema Target Schema

= Product
Pickure
d
Marmne
Descripkion

= Feakures

+- Sizes
+- Colors
Availability
Price

Farnily
Cnlinestore

Presiew | Qutpuk

%path loop expression

Ahsolute ¥Path expression Loop limit

Fields to extract

Relative or absolute ¥Path expression Column Mame

File Wigwer

<xsd:schema xmins: xsd="http:/ w3, org 2001 fxMLS
<wsdiimport namespace="http: fvaa w3, orgf 2001 5
<xsd:element name="Product" >
<xsd:annotation =
<xsdiappinfo source="%_Label EN"=Product</xs
<xsdiappinfo source="%_Label_FR"=Produit<xsc
<lxsd:annotation =
<xsdicomplexType =
<xsdiall maxOoours="1" minOccurs="1">
<xsdielement maxOcocurs="1" minOccurs="0" n.
<xsd:annotation =
<xsd:appinfo source="¥_Label_EN">Pictur

< b

Export as Context

©

The schema of the entity you selected automatically display in the Sour ce Schema panel.

Here, you can set the parameters to be taken into account for the XML schema definition.

The schemadialog box is divided into four different panels as the following:

Panel Description

Source Schema Tree view of the uploaded entity.
Target schema Extraction and iteration information.
Preview Target schema preview.

File viewer Raw data viewer.

6. Inthe Xpath loop expression area, enter the absolute X Path expression leading to the XML structure node
on which to apply the iteration. Or, drop the node from the source schemato the target schema Xpath field.
Thislink isorangein color.
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The Xpath loop expression field is compulsory.

If required, define aL oop limit to restrict the iteration to a number of nodes.

Source Schema Target Schema
= Product #path loop expression
Picture : o
1 Absolute XPath expression Loop limit
Name [Product/Features 50
Description
—|- Features
1 Sizes Fields to extract
Caol

* ) " l_:'_rs Relative or absolute XPath expression Column M...
Aeyailability
Price

Farnily
onlinestore

In the capture above, we use Features as the element to loop on because it is repeated within the Product
entity as follows:

<Pr oduct >

<| d>1</1d>

<Nanme>Cup</ Name>

<Descri pti on/ >

<Feat ur es>
<Feat ur e>Col or red</ Feat ure>
<Feat ure>Si ze maxi </ Feat ure

<Feat ur es>

</ Pr oduct >
<Pr oduct >
<| d>2</1d>
<Nanme>Cup</ Name>
<Descri pti on/ >
<Feat ur es>
<Feat ur e>Col or bl ue</ Feat ur e>
<Feat ur e>Ther nos</ Feat ur e>
<Feat ur es>

</ Pr oduct >

By doing so, the tM DM I nput component that uses this MDM connection will create a new row for every
item with different feature.

To define the fields to extract, drop the relevant node from the source schema to the Relative or absolute
XPath expression field.
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Source Schema Target schema
(= Product ¥path loop expression
Picture : Hr
1 Ahsolube ¥Path expression Loap lirmik
Name [ProductfFeatures 50
Descripkion =
[=- Features )
[+ Sizes Fields to extract
[#- Colors
o Relative or absolute ¥Path expression Calurnn M. ..
Ay ailability
Price -+/1d 1d
- . [Mame Mame
Farnily B b o . JDescription Descripkion
OnlineStore

Use the [+] sign to add rows to the table and select as many fields to extract as necessary. Press the
¥ Ctrl or the Shift keysfor multiple selection of grouped or separate nodes and drop them to the table.

9. If required, enter a name to each of the retrieved columns in the Column name field.

Y ou can prioritize the order of the fields to extract by selecting the field and using the up and down
s arrows. Thelink of the selected field is blue, and all other links are grey.

10. Click Finish to validate your modifications and close the dialog box.

The newly created schemais listed under the corresponding MDM connection in the Repository tree view.

=-[E] Talend MDM
\=| DStar 0.1
= |_| Product 0,1

fizfProduct Schena

B Product m
|=| test 0.1 &1 Read Entity

P WSDL

i 1=| Copy to Generic schema
To modify the created schema, complete the following:

1. IntheRepository treeview, expand M etadata and Talend MDM and then browse to the schema you want
to modify.

2. Right-click the schema name and select Edit Entity from the contextual menu.

A dialog box displays.
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Mame Product_Schema

Carmmenkt

Schema

Click Guess button to update the schema below according to your setkings

Description of the Schema

Calurmn Key = Type
EL 1d String
Marne |:| Skring

Descripkion ] string

wl| M.. Date Pattern (Ckrl...

—
()
W

Modify the schema as needed.

Click Finish to close the dialog box.

7.14.2.2. Defining output MDM schema

GUESS

Precision Default | Commer
u]
1]
]

Finish ] [ Cancel

Y ou can change the name of the schemaaccording to your needs, you can a so customize the schema structure
in the schema panel. The tool bar allows you to add, remove or move columns in your schema.

The MDM input connection (tM DM I nput) is now ready to be dropped in any of your Jobs.

This section describes how to define and download an output MDM XML schema. To define and download an
input MDM XML schema, see Section 7.14.1, “ Step 1: Setting up the connection”.

To set thevaluesto bewrittenin one or more entitieslinked to aspecific MDM connection, completethefollowing:

1

In the Repository tree view, expand M etadata and right-click the MDM connection for which you want to

write the entity values.

Select Retrieve Entity from the contextual menu.

A dialog box displays.
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MDM Model

Select one model to create MODM metadata

) Input MDM
(%) Oukput MDM
) Receive MOM

@ [ <o

3. Select the Output MDM option in order to define an output XML schema and then click Next to proceed
to the following step.

MDM Entity

Entities | Product W |

Marne | Praduct_Dukpuk_Schema |

@ [ <o

4. From the Entitiesfield, select the business entity (XML schema) in which you want to write values.
The name displays automatically in the Name field.

: Y ou arefreeto enter any text in thisfield, although you would likely put the name of the entity from
7 which you are retrieving the schema.

5. Click Next to proceed to the next step.
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6.

7.

MDM Entity

Linker Source

Schema Management

Schema List

Pickure
Id
Marne
Description
Features
Sizes
Size

Colors
Color

Availability
Price

Farmily
COnlineStore

@

Linker Target
EML Tree Related Column Mode Status Default Walue
= Product
Pickure Pickure
Id Id loop element
Mame Mame
Description Descripkion
= Features Features
[=] Sizes Sizes
Size Size
= Colors Colors
Caolor Caolaor
A ailability A il ability
Price Price
Farily Family
ConlineStore Onlinestore
[ Finish ] [ Cancel ]

Identical schema of the entity you selected is automatically created inthe Linker Target panel, and
? columns are automatically mapped from the source to the target panels. The wizard automatically
defines the item Id as the looping element. Y ou can always select to loop on another element.

Here, you can set the parameters to be taken into account for the XML schema definition.

Click Schema M anagement to display adialog box.

Do necessary modifications to define the XML schemayou want to write in the selected entity.

% Schema IZHEW@
Colurmn kevy  Type ¥ M., DateP... Length Precision O,

Marie (]  string o

Description [] string o

Features [l string o

Size [] string o

Colar [] string 0
< i
) (x)a]e)E) & (s)@)

[ i ] [ Cancel

Your Linker Source schema must corresponds to the Linker Target schema, i.e define the elements in

which you want to write values.
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8. Click OK to close the dialog box.

The defined schema displays under Schema list.

DM Entity
Linker Source Linker Target
[Schema Management ] XML Tree Related Column | Mode Status Default value
Schema List = Product
Mame Picture
Description \ Id
Features 1—-* Mame Mame
Size — Description Description
Color = Features loop element
= Sizes
—¥ Size Size
= Colors
- Color Colar
Aeyailabiliby
Price
Farnily
onlinestore

@:’ Firish ] [ Cancel

9. InthelLinker Target panel, right-click the element you want to define as a loop element and select Set as
loop element. Thiswill restrict the iteration to one or more nodes.

By doing so, the tM DM Output component that uses thisMDM connection will create a new row for every
item with different feature.

You can prioritize the order of the fields to write by selecting the field and using the up and down
¥ arrows.

10. Click Finish to validate your modifications and close the dialog box.

The newly created schemais listed under the corresponding MDM connection in the Repository tree view.

=-[E] Talend MDM
= | DStar 0.1
= |_| produck 0.1

izl product_Outau Schena

Beon N
P WSDL & Read Entity

= Documentation =) Copy ko Generic schema

3} Recycle bin
Z l:;.(h

Impact Analysis

To modify the created schema, complete the following:
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In the Repository tree view, expand M etadata and Talend MDM and then browse to the schema you want
to modify.

Right-click the schema name and select Edit Entity from the contextual menu.
A dialog box displays.

Marme Product_Oukpuk_Schema

Carmment

Schema

Click. Guess button to update the schema below according ko your settings

Description of the Schema

Column key  Type w| Mull... DatePattern (Ctr... Length Precision Defaulk Comment
% Mame Skring ]
Description |:| Skring ]
Features |:| Skring ]
Size [] string 0
Colar [] string i

€]
[#]

(f?.;: [ Finish l [ Cancel

Modify the schema as needed.

Y ou can change the name of the schemaaccording to your needs, you can also customi ze the schemastructure
in the schema panel. The tool bar allows you to add, remove or move columns in your schema.

Click Finish to close the dialog box.

The MDM output connection (tM DM Output) is now ready to be dropped in any of your Jobs.

7.14.2.3. Defining Receive MDM schema

This section describes how to define areceive MDM XML schema based on the MDM connection.

To set the XML schema you want to receive in accordance with a specific MDM connection, complete the
following:

1

In the Repository tree view, expand M etadata and right-click the MDM connection for which you want to
retrieve the entity values.

Select Retrieve Entity from the contextual menu.

A dialog box displays.
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MDM Model

Select one model ko create MOM metadata

) Inpuk MOM
() Oukpuk MOM
@' Receive MDM

3. Select the Receive MDM option in order to define areceive XML schema and then click Next to proceed
to the following step.

MDM Entity

Entities | Product v |

Mame | ProductReceive |

@ [ <o

4. From the Entities field, select the business entity (XML schema) according to which you want to receive
the XML schema.

The name displays automatically in the Name field.

. You can enter any text in this field, although you would likely put the name of the entity according
¥ to which you want to receive the XML schema.

5. Click Next to proceed to the next step.
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WD Entity
Source Schema Target Schema
=l Product #path loop expression
Fickure = T
1 Ahsolute ¥Path expression Loop limit
Marmne
Descripkion
= Feakures
+- Sizes Fields to extract
Col

* ) - '_:',rs Relative or absolute ¥Path expression Column Mame
Availability
Price

Farnily
Cnlinestore

Preview | Qutpuk File Yigwer

<xsd:schema xmins: xsd="http:/ w3, org 2001 fxMLS
<wsdiimport namespace="http: fvaa w3, orgf 2001 5
<xsd:element name="Product" >
<xsd:annotation =
<xsdiappinfo source="%_Label EN"=Product</xs
<xsdiappinfo source="%_Label_FR"=Produit<xsc
<lxsd:annotation =
<xsdicomplexType =
<xsdiall maxOoours="1" minOccurs="1">
<xsdielement maxOcocurs="1" minOccurs="0" n.
<xsd:annotation =
<xsd:appinfo source="¥_Label_EN">Pictur

< b

Export as Context

©

The schema of the entity you selected display in the Sour ce Schema panel.

Here, you can set the parameters to be taken into account for the XML schema definition.

The schemadialog box is divided into four different panels as the following:

Panel Description

Source Schema Tree view of the uploaded entity.
Target schema Extraction and iteration information.
Preview Target schema preview.

File viewer Raw data viewer.

In the Xpath loop expression area, enter the absolute X Path expression leading to the XML structure node
on which to apply the iteration. Or, drop the node from the source schemato the target schema X path field.
Thislink isorangein color.
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The Xpath loop expression field is compulsory.

7. If required, define aL oop limit to restrict the iteration to one or more nodes.

Source Schema Target Schema
= Product #path loop expression
Picture : o
1 Absolute XPath expression Loop limit
Name [Product/Features 50
Description
—|- Features
1 Sizes Fields to extract
Caol

* ) " l_:'_rs Relative or absolute XPath expression Column M...
Aeyailability
Price

Farnily
onlinestore

In the above capture, we use Features as the element to loop on because it is repeated within the Product
entity as the following:

<Pr oduct >

<| d>1</1d>

<Nanme>Cup</ Name>

<Descri pti on/ >

<Feat ur es>
<Feat ur e>Col or red</ Feat ure>
<Feat ure>Si ze maxi </ Feat ure

<Feat ur es>

</ Pr oduct >
<Pr oduct >
<| d>2</1d>
<Nanme>Cup</ Name>
<Descri pti on/ >
<Feat ur es>
<Feat ur e>Col or bl ue</ Feat ur e>
<Feat ur e>Ther nos</ Feat ur e>
<Feat ur es>

</ Pr oduct >

By doing so, the tM DM Receive component that uses this MDM connection will create a new row for every
item with different feature.

8. To define the fields to receive, drop the relevant node from the source schema to the Relative or absolute
XPath expression field.
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Source Schema Target schema
(= Product ¥path loop expression
Picture : Hr
1 Ahsolube ¥Path expression Loap lirmik
Name [ProductfFeatures 50
Descripkion =
[=- Features )
[+ Sizes Fields to extract
[#- Colors
o Relative or absolute ¥Path expression Calurnn M. ..
Ay ailability
Price -+/1d 1d
- . [Mame Mame
Farnily B b o . JDescription Descripkion
OnlineStore

Use the plus sign to add rows to the table and select as many fieldsto extract as necessary. Pressthe
¥ Ctrl or the Shift keysfor multiple selection of grouped or separate nodes and drop them to the table.

9. If required, enter a name to each of the received columnsin the Column name field.

Y ou can prioritize the order of the fields you want to receive by selecting the field and using the up
s and down arrows. The link of the selected field is blue, and all other links are grey.

10. Click Finish to validate your modifications and close the dialog box.

The newly created schemais listed under the corresponding MDM connection in the Repository tree view.

=-Z] Talend MDM
=) pstar 0.1
== Product 0.1
B2 ProductOut

g ProductRecaivs)

e
{8 Documentation & Read Entity

* =‘] Recycle bin “=| Copy ko Generic scherna

@h Impact Analysis
To modify the created schema, complete the following:

1. IntheRepository tree view, expand M etadata and Talend MDM and then browse to the schema you want
to modify.

2. Right-click the schema name and select Edit Entity from the contextual menu.

A dialog box displays.
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Mame ProductReceive

Camment

Schema

Click Guess butkon ko update the schema below according to your settings

Description of the Schema

Column kev  Tvpe | M. DatePattern (Ckrl...  Length Precision Default Comn
E 1 Skring 0
Marne |:| Skring ]
Descripkion |:| Skring 1]

',/?.: [ Finish H Cancel

3. Modify the schema as needed.

Y ou can change the name of the schemaaccording to your needs, you can also customi ze the schemastructure
in the schema panel. The tool bar allows you to add, remove or move columns in your schema.

4. Click Finish to close the dialog box.

The MDM receive connection (tM DM Receive) is now ready to be dropped in any of your Jobs.

7.15. Setting up a Web Service schema

In Talend Open Sudio for Data Integration you can save your Web Service connections in the Repository.

7.15.1. Setting up a simple schema

This section describes how to define aweb Service schema

7.15.1.1. Step 1: General properties

This step illustrates how to define the file's general properties.
1. Inthe Repository, expand the M etadata node.

2. Right-click Web Service and select Create Web Service schema from the context menu list.
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3.

4.

[£| Talend MDM

£ pocumentation | B
3l Recycle bin [ Create folder

@ Irmport items
[l Expart items

ate \Web Service schema

o
Enter the generic schema information such as its Name and Description.
#® Create new Web Service schema |:,E
File - Step 1 of 4
Add a File metadata on repository, Define the properties,
Mame | SimplecetWeather| |
Purpose | |
Descripkion
Author | |
Locker | |
Wersion | ||E
Skakus | b |
Path | " Select ]
@ = Back [ Mext = ] [ Einish ] [ Cancel

Click Next to select the schematypein step 2.

7.15.1.2. Step 2: URI and method definition.

This step involves the definition of the URI and other parameters required to obtain the desired values.
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Web Service Parameter

Wb Service Rikkps f v, deepkraining, com)webservices weather, asmxPWSDL

[ Imeed authentication?

[ ]Use http prowy

Method GetWeather

Timne Cuk{Second) | 20

Parameters

Walue
Melbourne

Remove

In the Web Service Parameter zone:
1. Enter the URI which will transmit the desired values, in the Web Servicefield.

2. If necessary, select the Need authentication? check box and then enter your authentication information in
the User and Password fields.

3. Ifyouusean http proxy, select the Use http proxy check box and enter the information required in the host,
Port, user and password fields.

4. Enter the Method name in the corresponding field.
5. IntheValuetable, Add or Remove values as desired, using the corresponding buttons.

6. Click Refresh Preview to check that the parameters have been entered correctly.

Presview | Cubput

Refresh Preview ] [ Web Service Explarer

Getiweather
Sunny
'/j? [ < Back, ][ Mext = H Finish H Cancel

In the Preview tab, the values to be transmitted by the Web Service method are displayed, based the parameters
entered.
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7.15.1.3. Step 3: Finalizing the end schema

Y ou can modify the schema name (metadata, by default) and modify the schema itself using the tool bar.

Add a File metadata on repository, Define the setting of the parsed job,

Mame metadata

Commenk

achema

Click bo update schema preview
S

Description of the Schema

Column Key  Type w| Mullable Date Pattern ... Length = Precision — Def... Commenk
Getweather [ String 5 0

=~

1 . =

Add or delete columns using the. ™ . and . “* . buttons.
2.

Modify the order of the columns using the @ and buttons.
3. Click Finish.

The new schema is added to the Repository under the Web Service node.

7.16. Setting up an FTP connection

If you need to connect to an FTP server regularly, you can centralize the connection information under the
Metadata node in the Repository view.

7.16.1. Step 1: General properties

To create a connection to an FTP server, follow the below steps:

1. Expand the Metadata node in the Repository tree view.
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7
k m
B B Y5 9 Create folder

= Docur
5 Recyd @ Impart items
Ga Export items

2. Right-click FTP and select Create FTP from the context menu.

The connection wizard opens:

Talend FTP

Creabte a FTPConneckion

Mame | MewFTR |

Purpose | |

Deschipkion | Description of wour FTP

Author | |
Locker | |
Version | [1][m]
Status | v|
Path | | select |
@ < Back Mext> || Finish || cancel

3. Enter the generic schemainformation such as its Name and Description.
The status field is a customized field which can be defined in the Preferences dialog box (Window
2 > Preferences). For further information about setting preferences, see Section 2.5, “ Setting Talend
Open Studio for Data Integration preferences”.

4.  When you have finished, click Next to enter the FTP server connection information.

7.16.2. Step 2: Connection

In this step we shall define the connection information and parameters.

1. Enter your Username and Password in the corresponding fields.
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7.

Talend_FTP
Server
Isernarme indus
Password Ty
Host degas
Port 21

Encoding |I50-5859-15

[]Use Socks Prosy

Connection Maodel Ackive W
Parameter
[ ]5FTF Support [ FTPs Supportisuppork EFTPEEE kempararily

=

Inthe Host field, enter the name of your FTP server host.
Enter the Port number in the corresponding field.

Select the Encoding type from the list.

From the Connection Model list, select the connection model you want to use:

» Select Passive if you want the FTP server to choose the port connection to be used for data transfer.

» Select Activeif you want to choose the port yourself.

In the Parameter area, select a setting for FTP server usage. For standard usage, there is no need to select

an option.

» Select the SFTP Support check box to use the SSH security protocol to protect server communications.

An Authentication method appears. Select Public key or Password according to what you use.

» Select the FTPs Support check box to protect server communication with the SSL security protocol.

 Select the Use Socks Proxy check box if you want to use this option, then enter the proxy information (the

host name, port number, username and password).

Click Finish to close the wizard.

All of the connections created appear under the FTP server connection node, in the Repository view.

Y ou can drop the connection metadata from the Repository onto the design workspace. A dialog box opensin
which you can choose the component to be used in your Job.

For further information about how to drop metadata onto the workspace, see Section 4.2.2.2, “How to drop
components from the M etadata node”.
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7.17. Exporting Metadata as context

For every Metadata connection (either File or Database), you can export the connection details as a Context.
1. Onthelast step or second last step of the wizard, click Export as Context.

2. The Context creation 2-step wizard launches.

3. On Step 1, fill out aname for the Context. By default the name of the Metadata entry is proposed.

4. Click Next.

5.  On Step 2, the automatically created context variables are displaying on the three tab table. Check out that
the variable values showing on the Values tab are correctly set.

6. Click Finish to validate the creation.

286 Talend Open Studio for Data Integration User Guide



Chapter 8. Managing routines

This chapter defines the routines, along with user scenarios, and explains how to create your own routines or how
to customize the system routines. The chapter also gives an overview of the main routines and use cases of them.
To have an overview of the most commonly used routines and other use cases, see Appendix C, System routines.

Before starting any data integration processes, you need to be familiar with Talend Open Sudio for Data
Integration Graphical User Interface (GUI). For more information, see Appendix A, GUI.
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8.1. What are routines

Routines are fairly complex Java functions, generally used to factorize code. They therefore optimize data
processing and improve Job capacities.

You can also use the Repository tree view to store frequently used parts of code or extract parts of existing
company functions, by calling them via the routines. This factorization makes it easier to resolve any problems
which may arise and allows you to update the code used in multiple Jobs quickly and easily.

Ontop of this, certain system routines adopt the most common Javamethods, using the Talend syntax. Thisallows
you to escalate Java errors in the studio directly, thereby facilitating the identification and resolution of problems
which may arise as your integration processes evolve with Talend.

There are two types of routines:

» System routines: anumber of system routines are provided. They are classed according to the type of datawhich
they process: numerical, string, date...

» User routines: these are routines which you have created or adapted from existing routines.

Y ou do not need any knowledge of the Java language to create and use Talend routines.
2

All of the routines are stored under Code > Routines in the Repository tree view.
For further information concerning the system routines, see Section 8.2, “Accessing the System Routines’.
For further information about how to create user routines, see Section 8.4.1, “How to create user routines’.
Y ou can also set up routine dependencies on Jobs. To do so, simply right click a Job on the Repository

¥ tree view and select Set up routine dependencies. In the dialog box which opens, all routines are set by
default. Y ou can use the tool bar to remove routines if required.

8.2. Accessing the System Routines

To access the system routines, click Code > Routines > system. The routines or functions are classed according
to their usage.

The system folder and its content are read only.
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Customizing the system routines

=1ty Job Designs

{8 Test 0.1
H best13065 0.1
Contexts
= Code
=-=3| Routines
= system
=23 DakaCperation 0.1
=4 Mathematical 0.1
=25 MNurmneric 0.1
=24 Relational 0.1
=3 StringHandling 0.1
3 TalendDataGenerator 0.1
=3 TalendDate 0.1
=3 Talendstring 0.1

=3 GeneratorUUID 0.1
+ _r S0L Templates

Each class or category in the system folder contains several routines or functions. Double-click the class that you
want to open.

All of theroutines or functionswithin aclassare composed of some descriptivetext, followed by the corresponding
Java code. In the Routines view, you can use the scrollbar to browse the different routines. Or alternatively:

1. PressCtrl+O intheroutines view.
A dialog box displays alist of the different routinesin the category.
2. Click theroutine of interest.
The view jumps to the section comprising the routine' s descriptive text and corresponding code.

The syntax of routine call statementsis case sensitive.
3

For more information about the most common Java routines, see Appendix C, System routines.

8.3. Customizing the system routines

If the system routines are not adapted to your specific needs, you can customize them by copying and pasting the
content in a user routine, then modify the content accordingly.

To customize a system routine:

1. First of al, create a user routine by following the steps outlined in the Section 8.4.1, “How to create user
routines’. The routine opens in the workspace, where you shall find a basic example of aroutine.

2. Then, under Code > Routines > system, select the class of routines which contains the routine(s) you want
to customize.

3. Double-click the class which contains the relevant routine to open it in the workspace.

4. Usethe Outline panel on the bottom left of the studio to locate the routine from which you want to copy
al or part of the content.
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& TalendDate 0.1 53

{53 DataOperation 0.1
-84 DataQuality 0.1
-84 DQStemmer 0.1
-84 DQTechnical 0.1
-84 Mathematical 0.1
{83 Mumeric 0,1

-84 Relational 0.1
-84 StemmerHelper 0.1
(&4 StringHandling 0.1
&) TalendDataGenerator 0.1
&) TalendDate 0.1
{8 TalendString 0.1
-84 TISString 0.1

&4 My2ndRoutine 0.1
{5 MyNewRoutine 0.1

EII---..|_.—L|l SQL Templates
#-H Metadata
E]--% Documentation

Ocso formatDate(String, Date) : String
' isDate(String, String) : boolean

et compareDate(Date, Date, String) @ int
et compareDate(Date, Date) : int

© 9 addDate(Date, int, String) : Date

et diffDate(Date, Date, String) : long

A P bn Pimbed e

oF Outine i ._[EI Code \ﬂewer} =0
BRE o~
import dedarations »

= TalendDate

et addDate(String, String, int, String) : String

i Repository X = O] | &g MyNewRoutine 0. 1
LOCAL: component = Q:><h || - =L ,
&[5 Code ~ ]
) Routines *
-0 system * 3y

*/

= public

=0

TERalL LS f

—>»> isDate ("2008-11-24 12:15:25", "yyyy-MM-dd HH:mm:=s=

isDate ("2008-11-24 12:15:25",

"yyyy-MHM-dd HH:mm")

—>» isDate("2008-11-32 12:15:25",

"yyyy-MHM-dd HH:mm:ss

static boolean isDate(S5tring stringDate, String pe

(stringDate = nmll)} {
return false;

.SimpleDateFormat sdf = new java.text.S5impl
.util.Date testDate = null;

try {
testDate

adf.parse (stringDate) ;

} catch (Pars ception e) {
return false;

H
if (!sdf.format (testDate) .equals (sctringDate)) {
return false;

}

return trume;

4 Routi _r_ﬂl Cont | %2 Comp &2 [ Run ﬂ =5 Probq 2, Modul | d Talen} o Sd’1e1 'E: Job T: Eq
|

5. Intheworkspace, select al or part of the code and copy it using Ctrl+C.

6. Click the tab to access your user routine and paste the code by pressing Ctrl+V.

7. Modify the code as required and press Ctrl+Sto saveit.

We advise you to use the descriptive text (in blue) to detail the input and output parameters. This will make your
routines easier to maintain and reuse.

8.4. Managing user routines

Talend Open Sudio for Data Integration allows you to create user routines, to modify them or to modify system

routines, in order to fill your specific needs.

8.4.1. How to create user routines

Y ou can create your own routines according to your particular factorization needs. Like the system routines, the
user routines are stored in the Repository tree view under Code > Routines. Y ou can add foldersto help organize
your routines and call them easily in any of your Jobs.

To create a new user routine, complete the following:

1. Inthe Repository tree view, expand Code to display the Routines folder.
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= 9 Create folder
=3 Expand/Collapse
= QEI Import items

& Lyl Export items
=

(RIRIS RIS TS RIS RS P s

=) TalendDataGenerator 0.1
=) TalendDate 0.1
=3 Talendstring 0.1

=3 GenerakarUJID 0,1

Right-click Routines and select Createroutine.

The [New routine] dialog box opens. Enter the information required to create the routine, ie., its name,
description...

Click Finish to proceed to the next step.

File Edit window Help

@ g EH) Q- 'Eb e .,"" 2| ﬁh_’ Data Integrat. .. |
m Learn % Ask g Upgrade!
0 = O = MyMewRoutine 0.1 52 =08
:.OCAL:_comDDnent = QDQ |£|v 16 * Function's parameter name. the {parsm! is optional. so if wyou the Functi®
4 Business Models 17 + added. wou can have many parameters for the Function.
’EE Job Designs 1g "
™ Contexts 19 * 5. {example} gives & example for the Function. it is optional.
= Code 20 i
%5 Routines Z1 public class MyNewRoutine {

= system 22

=8 MyNewRoutine 0.1 3= £
_rSQLTemplal:es 4 * helloExample: not return value, only print "hello™ + message.
EE Metadata s ”
r_==L Documentation 6 *
{3} Recycle bin 7 * {talendTypes} String
a8 *
=) * {Category: User Defined
[n] *
1 * {parsm! string("world") input: The string need to be printed.
2 *
3 * {example} helloExemwple|"world™) # hello world !.
4 w7
58 public static woid helloExample (String message) |
5= outlin &2 Bl Code =0 3 if (message == null) {
= ", _ —
R o ; } wessage Worldr; //4$NON-NLZ-1%
H# routines =] System. out.println("Hello ™ + message + " ") //SHOM-NLZ-13% /7 SHICH
=@ IMyMewRoutine o '
el helloExampledString) : wo 41 %
4z hd
£ >
< > s O
£ Job | ) Contexts | 5% Component &2 [l Run job | 2, Modules 'E: Job Hierarchy =g
[

Thenewly created routine appearsinthe Repository treeview, directly below the Routinesnode. Theroutine
editor opens to reveal amodel routine which contains a simple example, by default, comprising descriptive
text in blue, followed by the corresponding code.

We advise you to add a very detailed description of the routine. The description should generally

¥ include the input and output parameters you would expect to use in the routine, aswell asthe results
returned along with an example. This information tends to be useful for collaborative work and the
maintenance of the routines.

The following example of codeis provided by default:

Talend Open Studio for Data Integration User Guide 291



How to edit user routines

public static void hell oExanpl e(String nmessage) {
if (message == null) {
nessage = "World"; //3SNON- NLS-1$

}
Systemout.println("Hell o

+ message + " I");

5. Modify or replace the model with your own code and press Ctrl+Sto save the routine. Otherwise, the routine
is saved automatically when you closeiit.

Y ou can copy all or part of a system routine or class and use it in auser routine by using the Ctrl+C and

¥ Ctrl+V commands, then adapt the code according to your needs. For further information about how to
customize routines, see Section 8.3, “Customizing the system routines”.

8.4.2. How to edit user routines

Y ou can modify the user routines whenever you like.

The system folder and all of the routines held within are read only.
7

To edit your user routines:

1. Right click the routine you want to edit and select Edit Routine.

2. Theroutine opens in the workspace, where you can modify it.

3. Onceyou have adapted the routine to suit your needs, press Ctrl+Sto save it.

If you want to reuse a system routine for your own specific needs, see Section 8.3, “Customizing the system
routines’.

8.4.3. How to edit user routine libraries

You can edit the library of any of the user routines by importing external .jar files for the selected routine. These
external library fileswill belisted, like modules, inthe M odulesview inyour current Studio. For moreinformation
on the M odules view, see Section 4.5.4, “How to install external modules’.

The .jar file of the imported library will be aso listed in the library file of your current Studio.

To edit auser routine library, complete the following:

1. IntheRepository tree view, expand Code > Routines.

2. Right-click the user routine you want to edit its library and then select Edit Routine Library.

The[Import External Library] dialog box displays.
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% Import External Library

Configuration of external libraries For routine, L

Library File: Module Regured | Description

testroutine. jar |

reload the library

@ Finish ] [ Cancel

3. Click New to open anew dialog box where you can import the external library.

You can delete any of the already imported routine files if you select the filein the Library File
s list and click the Remove button.

= New Module £ I'= @

() Input & library's name

(%) Browse a library file

Library File: | CiDocuments and SettingsihmassyiBureaute | [ Browse. .. ]

If the Library file is reguired

Description:

Ok, H Cancel ]

4. Enter the name of thelibrary filein the Input alibrary’s name field followed by the file format (.jar), or

5. Select the Browsealibrary file option and click browse to set the file path in the corresponding field.

6. If required, enter adescription in the Description field and then click OK to confirm your changes.
Theimported library fileislisted in the Library Filelist in the [Import External Library] dialog box.

7. Click Finish to close the dialog box.

The library file isimported into the library folder of your current Studio and also listed in the M odule view
of the same Studio.

For more information about the M odules view, see Section 4.5.4, “How to install externa modules”.
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8.5. Calling a routine from a Job

Pre-requisite: Y ou must have at least one Job created, in order to run aroutine. For further information regarding
how to create a Job, see Section 4.2.1, “How to create a Job " of the Talend Open Sudio for Data Integration
User Guide.

You can call any of your user and system routines from your Job components in order to run them at the same
time as your Job.

To access all the routines saved in the Routines folder in the Repository tree view, press Ctrl+Space in any of
the fields in the Basic settings view of any of the Talend components used in your Job and select the one you
want to run.

[i@ tivlysglConnection_1

Basic settings Property Type Built-In "

Adwvanced settings DE Versian Mysgl 5 e

Dwnamic sekkings Hast ..i.

Wig Database c context.local_database

T context.local_host
Username ¢ context.local_passwaord

_ : context. local_username

Encading Type I Datatperation. CHAR

DataCperation,DTx
DataCperation.FIX
DataCperation, <TD
global . jobMame
glabal . projectMane
Mathermatical. AES

[ Juse or register a sh.

Alternatively, you can call any of these routines by indicating the relevant class name and the name of the routine,
followed by the expected settings, in any of the Basic settings fields in the following way:

<Cl assNanme>. <Rout i neNane>

8.6. Use case: Creating a file for the current
date

This scenario describes how to use aroutine. The Job uses just one component, which calls a system routine.

[}

| T8
R T

F
LFileTowch_1

1. Inthe Palette, click File > Management, then drop a tFileTouch component onto the workspace. This
component allows you to create an empty file.

2. Double-click the component to open its Basic settings view in the Component tab.
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3. IntheFileNamefield, enter the path to accessyour file, or click [...] and browsethe directory tolocatethefile.

|_j " tFileTouch_1

Basic settings File Mame "D Inputcuskonmer, bxk”
Advanced seftings [ licreate direckory if not exisks:

[vnamic settings

Wiew

Documentakion

4. Closethe double inverted commas around your file extension as follows: " D:/Input/customer” .txt.
5. Add the plus symbol (+) between the closing inverted commas and the file extension.

6. Press Ctrl+Space to open alist of al of the routines, and in the auto-completion list which appears, select
TalendDate.getDate to use the Talend routine which allows you to obtain the current date.

7. Modify the format of the date provided by default, if required.

8. Enter the plus symbol (+) next to the getDate variable to complete the routine call, and place doubleinverted
commas around the file extension.

Lj " tFileTouch_1

Basic settings File Mame "D /Tnputfcustomer”+TalendDate. getDate!"CCYY-MM-DD hhmmss"+", csw"
Advanced settings [(]create directary if nok exists

Dwnamic settings

Wiew
Docurmentatian
If you are working on windows, the":" between the hours and minutes and between the minutes and
F iy

seconds must be removed.

9. PressF6 to run the Job.

ThetFileT ouch component creates an empty file with the days date, retrieved upon execution of the GetDate

routine called.
LT', customer2010-02-09
L a 134105, csv
r| Fichier C5% Microsoft Office E. ..
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Chapter 9. Using SQL templates

SQL templates are groups of pre-defined query arguments that run in the ELT mode. This chapter explains the
ELT mode, defines the SQL templates and provides user scenarios to explain how to use the SQL templates or
how to create your own ones.

Before starting any data integration processes, you need to be familiar with Talend Open Sudio for Data
Integration Graphical User Interface (GUI). For more information, see Appendix A, GUI.
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What iSELT

9.1. What is ELT

Extract, Load and Transform (ELT) is a data manipulation process in database usage, especidly in data
warehousing. Different from the traditional ETL (Extract, Transform, Load) mode, in ELT, data is extracted,
loaded into the database and then is transformed where it sitsin the database, prior to use. Thisdatais migrated in
bulk according to the data set and the transformation process occurs after the data has been |oaded into the targeted
DBMSinitsraw format. Thisway, less stress is placed on the network and larger throughput is gained.

However, the ELT mode is certainly not optimal for al situations, for example,
» AsSQL isless powerful than Java, the scope of available data transformationsis limited.
* ELT requires users that have high proficiency in SQL tuning and DBM S tuning.

» Using ELT with Talend Open Sudio for Data Integration, you cannot pass or reject one single row of data as
you can do in ETL. For more information about row rejection, see Section 4.3.1.1, “Row connection”.

Based on the advantages and disadvantages of ELT, the SQL templates are designed as the ELT facilitation
requires.

9.2. Introducing Talend SQL templates

SQL is a standardized query language used to access and manage information in databases. Its scope includes
data query and update, schema creation and modification, and data access control. Talend Open Sudio for Data
Integration provides arange of SQL templatesto simplify the most common tasks. It also comprisesa SQL editor
which alows you to customize or design your own SQL templates to meet |ess common regquirements.

These SQL templates are used with the components from the Talend ELT component family including
tSQL Template, tSQLTemplateFilterColumns, tSQLTemplateCommit, tSQL TemplateFilter Rows,
tSQL TemplateRollback, tSQL TemplateAggr egate and t SQL TemplateM er ge. These components execute the
selected SQL statements. Using the UNION, EXCEPT and INTERSECT operators, you can modify data directly
on the DBM S without using the system memory.

Moreover, with the help of these SQL templates, you can optimize the efficiency of your database management
system by storing and retrieving your data according to the structural requirements.

Talend Open Sudio for Data I ntegration provides the following types of SQL templatesunder the SQL templates
node in the Repository tree view:

» System SQL templates: They are classified according to the type of database for which they are tailored.
» User-defined SQL templates: these are templates which you have created or adapted from existing templ ates.
More detailed information about the SQL templatesis presented in the bel ow sections.

For further information concerning the components from the ELT component family, see Talend Open Studio
Components Reference Guide.

Asmost of the SQL templates are tailored for specific databases, if you change database in your system,
¥ it isinevitable to switch to or develop new templates for the new database.

9.3. Managing Talend SQL templates

Talend Open Sudio for Data Integration enables you viathe SQL Templatesfolder in the Repository tree view
to use system or user-defined SQL templates in the Jobs you create in the Studio using the ELT components.
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The below sections show you how to manage these two types of SQL templates.

9.3.1. Types of system SQL templates

This section gives detail information related to the different types of the pre-defined SQL templates.

Even though the statements of each group of templates vary from database to database, according to the operations
they are intended to accomplish, they are also grouped on the basis of their types in each folder.

The below table provides these types and their related information.

Name Function Associated components Required component
parameters
Aggregate Redlizes  aggregation|tSQL TemplateAggregate Database name
(sum, average, count,
etc.) over aset of data. Source table name
Target table name
Commit Sends a  Commit|tSQL Template Null
instruction to RDBMS  [tSQL TemplateAggr egate
tSQL TemplateCommit
tSQL TemplateFilter Columns
tSQL TemplateFilter Rows
tSQL TemplateMerge
tSQL TemplateRollback
Rollback Sends a  Rollback|tSQL Template Null
instruction to RDBMS. |[tSQL TemplateAggregate
tSQL TemplateCommit
tSQL TemplateFilter Columns
tSQL TemplateFilter Rows
tSQL TemplateMerge
tSQL TemplateRollback
DropSourceTable |Removes asourcetable. |tSQL Template Table name (when use
tSQL TemplateAggregate tSQL Template)
tSQL TemplateFilter Columns
tSQL TemplateFilter Rows Source table name
DropTargetTable |Removesatarget table |tSQL TemplateAggregate Target table name
tSQL TemplateFilter Columns
tSQL TemplateFilter Rows
Filter Columns Selects and extracts a|tSQL TemplateAggregate Target table name (and
set of data from given|tSQL TemplateFilter Columns schema)
columnsin RDBMS. tSQL TemplateFilter Rows
Source table name (and
schema)
Filter Row Selects and extracts a set |t SQL TemplateAggr egate Target table name (and
of data from given rows|tSQL TemplateFilter Columns schema)
in RDBMS. tSQL TemplateFilter Rows
Source table name (and
schema)
Conditions
Mergelnsert Inserts records from the|tSQL TemplateM erge Target table name (and
source table to the target |t SQL TemplateCommit schema)

table.
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Source table name (and
schema)

Conditions

MergeUpdate Updates the target table|tSQL TemplateM erge Target table name (and
with records from the|tSQL TemplateCommit schema)
source table.

Source table name (and
schema)

Conditions

9.3.2. How to access a system SQL template

To access asystem SQL template, expand the SQL Templates node in the Repository tree view.
151 X T Mavigat | O
LOCAL: component = ,:é}:. B b4

Lf Business Models
i1 Job Designs
Contexts
+ Code
= _r SOL Templates
=I-[=F Generic
= system
_r Agaregate 0.1
LI commit 0.1
_r DropSaourceTable 0.1
_r CropTargetTable 0.1
_r FilterZaolumns 0.1
I Filkerrow 0.1
" Rollback 0.1
T userDefined
= Hive
#-- L] system
L UserDefined
My SOL

&
[ Metezza

L oradle

L paraccel

[ Teradata
Metadata
Documentation
Recycle bin

+
I!;WE:D+++++

13
\_'

Each folder contains system sub-folders containing pre-defined SQL statements, as well as a User Defined folder
in which you can store SQL statements that you have created or customized.

Each system folder contains severa types of SQL templates, each designed to accomplish a dedicated task.

Apart from the Generic folder, the SQL templates are grouped into different folders according to the type of
database for which they are to be used. The templatesin the Generic folder are standard, for use in any database.
You can use these as a basis from which you can develop more specific SQL templates than those defined in
Talend Open Sudio for Data Integration.
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"

The system folders and their content are read only.

From the Repository tree view, proceed as follows to open an SQL template:

1. IntheRepository tree view, expand SQL Templates and browse to the template you want to open.

2. Double click the class that you want to open, for example, aggregate in the Generic folder.

The aggregate template view displaysin the workspace.

| [ aggregate 0.1 52 =B

1

<%
EXTRACT(__ GROUPEY__ ):
EXTRACT{__ OPERATICH ) :
String operation = "'";
bhoolean flag=false;
for(int i=0; i < _ OPERATICN_INFUT_ COLUMNM__ .length: i++){

if (flac) |

operation += ", ";

telse(

flag=true;

b

operation += (_ OPERATICN FUNCTION [i] + "(" + _ OPERATICN INPU

b
£33

INSERT INTO <%= TABLE NAME TARGET %> (<%=StringUtils.list( OPERATI
SELECT <%= operation %>, <%= StringUtils.list( GROUPBY INPUT COLUMN
GROUP BY <%=StringUtils.list( GROUPBY INPUT COLUMN , ",r, mn, mwej g

4 b

You can read the predefined aggregate statements in the template view. The parameters, such as
TABLE_NAME_TARGET, oper at i on, areto be defined when you design related Jobs. Then the parameters can
be easily set in the associated components, as mentioned in the previous section.

Everytimeyou click or open an SQL template, its corresponding property view displays at the bottom of the studio.
Click the aggregate template, for example, to view its properties as presented below:

T S0L Te
T Aggregate 0.1

Main

Wersian

&3 Context | 5% Compon | 0B Run (Jo | [2 Problem F2 Modules | d& Talend B Schedul Tg JobHer | — 8

Marme

Author Version
Purpose Status
Description

Creation Modification

For further information regarding the different types of SQL templates, see Section 9.3.1, “ Types of system SQL

templates”

For further information about how to use the SQL templates with the associated components, see Section 4.4.3,
“How to use the SQL Templates’.
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9.3.3. How to create user-defined SQL templates

Asthe transformation you need to accomplish in ELT may exceed the scope of what the given SQL templates can
achieve, Talend Open Sudio for Data Integration allows you to develop your own SQL templates according to
somewriting rules. These SQL templates are stored in the User -defined fol ders grouped according to the database
type in which they will be used.

For more information on the SQL template writing rules, see Appendix D, SQL template writing rules.
To create a user-defined SQL template:

1. Inthe Repository tree view, expand SQL Templates and then the category you want to create the SQL
templatein.

= =_r S0L Templates
E-[= Generic
(] sysbem
]
3 Hive E Create SQOLTemplate
[ MywSOL [ Create folder
£ Metezza 43 Import itermns
3 Oracle
[ Parfceel
[ Teradata

2. Right-click User Defined and select Create SQL Template to open the [SQL Templates] wizard.

# New SQLTemplate |:| @

New SOL Template
Add a new SQL Template to repository

Mame |SQLTempIate |

Purpose | |

Descripkion

Author

Locker

|

| |
Version | ||E]

|

|

Stakus b |

Path || Select ]

@ Finish l [ Cancel

3. Enter the information required to create the template and click Finish to close the wizard.
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The name of the newly created template appears under User Defined in the Repository tree view. Also, an
SQL template editor opens on the design workspace, where you can enter the code for the newly created
template.

For further information about how to create a user-defined SQL template and how to use it in a Job, see
tMysqglTableList in Talend Open Studio Components Reference Guide.

9.3.4. A use case of system SQL templates

As there are many common, standardized SQL statements, Talend Open Sudio for Data Integration allows you
to benefit from various system SQL templates.

This section presents you with a use case that takes you through the steps of using MySQL system templatesin
a Job that:

* opens a connection to aMysgl database.

collects data grouped by specific value(s) from a database table and writes aggregated datain atarget database
table.

deletes the source table where the aggregated data comes from.

reads the target database table and lists the Job execution result.

To connect to the database and aggregate the database table columns:

Procedure 9.1. Configuring a connection to a MySQL database

1. Drop the following components from the Palette onto the design workspace: tMysglConnection,
tSQL TemplateAggregate, tSQL TemplateCommit, and tMysgllnput, tL ogRow.

2. Right-click tMysglconnection and from the contextual menu, select Trigger > OnComponentOk to connect
tMysglConnection to tSQL TemplateAggr egate.

3. Connect tSQL TemplateAggregate, tSQL TemplateCommit and tMysgllnput using OnComponentOk
links.

4. Connect tMysgllnput to tL ogRow using an Main > Row link.
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tMysqICD nection_1
CnCompprientok, =

f

tSQLTempIat Aggregate 1

onsutjobick

_.‘_I:I'_m_

&

ESQLTemplabeCommit_1

arEn ]DbOk - - I . . . . . . . . . —

& _ _ ru:ul.:\.ll {Ma_in]l _ _ " ““‘\

EMysqlInput_1 ' ' " HLogRow 1

a———

In the design workspace, select tMysqlConnection and click the Component tab to define the component
basic settings.

In the Basic settings view, set the database connection details manually.

5y Job(EL Conkex | 5 Compo 54 O Runid | [£¢ Proble | Z Module | s Talend BY Sched ?g JobH | T B

=11
[i’:l] tMysqlConnection_1 Sl D

Basic settings Property Type Repository || | DB (MYSQL):Localhost ()

Advanced settings DB Yersion .

Lrynamic settings Host “lacalhost" o Port | "3308" .

=Y [atabase "tunit" ? Additional JIDBC Parameters | "noDatetimestring o

Docurnenkation " *
Username "rook" n Passworg | e .
Encoding Type IS0-8859-15 4

[Juse or register a shared DB Connection

In the design workspace, select tSQL TemplateCommit and click the Component tab to define its basic
settings.

Onthe Databasetypelist, select therelevant database type, and from the Component list, select the relevant
database connection component if more than one connection is used.

Procedure 9.2. Grouping data, writing aggregated data and dropping the source table

1. Inthe design workspace, select tSQL TemplateAggregate and click the Component tab to define its basic
Settings.

2. OntheDatabasetypelist, select the relevant database type, and from the Component list, select the relevant
database connection component if more than one connection is used.

3. Enter the names for the database, source table, and target table in the corresponding fields and click the[...]
button next to Edit schema to define the data structure in the source and target tables.
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The source table schema consists of three columns: First Name, Last Name and Country. The target table
schema consists of two columns; country and total. In this example, we want to group citizens by their
nationalities and count citizen number in each country. To do that, we define the Operations and Group
by parameters accordingly.

1 Job(ELT Context | Ge Compon 9 0B Run (Job | [2 Problem | =, Modules | @& Talend E | &Y Schedul | T2 Job Hier

=0a
| E
[.-——.~ tsOLTemplateAggregate_1 =5
o—
Basic settings Database Type IMysgl w | Component List  |EMysgliConneckion_L s
Advanced settings Database name "tunit"
Dynamic sektings Source kable name | "Citizen'withLabel" Schema  |Repasitory s || |DB (MYSQL):Localhost - citizen
SGL Templake =
Q & Target kable name  |"CitizenCount” Schema |Repository s || |DB (MYSQL):Localbost - citizen
View
Documnentation ©perations Oukput column Function Input colurn position
Tokal counk Counkry
< >
Group by Qukput calumn Input column position
Counkey Country
< >

In the Oper ations table, click the plus button to add one or more lines and then click in the Output column
line to select the output column that will hold the counted data.

Click in the Function line and select the operation to be carried on.

In the Group by table, click the plus button to add one or more lines and then click in the Output column
line to select the output column that will hold the aggregated data.

Click the SQL template tab to open the corresponding view.
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10.

“py Job(EL Conkex | e Compo £ OB Run (1 | [20 Proble | 2, Module | #& Talend | EY Sched ?g Job Hi

["—_E" tSOLTemplateAggregate_1

Basic settings

Advanced settings

Crynamic setkings S0L Temnplate Lisk

SQL Template My a0LAggregate

View MySOLDropSourceTable
Docurmentation

[cuzndd] [ S;EDelete] [ @u;:.] [J}dnwn]

<%

EXTRACT{ _GROUPEY );

EXTRACT, OPERATION O

Skring operation ="}

baonolean flag=false;

Forfint i=0; i = _ OPERATION_INPUT COLUMM_length; i++3
iFiFlag)d
operation +=
telseq
Flag=true;

} W

nou,
L]

Click the plus button twice under the SQL template list table to add two SQL templates.

Click on thefirst SQL template row and select the MySQLAggregate template from the drop-down list. This
template generates codes to aggregate data according to the configuration in the Basic settings view.

Do the same to select the MySQL DropSour ceTabl e template for the second SQL template row. Thistemplate
generates codes to delete the source table where the data to be aggregated comes from.

To add new SQL templatesto an ELT component for execution, you can simply drop the templates

of your choice either onto the component in the design workspace, or onto the component’s SQL
templatelist table.

The templates set up in the SQL template list table have priority over the parameters set in
the Basic settings view and are executed in a top-down order. So in this use case, if you select
MySQL DropSourceT able from the list, the source table will be deleted prior to aggregation,
meaning that nothing will be aggregated.

Procedure 9.3. Reading the target database and listing the Job execution result

1.

In the design workspace, select tMysglInput, and click the Component tab to define its basic settings.
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& tMysglinput_1

Basic settings

Advanced settings Schema
Dwnarmic settings Table Name
Wiew

Query Tvpe
Documentation

Query

=B
==

Use an existing connection  Component List | tMysglConnection_1 s

Repositary s | | DB (MySQL):Localhost - citizencount

“citizencount” [::]

Built-In L [Guess Query] [Guess schema]

"SELECT citizencount . country o ¥ [:]
citizencount  total
FEOM citizencount”

Select the Use an existing connection check box to use the database connection that you have defined on

the tMysglConnection component.

To define the schema, select Repository and then click the three-dot button to choose the database table
whose schemaiis used. In this example, the target table holding the aggregated datais selected.

In the Table Name field, type in the name of the table you want to query. In this example, the table is the

one holding the aggregated data.

In the Query area, enter the query statement to select the columns to be displayed.

Save your Job and press F6 to execute it.

The source table is del eted.

Searfing qob FLTFPumdoangs a6 G50 457 287055808

[stati=tics] connecting to socket on port 3918

[2tati=tics] connected

tLogRow_1
=______+____ =
country | total
=______+____ =
Canada |2030
China |2012
France |2009
Japan |1925
TSA [2024

[=2tati=tics] dis=connhected
SJoaf FLIFinTang amded g6 5047 SeeoieBel g fasr e oodesiy

A two-column table citizencount is created in the database. It groups citizens according to their nationalities

and gives their total count in each country.
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Appendix A. GUI

This appendix describes the Graphical User Interfaces (GUI) of Talend Open Sudio for Data Integration.
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Main window

A.1. Main window

Talend Open Sudio for Data Integration main window is the interface from which you manage al types of data
integration processes.

The Talend Open Sudio for Data Integration multi-panel window is divided into:
* menu bar,

* toolbar,

» Repository tree view,

* design workspace,

+ Palette,

* various configuration views in a tab system, for any of the elements in the data integration Job designed in
the workspace,

e QOutlineview and Code Viewer.

The figure below illustrates Talend Open Sudio for Data Integration main window and its panels and views.

File Edit Wiew Window Help

L|:|.I Pl g S = & A i ) |f 100% s Y | oy Integration
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LOCAL: rB2575 = (I ' ) : : ’ ; - g g - = - - : 5
5 | o 8 .
i Business Models |~ i ' : : ' ' ’ ’ ' ' ’ ’ = =4
+ 1 Job Designs
Contexts e [ Business Intelligence
+ Code " =b = Busingss

+ _r SQL Templates

‘tRowGerisrator 2
+-{i] Metadata i

[~ Custom Code
= Daka Quality

r.% Documentation
-3 Recyde bin rnw_2 (L;ool_mp) [ Databases

; [=ELT
= : = = ESB

. R e
=% rowl (Main) aukput (Main ey, (= File

"tRowGenerator_1 i tMap_1 i " tLogRow_1
=% Inkernet

= Logs & Errors

= Designer | Code =l
EE o 52 » g [=% Misc
5 |8 “h Jobike Conkex | %8 Compo &3 . (B Run (Jo| @& Talend | [21 Proble = B || L= Orchestration
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+- tLogRow _1 LI‘“_&';J tLogRow_1 [ lc? :
- thlap_t . = Sample
= N . ach Buile-In i
- tRowGenerator_L Basic settings £hema v edeschems (] @ [ System
+|- tRowGenerstor 2 Advanced settings @M%i?sic (2= Talend MOM
[rvnamic setkings [ 3L

Ve ("3 Table {print values in cells of a table)
Documentation (i vertical (sach row is a keyjvalue list)

Field Separator "

[C]Print header

[CIprint component unique name in Front of each aukpuk row
[ Frint schema calumn name in Frant of each value

[Juse fixed length for values

The various panels and their respective features are detailed hereafter.
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Menu bar and Tool bar

All the panels, tabs, and views described in this documentation are specific to Talend Open Sudio for

¥ Data Integration. Some views listed in the [Show View] dialog box are Eclipse specific and are not
subjects of this documentation. For information on such views, check Eclipse online documentation at
http://www.eclipse.org/documentation/.

A.2. Menu bar and Toolbar

At thetop of the Talend Open Studio for Data Integration main window, various menus and a quick accesstoolbar
gather Talend commonly features along with some Eclipse functions.

A.2.1. Menu bar of Talend Open Studio for Data
Integration

Talend Open Sudio for Data Integration’s menus include:
» some standard functions, such as Save, Print, Exit, which are to be used at the application level.

» some Eclipse native features to be used mainly at the design workspace level as well as specific Talend Open
Sudio for Data Integration functions.

The table below describes menus and menu items available to you on the menu bar of Talend Open Sudio for
Data Integration.

The menus on the menu bar differ slightly according to what you are working with: a Business Model
' or aJob.

Menu Menu item Description

File Close Closes the current open view on the Studio design workspace.
Close All Closes all open views on the Studio design workspace.
Save Saves any changes done in the current open view.
Save as Saves any changes done without changing the current open view.

For more information, see Section 3.6, “ Saving a Business Model”

Save All Saves any changes donein all open views.

Print Unavailable option.

Switch project | Closesthe current session and launches another one to enable you to open
adifferent project in the Studio.

Edit project | Opens a dialog box where you can customize the settings of the current
properties project.

For more information, see Section 2.6, “ Customizing project settings”

Import Opensawizard that helpsyou toimport different types of resources (files,
items, preferences, XML catalogs, etc.) from different sources.

Export Opens a wizard that helps you to export different types of resources
(files, items, preferences, breakpoints, XML catalogs, etc.) to different
destinations.

Exit Closes The Studio main window.

Open File Opens afile from within the Studio.

Edit Undo Undoes the last action done in the Studio design workspace.
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Menu Menu item Description
Redo Redoes the last action done in the Studio design workspace.
Cut Cuts selected object in the Studio design workspace.
Copy Copies the selected object in the Studio design workspace.
Paste Pastes the previously copied object in the Studio design workspace.
Delete Deletes the selected abject in the Studio design workspace.
Select All Selects all components present in the Studio design workspace.
View Zoom In Obtains alarger image of the open Job.
Zoom Out Obtains a smaller image of the open Job.
Grid Displays grid in the design workspace. All items in the open Job are
snapped to it.
Snap to| Enables the Snap to Geometry feature.
Geometry
Window Per spective Opens different perspectives corresponding to the different items in the
list.
Show View... Opensthe[Show View] dialog box which enablesyou to display different
views on the Studio.
Maximize Active|Maximizesthe current perspective.
View or Editor...
Preferences Opens the [Preferences] dialog box which enables you to set your
preferences.
For more information about preferences, see Section 2.5, “ Setting Talend
Open Studio for Data Integration preferences’
Help Welcome Opens awelcoming page which haslinksto Talend Open Sudio for Data
Integration documentation and Talend practical sites.
Help Contents | Opens the Eclipse help system documentation.
About Talend|Displays:
Open Sudio for
Data Integration |-the software version you are using,
-detailed information on your software configuration that may be useful
if thereisaproblem,
-detailed information about plug-in(s),
-detailed information about Talend Open Sudio for Data Integration
features.
Export logs Opens a wizard that helps you to export all logs generated in the Studio
and system configuration information to an archived file.
Software Find and Install.... Opens the [Install/Update] wizard that helps
Updates searching for updates for the currently installed features, or searching for
new featuresto install.
Manage Configuration...: Opens the [Product Configuration] dialog
box where you can manage Talend Open Sudio for Data Integration
configuration.
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A.2.2. Toolbar of Talend Open Studio for Data
Integration

The toolbar containsicons that provide you with quick access to the commonly used operations you can perform
from Talend Open Studio for Data Integration main window.

Theiconsonthetoolbar differ slightly according to what you are working with: aBusinessModel or a Job.
J

The table below describes the toolbar icons and their functions.

Name Icon Description

Save = Saves current job design.

Save as 1= Saves as another new Job.

Export items = Exports repository items to an archive file, for deploying outside Talend

- Open Sudio for Data Integration. Instead if you intend to import the
exported element into a newer version of Talend Open Sudio for Data
Integration or of another workstation, make surethe sourcefilesareincluded
in the archive.

Import items & Imports repository items from an archive fileinto your current Talend Open
Sudio for Data Integration. For more information regarding the import/
export items feature, see Section 5.2.1, “How to import items”.

Find a specificjob | Displays the relevant dialog box that enables you to open any Job listed in

. the Repository tree view.

Run job O - Executesthe Job currently shown on the design space. For moreinformation
about job execution, see Section 4.2.7, “How to run a Job”.

Create Al Launches the relevant creation wizard. Through this menu, you can create
any repository item including Business models, Job Designs, contexts,
routines and metadata entries.

Project settings Launches the [Project Settings] dialog box. From this dialog box, you can

= add a description to the current Project and customize the Palette display.
For more information, see Section 2.6, “ Customizing project settings’.

Detect and update| Searches for all updates available for your Jobs.

all jobs

Export ~ Talend| Launchesthe[Export Talend pr oj ects] wizard. For moreinformation about

projects = project export, see Section 2.4.6, “How to export a project”.

A.3. Repository tree view

The Repository tree view gathers al the technical items that can be used either to describe business models or
to design Jobs. It gives access to any item including Business M odels, JobDesigns, as well as reusable routines
or documentation.

The Repository centralizes and stores all necessary elements for any Job design and business modeling contained
in aproject.

The figure below illustrates the elements stored in the Repository.
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Z| Documentation
(3} Recycle bin

L
The Refresh button " allows you to update the tree view with the last changes made.

The Activate filter button Ho Lv@ allows you to open the filter settings view so as to configure the display of
the Repository view.

The Repository tree view stores all your data (Business, Jobs) and metadata (Routines, DB/File connections, any
meaningful Documentation and so on).

The table below describes the nodes in the Repository tree view.

Node Description

Business M odels Under the Business M odels folder, are grouped all business models of the project.
Double-click the name of the model to open it on the design workspace. For more
information, see Chapter 3, Designing a Business Model.

Job Designs The Job Designs folder shows the tree view of the designed Jobs for the current
project. Double-click the name of the Job to open it on the design workspace. For
more information, see Chapter 4, Designing a data integration Job.

Contexts The Context folder groups files holding the contextual variables that you want
to reuse in various Jobs, such as filepaths or DB connection details. For more
information, see Section 4.4.2, “How to centralize contexts and variables’.

Code The Code folder is a library that groups the routines available for this project and
other pieces of code that could be reused in the project. Click the relevant tree entry
to expand the appropriate code piece.

For more information, see Chapter 4, Designing a data integration Job.

SQL Templates TheSQL Templatesfolder groupsall system SQL templates and givesthe possibility
to create user-defined SQL templates. For more information, see Section 4.4.3, “How
to use the SQL Templates”.

M etadata The M etadata folder bundles files holding redundant information you want to reuse
in various Jobs, such as schemas and property data. For more information, see
Chapter 4, Designing a data integration Job.

Documentation The Documentation folder gathers all types of documents, of any format.This could
be, for example, specification documents or adescription of technical format of afile.
Double-click to open the document in the relevant application. For more information,
see Section 5.6.1, “How to generate HTML documentation”.

Recycle bin The Recycle bin groups al elements deleted from any folder in the Repository tree
view.

The deleted elements are still present on your file system, in the recycle bin,
4 until you right-click the recycle bin icon and select Empty Recycle bin.
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Node Description
Expand the recycle bin to view any folders, subfolders or elements held
2 within. You can action an element directly from the recycle bin, restore it
or delete it forever by clicking right and selecting the desired action from
thelist.

A.4. Design workspace

In the Talend Open Sudio for Data Integration’s design workspace, both Business Models and Job Designs can
belaid out.

For more information, see Section 3.2, “Opening or creating aBusiness Model” and Section 4.2.1, “How to create
aJob”.

For both Business Models and Job Designs: active designs display in a easily accessible tab system above this
workspace.

For Job Designs only: Under this workspace, you can access several other tabs:
 the Designer tab: opens by default when creating a Job. It displays the Job in agraphical mode.
« the Code tab: enables you to visualize the code and highlights the possible language errors.

Warnings are indicated in yellow whereas errors are indicated in red.
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APaletteisdocked at the top of the design workspace to help you draw the model corresponding to your workflow
needs.

A.5. Palette

From the Palette, depending on whether you are designing a Job or modeling a Business Model, you can drop
technical components or shapes, branches and notes to the design workspace. You can define and format them
using the various tools offered in the Business M odel view for the Business Models and in the Component view
for the Job.
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Configuration tabs

Related topics:
» Chapter 3, Designing a Business Model.
» Chapter 4, Designing a data integration Job.

» Section 4.2.8.1, “How to change the Pal ette layout and settings”.

A.6. Configuration tabs

The configuration tabs are located in the lower half of the design workspace. Each tab opens a view that displays
the properties of the selected element in the design workspace. These properties can be edited to change or set the
parameters related to a particular component or to the Job as awhole.

tFileInputPositional _1 ' ' ' " tFileOutputsML_1

Designer | Code

ipy Job{tFileOutputiML_s1 23 Contexts{Job tFileOutp | %2 Component | 0B Run (Job tFileOutputsM t Problems =B

iy tFileOutputXML_s1 0.1

Main Mame

Extra . L
Author Yersion

Stats & Logs

Yersion Purpose Status
Description
Crestion Modification

The Component, Run Jobs, Problems and Error Log views gather all information relative to the graphical
elements selected in the design workspace or the actual execution of the open Job.

The M odules and Scheduler tabs arelocated in the same tab system as the Component, L ogs and Run Job tabs.
Both views are independent from the active or inactive Jobs open on the design workspace.

Y ou can show moretabsin thistab system and directly open the corresponding view if you select Window
¥ > Show view and then, in the open dial og box, expand any node and sel ect the element you want to display.

The sections bel ow describe the view of each of the configuration tabs.

View Description

Component Thisview details the parameters specific to each component of the Palette. To build a Job that
will function, you arerequired to fill out the necessary fields of this Component view for each
component forming your Job.

For more information about the Component view, see Section 4.2.6, “How to define
component properties’.

Run Job This view obviously shows the current job execution. It becomes alog console at the end of
an execution.
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View

Description

For details about job execution, see Section 4.2.7, “How to run a Job”.

Error Log

This view is mainly used for Job execution errors. It shows the history of warnings or errors
occurring during job executions.

Thelog tab has also an informative function for a Java component operating progress,
¥ for example.

Error Log tabishidden by default. Asfor any other view, go to Window > Show views, then
expand PDE Runtime node and select Error Log to display it on the tab system.

Modules

This view shows if amodule is necessary and required for the use of areferenced component.
Checking the Modules view helps to verify what modules you have or should have to run
smoothly your Jobs.

For more information, see Section 4.5.4, “How to install external modules”.

Scheduler

This view enables you to schedule a task that will launch periodically the Job you select via
the crontab program.

For more information, see Section 4.5.5, “How to launch a Job periodically”.

Job view

The Job view displays various information related to the open Job on the design workspace.
This view has the following tabs:

Main tab

This tab displays basic information about the Job opened on the design workspace, i.e. its
name, author, version number, etc. The information is read-only. To edit it you have to close
your Job, right-click its label on the Repository tree view and click Edit properties on the
drop-down list.

Extratab

Thistab displays extraparametersincluding multi thread and implicit context loading features.
For more information, see Section 4.6.7.2, “How to use the features in the Extra tab”

Stats/Log tab
Thistab allows you to enable/disable the statistics and logs for the whole Job.

Y ou can already enable these features for every single component of your Job by simply using
and setting the relevant components: tFlowM eter Catcher, tStatCatcher, tL ogCatcher.

For moreinformation about these components, see Talend Open Sudio Components Reference
Guide.

In addition, you can now set these features for the whole active Job (i.e. al components of
your Job) in one go, without using the Catcher components mentioned above. This way, all
components get tracked and logged in the File or Database table according to your setting.

Y ou can also save the current setting to Project Settings by clicking the[ Save to project settings
button.

For more details about the Stats & Logs automation, see Section 4.6.7.1, “How to automate
the use of statistics & logs’.

Version tab

This tab displays the different versions of the Job opened on the design workspace and their
creation and modification dates.

Talend Open Studio for Data Integration User Guide 317



Outline and code summary panel

View Description

Problems Thisview displaysthe messages|linked to theicons docked at acomponentsin case of problem,
for example when part of its setting is missing. Three types of icons/messages exist: Error,
Warning and Infos.

For more information, see Section 4.6.3.1, “Warnings and error icons on components’.

Job Hierarchy |Thisview displaysatreefolder showing the child Job(s) of the parent Job selected. To show this
view, right-click the parent Job in the Repository tree view and select Open Job Hierarchy
on the drop-down list.

Y ou can also show thisview in the Window > Show view... combination where you can select
Talend > Job Hierarchy.

You can see Job Hierarchy only if you create a parent Job and one or more child Job(s)
viathe tRunJob component. For more information about tRunJob, see Talend Open Sudio
Components Reference Guide.

Properties When inserting a shape in the design workspace, the Properties view offers a range of
formatting tools to help you customizing your business model and improve its readability.

A.7. Outline and code summary panel

This panel is located below the Repository tree view. It displays detailed information about the open Job or
Business Model in the design workspace.

The Information panel is composed of two tabs, Outline and Code Viewer, which provide information regarding
the displayed diagram (either Job or Business Model) and al so the generated code.

For more information, see Section 4.6.5, “How to display the code or the outline of your Job”.

A.8. Shortcuts and aliases

Below is atable gathering all keyboard shortcuts currently in use:

Shortcut Operation Context

F2 Shows Component settings view. Global application

Fa Shows Run Job view. Global application

F6 Runs current Job or shows Run Job view if no Job is| Global application
open.

Ctrl + F2 Shows M odule view. Global application

Ctrl + F3 Shows Problems view. Global application

Ctrl +H Shows the Designer view of the current Job. Global application

Ctrl +G Shows the Code view of the current Job. Global application

Ctrl +R Restores the initial Repository view. From Repository view

Ctrl + Shift + F3 | Synchronizes components javajet components. Global application

Ctrl + Shift +J  |Opens a Job. Global application (In Windows)

F7 Switches to Debug mode. From Run Job view

F5 Refreshes the Repository view. From Repository view
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Shortcut Operation Context

F8 Kills current Job. From Run Jab view

F5 Refreshes M odules install status. From Modules view

Ctrl+L Execute SQL queries. Talend commands (in Windows)
Ctrl+Spacebar  |Access global and user-defined variables. It can be| From any component field in Job or

error messages or line number for example, depending
on the component selected.

Component views
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Appendix B. Theory into practice: Job
examples

This chapter aims at users of Talend Open Sudio for Data Integration who seek areal-life use case to help them

take full control over the product. This chapter comes as a complement of the Talend Open Sudio Components
Reference Guide.
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tMap Job example

B.1. tMap Job example

B.1.1. Introducing the scenario

To illustrate the way Talend Open Studio for Data Integration operates, find below a real-life example scenario.
In this scenario, we will load a MySQL table with afile, that gets transformed on the fly. Then in afurther step,
we will select the datato be loaded using a dynamic filter.

Before actually starting the Job, let’ s inspect the input data and the expected output data.

B.1.1.1. Input data

Our input file, the data of which will be loaded into the database table, lists clients from all over the State of
Cdlifornia

The file structure usually called Schema in Talend Open Sudio for Data Integration includes the following
columns;

* First name
e Last name
» Address

» City

B.1.1.2. Output data

We want to load into the database, Californiaclientsliving in a couple of Counties only: Orange and Los Angeles
counties.

The table structure is dlightly different, therefore the data expected to be loaded into the DB table should have
the following structure:

» Key (key, Type: Integer)

* Nane (Type: String, max. length: 40)

» Addr ess (Type: String, max.length: 40)

* County (Type: String, max. length:40)

In order to load this table, we will need to use the following mapping process:
The Key column is fed with an auto-incremented integer.

The Nane column isfilled out with a concatenation of first and last names.

The Addr ess column data comes from the equivalent Address column of the input file, but supports a upper-
case transformation before the loading.
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The Count y column is fed with the name of the County where the city is located using a reference file which
will help filtering Orange and Los Angeles counties’ cities.

B.1.1.3. Reference data

As only Orange and Los Angeles counties data should be loaded into the database, we need to map cities of
Californiawith their respective county, in order to filter only Orange and Los Angeles ones.

To do so, we will use areferencefile, listing cities that are located in Orange and Los Angeles counties such as:

City County
Agoura Hills Los Angeles
Alhambra Los Angeles
Aliso Vigo Orange
Anaheim Orange
Arcadia LosAngeles

The referencefile in this Job is named LosAngel esandOrangeCounties.txt.

B.1.2. Translating the scenario into a Job

In order to implement this scenario, let’s break down the Job into four steps:
1. Creation of the Job, configuration of the input file parameters, and reading of the input file,
2. Mapping of data and transformations,

3. Definition of the reference file parameters, relevant mapping using thetM ap component, and sel ection of inner
join mode,

4. Redirection of the output into aMySQL table.

B.1.2.1. Step 1: Job creation, input definition, file reading

Launch Talend Open Studio for Data Integration, and create a local project or import the demo project if you
are launching Talend Open Sudio for Data Integration for the first time. For more information, see Section 2.2,
“Launching Talend Open Sudio for Data Integration” and Section 2.4, “Working with projects’.

The main window of Talend Open Studio for Data Integration is divided into several areas:

» Totheleft: the Repository tree view that holds Jobs, Business Models, M etadata, shared Code, Documentation
and so on.

* Inthe center: the Editor (main Design area)

At the bottom: Component and Job tabs

Talend Open Studio for Data Integration User Guide 323



Trandating the scenario into a Job

» To the right: the Palette of business or technical components depending on the software tool you are using
within Talend Open Sudio for Data Integration.

To the left of the Studio, the Repository tree view that gives an access to:

e TheBusiness Modeler: For more information, see Section 3.3, “Modeling a Business Model”.

e The Job Designer: For details about this part, see Section 4.2, “ Getting started with a basic Job design”.

e The Metadata M anager : For details about this part, see Section 4.4.1, “How to centralize the Metadataitems”.
 Contexts and routines; For details, see Section 4.4, “Using the M etadata Manager”

To create the Job, right-click Job Designs in the Repository tree view and select Create Job.

In the dialog box displaying then, only the first field (Name) isrequired. Typein Californial and click Finish.
An empty Job then opens on the main window and the Palette of technical components (by default, to the right of
the Studio) comes up showing a dozen of component families such as: Databases, Files, Internet, Data Quality
and so on, hundreds of components are already available.

To read the file California_Clients, let’s use the tFilel nputDelimited component. This component can be found
inthe File/lnput group of the Palette. Click this component then click to the left of the design workspace to place
it on the design area.

Let’'s define now the reading properties for this component: File path, column delimiter, encoding... To do so,
let'suse the M etadata M anager . Thistool offers numerous wizards that will help usto configure parameters and

allow usto store these properties for aone-click re-use in all future Jobs we may need.

Asour input fileisadelimited flat file, let’s select File Delimited on theright-click list of the M etadata folder in
the Repository tree view. Then select Create file delimited. A wizard dedicated to delimited file thus displays:

» At Step 1, only the Name field isrequired: ssimply type in California_clients and go to the next Step.

» At Step 2, select the input file (California_Clients.csv) viathe Browse... button. Immediately an extract of the
file shows on the Preview, at the bottom of the screen so that you can check its content. Click Next.

« At Step 3, we will define the file parameters: file encoding, line and column delimiters... As our input file is
pretty standard, most default values are fine. The first line of our file is a header containing column names.
To retrieve automatically these names, click Set heading row as column names then click Refresh Preview.
And click Next to the last step.

» At Step 4, each column of the file is to be set. The wizard includes algorithms which guess types and length
of the column based on the file first data rows. The suggested data description (called schemain Talend Open
Sudio for Data Integration) can be modified at any time. In this particular scenario, they can be used as is.

There you go, the California_clients metadatais compl ete!

We can now use it in our input component. Select the tFilelnputDelimited you had dropped on the design
workspace earlier, and select the Component view at the bottom of the window.

Select the vertical tab Basic settings. In thistab, you'll find all technical properties required to let the component
work. Rather than setting each one of these properties, let’s use the Metadata entry we just defined.

Select Repository as Property typein thelist. A new field shows: Repository, click “...” button and select the
relevant Metadata entry on the list: California_clients. Y ou can notice now that all parameters get automatically
filled out.
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! ammgiity ;
tFileInputDelimited_1

Designer | Code

1 Job{Californial 0.1) Contexts{lob Californial 0.1 | %2 Component &2 (B Pun (Job Californial) =
=D
\ﬁ tFileInputDelimited 1 D
Basic settings Property Type Repository s | | DELIM: California_dlients E]
Advanced settings File namestream | "C:jDocuments and Settingsimlelandais/BureauCalifornia_Clients,cey" ?
Dvnamic settings Row Separator L ; Field Separator | ™" ?
Wiew -
L)
Documentation Header 1  Footer | 0  Limit o
Schema Repositary s+ | | DELIM: California_clients - metadata * [3 Edit schema [Z]

o [JUncompress as zip file [ Die an error

At this stage, we will terminate our flow by ssmply sending the data read from this input file onto the standard
output (StdOut).

To do so, add atL ogRow component (from the Logs & Errorsgroup).

Tolink both components, right-click theinput component and select Row/M ain. Then click the output component:
tL ogRow.

This Job is now ready to be executed. To run it, select the Run tab on the bottom panel.

Enable the statistics by selecting the Statistics check box in the Advanced Settings vertical tab of the Run view,
then run the Job by clicking Run in the Basic Run tab.
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100 rows in 0,625

F- Fo0 romnsds . |:||—L1':|
1 rowl (Main) ey,
tFileInputDelimited 1 tLogRow_1

Designet | Code

1y Job({Californial 0.1) ConkextsiJob Californial 0 | %2 Component | DB Run (Job Californial) 23 (%1 Problems =0

Job Californial

. Execution
Basic Run

Advanced Setkings

AT e | AR ek A T | e o e AT a1 Ak W Ak R dn AR | A AL & A Ak A

Target Exec Lyndon|Lincoln| 644 East lst Street |GRANADA HILLS o
Lyndon|Fillmore|1109 Tanger Blwd|HISSION HILLS
Ronald|Truman|417 Santa Rosa Horth |SANTA CLARITA
Harrv|Carter|1094 El Caminoc Real | CANYON COUNTRY
Calvin|John=on|1705% Cabrillo Highwaw |SUN VALLEY
Benjamin|HcEinley|1399 Santa Rosa North|VALENCIA
William|Jefferson|573 Jones Road|TARZANL
Ronald|Washington|1250 San Harcos|WESTLAKE VILLAGE
Theodore | Johnson | 957 Cerrillos Road | WOODLAND HILLS
Chester |Honroe|1392 Harbor Dr|STEYENSON RANCH
Ulysses|Trumnan| 267 Carpinteria Avenue|VAN HUYS
[statistic=] disconnected
Sl fRdrfarnisd anday g 100 &E SECTECSGIE fosr e
o =0 b

The content of the input file display thus onto the console.

B.1.2.2. Step 2: Mapping and transformations

We will now enrich our Job to include on-the-fly transformations. To implement these transformation, we need
to add atMap component to our Job. This component is multiple and can handle:

» multiple inputs and outputs

« search for reference (simple, cartesian product, first, last match...)

e join (inner, outer)

* transformations

* reections

» and more...

Remove the link that binds together the job’ s two components via aright-click the link, then Delete option. Then
place the tMap of the Processing component group in between before linking the input component to the tM ap
aswedid it previoudly.

Eventually to link the tM ap to the standard output, right-click the tM ap component, select Row/* New Output*
(Main) and click the tLogRow component. Typein outl in the dialog box to implement the link. Logicaly, a

message box shows up (for the back-propagation of schemas), ignore it by clicking on No.

Now, double-click the tMap to accessits interface.
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To the l€eft, you can see the schema (description) of your input file (rowl). To the right, your output is for the
time being still empty (outl).

Drop the Firstname and Lastname columns to the right, onto the Name column as shown on the screen below.
Then drop the other columns Address and City to their respective line.

rowl ey out1 & g L
Colurmn Excpression Colurmn
Firstnarme rowl Firstname+" "+rowl Lastname Marne
Lastname rowl, Address, talpperCasel) Address
Address rowl, Ciky ik
ity

Then carry out the following transformations on each column:

e Change the Expression of the Name column to rowl. Firstnane + " " + rowl. Last Nane.
Concatenate the Firstname column with the Lastname column following strictly this syntax (in Java), in order
for the columns to display together in one column.

» Changethe Expression of the Addresscolumntor owl. Addr ess. t oUpper Case() whichwill thuschange
the address case to upper case.

Then remove the Lastname column from the out1 table and increase the length of the remaining columns. To do
S0, go to the Schema Editor located at the bottom of the tMap editor and proceed as follows:

Zolumn key  Tvpe w| M., DatePattern... | Length  Precision = Def...  Comm.,
Firstname |:| akring 10 0
Lastname |:| Skring 10 0
Address [1 string 26 1]
City [1 string 2z 0

£

1. Select the column to be removed from the schema, and click the crossicon.
2. Select the column of which you need increase the length size.

3. Typeinthelength sizeyou intend in thelength column. In thisexample, change the length of every remaining
column to 40.

As the first name and the last name of a client is concatenated, it is necessary to increase the length of
¥ the name column in order to match the full name size.

No transformation is made onto the City column. Click OK to validate the changes and close the Map editor
interface.

If you run your Job at this stage (viathe Run view aswe did it before), you' |l notice the changes that you defined
are implemented.
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Designer | Code

‘py Job(Californial 0.1)
Job Californial
Basic Run

Debug Run

Advanced Settings

Targek Exec

Subjob: =/

|ﬁ roml I:M.EhinlfE ;|i u:uu_tl {Ma?n]l " u-\\

EFileInputDelimited _1 EMap_1 tLogRow_1

Contexts{ Job Californial 0 | %2 Component | OB Run (Job Califarnial) &5 (50 Problems

Execution
Lyndon Lincoln|644 EAST 15T STREET|GRANADA HILLS 4

Lyndon Fillmore|1109 TANGERE BLVD|MISSION HILLS
REonald Truman|417 SANTA ROSA NORTH|SANTA CLARITA
Harry Carter|1094 EL CAMING REAL|CAHNYON COUNTRY
Calwin Johnson|1705 CABRILLO HIGHWAY |SUH VALLEY
Benjamin McKinley|1399 SANTA ROSA HORTH|VALENCIA
William Jefferson|S573 JONES ROAD|TARZANA

Ronald Washington|1250 SAN HARCOS|WESTLAKE VILLAGE
Theodore John=on|957 CERERILLOS ROAD|WOODLAND HILLS
Chester Monroe|1392 HARBOR DR|STEVENSON RANCH
Uly=sses Truman|267 CARFINTERIA AVENUE|VAN HUYS
Joad SRl rfarnisd andes a6 11055 FESoTEOSTIET fesr e
onFe =7

= B8

For example, the addresses are displayed in upper case and the first names and last names are gathered together

in the same column.

B.1.2.3. Step 3: Reference file definition, re-mapping, inner join

mode selection

Define the M etadata corresponding to the LosAngel esandOrangeCounties.txt file just theway wedid it previously
for California_clientsfile, using the wizard.

At Stepl of the wizard, name this metadata entry: LA Orange cities.

Then drop this newly created metadata to the top of the design areato create automatically a reading component

pointing to this metadata.

Then link this component to the tM ap component.

328
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subjob: =/

>

LA_Orange_cities

FolE {I.Eu:u:ukup]l
e P
@ rawl (Main] . outl (Main T ey
" Calfornia_clients ' ' tMap_1 ' ' " tLogRow 1

Double-click again on the tMap component to open its interface. Note that the reference input table (row2)
corresponding to the LA and Orange county file, shows to the left of the window, right under your main input
(rowl).

Now let’s define the join between the main flow and the reference flow. In this use case, the join is pretty basic
to define as the City column is present in both files and the data match perfectly. But even though this was not
the case, we could have carried out operations directly at this level to establish alink among the data (padding,
case change...)

To implement the join, drop the City column from your first input table onto the City column of your reference
table. A violet link then displays, to materialize thisjoin.

rowl a Q
Zolurmn
Firstname
Lastname
Address
Ciky
row? & |
Expr, key Colurmn
@, rowl City ity
Counky

Now, we are able to use the County column from the reference table in the output table (outl).
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rowl rep iy outl F | L
Colurmn Expression Colurmn
Firstname rowl Firstnarme+" "+rowl. Lastname Marne
Lastname row ], Address, ballpperCasel) Address
Address o], Ciky Ciky
iy o, Counky Counky
rowz? & | B
Expr, ke Colurmn
@, rowl City ity
Counky

Eventually, click the OK button to validate your changes, and run the new Job.

The following output should display on the console.

Execution
Ulysse=s Taft|1794 GRANDVIEW DRIVE|GARDEN GROVE|ORANGE -

Theodore Grant|1895 PACIFIC HUY S|ORANGE | ORANGE

John John=on|1554 SAN ¥SIDRO BLVD|HORCO|

Warren Jackson|2897 MONROE STREET|VILLA PAREK|ORANGE

Warren Van Buren|1633 WESTSIDE FREEWAY |PLACENTIA|QORANGE

Rutherford Eisenhower|448 BURNETT ROAD|COROHA |

Zachary Taft|385 W. RUSSELL ST. |VORBA LINDA|ORANGE

Fachary Pierce|1292 FONTAINE ROAD|VENTURA|

George Garfield|685 VIA REAL|CAMARILIO|

Warren Tawlorl|A3IN HORTH ATHERTOW STREETICARPTHTERTA I b

Asyou can notice, thelast columnisonly filled out for Los Angelesand Orange counties’ cities. For all other lines,
this column is empty. The reason for thisis that by default, the tM ap implements a left outer join mode. If you
want to filter your data to only display lines for which a match is found by the tMap, then open again the tM ap,
click the tMap settings button and select the Inner Join in the Join Model list on the reference table (row?2).

B.1.2.4. Step 4: Output to a MySQL table

Our Job works perfectly! To finalizeit, let’ s direct the output flow to aMySQL table.

Todo so, let’ sfirst create the M etadata describing the connection to the MySQL database. Double-click Metadata/
MySQL/DemoMySQL in the referential (on the condition that you imported the Demo project properly). This
opens the Metadata wizard.

On Step2 of the wizard, type in the relevant connection parameters. Check the validity of this connection by
clicking on the Check button. Eventually, validate your changes, by clicking on Finish.

Drop this metadata to the right of the design workspace, while maintaining the Ctrl key down, in order to create
automatically atMysglOutput component.

Remove the tL ogRow component from your Job.

Reconnect the outl output flow from the tM ap to the new component tMysglOutput (Right-click/Row/outl):
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Subjob: =/

' L.ﬁ._O'ranbe_'cities '

rowz {Lg::u:ukup]l

|ﬁ ro 1 I;Main]l _ =% _u:uutl I:_Main]l ='—a

" California_clients EMap_1 " My5OL_Local DB

On the Basic Settings tab of this component:

1. Typein LA Orange Clientsin the Table field, in order to name your target table which will get created
onthefly.

2. Select the Drop tableif exists and create option or on the Action on table field.

3. Click Edit Schema and click the Reset DB type button (DB button on the tool bar) in order to fill out
automatically the DB type if need be.

Run again the Job. The target table should be automatically created and filled with datain less a second!

In this scenario, we did use only four different components out of hundreds of components available in the Palette
and grouped according to different categories (databases, Web service, FTP and so on)!

And more components, this time created by the community, are also available on the community site
(talendforge.org).

For more information regarding the components, check out Talend Open Studio Components Reference Guide.

B.2. Using the output stream feature

B.2.1. Introducing the scenario

The following use case aims to show how to use the output stream feature in a number of components in order
to greatly improve the output performance.

In this scenario, a pre-defined csv file containing customer information is loaded in a database table. Then the
loaded datais selected using atM ap, and output to aloca file and to the console using the output stream feature.

B.2.1.1. Input data

The input file, the data of which will be loaded into the database table, contains customer information of various
aspects.

The file structure usually called Schema in Talend Open Sudio for Data Integration includes the following
columns:;
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 id (Type: Integer)

» CustomerName (Type: String)
» CustomerAge (Type: Integer)

» Customer Address (Type: String)
 CustomerCity (Type: String)

» RegisterTime (Type: Date)

B.2.1.2. Output data

The tMap component is used to select id, CustomerName and Customer Age columns from the input data. Then
the selected data is output using the output stream feature.

Thus the expected output data should have the following structure:
* id (Type: Integer)

e CustomerName (Type: String)

» CustomerAge (Type: Integer)

All the three columns above come from the respective columnsin the input data.

B.2.2. Translating the scenario into a Job

In order to implement this scenario, break down the Job into four steps:

1. Create the Job, define the schema for the input data, and read the input file according to the defined schema.
2. Set the command to enable the output stream feature.

3. Map the data using the tM ap component.

4. Output the selected data stream.

A complete Job looks as what it displays in the following image. For the detailed instruction for designing the
Job, read the following sections.

@ rowl {Main! E q : okl {Main) =@ rowz (Main) " u..;‘

custdners tMap_1 tFileOutputDelimited_1 tLogRow_1

CnSubjobok,

pro

I:'Ja\-'a_i
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B.2.2.1. Step 1: Reading input data from a local file

Wewill usethetFilel nputDelimited component to read the file customers.csv for the input data. This component
can be found in the File/I nput group of the Palette.

1.

5.

Drop atFilelnputDelimited component onto the design workspace, and double-click the to open the Basic
settings view to set its properties.

@ customers(tFileInputDelimited_1) EE u
Basic settings Froperty Type Bulin bt H

Advanced settings File name/Stream | "C:fmyFolderfcustomers, ooy * E]
Drynamic settings Row Separator "in" Field Separakor  |";" *
Wigw [[]csv options

e Header n Footer |0 Lirnik

Validation Rules -
Schema Built-In v | Edit schema []

Skip empby rows || Uncompress as zip file [ Die on errar

Click the three-dot button next to the File name/Stream field to browse to the path of the input data file.
Y ou can also typein the path of the input data file manually.

Click Edit schema to open adialog box to configure the file structure of the input file.

Click the plus button to add six columns and set the Type and columns names to what we listed in the
following:

olurmn Key | Twpe ~| M., DatePatt...  Length  Pre...  D... Co..
id []  Integer
Customeriame |:| Skring
Customerhge |:| Inkeger
Customeraddress [ String
CuskomerCity |:| Skring
RegiskerTime [ Date "dd-rra-w,

Click OK to close the dialog box.

B.2.2.2. Step2: Setting the command to enable the output stream

feature

Now we will make use of tJava to set the command for creating an output file and a directory that contains the
output file.

To do so:

1. Drop atJava component onto the design workspace, and double-click it to open the Basic settings view to

Set its properties.

tlava_1 = [

Basic settings Code new java.io.File("C:/myFolder™) .wkdirs():
globalMap.put ("out_file”, new
java.io.FileOutputStream("C: /myFolder,/customerselection. txt” , false) ) ;

Advanced settings
Dynamic settings
Wign

Docurmentation
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2.  Fill inthe Code areawith the following command:

new java.io.File("C /myFol der") . nkdirs();

gl obal Map. put ("out _file", new java.io. Fil eQut put St ream("C: / nyFol der/
custonersel ection.txt", fal se));

The command wetyped in this step will create anew directory C:/myFolder for saving the output file
customer selection.txt which is defined followingly. Y ou can customize the command in accordance
with actual practice.

3. ConnecttJavatotFilel nputDelimited usingaTrigger > On Subjob Ok connection. Thiswill trigger tJava

. . I:I.l<- . . . :
o Orebjobok T3 ?
klava_1 ' ' " customers

B.2.2.3. Step3: Mapping the data using the tMap component

1. DropatMap component onto the design workspace, and double-click it to open the Basic settings view to
set its properties.

= EE
E:»\‘QE tMap_1 [

Basic settings Map Editor: E] Mapping links display as:  Auto W

Advanced settings Store on disk

Dynamic settings Temp data directory path: [3
Wiemy

Crocurnentakion

2. Click the three-dot button next to M ap Editor to open a dialog box to set the mapping.

3. Click the plusbutton on theleft to add six columnsfor the schema of the incoming data, these columns should
be the same as the following:
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=l

rowl rep iy

Colurnn
id
ZuskomerMame
Cuskomerfge
CustomerAddress
CuskomerCity
RegisterTime

Schema editor . Expression editor

rowl

Colurmn Key = Twpe w| M., DatePatte...
id [] 1Integer
CustomerMame [] string
Customerage [] Integer
Customeraddress [] string
CustamerCity [] string
RegisterTime [l Date " MR-y

Click the plus button on the right to add a schema of the outgoing data flow.
'@' Mewy outpuk oukl

(O create join kable From Mamed

Ik l [ Cancel

Select New output and Click OK to save the output schema. For the time being, the output schemais still
empty.

Click the plus button beneath the outl table to add three columns for the output data.

ouktl e Q
Expression Column
niewColurmn
newolurmnl
newZolumnz

Drop theid, Customer Name and Customer Age columns onto their respective line on the right.
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=[]

rowl re

Colurnn
id
Custamerilanme
Cuskomerfge
Customerfddress
CuskarmerCity
ReqisterTime

Schema editor ™ Expression editor
rowl

Colurnn
id
Customerhlame
Custamerage
Customeraddress
CustomerCity
ReqisterTime

<

Yar oo | @ XK £ Auto map!
Q outl ™ Q
Expression Column
row] id id
row 1 CustomerMame Custamerhlame
rawl.Customer Age Cuskormerfge
outl
Key Type Column Key Type 7 I T
O Integer id O Integer
|:| Skring CustomerMame |:| Skring
O Irkeger Customerage O Inkeger
|:| Skring
|:| String
O

Date
>

<

8. Click OK to savethe settings.

B.2.2.4. Step4: Outputing the selected data stream

1. Drop atFileOutputDelimited component onto the design workspace, and double-click it to open the Basic
settings view to set its component properties.

2. Select the Use Output Stream check box to enable the Output Stream field and fill the Output Stream
field with the following command:

(java.io. Qut put St rean) gl obal Map. get ("out _file")

Y ou can customize the command in the Output Stream field by pressing CTRL +SPACE to select

2 built-in command from the list or type in the command into the field manually in accordance with
actual practice. In this scenario, the command we use in the Output Stream field will call the
j ava. i 0. Qut put St r eamclass to output the filtered data stream to alocal file which is defined
in the Code area of tJava in this scenario.

=10
CEI tFileOutputDelimited_1 ol E

Basic settings
Advanced settings
Dwnamic setkings
Wiew
Documentation

Validation Fules

Property Type Builk-In w i
se Qukput Skream
Cutpuk Skream ¥iava.io. OukputStream)globaltap . gek{"out_Fils")

Fow Separator "I Field Separator |
Include Header  [] Compress as zip File

Schema Bult-ln & | Editschema []

3. Connect tFilelnputDelimited to tMap using a Row > Main connection and connect tMap to
tFileOutputDelimited using a Row > out1 connection which is defined in the Map Editor of tMap.

4. Click Sync columnsto retrieve the schema defined in the preceding component.
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Trandating the scenario into a Job

To output the selected data to the console:
1. Drop atLogRow component onto the design workspace, and double-click it to open its Basic settings view.

2. Select the Table radio button in the M ode area.

T =0 [:
Nl tLogRow_1 2
—
Basic settings Schema Built-In w | Edit schemna E]
Advanced settings Mode
(}Baﬂc

Dwnamic settings

Tahl int walues in cells of a tabl
iew () Table {print walues in cells of a table)

——— () ertical {each row is a keyvalue lisk)

Yalidation Fules

3. Connect tFileOutputDelimited to tL ogRow using aRow > Main connection.
4. Click Sync columnsto retrieve the schema defined in the preceding component.

This Job is now ready to be executed.

. = - - -- .I. a o -. - .
Iﬁ rowel l{f‘-’lain!E ;Ii okl {Main) '% rowz (Main) =~ ey

custdmers EMap_1 tFileCutputDelimited 1 tLogRow 1

Cnsubiobok

=5

Elawa 1

5. PressCTRL+Sto save your Job and press F6 to execute it.

The content of the selected datais displayed on the console.
SESr eIy Fof SutpneSirean & 150 8RS0 T

[ztati=tic=s] connecting to =ocket on port 4059
[stati=tic=] connected

tLogRow_1
id | CustomerHame | Custonerige
10001 | Warren 67
10002 | Woodrow [
10003 | Grover 7
10004 | Abraham 74
10005 | Chester 78
10006 | Calwin 63
10007 | Zachary 53
10008 | Chester 36
10009| Chester a0
10010 | Woodrow 57

[=tati=tic=s] dis=connected
OB R EpnESEreas snged 3¢ 450 IR GeRgiE fesr s code=ay
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Trandating the scenario into a Job

The selected data is also output to the specified local file customer selection.txt.
[= customerselection. bt

L S T 3 IR ~ L S e

iy
(]

11

id: CustomerMNane: Customer Age
10001; Warren: a7
10002 : Woodrow: 65
100035 ; Grover: 77
10004 ; dbraham: 74

10005; Chester ;75

10006 Calvin: 63

10007 Zachary: 53

10005; Chester;36
10009 ;: Chester; a0

10010 Woodrow: 57

For an example of Job using this feature, see Scenario: Utilizing Output Sream in saving filtered data to a local
file of tFileOutputDelimited in the Talend Open Sudio Components Reference Guide.

For the principleof the Use Output Stream feature, see Section 4.5.7, “How to usethe Use Output Stream feature”.
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Appendix C. System routines

Thisappendix givesyou an overview of the most commonly used routines, along with use cases. In this Appendix,

routinesfollow the order in which they display inthe Repository. They are grouped according to their types. Each
typeisdetailed in adifferent section.

For more information on how to define routines, to accessto system routines or to manage system or user routines,
see Chapter 8, Managing routines.

Before starting any data integration processes, you need to be familiar with Talend Open Sudio for Data
Integration Graphical User Interface (GUI). For more information, see Appendix A, GUI.
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Numeric Routines

C.1. Numeric Routines

Numeric routines allow you to return whole or decimal numbers in order to use them as settings in one or more
Job components. To add numeric IDs, for instance.

To access these routines, double click on the Numeric category, in the system folder. The Numeric category
contains severa routines, notably sequence, random and decimal (convertlmpliedDecimal Format):

Routine Description Syntax

sequence Returns an incremental numeric ID. [Nuner i c. sequence( " Par anet er
nanme", start value, increment
val ue)

resetSequence Creates asequenceif it doesn't exist|Numer i c. r eset Sequence  ( Sequence

and attributes a new start value. Identifier, start val ue)

removeSequence Removes a sequence. Nuneri c. RenbveSequence (Sequence
Identifier)

random Returns a random whole number|Nureri c. randon{ m ni mum start

between the maximum and|val ue, naxi mum end val ue)
minimum values.

convertlmpliedDeci mal FBettains a decimal with the help of an|Nuner i c.

implicit decimal model. convert | npl i edDeci mal For mat
("Target Format", value to be
convert ed)

C.1.1. How to create a Sequence

The sequence routine allows you to create automatically incremented I Ds, using atJava component:

System.out.println(Mumeric.sequence ("=21",1,1))
System.out.println(Mumweric.sequence ("1™, 1,1));

The routine generates and increments the | D automatically:

[ztatisticse] connecting to szocket on port 3360
[statistic=] connected

1

2

C.1.2. How to convert an Implied Decimal

It is easy to use the convertlmpliedDecimal For mat routine, along with atJava component, for example:

System.out.println (Mumeric.convertImpliedDecimalFormat (F9VaQr F1237))

Theroutine automatically converts the value entered as a parameter according to the format of theimplied decimal
provided:

1.23
[z2tatistics] disconnected
Jah FEsE rowiine andad 38 14015 G4eRSeSgi8 farr s cadesag
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Relationa Routines

C.2. Relational Routines

Relational routines allow you to check affirmations based on booleans.

To access these routines, double click on the Relational class under the system folder. The Relational class
contains several routines, notably:

Routine

Description

Syntax

ISNULL

Checks if the variable provided is a null
value.

Rel ati onal . | SNULL(vari abl e
checked)

to

be

To check a Relational Routine, you can use the ISNUL L routine, along with atJava component, for example:
System.out.println(Relational. ISNULL (nuall) ) ;

In this example, the test result is displayed in the Run view:

Starfing job fosf ronfinse af 14004 G8-005-50180.

[ztatistics] connecting to socket
[statistic=] connected

true

[ztatistics] disconnected

on port 3375

Joabh fesd rowiine anded g8 1400 GRS eRI8 faxr b cods=ig

C.3. StringHandling Routines

The StringHandling routines allow you to carry out various kinds of operations and tests on aphanumeric
expressions, based on Java methods.

To access these routines, doubleclick on StringHandling under the system folder. The StringHandling class
includes the following routines:

Routine Description Syntax

ALPHA checks whether the expression is arranged | St ri ngHandl i ng. ALPHA("stri ng to
in alphabetical order. Returns the true or|be checked")
false boolean accordingly.

IS ALPHA checks whether the expression contains|St ri ngHandl i ng. 1S _ALPHA("string
alphabetical characters only, or otherwise.|t o be checked")

Returns the true or false boolean
accordingly.

CHANGE replaces an element of a string with a|Stri ngHandl i ng. CHANGE("string to
defined replacement element and returns|be  checked", "string to be
the new string. repl aced", "repl acenent string")

COUNT Returns the number of times a substring|St ri ngHandl i ng. COUNT( " st ri ng to
occurs within a string. be checked", "substring to be

count ed")

DOWNCASE converts al uppercase letters in an|Stri ngHandl i ng. DOANCASE( " stri ng

expression into lowercase and returns the
new string.

to be converted")
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How to store a string in alphabetical order

Routine Description Syntax
UPCASE converts al lowercase letters in an|StringHandl i ng. UPCASE("string to
expression into uppercase and returns the|be converted")
new string.
DQUOTE encloses an expression in double quotation| St ri ngHandl i ng. DQUOTE("string to
marks. be enclosed in double quotation
mar ks")
INDEX returns the position of the first character in|St ri ngHandl i ng. | NDEX( " st ri ng to
aspecified substring, withinawholestring. | be checked", "substring
If the substring specified does not exist in|speci fi ed")
the whole string, the value - 1 isreturned.
LEFT specifies a substring which correspondsto| St r i ngHandl i ng. LEFT("string to be
thefirst n charactersin a string. checked", nunber of characters)
RIGHT specifies a substring which corresponds to| St ri ngHandl i ng. RI GHT( " chai ne a
thelast n charactersin a string. vérifier", nunber of characters)
LEN calculates the length of a string. StringHandl i ng. LEN("string to
check")
SPACE generates a string consisting of a specified|St ri ngHandl i ng. SPACE( nunber of
number of blank spaces. bl ank spaces to be generated)
UOTE encloses an expression in single quotation| St r i ngHandl i ng. SQUOTE("string to
marks. be enclosed in single quotation
mar ks")
STR generates a particular character a the|Stri ngHandl i ng. STR(' character to
number of times specified. be generated’, number of tines)
TRIM deletes the spaces and tabs before the first|St ri ngHandl i ng. TRIM "string to be
non-blank character in astring and after the|checked")
last non-blank character, then returns the
new string.
BTRIM deletes al the spaces and tabs after thelast| St ri ngHandl i ng. BTRI M "stri ng to
non-blank character in a string and returns|be checked")
the new string.
FTRIM deletesall the spacesand tabs precedingthe| St r i ngHandl i ng. FTRIM "stri ng to

first non-blank character in a string.

be checked")

C.3.1. How to store a string in alphabetical order

It is easy to use the ALPHA routine along with atJava component, to check whether a string is in alphabetical

order:

The check returns a boolean value.
Stareing jabh fesf rogtins a6 14058 G405 FENE

Systemwm.out.println(3tringHandling. ALPHA ("abodefg™) ) ;

[ztatistics] connecting to =ocket on port 3469

[=tatistic=s] connected
tLrue
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How to check whether a string is al phabetical

C.3.2. How to check whether a string is alphabetical

Itiseasy tousethelS_ALPHA routine a ong with atJava component, to check whether the string is al phabetical :

System.out.println(StringHandling.I5 ALPHA ("ab33cd"));

The check returns a boolean value.
Srarfrmy jobh roufined a8 I8 045 FReGSCSENE
[=tati=stic=] connecting to socket on port 3892
[ztatistics] connected
fal=e

[ztatistics] dizconnected
P o finel anded ¢ I8 0485 SRESeSRTE ferr b oode =iy

C.3.3. How to replace an element in a string

It iseasy usethe CHANGE routine along with atJava component, to replace one element in astring with another:

Gystem.out.println(3tringHandling. CHANGE ("hello
world!'", "gor 14", "guy™1) ;

The routine replaces the old element with the new element specified.
hello guy!

C.3.4. How to check the position of a specific
character or substring, within a string

The INDEX routine is easy to use along with atJava component, to check whether a string contains a specified
character or substring:

System.out.println(StringHandling. INDEX ("hello world!"™, "hello™)):
System.out.println(StringHandling. INDEX ("hello world!"™, "world™)):
Syvstem.out.println(StringHandling.INDEX ("hello world!™, ™IW});
System.out.println(StringHandling.INDEX ("hellc world!™, "2?")):

The routine returns awhole number which indicates the position of thefirst character specified, or indeed thefirst
character of the substring specified. Otherwise, - 1 isreturned if no occurrences are found.
SrArermy Fabh rogrinsd 3¢ F5 47 Sdeofse B ar g,

[ztati=stics] connecting to =ocket on port 4027
[statistics] connected

1]

)

11

-1

[=2tatistics] disconnected

Jof rautined anded ¢ 15047 S Sesgle. fasr s codesig

C.3.5. How to calculate the length of a string

The LEN routineis easy to use, along with atJava component, to check the length of a string:
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How to delete blank characters

System.out.println(StringHandling.LEN ("hella world!™)):

The check returns awhole number which indicates the length of the chain, including spaces and blank characters.
12

C.3.6. How to delete blank characters

The FTRIM routine is easy to use, along with a tJava component, to delete blank characters from the start of
achain:

Sy=stem.out.println(StringHandling. FTRIM (" Hello world '")):

The routine returns the string with the blank characters removed from the beginning.
SEArfrmy Fabh rogfinsd 36 J& 014 SdefselERE

[ztatisticse] connecting to s=ocket on port 3790
[statistic=] connected

Hello world |

[ztatistics] disconnected

Jof routined anded 3¢ J60Fd Sl nle fesr o oonde =iy

C.4. TalendDataGenerator Routines

The TalendDataGener ator routines are functions which allow you to generate sets of test data. They are based
on fictitious lists of first names, second hames, addresses, towns and States provided by Talend. These routines
are generally used when developing Jobs, using a tRowGenerator, for example, to avoid using production or
company data.

To access the routines, double click on TalendDataGener ator under the system folder:

Routine Description Syntax

getFirstName  |returns a first name taken randomly | Tal endDat aGener at or . get Fi r st Nane()
from afictitiouslist.

getLastName returns a random surname from a|Tal endDat aGener at or . get Last Nane()
fictitious list.

getUsStreet returns an address taken randomly|Tal endDat aGener at or. get UsSt reet ()
from a list of common American
street names.

getUsCity returns the name of a town taken|Tal endDat aGener at or. get UsCi t y()
randomly from a list of American
towns.

getUsSate returns the name of a State taken|Tal endDat aGener at or. get UsSt at e()
randomly from a list of American
States.

getUsSateld returns an ID randomly taken from|Tal endDat aGener at or . get UsSt at el d()
a list of 1Ds attributed to American
States.

No entry parameter isrequired as Talend providesthe list of fictitious data.
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How to generate fictitious data

Y ou can customize the fictitious data by modifying the TalendGenerator Routines. For further information on
how to customize routines, see Section 8.3, “ Customizing the system routines’.

C.4.1. How to generate fictitious data

It iseasy to usethe different functionsto generate datarandomly. Using atJava component, you can, for example,
create alist of fictitious client data using functions such as getFir stName, getL astName, getUSCity:

Systemm.
3vstermn.
System.
System.
3ystermn.
System.

out.println(Talendbatatenerator.
out.println(Talendbatatenerator.
.println(Talendbatatenerator.
out.println(Talendbatatenerator.
println(TalendbataGenerataor.
.println(Talendbatatenerator.

getFirstMName (1) ;
getLastName ()]
getT=City (]
getUs3tate ()] !
getlUs3tateIdi) )
getUs3treet (1)

ot

ont.
ont

The set of data taken randomly from the list of fictitious datais displayed in the Run view:
Searermy qabh fesd routins 38 Id044 SLom s SaTE

[statistic=s] connecting to socket on port 3907
[ztatistics] connected

Jinmy

Arthur

Dez Moines

Wyoming

T

Hilpa=s Street

[ztatistics] dizconnected

ol fEst pownfine angdss s i80S RS CERIE. fesr f code =S

C.5. TalendDate Routines

The TalendDate routines allow you to carry out different kinds of operations and checks concerning the format
of Date expressions.

To access these routines, double click on TalendDate under the system folder:

Routine Description Syntax

addDate adds n days, n months, n hours, n minutes| Tal endDat e. addDat e(" Stri ng date
or n secondsto aJavadate and returnsthe(i nitiale", "format Date - eg.:
new date. yyyy/ MM dd", whole n,"format of

the part of the date to which nis

The Date format is: "yyyy", "MM", "dd",|t 0 be added - eg.:yyyy").
"HH", "mm", "ss"' or "SSS".

compareDate comparesall or part of two datesaccording| Tal endDat e. conpar eDat e( Dat e
to the format specified. Returns O if the|dat el, Date date2, "format to be
datesareidentical, 1if thefirst dateisolder|conpared - eg.: yyyy- M dd")
than the second and -1 if it is more recent
than the second.

diffDate returns the difference between two datesin| Tal endDat e. di f f Dat e( Dat e1(),
terms of days, months or years according|Dat e2(), "format of the part of the
to the comparison parameter specified. date to be conpared - eg.:yyyy")

diffDateFloor returns the difference between two dates| Tal endDat e. di f f Dat eFl oor ( Dat e1(),
by floor in terms of years, months, days, Dat e2(), "format of the part of
hours, minutes, seconds or milliseconds|t he date to be conmpared - eg.: MV')

Talend Open Studio for Data Integration User Guide

345



How to format a Date

Routine Description Syntax
according to the comparison parameter
specified.
formatDate returns a date string which corresponds to| Tal endDat e. f or mat Dat e( " dat e
the format specified. f or mat - eg.: yyyy- MM dd
HH: nm ss", Date() to be formatted
formatDatel ocaléchanges a date into a date/hour string| Tal endDat e. f or mat Dat eLocal e
according to the format used in the target|("format target”, java.util.Date
country. date, "language or country code")
getCurrentDate |returnsthecurrent date. No entry parameter| Tal endDat e. get Cur r ent Dat e()
isrequired.
getDate returns the current date and hour in the|Tal endDat e. get Dat e(" For mat of the

format specified (optional). This string can
contain fixed character strings or variables
linked to the date. By default, the string is
returned in the format, DD/MM/CCY'Y.

string - ex: CCYY-Mw DD")

getFirstDayOfMqmthenges the date of an event to thefirst day

of the current month and returns the new
date.

Tal endDat e. get Fi r st DayMont h( Dat e)

getLastDayOfMo

nthanges the date of an event to the last day
of the current month and returns the new
date.

Tal endDat e. get Last DayMont h( Dat e)

getPartOfDate |returns part of a date according to the|Tal endDat e. get Part Of Dat e(" Stri ng
format specified. This string can contain|i ndi cating the part of the date
fixed character strings or variables linked{to be retrieved, "String in the
to the date. format of the date to be parsed")
getRandomDate |returns arandom date, inthe ISO format. |Tal endDat e. get RandonDat e( " f or nat
date of the character string",
String ninDate, String naxDate)
isDate checkswhether the date string corresponds| Tal endDat e. i sDate(Date() to be
totheformat specified. Returnstheboolean|checked, "format of the date
value true or false according to the{to be checked - eg.: yyyy-wMdd
outcome. HH: nm ss")
parseDate changesastringinto aDate. Returnsadate| Tal endDat e. par seDat e("format date
in the standard format. of the string to be parsed”,
"string in the format of the date
to be parsed")
parseDatelocale|parses a .string according to a specified| Tal endDat e. par seDat eLocal e("dat e
format and extracts the date. Returns|f or mat of the string to be parsed”,
the date according to the local format|"String in the format of the date
specified. to be parsed", "code corresponding
to the country or |anguage")
setDate modifies part of a date according to the|Tal endDat e. set Dat e(Dat e, whol e n,

part and value of the date specified and the
format specified.

"format of the part of the date to
be nodified - eg.:yyyy")

C.5.1. Ho

w to format a Date

The formatDate routine is easy to use, along with atJava component:
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How to check a Date

Syetem.out.println(TalendDate.formatDate ("dd-MM-vvvv", new Date |:|:| |

Thecurrent dateisinitialized according to the pattern specified by thenew dat e() Javafunction andisdisplayed
inthe Run view:
Srarfrng jobh roufinsel & FF 0S8 SRS FGTE.

2010-02-25 17:28:07
Job roufinsl anded ¢ 17058 FEAGSeSGIE Fasrf codesady

C.5.2. How to check a Date

It is easy to use the isDate routine, along with atJava component to check if a date expression is in the format
specified:
System.out.println(Talendbate.izhate ("2010-02-092 00:00:00%, Puyyy—-MM-dAd
HH:rm:ss") ) ;2

A boolean isreturned in the Run view:
Starérny b rowirnsl a8 170 FE FEogSeS0TE.

trus
Jod roufinsl anded ¢ 17058 SRS Fasr s codesig

C.5.3. How to compare Dates

Itis easy to use the formatDate routine, along with atJava component to check if the current date is more recent
than a specific date, according to the format specified.

System.out.println(TalendDate.compareDate (new Datel(),
TalendDate.parseDate ("vyyy-MM-dd", "2010/11/24"), "yyyy-MHM-dd")):

The current date is initialized by the Java function new dat e() and the value -1 is displayed in the Run view
to indicate that the current date precedes the reference date.
SEarermy Fabh rogfinsd 38 I8 G5 SEoGSeSETE

-1
Jof o finel anded 3¢ JE T SRS SRTE . fasr b oode =i

C.5.4. How to configure a Date

It is easy to use the setDate routine, along with a tJava component to change the year of the current date, for
example:

Svstem.out.println (TalendDate.formatDate ("vyvy/ MM/ dd HH:HE:SS",hew

Date())):

System.out.println(TalendDate.sectDate (new Date () 2011, "yvyyvy") )’

The current date, followed by the new date are displayed in the Run view:
SEaresng job roucinsd ¢ 18 0F SRS SETE,
2010-02-26 18:03:14

Sat Feb 26 18:03:14 CET 2011
Jab rogfinal andad at I8 GF FESTRSIGIG faxif oodesi7
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How to parse a Date

C.5.5. How to parse a Date

It is easy to use the parseDate routine, along with a tJava component to change a date string from one format
into another Date format, for example:

Syastem.out.println(TalendDate.parselDate ("yyyy-MM-dd HH:mm:=ss",

"1879-10-20 15:00:59")):

The string is changed and returned in the Date format:
Searesmy job rogeinsd ¢ 17055 GFoGFeS030

Sat Oct 20 19:00:59 CET 1979
Jof rowrirnsd andes ¢ I 058 BloRReSENE fesat oode =i

C.5.6. How to retrieve part of a Date

It iseasy to use the getPartOfDate routine, along with atJava component to retrieve part of adate, for example:
Date D=TalendDate.parselate "dd-MM-yvvy HH:meo:ss™, "13-10-2010 12:23:45");

System.out.println(D.to3tring()):
System.out.println(Talendbate.getParc0fbate ("DAT OF MONTH", Dj):
Jystem.out.println(Talendbate.getPart0fhate ("HONTH™, D)) !
System.out.println(Talendbate.getPartOfhate ("YEAR", D) ):
System.out.println(Talendbate.getPart0fbate ("DAT OF VEARM™, D):
System.out.println(Talendlbate.getParcOofbate ("DAT OF WEEK", D)) ;

In this example, the day of month (DAY_OF _MONTH), the month (MONTH), theyear (Y EAR), the day number
of theyear (DAY _OF_YEAR) and the day number of theweek (DAY _OF WEEK) arereturned inthe Run view.
All the returned data are numeric data types.

Searfrmy jobh rowiins af J0EF RIS 0NT.

[=tatiztics] connecting to =zocket on port 3565

[=tati=stics] connected

Wed Oct 13 12:23:45 CEST 2010

13

g

2010

286

4

[=tati=stics] disconnected
Job roufine andad 3¢ FECEF PP ECFENE fesd b o code=87

In the Run view, the date string referring to the months (MONTH) starts with O and ends with 11: 0
¥ corresponds to January, 11 corresponds to December.

C.5.7. How to format the Current Date

It is easy to use the getDate routine, along with a tJava component, to retrieve and format the current date
according to a specified format, for example:

System.out.println(TalendDate.getDate ("CCYY-MM-DD™) ) ;

The current date is returned in the specified format (optional):
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TalendString Routines

SEarEsmy Jjob roucinsd & 10058 G5oGEeS01 0,

2010-03-02
Joh rorrdrned anded a6 I 58 GEAGRSEIE. o b oode =T

C.6. TalendString Routines

The TalendString routines allow you to carry out various operations on a phanumerical expressions.

To accessthese routines, double click on TalendString under the system folder. The TalendString class contains

the following routines:

Routine

Description

Syntax

replaceJpecial Char For XM

Ilreturns a string from which
the special characters(eg.:: <,
>, &...) havebeenreplaced by
equivalent XML characters.

Tal endSt ri ng. repl aceSpeci al Char For X\
("string containing the special
characters - eg.: Thelma & Louise")

checkCDATAFor XML

identifies characters starting
with <! [ CDATA[ and
ending with ]J]> as
pertaining to XML and
returns  them without
modification. Transforms the
strings not identified as XML
inaformwhichiscompatible
with XML and returns them.

Tal endStri ng. checkCDATAFor XML("strin
to be parsed")

talendTrim

parses the entry string and
removes the filler characters
from the start and end of
the string according to the
alignment value specified: -1
for the filler characters at the
end of the string, 1 for those
at the start of the string and 0
for both. Returnsthe trimmed
string.

Tal endString.talendTrin("string to
be parsed", "filler character to be
renoved", character position)

removeAccents

removesaccentsfromastring
and returnsthe string without
the accents.

Tal endStri ng. renmoveAccents("String")

getAsciiRandomString

generates a random string
with a specific number of
characters.

Tal endSt ri ng. get Asci i Randontt ri ng
(whol e nunber indicating the |ength
of the string)

C.6.1. How to format an XML string

It is easy to run the replaceSpecialChar For XML routine along with a tJava component, to format a string for

XML:

System.out.println(TalendString. replaceSpecialCharForXML ("Thelma &

Loaise™) ) »
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How to trim a string

In this example, the "&" character is replaced in order to make the string XML compatible;
SEArErmy Fabh rogfinsd & 1548 GEoGFeS0E,

Thelmns &damnp; Louise
Joah rontinsl andes s¢ 15048 BEoRReSRNE. fesr s oodesiy

C.6.2. How to trim a string

It is easy to use the talendTrim routine, along with atJava component to remove the string padding characters
from the start and end of the string:

System.out.println(TalendString. talendTrim("**talend open studig*®#*=",

T B

System.out.println(Talend5tring. talendTIrim("**calend open studig®®®="
Ery 1))

Eystem.out.println(Talend5tring. talendTrim("**talend open studig*®*="
ety 0) )

The star characters are removed from the start, then the end of the string and then finally from both ends:
SEaresny qob rogiinsd & I4075 GEoGEeS01 0,

*#%talend open studio

talend open studio*xxx

talend open =tudio

Joab rogfinsl andad af 4017 SEoOFS0N0. farrl oode =07

C.6.3. How to remove accents from a string

It is easy to use the removeAccents routine, along with a tJava component, to replace the accented characters,
for example:

System.out.println(TalendString. removeldccents ("sdcrebleii! ™)) ;

The accented characters are replaced with non-accented characters:
SrArermy Fah rogrinsl 36 F& 8T G R

zacrebleul
Joab rogfinsd andad af 16005 SR-RF-FRI8. fasrf oode=a7
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Appendix D. SQL template writing rules

This chapter describesthe rules applied for the creation of SQL templates. It aimsto help users of SQL templatesin
Talend Open Studio for Data I ntegration to understand and devel op the SQL templatesfor more customized usage.

These rules provide details that you have to respect when writing the template statement, a comment line or the
different relevant syntaxes.

These rules helps to use the SQL code in specific use cases, such as to access the various parameters defined in
components.
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SQL statements

D.1. SQL statements

An SQL statement can be any valid SQL statement that the related JDBC is able to execute. The SQL template
code isagroup of SQL statements. The basic rules to write an SQL statement in the SQL template editor are:

* An SQL statement must end with ; .

» An SQL statement can span lines. In this case, no line should be ended with ; except the last one.

D.2. Comment lines

A comment line startswith # or - - . Any linethat startswith # or - - will be ignored in code generating.

Thereis no exception to the linesin the middle part of a SQL statement or withinthe<% . . % syntax.

D.3. The <% . . % syntax

This syntax can span lines. The following list points out what you can do with this syntax and what you should
pay attention to.

 You can define new variables, use Javalogical codelikei f, f or and whi | e, and also get parameter values.

For example, if you want to get the FILE_Name parameter, use the code as follows:

<%
String filename = _ FILE NAME _;
%>

* This syntax cannot be used within an SQL statement. In other words, it should be used between two separated
SQL statements.

For example, the syntax in the following code is valid.

#sql sentence

DROP TABLE t enp_0;

<%

#1 oop

for(int i=1; i<10; i++){
%

#sql sentence

DROP TABLE tenp_<%i %;
<%

}
%

#sql sentence

DROP TABLE tenp_10

In this example, the syntax is used between two separated SQL templates: DROP TABLE t enp_0; and DROP
TABLE tenp_ <%i %; .

The SQL statements are intended to remove severa tables beginning from temp_0. The code between <%and
%> generate a sequence of number in loop to identify tables to be removed and close the loop after the number
generation.
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The<%. . . % syntax

« Within this syntax, the<%-. . . % or </ . . . / > syntax should not be used.

<%...% and</.../>arealso syntax intended for the SQL templates. The below sections describe related
information.

Parameters that the SQL templates can access with this syntax are simple. They are often used for
’ connection purpose and can be easily defined in components, such as TABLE_NAME, DB_VERS ON,
SCHEMA_TYPE, etc.

D.4. The <%-. . . % syntax

This syntax cannot span lines and is used for SQL statement. The following list points out what you can do with
this syntax and what you should pay attention to.

» Thissyntax can be used to generate any variable value, and also the value of any existing parameter.
» No space char is alowed after <%-.
¢ Inside this syntax, the <%.% or </ ..[ > syntax should not be used.

The statement written in the below exampleisavalid one.

#sql sentence
DROP TABLE tenp <% TABLE NAVE  %;

The code is used to remove the table defined through an associated component.

For more information about what components are associated with the SQL templates, see Chapter 4, Designing
a data integration Job.

For more information on the <% . . % syntax, see Section D.3, “The<% . . % syntax”.
For more information onthe </ . . . / > syntax, see the following section.

Parameters that the SQL templates can access with this syntax are simple. They are often used for
¥ connection purpose and can be easily defined in components, such as TABLE_ NAME, DB_VERSON,
SCHEMA _TYPE, etc.

D.5. The</.../>syntax

This syntax cannot span lines. The following list points out what you can do with this syntax and what you should
pay attention to.

* It can be used to generate the value of any existing parameter. The generated value should not be enclosed by
quotation marks.

» No space char is alowed after </ or before/ >.
* Inside this syntax, the <%.% or <%= ..% syntax should not be used.

The statement written in the below exampleisavalid one.

#sgl sentence
DROP TABLE t enp_</ TABLE_NAME/ >;

The statement identifies the TABLE_NAME parameter and then removes the corresponding table.
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For more information on the <% .% syntax, see Section D.3, “The <% . . % syntax”.
For more information on the <%-..%> syntax, see Section D .4, “The <% . . . % syntax”.
The following sections present more specific code used to access more complicated parameters.

Parameters that the SQL templates can access with this syntax are simple. They are often used for
¥ connection purpose and can be easily defined in components, such as TABLE_NAME, DB_VERSON,
SCHEMA _TYPE, etc.

D.6. Code to access the component schema
elements

Component schema elements are presented on a schema column name list (delimited by adot “.”). These elements
are created and defined in components by users.

The below code composes an example to access some elementsincluded in acomponent schema. In the following
example, the ELT_METADATA SHEMA variable name is used to get the component schema.

<%

String query = "select ";
SCHEMA( __ELT METADATA SHEMA ) ;

for (int i=0; i < __ELT METADATA SHEMA .length ; i++) {
query += (__ELT METADATA SHEMA [i].name + ",");

}
query +=
%
<%query %,;

from" +  TABLE NAVE ;

In this example, and according to what you wantto do, the_ ELT METADATA SHEMA [i]. name codecan
bereplacedby _ ELT _METADATA SHEMA [i].dbType,__ ELT METADATA SHEMA _ [i].i sKey,
_ ELT METADATA SHEMA [i].length or __ELT METADATA SHEMA [i].null abl e to access
the other fields of the schema column.

The extract satement is SCHEMA(__ELT METADATA SHEMA );. In this statement,
ELT_METADATA SHEMA is the variable name representing the schema parameter to be extracted. The variable
name used in the code is just an example. Y ou can change it to another variable name to represent the schema
parameter you already defined.

Make sure that the name you give to the schema parameter does not conflict with any name of other
parameters.

For more information on component schema, see Section 4.2.6.1, “Basic Settings tab”.

D.7. Code to access the component matrix
properties

The component matrix properties are created and changed by users according to various data transformation
purposes. These properties are defined by tabular parameters, for example, the operation parameters or groupby
parameters that users can define through the tSQL TemplateAggr egate component.

To accessthese tabular parametersthat are naturally more flexible and complicated, two approaches are available:
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e The</. ../ > approach:

</ ...l >isone of the syntax used by the SQL templates. This approach often needs hard coding for every
parameter to be extracted.

For example, a new parameter is created by user and is given the name NEW_PROPERTY. If you want to access
it by using </ NEW PROPERTY/ >, the below code is needed.

elseif (paranmName.equals("NEW_PROPERTY™")) {

List<Map<String, String>> newProperty TableValue = (List<Map<String, String>>)
ElementParameterParser.getObjectVaue(node, " NEW_PROPERTY__");

for (intii = 0; ii <newPropertyTableValue.size(); ii++) {

Map<String, String> newPropertyMap =newProperty TableV alue.get(ii);

realValue += ...;/[append generated codes

» The EXTRACT( __ GROUPBY__ ) ; approach:

The below code shows the second way to access the tabular parameter (GROUPBY).

<%

String query ="insertinto" + _ TABLE_NAME__ + "(id, name, date_birth) select sum(id), name, date birth
from cust_teradata group by";

EXTRACT(__GROUPBY_);

for (inti=0; i <__GROUPBY_LENGTH__;i++){
query += (__GROUPBY _INPUT_COLUMN__[i] +"");
}
%>

<%=query %>;

When coding the statements, respect the rules as follows:

» The extract statement must use EXTRACT( __ GROUPBY__) ;. Upcase should be used and no space char is
alowed. This statement should be used between <%and %>.

e Use_ GROUPBY_LENGTH__, inwhich the parameter nameisfollowed by L ENGTH, to get the line number
of the tabular GROUPBY parameters you define in the Groupby area on a Component view. It can be used
between <%and % or <% and %.

* Use code like _ GROUPBY_I NPUT_COLUWMN__[i] to extract the parameter values. This can be used
between <%and % or between <% and %.

e In order to access the parameter correctly, do not use the identical name prefix for several parameters.
For example in the component, avoid to define two parameters with the names PARAMETER _NAME and
PARAMETER NANME 2, asthe same prefix in the names causes erroneous code generation.
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